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Preface
HansaWorld FirstOffice Start is a powerful accounting system for the
Windows, Linux and Macintosh platforms. The program is practically
identical in the three environments, and is designed to make administration
and accounting as easy and fast as possible. In the specific areas where there
are significant differences, these are described and illustrated in full. In all
other cases all illustrations are taken from the Windows XP version.
Text in square brackets - [OK], [Cancel] - refers to buttons on screen.
Information in this document is subject to change without notice and does not
represent a commitment on the part of HansaWorld. The Software described
in this document is a sophisticated information management system. Features
are liable to alteration without notice. This documentation is not intended as a
de facto representation of the system, but as an overview of its facilities. It
cannot be exhaustive in all respects. Whilst effort is made to ensure the
accuracy of the information published concerning the features and use of
HansaWorld FirstOffice Start software, it is still possible that certain
functions mentioned may not be fully implemented, may not be available
under certain circumstances, or may possibly relate to a future release of the
software. Errors and omissions excepted. HansaWorld accepts no contingent
liabilities. All HansaWorld FirstOffice Start software related transactions are
subject to HansaWorld's Conditions of Sale and Software Licence
Agreement. All rights reserved.
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Chapter 1: Introduction and Installation
HansaWorld FirstOffice Start is an integrated accounts and office
administration tool for Macintosh and Windows. It includes Sales, Purchase
and Nominal Ledgers, and a Calendar and Task Manager that you can use for
contact and diary management. The abbreviated term “FirstOffice” is used
throughout these manuals when referring to HansaWorld FirstOffice Start.
In this introductory chapter, we will describe the steps you need to follow to
get started with FirstOffice. Topics covered include installation and the
creation of a new database. Subsequent chapters cover FirstOffice’s working
environment, its structure and the way information is handled, and starting
work. The remaining chapters describe FirstOffice’s settings, used to define
preferences and look-up information, the individual registers in detail,
printing documents and reports and, finally, exporting and importing.

Structure of FirstOffice
The FirstOffice system consists of several registers, or files, in which
information of a particular type is stored. These registers interact with each
other in many ways. For example, all information about Customers is stored
in a Customer register, all information about Items is stored in an Item
register and so on. Information in the Customer register can be used by Sales
Invoices, and saving a Sales Invoice will normally cause a Nominal Ledger
journal to be generated in the Transaction register.
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The following illustration shows the registers available in FirstOffice—
Registers in FirstOffice Start

The first five registers are known as “Transaction Registers”. Each
transaction register represents a particular type of accounting transaction.
Invoices, Receipts (payments that you receive against Invoices that you have
issued), Purchase Invoices and Payments (that you issue against Purchase
Invoices) are each stored in separate registers. The Transaction register is
used for all other kinds of transaction (e.g. credit card payments, salaries,
transfers between bank accounts).
The other three registers are known as “Base Registers”. Base registers
typically contain information that is then used elsewhere. This information
will not itself be changed very often. For example, the Customer register is
effectively a list of Customer names and addresses that will be referred to
from the Calendar and from Invoices and Receipts.
Finally, the Calendar and Task Manager allow you to organise your diary,
providing a means of recording appointments and other tasks. These are
known as “Personal Registers”.
The integration between registers is quite straightforward: information in one
register can easily be accessed from other registers, so that there is never any
19
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need to type anything more than once. For example, the Sales, Purchase and
Nominal Ledgers can all access the Chart of Accounts, stored in the Accounts
setting.
In addition to the registers, there are several smaller files known as ‘Settings’.
The difference between a setting and a register lies in the frequency and
nature of use. The information with which you will be working daily, such as
Customers, Suppliers, Invoices and Receipts, tends to be stored in registers,
while information stored in settings tends to be used in ‘look-up’ tables or
used to determine the manner in which a particular function operates.

Work Flow
The administration of a company is always associated with a certain flow of
tasks and work. In a typical trading company, items are purchased from a
group of suppliers, they are then shipped to customers and invoices issued,
and payments are made and received. All transactions are logged and
recorded, and financial events are recorded in the appropriate transaction
register.
A modern financial system like FirstOffice is designed to automate as many
administrative tasks as possible. If information is entered in one part of the
system, there should be no need to enter it again elsewhere. Information
should be recorded for re-use, and it should be available throughout the
system.
The Administrative Workflow in a Business

N/L
N/L Trans

Payment

Invoice

SUPPLIER
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The illustration above shows a simplified description of the interaction of
functions and information (messages) in a traditional trading business. The
larger rectangles represent “administrative” functions that handle the flow of
information in the business. The smaller rectangles are messages containing
information that are passed around in the business. The dashed frame is the
boundary of the business: although Suppliers and Customers are on the
outside, there is a continuous exchange of information with them.
One of the tasks of the administration is to keep the organisation’s
“memory”. This is done with the help of files and registers, where
information about business events is kept. The following picture shows the
same structure as above, but the messages have been removed and are
replaced by the registers kept by the business.
Basic Registers in a Trading Business

N/L

P/L

Invoices
Payments
P/L

Accounts
Balances
Transactions

S/L

Invoices
Receipts
S/L

FirstOffice’s modular design provides a number of standardised tasks for
each functional area in a business. The design is very flexible, so that many
different types of business can use the software. In FirstOffice it is always
possible to access information immediately. If for example the person
involved with the Purchase Invoices needs some information about a Sales
Invoice, then it is immediately available to them without any need to leave
the system.
FirstOffice is an integrated accounting system. The different parts of the
system interact with each other. The Sales Ledger is for example integrated
with the Nominal Ledger so that as soon as an Invoice has been approved, all
ledgers in the company’s accounts are automatically updated. This interaction
is immediate, and covers the entire accounting system. All registers, ledgers
and reports are updated.
In many cases, this integration means that you, the user, will not notice the
actual creation of Nominal Ledger Transactions from the Sales and Purchase
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Ledgers. These Transactions constitute about 80% of the Nominal Ledger
transactions in a manual system - you simply can forget them, together with
all the hassle of reconciling the ledgers with each other. FirstOffice does all
this automatically. The picture below illustrates the integration process.
FirstOffice Start
Integration
Transactions
Invoice

Purchase Invoice

Receipt

Payment

N/L Transactions
are generated
automatically

N/L Transactions
entered manually

Nominal Ledger

Multi-year Database
FirstOffice uses a multi-year database. This means that Transactions,
Invoices etc. from several years are stored in the same database. Closing
balances for all accounts at the end of one financial year are automatically
converted into opening balances for the beginning of the next. The multi-year
database thus simplifies your end-of-year procedures.
FirstOffice’s database is continuous. Transactions are stored continuously,
with no periods fixed in advance. It is possible to extract reports for
completely arbitrary periods. When a certain period is finally reconciled it
can be closed for further entries. However, you can have as many periods
open as you wish.
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Preparing for Installation
FirstOffice is designed with a modern graphical user interface - for Windows,
Linux and Macintosh. It uses many different “windows” on the screen, one
for each task. The basic idea is to create a working environment that as
closely as possible relates to the way you handle papers, files and documents
on your desk.
Accounting tasks normally require that you work with several documents at
the same time. This fact is reflected in the design of FirstOffice, and
documents and reports are handled in a slightly different manner to what you
may be used to in word processors or spreadsheet programs. FirstOffice
therefore contains a number of features that you may not be familiar with.
If this is the first program you will be using in a Windows, Linux or
Macintosh environment, you should first of all take the time to learn as much
as possible about the computer and how to use it. And you must of course be
sure that the correct version of the computer’s operating system is installed.
Talk to your computer dealer or consultant if you are uncertain.
In the ‘Accounting Principles’ chapter later in this manual you can read more
about the basic accounting tasks in a business. Please ensure you read it if
this is your first attempt with computerised accounting.
Even if you are an experienced computer user, you should read this
Introduction, because FirstOffice contains a large number of features
designed to facilitate your work and to make it faster. If you are the ‘I-neverread-manuals’ type of person, you will of course be able to use FirstOffice
anyway - it is very simple. But there are some not so obvious shortcuts that
can save you a lot of time. They are all in the manual.
Efficient Management
FirstOffice is easy to use. By following the instructions in the installation
section of this manual, you can set up your invoicing system in a very short
time. You will quickly be able to get the benefits from an efficiently
functioning system for your Sales Ledger and debtors.
The basic idea with automatic administration is to make the computer do
most of the routine work. In the beginning it may seem a lot of work to enter
all the necessary information about Items and Customers, but that is really all
the preparation you have to do. It is not necessary to use all the many features
of FirstOffice. Remember, however, that the more basic information you can
enter into the various files and registers, the more the program will be able to
assist you in your work.
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Planning and Setting up
If this is the first time that you will be using a computerised accounting
system to manage your sales, purchase and nominal ledgers, or if you are
changing from another system, why not take a good look at the overall
operations? Maybe you can do things in your present operation more
efficiently.
A good idea is to sit down with pen and paper for a while, and go through
your Items (products and services you buy and sell), Accounts, Payment
Modes and Terms, etc. If some of the concepts of FirstOffice are new to you,
it is always a good idea to think first.
The setting up of a FirstOffice system in your business requires some
planning and forethought. You will have to make a number of decisions
about Customers, Items, statistical classifications, invoice procedures and so
on. FirstOffice allows a great deal of flexibility, and you can create almost
any work environment you want. But remember that you are in charge. If you
find that the standard Chart of Accounts is not suitable for your business,
only you can make the decision to use another chart. FirstOffice allows
almost anything.
Most people think that the beginning of the year is the only time when you
should change the accounting procedures in a business. Quite to the contrary,
it is better to change systems during the year. You can then select a calm
period of the year, enter all data from the beginning of the year and check the
outcome against reports produced from the previous system.
Remember that once the installation process has been completed, FirstOffice
does require some maintenance. At the very least, you should establish a
regular routine for backing up. A financial system is very different from a
word processor, which handles individual documents. FirstOffice works - like
all financial systems - with a database, in which all your data about
customers, invoices, nominal ledger etc. is stored in a single file. If you lose
that file, you have lost not just a single document, but all your accounting and
customer information.
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Installation
The installation of a FirstOffice financial system is technically simple. If you
are used to computers and have some experience of installing software, you
will find the installation of FirstOffice very straightforward.

System Requirements
Windows
You will need a Windows computer with a hard disk drive and a printer. The
minimum processor is a 450 MHz Pentium II (600 MHz PIII or P4
recommended). The minimum memory requirement is 256 Mb. You will
need at least 20 Mb of free space on your hard disk for FirstOffice and your
data. Windows 98SE/2000/XP must be installed: you can also use Windows
NT (NT 4 Service Pack 6) but it is not recommended. Windows 98 is not
supported. GdiPlus.dll must be present in the same directory as the
application if you are using Windows 98 Second Edition (SE) or Windows
NT 4 Service Pack 6, and Unicows.dll should also be in that directory if you
are using Windows 98SE.
Macintosh
You will need a Macintosh with a hard disk drive, a printer and at least 64
Mb (OS 9) or 128 Mb (OS X) of internal memory. The minimum
recommended machine is an iMac or a Macintosh G3 (G4 if you are using
OS X). You will need some 20 Mb of free space on your hard disk for
FirstOffice and your data. FirstOffice requires Macintosh System 9.2.1 (or
later), or 10.2.7 (or later). OS 9 support will be discontinued in FirstOffice
version 5.0.
Linux
Please refer to the Windows or Macintosh sections above for details of
hardware requirements. Recommended distributions are Red Hat 7.1, SuSE
7.0, Slackware 7.2 or similar/later. The X Window System should be
installed.

Installation
FirstOffice is supplied on a CD-ROM, and you can always obtain the latest
version from the Downloads area of our website, www.hansaworld.com.
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The CD-ROM contains an installer program for installing FirstOffice on a
Windows machine. Self-expanding archives are provided for other platforms
(Linux, and Macintosh OS 9 and OS X). The files available for downloading
from our website are all self-expanding archives.
In this section we first describe installing from a self-expanding archive (in
which case the basic procedure is the same for all platforms). This is
followed by a description of the Windows installer program that can be found
on the CD-ROM.
1.

To install from a self-expanding archive, first create a new folder on your
hard disk.

2.

Copy the archive that is correct for your machine and operating system
from the CD-ROM into this folder, or move the file that you have
downloaded into this folder.

3.

Make sure you have at least 20 Mb available for the FirstOffice
application, the associated files and for the data file which will be created
the first time you launch FirstOffice. Then, double-click the file to
expand it.

4.

In some operating systems (e.g. Windows), you will now be asked where
you would like the FirstOffice application and associated files to be
saved.

Specify where you would like the application to be saved, using the
[Browse] button if necessary to locate the correct folder. Click [OK].
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In other operating systems (e.g. Macintosh OS 9 and OS X), the
FirstOffice application and associated files will be saved in the folder
containing the self-expanding archive.
5.

A thermometer bar will show you how the installation is progressing.

To install FirstOffice from the CD-ROM using the Windows installer
program, follow these steps—
1.

Start Windows.

2.

Insert the FirstOffice CD-ROM into your CD drive.

3.

If you have Windows NT, go to the Main window and open the File
Manager by double-clicking. Select the CD drive (usually D:) by
clicking the appropriate button in the top left-hand corner of the window.
If you have Windows 98SE/2000/XP, go into the Explorer or “My
Computer” window and double-click the icon representing your CDROM drive. The following window opens—

Double-click “FOStart43ENGSetup” (or “FOStart43ENGSetup.exe” if
you have chosen to show extensions in the Explorer).
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Alternatively, select the ‘Run’ command from the Start menu (Windows
98SE/2000/XP) or from the File menu in the File Manager (Windows
NT). The illustration below is from Windows XP—

4.

In the Command line field, type “D:\FOStart43ENGSetup.exe” (where
“D” represents your CD or DVD drive), and where
FOStart43ENGSetup.exe is the name of the installer program on the CDROM) and press [OK].
The following window will be opened—
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5.

Click [Next]. The following window appears—

The empty space on the hard disk is shown at the bottom. Check that you
have at least 20 Mb free: the installation will require 12.2 Mb, and a data
file will be created as soon as you run FirstOffice for the first time.
By default, FirstOffice will be installed in a directory named
“HansaWorld FirstOffice Start” in the “Program Files” directory. You
can choose another destination if necessary. When you have decided
where FirstOffice is to be saved, click [Next].
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6.

The following window appears—

Use this window to name the Shortcut Folder that the installer will add to
your Start menu.
Click [Next] and follow the on-screen instructions to begin the
installation process. A thermometer bar will show you how the
installation is progressing.
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Under Windows NT, the installation process will create a Program
Group and some icons in the Windows Program Manager. A message
will tell you that the installation was successful. If anything went wrong,
you will be informed.
Under Windows 98SE/2000/XP, the FirstOffice application will be
installed in a new FirstOffice directory. The installer will also create a
shortcut, allowing you to launch FirstOffice from the Start menu.
Whether you install using a self-expanding archive or the Windows installer
program, the resulting FirstOffice folder or directory will also include some
files containing a Chart of Accounts, report definitions, a help file, standard
settings, document definitions and a sample database. These are described in
the section entitled ‘After Installation’ immediately below.

After Installation
The FirstOffice directory or folder contains a number of files—

Shown is the Windows XP folder: its appearance on your computer and the
number of files and folders may differ slightly according to the type of
machine you are using, its operating system and certain other settings. In the
illustration, for example, all file extensions are shown. Some or all of the
following files should be present—
1.

The FirstOffice application, consisting of the program file “1Office.exe”
or “1Office” (Windows) or “1Office” (Macintosh).
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2.

The “Hob” folder, containing language and other files. This must be
present in the same folder or directory as the FirstOffice application.

3.

The file “DBDef.txt”, which is used by FirstOffice to import some basic
settings data whenever a new database is created. This file must be
present in the same directory as the program when a new database is
created.

4.

The file “Default.txt”, which is used by FirstOffice to import some basic
settings data whenever a new Company is created. This file must be
present in the same directory as the program when a new Company is
created. Companies and databases are described below on page 33.

5.

The file “FOStartStandard.txt” which contains sample set-up data,
“UKAccounts1.txt”, which contains a sample Chart of Accounts, and
“FOStartForms.txt”, which contains templates for Invoices and other
forms. If you wish to use these, follow the instructions in the section
entitled ‘Creating a New Company’ below on page 34 first to create a
new database and then import these settings. The name and precise
make-up of this file will vary according to the country of use. In some
installations, these two files will be placed in a folder named “Setup”.

6.

A back-up of an example database for training purposes
(“FODemoDataMay2005.txt”). It includes the Chart of Accounts and
other settings that are also in the files described in the previous
paragraph. To use the example database, follow the instructions in the
section entitled ‘Restoring from a Back-up’ below on page 55 covering
the creation of a new database and the importing of a back-up file. In
some installations, this file will be placed in a folder named “Setup”.

7.

An “Attach” folder, which must be present if you want to attach files to
records. Such Attachments are fully described on page 111 in Chapter 2,
‘Work Area’. In some installations, this folder will not be created until
you run FirstOffice for the first time.

8.

A “Backup” folder to be used for storing daily back-up files. In some
installations, this folder will not be created until you run FirstOffice for
the first time.

9.

Two extra folders, “PS” and “Scripts”, will be present in Linux
installations.
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Starting FirstOffice
Companies and Databases
The key components of a FirstOffice system are the application and the
database. The application, or program, has the following symbol in the
directory window (Windows) or in the Finder (Macintosh)—

The database is the file used by FirstOffice to store its data. This file must be
called “1Office.hdb”. In many cases, that data will pertain to a single
company. However, where there are separate departments or subsidiary
companies that keep separate accounts, their data can also be stored in a
single database, in separate ‘Companies’. If you set up more than one
Company in FirstOffice, each will be completely separate: there will be no
common information, although it is possible to copy from one to another
using the export and import functions. Separate account balances will be
maintained, and each Company within a database can be backed up
separately or together.
You should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.

!

The database file must have the name
“1Office.HDB” and be present in the
same folder or directory as the
FirstOffice application. If you moved
the database file or rename it, a new
database will be created the next time
you start FirstOffice.

Loading an Existing Database and Company
Start FirstOffice just like any other Windows, Linux or Macintosh
application, by double-clicking the program icon. FirstOffice will load the
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database named “1Office.HDB”. If this is not present in the folder or
directory, a new database will be created automatically.
If you have a single Company in your database, that will be loaded by default
and you will be ready to start work.
If you have more than one Company in your database, you will be asked to
select one before work can begin.

Double-click the appropriate Company in the list, or highlight it and press the
Enter key on your keyboard. The database is now ready to use.

Creating a New Database
In the event that you need to create a new database, simply ensure there is no
database file with the name “1Office.HDB” in the same folder as the
FirstOffice application when launching. A new database will be created
automatically.
The “DBDef.txt” and “Default.txt” text files must be present in the same
folder as the application when a new database is created. FirstOffice will use
these files to set some initial preferences in the new database.

!

The installation will not be correct if
the “DBDef.txt” file is missing.

Creating a New Company
When creating a new database, the first task is to enter a new Company.
FirstOffice automatically opens the ‘Companies: Inspect’ window, allowing
you to do this.
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If the ‘Companies: Inspect’ window is not opened at this point, this is
because your example of the “DBDef.txt” file has instructed FirstOffice to
create a new Company automatically. In this case, turn now to the next
section, ‘Importing from a Back-up’ and continue with the set-up sequence
from there. When you reach the section entitled ‘Adding New Companies’,
follow its instructions to change the Company’s name to something more
suitable.

Click in the Code field in the first blank row and enter information as
described below. Use the Tab or Return key to move from field to field.
The following fields are present in this window—
Code

Enter a unique code. This can be a numeric code greater
than 0 or an alpha code of up to five characters.

Name

Enter a name by which this company or department will
be identified in the ‘Select Company’ window
(illustrated at the end of this section). This window will
allow you to choose the Company you want to work
with each time you log in to FirstOffice.

Short

If you have more than one Company in your database,
you can switch between Companies in a work session,
leaving windows from each Company open. This Short
Code appears as part of every window title to indicate
the Company to which the information in the window
belongs.

You can only enter one Company now: if you need more than one, you will
be able to add them later in the set-up process (described in the ‘Adding New
Companies’ section below on page 40). You can have up to four Companies.
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The “Default.txt” text file must be present in the same folder as the
FirstOffice application when you create a new Company. FirstOffice will use
this file to import some basic settings to the new Company. When the entry is
complete and you have made certain that the “Default.txt” file is in the right
place, click the [Save] button in the top right-hand corner of the Company
screen.
You should now inform FirstOffice that you wish to use the Company you
have just created. The ‘Select Company’ list window will appear
automatically—

Select the single Company to work with and press the Enter key.
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Importing from a Back-up
FirstOffice will now open a window listing back-up files that can be
imported. FirstOffice looks in the folder or directory containing the
application for folders named “Backup” and “Setup”. Any files in these
folders in the correct format are listed in this window.

Proceed down one of the following routes, depending on your
circumstances—
1.

If you are launching FirstOffice for the first time, you will not have any
back-up files to be imported. If you do not wish to import the example
database or the sample Chart of Accounts, close the window using the
close box and refer to the next section, ‘The Work Area’.

2.

If you are launching FirstOffice for the first time and wish to import the
example database or the sample Chart of Accounts, double-click the file
to be imported, or highlight it and press the Enter key. If you choose to
import the example database, FirstOffice will quit when it has finished
importing the file. Restart FirstOffice and log in as SJ with no password.

3.

If you are creating a new FirstOffice database which is to be based on
your existing data (perhaps you are restoring from a back-up because
your previous database has become damaged or because you are
updating to a new version), double-click the back-up file to be imported,
or highlight it and press the Enter key. For full details of this process,
please refer to the ‘Restoring from a Back-up’ section below on page 55.

The Work Area
Whether you imported a back-up file or not, the FirstOffice work area will
now appear. This will be the basis for all your work in FirstOffice and is fully
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described in the next chapter, ‘Work Area’. It is illustrated below to enable
you to identify the various parts of the screen mentioned in the following
sections.

HansaWorld.com
Menu Bar
Registers

Personal
Desktop

Menu Commands

Master
Control
Panel

Settings
FirstOffice contains a number of settings that you can use to control how the
program operates. You can access them by selecting ‘Settings’ from the File
menu or by clicking the [Settings] button in the Master Control panel. Before
you start working with FirstOffice, you should look at the settings, since its
functions depend on the settings being correct.
Many settings take the form of options or preferences. Others, such as
Company Info, that will be considered next, require information or a number
of records to be entered.
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Changing the Company Name
You will now enter your company name, address and other information to be
used in reports and documents such as Invoices.
Select ‘Settings’ from the File menu or click the [Settings] button in the
Master Control panel to bring up the ‘Settings’ list window—

In the list, select ‘Company Info’ by double-clicking. The ‘Company Info:
Inspect’ window appears.

Enter the name, address and other information as shown in the example
illustration.
Click the button marked “Reg” towards the top centre of the window to see
the other fields in this setting.
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The Bank Customer ID is an ID number used for automatic (modem)
communication with certain credit institutions in some countries. The Edit
and Report Font fields allow you to select different fonts for use on screen
and in reports respectively. If you leave these fields empty, FirstOffice’s
default fonts will be used. These are selected for maximum readability, and
you should only change them if you have good reasons to do so. In nonEnglish versions of FirstOffice, use these fields to select fonts with special
character sets.

VAT Law and Character Set ensure the behaviour of FirstOffice conforms to
certain local conventions of the country in which it is being used. To choose
the correct VAT Law and Character Set for your location, place the cursor in
one of these fields and then press the Ctrl-Enter (Windows and Linux) or Enter (Macintosh) key combination. A selection list will appear in which you
can choose an option by double-clicking. In the case of the VAT Law field, if
your country is not listed in the ‘Paste Special’ list, choose the “Default”
option.
Details of the other fields can be found on page 210 in Chapter 5, ‘Settings’.
When you have completed the window, click the [Save] button in the top
right-hand corner to save the changes and close the window.
Adding New Companies
If your business is one where there are separate departments or subsidiary
companies that keep separate accounts, you can set these up as separate
accounting entities in FirstOffice. Each department or subsidiary is termed a
‘Company’. If you set up more than one Company in FirstOffice, each will be
completely separate: there will be no common information, although you can
copy from one to another using the export and import functions or by
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dragging and dropping. Separate account balances will be maintained, and
each Company within a database can be backed up separately or together.
You should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.
If you need more than one Company, the next task is to ensure that the
correct number of Companies has been registered (by default, this will be set
to one). If you no longer have the ‘Settings’ list on screen, select ‘Settings’
from the File menu or click the [Settings] button in the Master Control panel
once again. Select ‘Configuration’ by double-clicking. The ‘Configuration:
Inspect’ window appears—

If the number shown is wrong, enter the correct number (up to a maximum of
four) in the No. of Companies field. Choose the options that describe your
hardware most accurately in the Computer Hardware and Computer OS
fields. To choose an option, place the cursor in one of these fields and press
the Ctrl-Enter (Windows and Linux) or  -Enter (Macintosh) key
combination. A selection list will appear in which you can choose an option
by double-clicking. Finally, click [Save].
If you intend applying for an Enabler Key using the ‘Automatic Internet
Enabler’ method, you should at least make sure you have specified your
Computer Hardware and Computer OS in the Configuration setting before
doing so. The other information will be downloaded from the HansaWorld
server together with the Enabler. If you will use one of the other methods to
apply for an Enabler Key, you must make sure the Configuration setting is
complete and correct before applying. Details about applying for an Enabler
Key are below on page 43.
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Changing and Adding Companies
If you want to change the company identifier that appears in the title bar of
each window, and/or you need more than one Company, you can do this now.
Click the [Companies] button in the Master Control panel—

Then, select ‘Open Company Register’ from the Operations menu. The
‘Companies: Inspect’ window that you saw earlier is opened, showing the
Company that you created—

To create more Companies, click in the Code field in the first blank row and
enter information as described in the section above on page 34 entitled
‘Creating a New Company’. Remember, this should only be done for parts of
your business that are completely separate accounting entities to the first
Company.
If you are creating a new Company, the “Default.txt” text file must be present
in the same folder as the FirstOffice application. FirstOffice will use this file
to import some basic settings to the new Company.
It is advisable to enter as many Companies as you need now (up to a
maximum of four), so that you only need apply for an Enabler Key once. You
will be able to enter all set up information such as a Chart of Accounts to one
Company and then to export those settings to the other Companies.
Remember that each Company will maintain completely separate accounts,
so there is no need to create separate Companies for departments that are part
of the same accounting whole.
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When the entry is complete, click the [Save] button in the top right-hand
corner of the Company screen.
For security reasons, FirstOffice will shut down after any changes or
additions have been made in the Companies setting. Restart the program to
continue working.
For each Company added, you should now repeat the process described
above on page 39 in the ‘Changing the Company Name’ section, entering the
correct company name and address. To change Companies, select
‘Companies’ from the File menu and choose another Company in the list that
appears. Depending on the method you will use to apply for an Enabler Key,
this work should be completed before doing so.
The Enabler Key
The next stage is to inform FirstOffice that you have a full licence for its use.
A FirstOffice licence normally gives you the right to use the program for a
single database. Each database will normally require its own Enabler key
provided to you on application by your local FirstOffice distributor. When
you first purchase FirstOffice, this Key is absent but FirstOffice will be fully
operational for 30 days after installation, allowing time for the set-up work
described in the previous sections. After 30 days, if you have not applied for
your Key, FirstOffice will change to demonstration mode: it will remain fully
functional, but printing will be disabled. You can apply for the Key at any
time (before or after the 30 day point), but before doing so you should ensure
you have entered all required Companies in the Companies setting and named
them all in the Company Info setting (as described above).
To gain full use of the program, you need to obtain an Enabler Key. You can
do this using one of three methods, described below.
Once you have obtained a Key, if you change the Valid Until Date in the
Configuration setting, FirstOffice will go into demonstration mode. You can
regain full use of FirstOffice by reverting the Configuration setting to its
original state.
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If you add a new Company to the database, or change the Company Name in
the Company Info setting in any existing Company, this will also cause
FirstOffice to go into demonstration mode. In this case, however, you can
only regain full use of FirstOffice by applying for a new Key.

!

Set up your Companies and define
the Configuration and Company Info
settings in each one before applying
for an Enabler Key.

If you need to call HansaWorld support for help obtaining an enabler, you
can find your local telephone number by clicking the “Countries” link at
www.hansaworld.com.

Automatic Internet Enablers
If you use the Automatic Internet method to apply for an Enabler Key, you
will instruct your copy of FirstOffice to connect to the connect to the
customer database on the HansaWorld server, which contains details of your
contract. A Key will then be downloaded from the HansaWorld server, as
will the number of companies and other information to the Configuration
setting. Everything previously in the Configuration setting will be
overwritten. Unlike the other methods, therefore, you do not need to ensure
the Configuration setting is complete or accurate before applying for a Key
using this method. All you need do is make sure you have specified your
Server Hardware and Server OS in the Configuration setting. You should also
make sure you have recorded your company name in the Company Info
setting. Follow these steps—
1.
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If you no longer have the ‘Settings’ list on screen, select ‘Settings’ from
the File menu or click the [Settings] button in the Master Control panel
once again. Select ‘Internet Enablers’ by double-clicking.
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2.

Fill in the fields as follows—

Registered in

Enter the country where your company is registered. To
choose an option, place the cursor in this field and press
the Ctrl-Enter (Windows and Linux) or -Enter
(Macintosh) key combination. A selection list will
appear in which you can choose an option by doubleclicking.

Customer Code at HansaWorld
Enter the Customer Number allocated to your company
by HansaWorld. This can be found on your HansaWorld
invoice.
Contract Number at HansaWorld
Enter the Customer Number allocated to your company
by HansaWorld. This can be found on your HansaWorld
invoice.
Contract Daughter No.
In most cases, this field can be left blank. If appropriate,
enter here the contract number of your parent company
here, or your sub-contract number if, for example, you
have two contracts.
3.

If you do not have enough information to fill in these fields (e.g. you do
not know your Customer Code at HansaWorld), click the [Automatically
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Fill These Settings] button. Assuming you are connected to the internet,
your copy of FirstOffice will connect to the customer database on the
HansaWorld server. It will then search the customer database for your
company name as entered in the Company Info setting. The two names
must match exactly: an extra space, for example, will mean that a match
will not be found. If it does not find a match, it will search for your VAT
Number, telephone number and company registration number. If any of
those match, it will download information to these fields from the
customer database.
4.

Click the [Save] button in the Button Bar to save the Internet Enablers
setting.

5.

The setting will close: re-open it and click the [Register for Automatic
Internet Enablers] button. Assuming you are connected to the internet,
the Registration No. field in the Internet Enablers setting and the Valid
Until and Enabler Key fields in the Configuration setting will be filled in
automatically.

The Valid Until date will be set to three months from the current date or to
the end date of your contract, whichever is the nearer. Once a month your
copy of FirstOffice will connect to the HansaWorld server automatically to
get a new Enabler Key. The new key will add an extra month to the Valid
Until date. If for some reason this automatic process fails and your copy of
FirstOffice is unable to obtain a new key, it will attempt to connect once a
day for the next two months. If it is still unable to obtain a new key, your
copy of FirstOffice will go into demonstration mode. If you want to activate
the monthly connection yourself, open the Configuration setting and select
‘Connect to get your Enabler’ from the Operations menu. The next automatic
connection will occur one month later.
As mentioned above, everything previously in the Configuration setting will
be overwritten when you apply for an Enabler Key using this method. It is
therefore recommended that you check the Configuration setting once you
have obtained your Key. Call HansaWorld support if you think the new
settings are wrong.
If your application for an Enabler Key is unsuccessful, the probable reasons
are—
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i.

You did not save the Internet Enablers setting in step 5 before clicking
the [Register for Automatic Internet Enablers] button.

ii

A “server not responding” message is usually caused by your firewall. It
is recommended that you re-configure it to allow communication with
www.hansaworld.com.
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HansaWorld.com Website Enablers
If you have an internet connection but your copy of FirstOffice is not on a
computer that is connected to the internet, you can obtain an Enabler Key
through the www.hansaworld.com website. This method uses the Control
String and Control Code to determine the Enabler Key. So, if you are using
this method, you must make sure you have created all the Companies that
you need and that you have defined the Configuration and Company Info
settings in each one before applying for an Enabler Key.
Follow these steps—
1.

If you are using Internet Explorer 6, you will need to check your internet
security settings and add www.hansaworld.com as a trusted site.

2.

Open the Configuration setting.

3.

Enter the expiry date of your FirstOffice contract in the Key Valid Until
field. Make sure the setting is otherwise complete and accurate, and click
the [Save] button in the Button Bar to save and close it.

4.

Quit and restart your FirstOffice system. This will force the Control
String and Control Code to be recalculated.

5.

Produce a Company Info report: this is described on page 433 in Chapter
10,‘Reports’, later in this manual.

6.

Go to www.hansaworld.com and click the “Enablers” link.

7.

Click the appropriate link for the country where your company is
registered.

8.

Enter your Customer Number and click the [Register] button to be given
a password. The password will be sent to you by fax or email. Your
Customer Number can be found on your HansaWorld invoice. You can
also use the [Register] button if you already have a password but have
forgotten it.

9.

Enter your Customer Number and password and follow the instructions
on screen.

Contact HansaWorld support if you don’t know your Customer Number or if
the password email does not arrive.
If your application for an Enabler Key is unsuccessful, the probable reasons
are—
i.

The “Unknown Log in”, “No valid contract” or “You are not properly
registered with us” messages mean you clicked the wrong customer link
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(wrong country), you entered your Customer Number and/or password
incorrectly, or you have not signed and returned your maintenance
agreement.
ii. The “Enabler failed” message means that the information in your
Configuration setting does not match the information in the customer
database on the HansaWorld.com server. You will be sent an email
listing what should and what should not be included in your
Configuration setting according to your contract with HansaWorld.
Update your Configuration to match the email and follow the sequence
above from step 4, or call HansaWorld support if you think the email is
wrong.

Manual Enablers
If you do not have an internet connection at all, you can obtain an Enabler
Key by telephone or fax. This method uses the Control String and Control
Code to determine the Enabler Key. So, if you are using this method, you
must make sure you have created all the Companies that you need and that
you have defined the Configuration and Company Info settings in each one
before applying for an Enabler Key.
Follow these steps—
1.

Open the Configuration setting.

2.

Enter the expiry date of your FirstOffice contract in the Valid Until Date
field. Make sure the setting is otherwise complete and accurate, and click
the [Save] button in the Button Bar to save and close it.

3.

Quit and restart your FirstOffice system. This will force the Control
String and Control Code to be recalculated.

4.

Contact your local FirstOffice representative during normal working
hours and quote the Control String and Control Code. You may be asked
to produce a Company Info report: this is described on page 433 in
Chapter 10, ‘Reports’. You will then be given a Key.

5.

Open the Configuration setting, enter the Key in the Enabler Key field
and click [Save]. This will inform FirstOffice that you have a full licence
for its use.

Setting up a Basic Accounts System
FirstOffice is supplied with a basic accounts template that you can use as a
basis for your own system if necessary. It includes VAT Codes, Fiscal Years,
a Chart of Accounts, report definitions and so on.
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If you did not import this template when creating your database (as described
in the ‘Creating a New Database’ section above on page 34), you can do so at
any time. To import this template, select ‘Imports’ from the File menu. The
‘Imports’ window is shown—

Double-click ‘Automatic’, or click once and press the Enter key. FirstOffice
opens a window listing importable files in the “Backup” and “Setup” folders,
which are in the same folder as the FirstOffice application. Locate
“UKAccounts1.txt” and click [Open] or [Select] (depending on the operating
system).
The file will be imported. A message window informs you about the progress
of the import.
When the import is finished, repeat the process, selecting
“FOStartForms.TXT” and then “FOStartStandard.TXT” to import template
forms and other settings. Then, close the ‘Imports’ list window using the
close box.
Your FirstOffice database is now ready to be used. You are free to change
any aspect of the model Chart of Accounts, but note that some of the default
settings in FirstOffice presume that the model chart is being used in an
unmodified form. If you alter the chart, you must also alter these defaults
wherever they occur. For example, if you change the Account Code of the
VAT Outputs Payable Account, remember to alter all the VAT Code records
accordingly as well.

If you do not wish to use the template supplied
You are also free to implement your own accounting set-up. If you choose to
do this, please first refer to Chapter 3, ‘Accounting Principles’, where some
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basic accounting principles are outlined (page 130). Then, you will need to
create your Chart of Accounts and define your Fiscal Years and VAT Codes
(all covered in Chapter 5, ‘Settings’, on pages 189, 220 and 259
respectively). Referring to the appropriate sections in the ‘Settings’ chapter,
ensure the correct Accounts have been defined for use by various functions
using the Account Usage P/L and Account Usage S/L settings (pages 181 and
184). You should also check the Payment Modes setting (page 238). Finally,
referring to Chapter 10, ‘Reports’, define the Balance Sheet, the Profit &
Loss Report and the VAT Report (pages 424, 452 and 467).
Importing your own Chart of Accounts

If you are changing to FirstOffice from another computerised accounts
program, you may be able to import the accounts set-up from that program.
This will have three advantages: the import procedure is relatively fast
(compared to entering the accounts manually), the possibility of data entry
errors is reduced and you will be able to use a Chart of Accounts with which
you are already familiar.
If you wish to follow this procedure, please follow the import instructions
described above on page 48 in the section ‘Setting up a Basic Accounts
System’ to import your text file. For details of the composition of the text
file, please refer to your FirstOffice representative.

Entering Data and Opening Balances
Your FirstOffice database is now ready for the entry of data and of opening
balances. Please refer to Chapter 4, ‘Starting Work’ (page 154), for full
details of how to proceed. Before you do so, however, it is recommended that
you read the following sections of this chapter. Chapter 2, ‘Work Area’ (page
62), will enable you to familiarise yourself with FirstOffice’s tools, windows
and method of working, while Chapter 3, ‘Accounting Principles’ (page 130),
describes some of the accounting concepts used by FirstOffice.
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Backing Up
When the day’s work with FirstOffice is done, we advise you to make a backup. It is a good idea to save a copy of the file on a diskette and store it in a
safe place. It might seem unnecessary to make a back-up every day, but the
short time this takes is a good investment for the day something goes wrong
with the hard disk.
To back up your data is particularly important when, as in the case of a
FirstOffice database, the financial information of your company is involved.
If you should lose all your data, you will find yourself in a very awkward
situation, missing all invoices, receipts, reports etc. Make sure you make a
back-up each time you have been working with your accounts. Name your
copies systematically with dates so that you can easily restore the database,
should an accident occur.
If you get a virus on your computer, you must first try to establish the date
when your computer was infected. In this case you must restore your data
from a back-up created before the infection date. Otherwise you run the
obvious risk of re-infecting the computer again.
FirstOffice’s method of back-up is fast and economical. The data is saved as
a back-up file that takes up a minimal amount of space, and the back-up files
are independent of the program versions. Of course, it is also possible to copy
the database file as it appears on your hard disk, but this is not so economical
in terms of disk space, and a subsequent restoration may not be successful if
the version of your FirstOffice application has changed since the back-up was
made.

!

Use FirstOffice’s built-in back-up
feature to guarantee a successful
restoration.

To create a back-up, follow these steps—
1.

Click the [Backup] button in the Master Control panel.

The resulting back-up file will contain the data from the whole database.
Alternatively, if you want to back up a section of the database, follow
step 2 below.
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2.

Choose ‘Exports’ from the File menu or click the [Exports] button in the
Master Control panel. The available Exports are listed—

Double-click ‘Company Text Backup’ (if you wish to back up the data in
the database relating to the single Company currently selected) or
‘Database Text Backup’ (if you wish to back up the whole database).
The second choice creates the same back-up file as clicking the [Backup]
button in step 1.
Usually you should use the ‘Database Text Back-up’ option, as this is the
only choice that backs up the entire database. You must use it regularly
for your safety and peace of mind. Some registers and settings (e.g. the
Configuration setting) are stored at database level, not Company level.
These will not be exported by the ‘Company Text Back-up’ option, even
if your database only contains a single Company. The ‘Company Text
Back-up’ option is intended for use in the situation where you need to
move all the information relating to a specific Company from one
database to another.
3.
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If you followed step 1 above, the ‘Specify Text Backup’ window
appears. This offers you 40 characters with which to describe the backup file that you are about to create. If it becomes necessary to restore
from a back-up, this description will be shown in the list of importable
files to help you select the correct one.
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Enter an appropriate description and click [Run].
4.

If you have chosen to back up the whole database and you have more
than one Company, you will now be asked to log in to any that you have
not yet used in this work session. For reasons of security, if you are not
able to log in to all Companies, the back-up procedure will be halted.

5.

FirstOffice opens a dialogue where you can name and place the export
file. Enter the name of the file in the filename area and locate it in the
appropriate directory in the usual way. The name of the back-up should
include the date the back-up was made. For ease of importing later, it is
recommended that you do not include spaces or other non-alphabetic
characters in the name of your back-up file, and that you give it a .txt
extension. Then, click [Save].
It is recommended that you save the back-up file in a folder or directory
named “Backup” which should be in the same folder or directory as the
FirstOffice application. All back-up files in this folder will be shown in a
list of importable files if it becomes necessary to restore from a back-up.
A message window informs you about the progress of the export.

When the export is finished, if you followed step 2 above, you are brought
back to the ‘Exports’ list. Close it using the close box.

!

Under no circumstances should you
edit or change a back-up file with
another program.
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Automatic Timed Back-ups
The importance of establishing a regular routine for backing up cannot be
emphasised enough. Because FirstOffice works - like all financial systems with a single file database in which all your data about customers, invoices,
nominal ledger etc. is stored, if you lose that file, you have lost not just a
single document, but all your accounting and customer information.
To make this task easier, FirstOffice contains a timed back-up feature
whereby a database back-up file can be created automatically every day. To
specify when the back-up files are to be created, and where they are to be
stored, follow the steps outlined below.
1.

Choose ‘Settings’ from the File menu. Double-click ‘Timed Operations’.
The following window appears—

2.

Set the Operation Time (the time when the backup is to take place) to the
appropriate time, when it is likely that you will not be using FirstOffice.
Use the 24-hour clock, and place a colon (:)between the hour and the
minute. The back-up file will be created at the specified time, even if you
are still logged in to FirstOffice. However, you will find the speed of
operation to be much reduced while the back-up is being carried out. It is
therefore highly recommended that you specify a time that is outside
working hours, to minimise such inconvenience.

3.

Specify the Database Backup Path, which determines where on your hard
disk the back-up files are to be saved. If you leave this field blank, the
back-up files will be saved in the folder containing the FirstOffice
application.
The following examples show the correct syntax for the Database
Backup Path. You can use either \ or / as a separator between folder
names under Windows, Linux and Mac OS X while you should use : on
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Mac OS 9. Note that the separator appears as the final character in the
path.
It is recommended that you save the back-up file in a folder or directory
named “Backup” which should be in the same folder or directory as the
FirstOffice application. All back-up files in this folder will be shown in a
list of importable files if it becomes necessary to restore from a back-up.
Under Windows XP, Linux and Mac OS X, you can do this using a
relative path—
backup/
Under Mac OS 9, you can only use an absolute path—
hard disk:firstoffice:backup:
If you want to store the back-up file somewhere else, use absolute paths
with the following syntax—
Windows

c:/samplefolder1/samplefolder2/backup/

Mac OS 9

hard disk:samplefolder1:samplefolder2:backup:

Mac OS X

/samplefolder1/samplefolder2/backup/

Note that if you make a mistake (for example, you make a syntax error or
specify a non-existent folder) there is a risk that the back-up file will not
be created.
4.

Click the [Save] button in the Button Bar to save the back-up
specifications.

Once you have set up the timed back-up feature as described above, a new
back-up file will be created automatically every day at the same time. It will
be given the name “TBYYMMDD.TXT” where “YYMMDD” represents the
current date. The file will contain a back-up comment stating that it was
created by timed back-up and showing the date and time this occurred.

Restoring from a Back-up
To restore from a back-up, you must first create a new database. Then import
the back-up file using the ‘Imports’ function on the File menu.
The replacement of a safety back-up is a non-destructive process, i.e. the
back-up file is not affected by the reading process. This means that you can
use the same back-up file more than once.
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Restoring from a back-up is done in the following way—
1.

Move the old database (named “1Office.HDB”) to another
folder/directory or to a diskette, to avoid mixing things up. Rename it so
that you know what it contains.

2.

Delete the database file “1Office.HDB” from the folder or directory with
your FirstOffice application. Double-clicking the FirstOffice application
now will force it to create a new database, as described earlier in this
chapter.

!

It is important to restore to a new,
empty database, to avoid mixing the
restored data with the old, damaged
database.
The “DBDef.txt” and “Default.txt” files should always be present in the
same directory/folder as the FirstOffice application. They contain some
important data used when setting up the new database and creating new
Companies. If this file is missing, your FirstOffice application may not
work the way you expect it to do!

3.

As part of the process of creating a new database, a list of back-up files is
shown. To be included in this list, a back-up file must be stored in the
“Backup” or “Setup” folder or directory, which should be in the same
folder or directory as the FirstOffice application.
In the list, the filename of each back-up file is shown together with the
date it was saved and any comment added when it was created (this last
is only applicable to back-up files created by clicking the [Backup]
button in the Master Control panel, step 1 in the previous section).
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4.

Highlight the file you want to import (the back-up to which you wish to
revert) and click [OK] (or double-click on the name of the file). The
back-up data will be imported. A message window informs you about the
progress of the import. For reasons of security, FirstOffice will then
close if the back-up file contains at least one record in the Persons
setting. Restart the program: you are now ready to continue working.

Files whose name contains a space will be shown in the list of available backup files, but FirstOffice will not be able to import them successfully. If the
name of your back-up file contains a space or any other non-alphabetic
character (or it is not shown in the list of available files because it is not
stored in the “Backup” or “Setup” folder or directory, or because its name
does not have a .txt extension), continue with these steps—
5.

If it is still open, close the list of available import files using the close
box.

6.

Choose ‘Imports’ from the File menu. The ‘Imports’ window is shown—

7.

Select ‘Automatic, manual file search’ and press the Enter key (or
double-click on ‘Automatic, manual file search’).
FirstOffice opens a dialogue box with a list of the files in the current
folder of the current volume. To find the back-up file, scroll through the
list or select another folder or volume in the normal way.
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8.

Once you have found the file you want to import (the back-up to which
you wish to revert), highlight it and click [Open] or [Select] (depending
on the operating system), or double-click on the name of the file.
A message window informs you about the progress of the import.

For reasons of security, FirstOffice will close when the import finishes if the
back-up file contains at least one record in the Persons setting. Restart the
program: you are now ready to continue working.

Updating from Previous Versions of FirstOffice
The latest version of FirstOffice is always available at www.hansaworld.com,
from where updates should be obtained. If you are online, clicking the
[HansaWorld.com] button in the Master Control panel will take you to this
site.
Inevitably, new versions of FirstOffice will incorporate significant structural
changes. Because of this, it cannot be guaranteed that they will be able to
open databases created by previous versions unless you use the built-in
export and import functions.
To update, follow these steps—
1.
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Before installing the new version, create a database back-up as usual and
as described above using the old application.
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2.

Install the new version of FirstOffice in a new folder or directory.

3.

Ensure that the new folder or directory contains the “DBDef.txt” and
“Default.txt” files, but not a “1Office.HDB” file. Ensure it also contains
a folder or directory named “Backup” which in turn contains the back-up
file created in step 1, and that the name of this file has a .txt extension
and does not contain any spaces or other non-alphabetic characters.

4.

Copy the “Attach” folder and its contents from the old FirstOffice folder
to the new one. Do NOT copy the “Hob” folder.

5.

Launch the new FirstOffice application. A new database is created.

6.

Import the back-up created by the previous version of FirstOffice using
the procedure described above on page 55, ‘Restoring from a Back-up’.
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Chapter 2: Work Area
When you create a database or open an existing one, FirstOffice’s desktop
will appear, with the Master Control panel in the centre of the screen. You
can use the icons in this panel as shortcuts to different parts of the program.
You can carry out most operations in FirstOffice in three different ways—
•

Selecting an option from a menu

•

Clicking a button in the Master Control panel

•

With a keyboard command

Use the method you feel most comfortable with. In the beginning you may
find it easiest to select from menus or from the Master Control panel, but
when you get more used to the program, you will find the keyboard
commands faster to work with.

HansaWorld.com
Menu Bar
Registers

Personal
Desktop

Menu Commands

Master
Control
Panel
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The Master Control Panel
FirstOffice’s work area contains a single movable, tool palette, the Master
Control panel, located by default in the centre of the screen. This contains the
Personal Desktop and four rows of buttons. The buttons in the first row
(entitled ‘Personal’) mostly control functions that cannot be operated in any
other way. Those in the second row (entitled ‘Routines’) duplicate some of
the functions on the File menu, while those in the third and fourth rows
(entitled ‘Registers’) can also be activated at all times using the keyboard
shortcuts Ctrl-1-8 (Windows and Linux) or -1-8 (Macintosh). Since the
Master Control panel is always visible, it is often simpler to use the buttons it
contains than to select functions from the menus.
You can bring the Master Control panel to the front at any time using the
‘Master Control’ item on the File menu. Windows and Linux users can use
the keyboard shortcut Ctrl-M, while Macintosh users can use -M. To close
the Master Control panel, click the close box or use the keyboard shortcuts
Ctrl-F4/-W.

The tools in the Master Control panel are divided into three sections—
Personal

These buttons allow you to change the Company you are
working in, to organise your diary, and to start the
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process of backing up your database. Some of these
buttons have a keyboard shortcut, as shown below,
which you can use when the Master Control panel is the
active (front) window.
[Companies]

Windows/Linux keyboard shortcut: Ctrl-O
Macintosh keyboard shortcut: -O
If you have more than one Company in your
database, use this button to move between
Companies. For more information about using a
multi-Company database, refer to the ‘Working
with Companies’ section below on page 107.

[Calendar]

Click this button to open the Calendar: a graphic
representation of your completed Activities and
those of other users. Full details can be found on
page 402 in Chapter 8, ‘Personal Registers’.

[Tasks]

This button allows you to organise your diary,
providing a means of recording appointments and
other tasks. Full details can be found on page 397
in Chapter 8, ‘Personal Registers’.

[Backup]

In a single-user system, you can use this button to
back up your entire database. Please refer to page
51 in the first chapter in this manual for details
about backing up.

Routines

[Reports]

These buttons are equivalent to some of the commands
on the File menu. In each case, clicking the button
produces a list of options from which the required one
can be selected by double-clicking. Each of these buttons
has a keyboard shortcut, as shown below, which you can
use at any time.
Windows/Linux keyboard shortcut: Ctrl-R
Macintosh keyboard shortcut: -R
Click this button to produce reports. You can
define some of the reports and choose where they
are to be printed (e.g. to screen, to a printer or to a
text file). General details about producing reports
can be found in the ‘Report Window’ and ‘File
Menu’ sections below on pages 78 and 91
respectively, while the reports themselves are
described in detail in Chapter 10, ‘Reports’.
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[Documents]

Windows/Linux keyboard shortcut: Ctrl-D
Macintosh keyboard shortcut: -D
Use this button when you want to print
documents intended for external use (e.g.
Invoices). Details about printing documents can
be found in the ‘File Menu’ section below on
page 94, while the documents themselves are
described individually in Chapter 9, ‘Documents’.

[Exports]

Windows/Linux keyboard shortcut: Ctrl-E
Macintosh keyboard shortcut: -E
This is the button you use when you need to back
up your FirstOffice database and to export data
from FirstOffice. Exports are described
individually in Chapter 11, ‘Exports’, and details
about backing up can be found on page 51 in the
previous chapter.

[Settings]

Windows/Linux keyboard shortcut: Ctrl-S
Macintosh keyboard shortcut: -S
Settings allow you to set operating preferences
within FirstOffice, to tailor its operations to your
requirements. Before you start working with
FirstOffice, you should consider the settings,
since the program’s functions depend on the
settings being correct. Many settings take the
form of options or preferences. Others require
information or a number of records to be entered.
Click the button to open the ‘Settings’ list
window where you will find an alphabetical list
of the settings that are available. Double-click an
item in this list to add to or change a particular
setting. Settings are described individually in
Chapter 5, ‘Settings’.

Use the other two rows of buttons to open registers. Each register is used to
store information of a particular type. Click on a register button to open the
browse window for the register. This window lists all the records contained in
the register. In FirstOffice, registers are divided into two groups as follows—
Transactions

Each transaction register represents a particular type of
accounting transaction. Invoices, Receipts (payments
that you receive against Invoices that you have issued),
Purchase Invoices and Payments (that you issue against
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Purchase Invoices) are each stored in separate registers.
Use the Transaction register for all other kinds of
transaction (e.g. credit card payments, salaries, transfers
between bank accounts).
Base Registers

Base registers typically contain information that is then
used elsewhere. This information will not itself be
changed very often. For example, the Customer register
is effectively a list of Customer names and addresses that
will be referred to from the Calendar and from Invoices
and Receipts.

HansaWorld.com
In the top right-hand corner of the Master Control panel there is a
[HansaWorld.com] button—

Click this button to connect to the web and go the FirstOffice website
(www.hansaworld.com). The latest version of FirstOffice is always available
for downloading from this site.

Personal Desktop
The area on the right of the Master Control panel is known as the “Personal
Desktop”. If you have certain records, registers or reports that you use all the
time, you can move them to your Personal Desktop for easy access. You can
open a record or register or run a report from your Master Control panel at
any time, without first having to find them in their proper place in
FirstOffice. The Personal Desktop is therefore similar to a list of Bookmarks
in a browser. Please refer to the description of the Personal Desktop below on
page 119 for full details.

Passwords
You can set or change your password from the Master Control panel,
providing that a record for you already exists in the Persons setting (the
Persons setting is described on page 243 in Chapter 5, ‘Settings’). Select
‘Change Password’ from the Operations menu. Enter the old password if
there is one and then type in the new one twice to ensure that it is correct.
Click [Save] to close the window and save, or [Cancel] if you do not want to
save changes. The password is case-sensitive.
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Windows
FirstOffice allows you to work with several windows on the screen at the
same time. The window that is currently in use is known as the ‘active
window’. That is the uppermost window, where the title bar is not dimmed.
In the Windows version you can “Iconise” a window, i.e. shrink it to an icon
on the screen, using the symbol “ ” in the top right hand corner of a
window. You can re-open the window by clicking the symbol again.
You can move the active window by dragging the title bar, and change its
size by dragging the size box in the bottom right-hand corner. Close the
window by clicking the close box or by pressing the Esc key on your
keyboard. On the Macintosh, clicking the close box of a window while
holding down the Alt key will close all windows, while Windows and Linux
users can use the ‘Close All’ function on the Window menu. In addition, you
can save attributes such as size and position for a particular window using the
Window menu. If you have several windows open, you can bring each one to
the front in turn using the Ctrl-Tab or -Shift-N keyboard shortcuts.

!

FirstOffice allows you to have up to
100 windows open at the same time.
It is however a good habit to close a
window when it is no longer needed.
Too many open windows may become
confusing.

There are six types of window.

Browse Window
Browse windows are used to display lists of records. Clicking a register
button in the Master Control panel will open a browse window listing every
record stored in that register. In a browse window, you can search for a
certain record and select a specific record for processing. You can have
several different browse windows open at any time.

67

HansaWorld FirstOffice Start

For example, if you click the [Transactions] button in the Master Control
panel, the window that opens is a browse window, entitled ‘Transactions:
Browse’. This window lists all the Transactions in the register—

You can scroll through the list using the scroll bar on the right. You can
scroll down or up a screen at a time by selecting ‘Next’ or ‘Previous’
respectively from the Record menu.
You can change the sort order of the list. Click the heading of the column
you want to sort by, and the list will re-sort immediately. The heading of the
column will be coloured blue to show the selected sort order. If you click on
the heading a second time, the sort order will be reversed.
At the top of each browse window there is an area known as the Button Bar.
This contains a set of buttons—

Operations

This drop-down menu appears in certain browse
windows only. Highlight one or more records in the list
(hold down the Shift key while clicking) and then
choose a function from this menu. The function will be
applied to all highlighted records. The contents of the
Operations menu will vary depending on the browse
window. Full details of each function can be found in
the appropriate chapters elsewhere in this manual.

[New]

Windows/Linux keyboard shortcut: Ctrl-N
Macintosh keyboard shortcut: -N
Click this button to open a new blank record for data
entry.
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[Duplicate]

Windows/Linux keyboard shortcut: Ctrl-K
Macintosh keyboard shortcut: -Y
If you need to create a new record that is a copy of one
that already exists, first find the earlier record in the list
and highlight it by clicking once. Then, click this button.
A new record is opened, a duplicate of that highlighted.
In many cases, the new record will contain the current
date, not the date of the copied record.

[Search]

Use the Search field and button (on the right of the
Button Bar) to find a particular record in the list. First,
sort the list by the column that you want to use for the
search. In the illustration above, for example, the list is
sorted by Text allowing you to search for a Transaction
with a certain Number. Then, type a letter, word,
number, or date in the Search field (there is no need to
click in the field before typing). Then press Enter or
click [Search]. FirstOffice will search the column by
which the list is sorted for a match. The first row
beginning with an exact match (or, if there is no exact
match, with the nearest match) will be highlighted. If
you are not certain of the exact spelling, use the *
character as a wildcard. For example, in the illustration
shown above, to find Transactions relating to Mutual of
New York but do not know their Customer Number
(013), sort the list by the Text column and type
“*Mutual” in the Search field and press the Enter key. If
the first record found is not the one you want, press the
Shift-Enter key combination to search again.

If you want to view or modify an existing record, first find it using the
Search facility described above. Then, open the record by double-clicking its
line in the window, or by first selecting the line and then pressing the Enter
key.

!

It is not possible to delete a record
directly from the browse window. You
must open the record first.

Record Window
You will use record windows to enter, view and edit individual records. The
heading may read ‘New’, ‘Inspect’, ‘Update’ or ‘Remove’, depending on the
circumstance. All data entry to FirstOffice is made in windows of this type.
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A record window is shown when you open a specific record from a browse
window by double-clicking, and when you create a new record. Below is the
window that is opened when you double-click a row in the ‘Invoices:
Browse’ window.

The record window is where you enter or edit information. Note that certain
fields will only accept numbers or uppercase letters, while others cannot be
changed at all. In some cases, all characters will be converted to uppercase
automatically.
Use the Return, Tab or arrow keys to move from field to field. The Return
key moves the cursor to the next editable field, while the arrow keys move to
the next field, whether it can be changed or not. You can also use the mouse
to click directly in a field to enter or change its data. When you click in a
field, its contents will be highlighted, and the contents will be replaced as
soon as you start typing. If you click twice in the same field, the insertion
point will be placed at the point where you click, allowing you to enter or
delete characters at that point.
Some record windows, such as that in the illustration, are divided into two:
the top half shows details of the parent record (in this case, an Invoice) and
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the lower half contains the individual items (or rows) that are listed on that
Invoice.
Sometimes a record window contains more information than can be shown
on screen at once. If this is the case, there will be a series of tabs (marked
Terms’, ‘Items’, etc in the example of the Invoice illustrated above) that you
can click to show more pages of information about the parent record.
Button Bar
At the top of each record window there is an area known as the Button Bar.
This contains a set of buttons—

Windows/Linux keyboard shortcuts: PgUp and PgDn
Macintosh keyboard shortcuts: -- and -+
These are the [Previous Record] (on the left) and [Next
Record] buttons. Use them to go from record to record.
Once you have opened a record from a list in a browse
window, click the [Next Record] button to move to the
next record of that list. At the same time everything you
may have changed in the record you are leaving will be
saved. If you want to cancel the changes, close the
record window with the close box or press the [Cancel]
button on the right of the Button Bar. Similarly, clicking
the [Previous Record] button will open the previous
record in the list.
These buttons have the same effect as selecting
‘Previous’ and ‘Next’ from the Record menu.
Operations

In several record windows, such as those for Purchase
Invoices, Transactions and Receipts, there is an
Operations menu available. This contains different
functions depending on the window. For the Invoice
record, the following menu items are available—

‘Invoice Status’ opens a window with a summary of the
status of the invoice; payments etc.
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Full details of each function can be found in the chapters
covering the registers elsewhere in this manual.
Windows/Linux keyboard shortcut: Ctrl-P
Macintosh keyboard shortcut: -P
Click this Printer icon to print the current record. The
Printer icon will only appear in the Button Bar when the
record window contains something that can be printed
directly, e.g. an Invoice. The ‘Print’ command in the
File menu has the same function.
When you start a printout, it will print directly on your
selected printer. Normally, no printer dialogue is shown.
Windows/Linux keyboard shortcut: Ctrl-Shift-P
Macintosh keyboard shortcut: -Shift-P
Clicking the Preview icon will cause the current record
to be printed to screen in a new window. This will allow
you to see what it will look like when you print it on a
printer by clicking the Printer icon immediately to the
left.
If you are using Windows, in some record windows,
such as those for Invoices and Customers, there is a
[Communicate] button. If you need to contact the
company whose details you are viewing, click this
button. The following window opens, containing the
company’s contact details—
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Subject to your computer or network having the suitable
connection software and hardware, click on a contact
method in the list on the left, and then click the
appropriate button on the right. The Skype application
will be started automatically, allowing you to call using
Skype or SkypeOut (if you clicked on a telephone
number). A new Activity window will also be opened,
allowing you to record the details of the call or contact
immediately.
[New]

Windows/Linux keyboard shortcut: Ctrl-N
Macintosh keyboard shortcut: -N
Click this button to save the current record and to close
it. A new blank record is then opened for data entry.

[Duplicate]

Windows/Linux keyboard shortcut: Ctrl-K
Macintosh keyboard shortcut: -Y
Click this button to save the current record and to create
a copy of it. The original record is closed and the new
copy is opened. In many cases, the new record will
contain the current date, not the date of the copied
record.

[Cancel]

Macintosh keyboard shortcut: -B
If you have not saved the current record (i.e. the window
title is ‘New’), click this button to cancel the data entry
process and to close the record window. The record is
not saved. If you have previously saved the current
record (i.e. the window title is ‘Update’), click this
button to discard all changes made since it was last
saved. In this case, the record window is not closed.

[OK]

Windows/Linux keyboard shortcut: Shift-Enter
Macintosh keyboard shortcut: Shift-Enter
This button saves all changes to the current record but
does not close it.

Paste Special
When you enter information in FirstOffice, you frequently need to refer to
another register, or setting. For example, when you enter an Invoice,
specifying the Customer Number will bring information in from the
Customer register (e.g. the name and address of the Customer), while
specifying a Payment Term brings information in from the Payment Terms
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setting. Using the ‘Paste Special’ command, you can find out the information
you require from a selection list quickly and easily (e.g. you can easily
choose the correct Customer or Payment Term). Pressing Ctrl-Return or CtrlEnter in a field activates the Paste Special feature. Macintosh users can press
-Return or -Enter. The following example shows pasting the Customer
Number into an Invoice.

With the cursor placed in the Customer field, press the Ctrl-Enter (Windows
and Linux) or -Enter (Macintosh) key combination. A new window will
open, showing the contents of the register or setting from which you can
select a record (in this case, the Customer register). This window is similar to
a browse window in its behaviour, so you can sort the list by any of the
columns by clicking the column heading and use the Search field to find the
record you are looking for (using the * wildcard if necessary).
Select the Customer you want by double-clicking or by highlighting and
pressing Enter. The Customer Number and other details are transferred to the
Invoice screen.
You can make the ‘Paste Special’ feature more powerful by saving the sort
order of the ‘Paste Special’ list. For example, whenever you need to choose a
74

Chapter 2: Work Area - Windows - Record Windows

Customer, you will probably know its Name but not its Number. The first
time you use the ‘Paste Special’ feature to choose a Customer, sort the list by
Name and then select ‘Save Normal Position’ (Windows and Linux)/‘Save’
(Macintosh) from the Window menu. From now on, the list will be sorted by
Name when it opens. Now you can type the first few characters of the
Customer Name in a Customer field and then press Ctrl-Enter or -Enter.
When the ‘Paste Special’ list opens, the highlighted Customer will be the
first one to match what was typed. If this is the correct one, all you need do is
press the Enter key and carry on typing without interruption. In the example
shown below, we typed “OSLO” into the Customer Number field of an
Invoice and then pressed Ctrl-Enter. The ‘Paste Special’ list opens, with the
first Customer whose name begins with “OSLO” highlighted—

If the record you are looking for does not exist and so is not shown in the
‘Paste Special’ list, you can often enter it on the fly. In the ‘Paste Special’
window, press Ctrl-N or -N, or click the [New] or [Duplicate] buttons as
appropriate. A new Customer screen (in this example) is shown. Enter the
new Customer, click [Save] and the new record is entered. At the same time,
the Customer Number is entered in the Invoice.
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If you are entering an Invoice and realise that your information about the
Customer is out of date (they might have changed their address or telephone
number, for example), highlight the Customer in the ‘Paste Special’ window
and press F2 (Windows and Linux) or -Shift-V (Macintosh). The Customer
record is opened, allowing you to make the necessary changes. You can also
do this if the Customer Number has already been entered to the Invoice. With
the cursor in the Customer Number field, press F2 or -Shift-V. This feature
is available from most fields with a ‘Paste Special’ link.
You can use ‘Paste Special’ when you are in a date field. When you press
Ctrl-Enter or -Enter, the ‘Paste Date’ window opens—

The current date is marked with a square. Press the Enter or Return key to
bring the current date into the date field. If you need a different date, use the
arrow keys to move the red square to the date you need—

The grey square marks the current date. Use the PgUp and PgDn keys to
change to a different month. Press Enter or Return to bring your chosen date
into the date field. If dashes appear instead of Week Numbers in the ‘Paste
Date’ window, the probable cause is that there is no record in the Weeks
setting, or the record that is there is incomplete. Please refer to the
description of the Weeks setting on page 263 in Chapter 5, ‘Settings’.
You can also use ‘Paste Special’ when you are in a time field. Simply press
Ctrl-Enter or -Enter and the current time will be entered straight away.
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Drag and Drop
You can also link information in different registers or settings by dragging
and dropping. Information can be dragged from the browse window of one
register into the record window of another. For example, you can drag a
Customer Number from the ‘Customers: Browse’ or the ‘Paste Customer’
window into an Invoice. With both the ‘Customers: Browse’ and ‘Invoice:
New’ windows open, find the correct Customer in the list, click on the
Customer Number and drag it to the Customer Number field of the Invoice.
Items, Accounts and information from settings such as Payment Terms can
be added to Invoices, Purchase Invoices and other transactions in the same
manner. In the case of Items, you can open the ‘Items: Browse’ or the ‘Paste
Item’ window and select a range of Items by clicking while holding down the
Shift key. Then drag them to the Item field in the first empty Invoice row.
You can also copy lists from spreadsheets or word processing documents.
For example, you can copy a list of Item Numbers from a spreadsheet and
paste them in the Item field in the first empty Invoice row. All appropriate
Item Descriptions, Prices, etc will be brought it automatically. Similarly you
can copy a list of Invoice Numbers from a spreadsheet and paste them in a
Receipt or Payment.
If you have several Companies, you can transfer information from one
Company to another by dragging and dropping between browse windows.
For example, when you create a new Company, you can drag all the
Accounts from the ‘Accounts: Browse’ window of an existing Company to
that of the new Company. This makes it easy to transfer basic information to
the new Company. If you transfer approved accounting transactions of any
kind using this method, they will appear as unapproved transactions in the
new Company. An approved transaction is one from the Sales or Purchase
Ledger that has been posted to the Nominal Ledger.
Attachments
All record windows contain an [Attachments] button, which can take one of
two forms—

This button allows you to connect files, notes or other records to any record
in FirstOffice. These connected objects are known as “Attachments”. Please
refer to the description of Attachments below on page 111 for full details.
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Report Window
Report windows are used to display the reports you print to the screen.
Below we show an example report. You can scroll up and down in the
window, and search for information in the report.

At the top of the report window there is a report header, showing the name of
the report and the selection on which it is based. This is important
information, since every report can be produced using different selections.
Below this is the report itself, always shown to its full width in its own
window. You can change the window’s height and width, which may lead to
the report not fitting in the window. You can therefore scroll the window up
and down with the scroll bar to the right or using the Page Down, Page Up,
Home and End keys on the keyboard. If the window is too narrow, the report
is compressed sideways, which may make it hard to read. By increasing the
width of the window the report can be made to expand.
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Since each report is shown in its own window, several reports can be put on
the screen at the same time, totally independently. This gives FirstOffice an
unmatched reporting power. You can for example show two versions of a
Customer statement simultaneously, in two different windows. In one you
might show all open (unpaid) Invoices and restrict the other to show only
those Invoices that are due for payment (i.e. those that are older than their
payment terms). FirstOffice can easily give you information that can only be
obtained after some complicated manoeuvring in other accounting systems.
There is no limit for the number of reports shown simultaneously on the
screen. Since FirstOffice's windows are completely independent, report
windows can be mixed with data entry windows and lists from different parts
of the system.
In the following picture we show an example where four reports are shown at
the same time.
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Printouts
You can print any report to paper by clicking the Printer icon in the Button
Bar of the window containing the report. The page format is set in advance
for each report so that the report will fit in a portrait or landscape page.
Searching in Reports
Another useful function built in to all FirstOffice's reports is the option to
search for a text string in a report. The search string may contain any
combination of letters and digits occurring in the report.

In this example you might want to search for the Nominal Ledger
Transaction resulting from Invoice 970017. Enter “970017” into the Search
field on the right of the Button Bar and press the Enter key. FirstOffice will
search for the first text string in the report that matches the search word,
scroll the report to the position where the text was found, and highlight the
text. Pressing the Enter key again repeats the process finding the next match.
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Recalculating Reports
All reports are shown in their own windows. You can leave a report on the
screen and go to other windows to do various additions and alterations. If
such alterations change the contents of the report, there is a simple shortcut
for updating the report. With the report window active again - activate it by
clicking in it - the Operations menu is available in the menu bar. Select the
‘Recalculate’ command (or use the Ctrl-Shift-R/-Shift-R keyboard
shortcut) to produce an updated version of the report, using the same
specifications. If you want to produce an updated version of the report using
different specifications, select ‘Reopen Report Specification’ from the
Operations menu.
Drill-down
FirstOffice has a unique drill-down feature in some reports when they are
printed to screen. When you for example have a Profit & Loss statement on
the screen, you can click on any of the Account Numbers in the report. The
Nominal Ledger report for the same selection and period is then opened in a
separate window, showing all the Transactions that constitute the total
amount on the Profit & Loss statement. If you further double-click on one of
the Transaction numbers in the Nominal Ledger report, the Transaction
record will open, showing all the details recorded for the event. The picture
on the next page illustrates the above example.

81

HansaWorld FirstOffice Start

Text with the drill-down feature is shown underlined in a screen report.
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Attaching Reports to Records and the Personal Desktop
The Button Bar of the report window contains an [Attachments] button that
allows you to attach a report to a record or to the Personal Desktop. Please
refer to the ‘Attachments and Personal Desktop’ section below on page 115
for details.

List Window
The list window is used whenever you need to choose from a list of options,
usually after you select the ‘Imports’, ‘Settings’, ‘Maintenance’, ‘Reports’
and ‘Documents’ functions. Double-click your choice in the list, or click it
once with the mouse and then press the Enter key.
You can use the scroll bar to find the item that you want, or you can type the
first letter of its name. For example, referring to the example illustrated
below and assuming ‘Customer List’ is the item you want, press the letter
“C” on your keyboard four times. After the first press, the highlight will
move down to the first item beginning with C, ‘Company Info’. As you press
“C” on your keyboard again, the highlight will move down until ‘Customer
List’ is highlighted. You can now press the Enter key to activate the report.
When the list window shows a list of documents, it will be accompanied by
an Operations menu allowing you to assign a Form to each document (the
Form contains the design that will be printed). This is described below on
page 94.
The following example shows the window from which you can select a
report—
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Specification Window
Specification windows allow you to specify the contents of a report or
document. A specification window will usually appear after you have
selected an option in a list window. Once you have entered the report criteria,
click [Run]. The example below shows the specification window for the
Profit & Loss report.
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File Dialogue Window
FirstOffice uses the standard Windows or Macintosh file dialogue window
when it requires you to select a file for import, or to give a file name to an
export file.
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Menus and Sub-menus
The Menu Bar
Select menus by pulling them down with the mouse in the normal way.
Where appropriate, keyboard shortcuts are shown to the right of the menu
items. Some commands are also available as icons in the Button Bar and the
Master Control panel.
Not all menu items are available at all times. Disabled items are grey or
dimmed.

File Menu

The File menu contains commands for the handling of files, documents and
printouts. Instead of selecting an item from the menu, you can in some cases
click on the corresponding button in the Master Control panel. Many of the
commands on the File menu also have a keyboard shortcut, shown to the
right of each command in the menu, e.g. Ctrl-P (Windows and Linux) or -P
(Macintosh) for ‘Print’. These shortcuts are shown in the illustrations above:
the Macintosh version is on the left, the Windows version on the right.
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Company
This command opens a list that allows you to select a Company to work with.
You will have entered the Companies listed in the window using the
Companies setting.

Double-click a Company to work with, or click once and press the Enter key
or click [OK].
If you need to add a new Company to the list, select ‘Open Company
Register’ from the Operations menu while the list is open. Refer to the
‘Adding New Companies’ section on page 40 in the previous chapter for full
details, but remember that adding a new Company will mean that you will
have to apply for a new Enabler Key.
Master Control
Choose this command to bring the main FirstOffice control panel to the front.
This will be necessary if you wish to use FirstOffice’s Calendar and Task
Manager functions as the Master Control panel provides the only means of
accessing these.
Exports
Use this command to copy information from FirstOffice into a text file on
your hard disk. This data is then available for use in other programs, such as
word processors, spreadsheets, database programs etc. Selecting the
command is equivalent to pressing the [Exports] button in the Master Control
panel.
When you select this command, the ‘Exports’ list is opened, where you can
choose the information to be exported by double-clicking.
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One reason to use the ‘Exports’ function is to back up your FirstOffice
database. For full details of how to do this, please refer to the ‘Backing Up’
section on page 51 in Chapter 1, ‘Introduction and Installation’. For security
reasons, the ‘Company Text Backup’ and ‘Database Text Backup’ exports do
not produce text files as described above but encrypted files that can only be
read by another copy of FirstOffice.
Note that all FirstOffice reports can also be printed to disk as text files. This,
in combination with the ‘Exports’ function, makes it very easy to retrieve
information from FirstOffice for use with other applications.
Imports
This command imports a text file, previously saved in the proper format, into
the Company you are working with. Only new records will be added during
the import process, and there is no danger that you will get duplicate data of
any kind in your database. However, if you import a setting that is a set of
fields and check boxes (e.g. the Account Usage S/L and Account Usage P/L
settings), the imported setting will overwrite the existing setting.
When you select this command, the ‘Imports’ list window is opened, where
you can specify what is to be imported.
The function can import information from another FirstOffice database or
from a text file created by another computer program. In the latter instance,
you should ensure the text file is correctly formatted (contains the
information in the correct order) before importing. This format information is
available from your local FirstOffice representative.
The first lines in the text file should be—
format
1

46

1

0

1

The numbers in the second line should be separated by tabs. These numbers
(parameters) inform the import procedure about the contents of the import
file, as follows—
Date Order

88

The first parameter tells the import procedure what date
format you have used in the text file. You can use the
following values—

0

Month/Day/Year

1

Day/Month/Year

2

Year/Month/Date
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Decimal Character
The second parameter uses ASCII codes to tell the
import procedure what decimal character you have used
in the text file. Typical values are—
44

comma

46

full stop

Machine Mode

Use the third parameter to specify the platform on which
you created the text file, as follows—

0

Macintosh, AIX, iSeries

1

Windows, Linux
The import procedure will use this information for
string conversion if the last parameter (String Type) is
0.

Replace

This parameter tells the import procedure what to do if
information in the text file duplicates what is already in
the database.

0

Any duplicate information in the text file will not
be imported. Records in the database will not be
replaced.

1

Duplicate information in the text file will be
imported, overwriting existing records in the
database. This applies to entire records. For
example, there is an existing Customer 001 in the
database with the name Customer A and Payment
Terms 30 days, and in the import file Customer
001 has the name Customer AA and no Payment
Terms. The import procedure will overwrite the
entire record for Customer 001, so the result will
be that it has the name Customer AA and no
Payment Terms. Records in the database with no
duplicate in the text file will not be touched.
Note that blocks will always be overwritten with
duplicate information from a text file, irrespective of
whether this parameter is 0 or 1. There are two types of
block: the setting that is a set of fields and check boxes
(e.g. Account Usage S/L, Account Usage P/L, Locking);
and the setting that is a series of rows (e.g. Payment
Modes, VAT Codes).
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String Type

Use the final parameter to specify the character set used
in the text file—

0

The text file contains characters belonging to a
single character set (e.g. ASCII, KOI-8R
[Russian Cyrillic], ISO-8859-1 [Western
European]).

1

The text file contains Unicode characters.
Text files exported from a FirstOffice database will
contain Unicode characters.

You should use the ‘Imports’ function to restore your FirstOffice database
from a back-up, and to import your information into a new version of
FirstOffice. For full details of how to do this, please refer to the ‘Restoring
from a Back-up’ section on page 55 in Chapter 1, ‘Introduction and
Installation’.
Maintenance
You can use the ‘Maintenance’ option on the File menu to carry out certain
updating tasks. When you select the function, a list window will appear, from
where you can choose the required option by double-clicking. The two
Maintenance functions in the list are described on page 279 in Chapter 6,
‘Base Registers’.
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Reports
FirstOffice can print reports or documents. Reports are used mostly in
relation to your internal accounting and management.
Reporting in FirstOffice is non-destructive, i.e. you can make and print a
report as many times as you wish. Some accounting programs are designed in
such a way as to allow journal printing only directly in connection with the
data entry. FirstOffice does not have this limitation.
When you select ‘Reports’ from the File menu or by clicking the [Reports]
button in the Master Control panel, a list is opened showing the reports
available in FirstOffice—

Choose a report by clicking an item in the list once. If you need to set the
page size, number of copies and other printer options for the report, choose
‘Page Setup’ from the File menu. These settings will be used whenever the
particular report is printed until you choose ‘Page Setup’ once again.
Windows users can also use this function to choose the printer on which the
report is to be printed.
Once you have done this, double-click the report name in the list. A
specification window will open, where you can choose the information that
you want to be shown in the report. For example, when producing a Balance
Sheet, you can use its specification window (illustrated below) to choose the
period that is to be covered by the report.
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While the specification window is open, you can choose the destination of
the printout by selecting one of the Media options at the bottom of the
window. The available options are Screen, Printer, File, Clipboard and Excel.
The last option is only available to Windows users. If you print to screen (the
default setting), the report will be shown in a new window. You can
subsequently send the report to a printer by clicking the Printer icon in the
Button Bar of this window or by selecting the ‘Print’ function on the File
menu.
If you are sending the report to a printer and you want a print dialogue to
appear, check the Printer Dialog box (last of the Media options). You might
do this if you want to print several copies of a report.
Once you have entered the reporting criteria and have chosen a print
destination, click [Run] to produce the report.

Page Setup
‘Page Setup’ on the File menu allows you to set the page size, number of
copies and other printer options for the report. These settings will be used
whenever the report is printed. Windows users can also use this function to
choose the printer on which the report is to be printed.

Defining Reports
For certain reports, you can redefine the contents and layout of the report. To
do this, use the Report Settings setting. Full details can be found on page 252
in Chapter 5, ‘Settings’.
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Updating Reports
While a report is on screen, it may be that you change some of the
information it contains. If so, there is no need to close and recreate the report.
Instead, simply select ‘Recalculate’ from the Operations menu (or use the
Ctrl-Shift-R/-Shift-R keyboard shortcut) to update the report. If you want
to change the report criteria before recreating the report (e.g. you want to
change the report period), choose ‘Reopen Report Specification’ instead.

Export to other applications
It is very easy to export the contents of any report to another application
program, e.g. Excel or Word. The specification window for each report
contains a set of Media options, one of which is ‘File’. If you select this
option, the report is saved as a tab-separated text file on your hard disk. This
can be used directly in Excel, for further calculations etc. On Windows only,
another Media option is ‘Excel’. This option opens the Excel application and
creates a new workbook containing the report.
The example illustraion overleaf shows a Customer Statistics report opened
in Excel.
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Documents
Documents are more formal printouts, usually printed using forms, such as
invoices or delivery notes. They are often directed to third parties, but cannot
be printed to screen or file.
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Defining Documents
You must assign a Form to each document before you print it for the first
time. The Form is the design or layout of the document. You can have a
single Form for each document, or you may have several versions of a
particular type of document, to be used on different occasions. To assign a
Form or Forms to a document, use the ‘Define Document’ function on the
Operations menu.
This is how you specify when each Form is to be used, using the Invoice as
an example.
1.

Click the [Documents] button in the Master Control panel. The
‘Documents’ list window is opened showing a list of available
documents. Highlight ‘Invoices’.

2.

Select ‘Define Document’ from the Operations menu. Specify INVOICE
as the Form on the first row.
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Seq

Use this column if you want to print two (or more)
different documents from a single command. For
example, you might want to print a Delivery Note and
an Invoice immediately when an Invoice is approved. In
this case, you would enter the Delivery Note with Seq.
no. 1 on the first row of the grid, and the Invoice with
Seq. no 2 on the second row.

Form

Enter the Form Code of the relevant Form in this field.
This field is case sensitive: you should only use upper
case characters. Use ‘Paste Special’ to select from a list
of Forms. Please refer to the description of the Forms
setting on page 222 in Chapter 5, ‘Settings’, for details
about designing Forms.

3.

Click [Save] to save the Invoice definition. When you print Invoices
from now on, the correct Form will be selected automatically, without
further user intervention.
You can repeat this process for almost all documents as required.
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Settings
This command opens the ‘Settings’ list window where you will find an
alphabetical list of the settings or preferences in the program. Settings are
used to tailor certain aspects of the program’s operation to your
requirements, and to supply information to be used throughout the program.

Choose an entry in the list by double-clicking it. Settings are described in
detail in Chapter 5, ‘Settings’.
Page Setup
This function is available when the active (top) window on the screen
contains a list of reports or documents.
When you print a report or document, one copy is usually produced, using a
standard page size. If you need to print more than one copy, or to use a nonstandard page size or magnification, highlight the desired report or document
in the list and then select ‘Page Setup’ from the File menu to make these
changes. Once this has been done, double-click the item in the list to carry on
with the printing process.
The number of copies, page size and/or magnification can be set individually
in this way for each document or report. These settings will remain
permanent until ‘Page Setup’ is chosen once again.
Windows users can also use this function to choose the printer on which the
report or document is to be printed.
Print
This function is available when the active (top) window on the screen
contains something that can be printed (a screen report, a transaction in the
transaction window).
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When you select ‘Print’, the transaction or the report is printed directly to the
selected printer, normally without the Print dialogue box being shown.
This menu item duplicates the functions of the Printer icon in the Button Bar
of the active window.
Quit
Quits FirstOffice. Remember to take a safety back-up of your work before
you quit!
Macintosh OS X users can find the ‘Quit’ command on the Hansa OSX
menu.

Edit Menu

You will usually use the commands on this menu when you are working with
the contents of individual fields. If you wish to copy or delete entire records,
you should instead use the commands in the Record menu, or the [New] or
[Duplicate] buttons in the Button Bar. If the active window contains nothing
editable, the commands will be dimmed. For each command in the Edit menu
there is a keyboard shortcut, e.g. Ctrl-Z (Windows and Linux) or  -Z
(Macintosh) for ‘Undo’. These shortcuts are shown in the illustrations above:
the Macintosh version is on the left, the Windows version on the right.
Undo
Select ‘Undo’ to undo your last action.
There are a few actions in FirstOffice that cannot be undone, e.g. deleting a
record with the ‘Delete’ command on the Record menu. Anything removed
using the ‘Clear’ command in the Edit menu also cannot be undone.
Cut
‘Cut’ removes the data you have selected (highlighted) and puts a copy in the
Clipboard. The Clipboard is a special part of the computer's memory, used to
store a single piece of data temporarily. This data can then be inserted
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(Pasted) into another place, once or several times, until you ‘Cut’ or ‘Copy’
something else. That will replace the old contents in the Clipboard.
In certain fields, e.g. the Account Number fields in a Transaction that has
already been saved, you may not remove the data, and thus not use ‘Cut’. If
you want to make a copy of the field’s contents, use the ‘Copy’ command
instead.
Copy
Use ‘Copy’ to copy text or numbers from one field to another without
removing the data from the original field. The copy is put in the Clipboard.
Then you can ‘Paste’ the copy in as many other locations as required. The
copy remains in the Clipboard until you ‘Cut’ or ‘Copy’ something else.
Note that ‘Copy’ (and ‘Cut’) can only be used to copy text from a single field
at a time. If you want to copy a whole record in a file, use the ‘Duplicate’
command in the Record menu (or the [Duplicate] button in the Button Bar).
Paste
With this command you can insert text or a value that has been cut or copied
to the Clipboard. The clipping is inserted at the insertion mark. If you select
several characters in the destination field, ‘Paste’ will replace the selected
text with the contents of the Clipboard.
Clear
‘Clear’ removes the characters you have selected (highlighted) without
copying them to the Clipboard.
The ‘Clear’ command removes text or values within a single field. If you
wish to remove an entire record, use the ‘Delete’ command on the Record
menu.
Select All
Use this command to select the entire contents of a field. You can use it
when you are editing a field and want to replace the whole contents with new
data.
Select Row
This command is used in screens that contain rows of information, divided
into separate columns (or ‘fields’), for example the Invoice and Transaction
screens. It allows you to select a whole row. When you choose ‘Select Row’,
the row in which the cursor is placed is selected. Clicking the number
identifier of the row (on the left) has the same effect.
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Record Menu

The Record menu contains the necessary commands to open, enter, change
and delete the records in the different registers.
Almost all these commands can also be executed using the buttons in the
Button Bar. In addition, there are keyboard shortcuts available for most of
them. Commands that cannot be used at a certain point are dimmed in the
menu.

!

The Record menu commands cannot
be undone with ‘Undo’.

Next
•

When you work in a record window, showing an individual record in a
register, ‘Next’ will take you forward to the next record in that register.
It will also save all changes you have made in the record you have just
left.
In this situation, the ‘Next’ command has the same effect as clicking the
[Next Record] button in the Button Bar.

•

When you work in a browse window, ‘Next’ will move forward to the
next group (page) of records.

•

When you work with a Report, ‘Next’ will scroll to the next page of the
report.

Previous
This command works in the same way as ‘Next’, but moves backwards
instead of forwards. As with ‘Next’, when working in a record window,
‘Previous’ saves all changes you have made in the record you are leaving.
In record windows, the ‘Previous’ command has the same effect as clicking
the [Previous Record] button in the Button Bar.
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OK
This command is equivalent to pressing the [Save] and [Run] buttons in the
Button Bar (depending on context). When you use this command in a record
window, it closes the record on screen and saves all changes. When you use
it in a browse window, it opens the selected (highlighted) record for editing.
In a specification window, it prints the report or document or activates the
Maintenance function.
Cancel
Closes the record on screen without saving any changes. It is equivalent to
the [Cancel] button in the Button Bar.
Windows of all types can also be closed using the close box or Ctrl-F4
(Windows and Linux) or -W (Macintosh). When using these methods, you
will be asked if you wish to save changes.
New
Use this command when you need to create a new record. You can only use
it after you have opened a register by clicking one of the buttons in the
‘Registers’ section of the Master Control panel.
This function opens a blank window into which you can enter the new
record. If you click [Save], the record will be saved into the register
concerned. If you click [New] again, the record will be saved and a new
blank window opened, enabling you to enter another new record in the same
register. If you click [Cancel], the record will be closed but not saved.
Duplicate
This function creates a new record by duplicating an existing one. The
duplicate is opened in a window marked ‘New’. In many cases, dates in the
new record will be changed to show the current date.
You can duplicate a record either from a record window containing the
record to be duplicated, or from the browse window in which you have
highlighted the record to be duplicated with the mouse.
Delete
Use this command to delete, i.e. remove, an existing record. The record must
be of a type that can be removed - records such as Invoices and Nominal
Ledger Transactions cannot be removed once completed. You must open a
record in the record window to be able to delete it.
When you delete a record, the next record in the register is displayed.
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!

Remember that you cannot undo the
deletion of a record.

When you use the ‘Delete’ command, you are usually not asked if you are
sure you want to go ahead with the deletion. If you would like such a
warning to appear, switch on the Prompt When Deleting option in the Local
Machine setting.

Window Menu

Use this menu to manage your windows, including closing them and
arranging them on screen. ‘Save Normal Position’ (Windows and
Linux)/‘Save’ (Macintosh) and ‘Restore Normal Position’ (Windows and
Linux)/‘Restore’ (Macintosh) allow you to save a particular setting for an
individual window. ‘Save Normal Position’ will save the position and size of
the window and, in browse or ‘Paste Special’ windows, the sort order, while
‘Restore Normal Position’ will return the setting of the window to standard.
Although the ‘Close All’ function is not available to Macintosh users,
clicking the close box of a window while holding down the Alt key will have
the same effect.

About FirstOffice
This command on the ? menu (Windows and Linux), the Apple menu
(Macintosh OS 9) and the Hansa OSX menu (Macintosh OS X) shows the
copyright information for FirstOffice. The version of the program and
information about the owner of the program license are also shown here. You
return to the program by clicking [OK].
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If you need to contact your local FirstOffice representative with a technical
query, you should first find out the precise version number from this
window.
This window also shows the size of your FirstOffice database and the amount
of disk space available on the hard disk on which it is stored.
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The Registers
FirstOffice consists of a number of Registers or Files in which your data is
stored.
To work with a register (for example, if you need to enter a new Sales
Invoice), click the relevant register button in the Master Control panel. A
browse window will open, listing all the existing records in the register (in
this example, all Sales Invoices). Then, click [New] in the Button Bar and a
blank record window will appear in which you can enter a new record.
Registers in FirstOffice Start
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Working with Records
Current Record
When you wish to work with a particular record, you may open its record
window using one of the following methods. All methods give the same
result.
•

Double-click the record in a browse window.

•

Select the record in a Browse Window and press Enter.

With the record opened in a record window, you can edit all fields in the
usual way. Some fields may be locked due to relations to other functions in
the program. If this is the case, FirstOffice will tell you.

New Record
You can create a new record from a browse window or a record window. To
create a new record do one of the following—
•

Click [New] on the Button Bar.

•

Select ‘New’ from the Record menu.

A blank record is opened in a record window.

Duplicate Record
You can copy a record from a browse window or a record window. Select the
record you want to copy and—
•

Click [Duplicate] in the Button Bar, or

•

Select ‘Duplicate’ from the Record menu.

A new record is created. Relevant data from the original record is transferred,
and you only need to enter some of the fields. In many cases, date fields will
not be copied, but instead will be given new values.
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Delete Record
1.

Open the record window for the record you want to delete.

2.

Select ‘Delete’ in the Record menu.

You may not delete a record that is used by other transactions, such as an
Account.

!

You cannot undo the deletion of a
record.

You cannot delete a record directly from a browse window. You must open
the record first.
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Working with Companies
A FirstOffice database can contain more than one Company. This feature can
be useful if your business is one where there are separate departments or
subsidiary companies that keep separate accounts. These can be set up as
separate accounting entities in FirstOffice. Each department or subsidiary is
termed a ‘Company’.
Note that you should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.
Companies are stored in the Companies setting. You can add new Companies
at any time: this process is described in the ‘Adding New Companies’ section
on page 40 in the previous chapter. If you have more than one Company in
your Companies setting, it is recommended that you specify a Short Code for
each one—

Each time you log in to FirstOffice, you will be asked to choose a Company
to work with—
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The names in this list are taken from the Name field in the Companies
setting.
Once you have logged in, the Short Code of the Company (“H” in the
example illustrated) will be included in the title of every window—
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If you need to change Companies, there is no need to quit FirstOffice and
restart. Instead, you can click the [Companies] button in the Master Control
panel or select ‘Company’ from the File menu and then select the new
Company. Once you have done this, the Short Code in the window title
identifies the Company to which the information in each window belongs—

In this illustration, the ‘Transactions: Browse’ window lists Transactions
belonging to Company H, while the ‘Accounts: Browse’ window lists
Accounts belonging to Company S. Only one Master Control panel can be
open at any time, so the Short Code in its title (“S” in the illustration) is
always that of the current Company. This is the Company whose information
will be shown in any new windows that you open, and the Company in which
any new records that you create will be saved. If you want to return to work
in Company H, use the ‘Company’ function on the File menu once again.
If you need to make a change to a record in a particular Company, that
Company must be your current Company. For example, you have a Customer
record from Company H open in a record window. If Company S is your
current Company, you will not be able to make changes to the Customer
record. You must change to Company H first, using the ‘Company’ function
on the File menu.
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Usually, each Company will be completely separate: there will be no
common information. If you want to copy information from one Company to
another, you can do so using one of two methods—
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1.

by dragging and dropping. For example, to copy a Customer record from
one Company to another, open the ‘Customers: Browse’ window in the
first Company, change to the second Company using the ‘Company’
function on the File menu, and open the ‘Customers: Browse’ window in
that Company as well. Then click on the relevant Customer record and
drag it from one browse window to the other. This method is suitable for
copying individual records. The Payment Terms used in the copied
Customer must exist in both Companies.

2.

using the export and import functions. This method is suitable for
transferring the entire contents of a register or setting from one Company
to another.
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Attachments and Personal Desktop
Attachments
You can connect files, notes or other records to any record in FirstOffice.
These connected objects are known as “Attachments”.
All record windows contain an [Attachments] button—

If the record already has an Attachment, the button has a different icon—

Click this button to work with Attachments. A list of objects currently
attached to the record is opened—

This list has its own Operations menu, which contains the functions
necessary to attach, view and remove Attachments—
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You must save a record at least once before you can add any Attachments.
Attaching Files to Records
To attach a file to a record, open the record in question and click the
[Attachments] button. Select ‘Attach File’ from the Operations menu. An
‘Open File’ dialogue box will open, allowing you to locate the file to be
attached. Find the file and click [Open]. The file will be attached to the
record. Its filename will appear in the list of Attachments with the prefix
“File:”. You can attach as many files as you like to a single record.
The ‘Attach File’ function attaches a file to a record by copying the file into a
folder called “Attach” that is in the same folder as your FirstOffice
application. This means that you will still be able to read the attached file,
even after the original has been deleted. If you want to attach a large file to a
record, make sure (using the disk space indicator in the ‘About FirstOffice’
window) that the hard disk containing your FirstOffice application has
sufficient space.

!

The “Attach” folder must be present
in the folder containing your
FirstOffice application if you want to
attach files to records. Do not rename
any of the files in the “Attach” folder.

Reading Files
You can read a file that has been attached to a record in one of two ways.
Whichever method you use, a ‘Save File’ dialogue box will be opened,
asking you where the file is to be saved.
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1.

By double-clicking on the file in the list of Attachments. When the file
has been saved to your hard disk, your default browser will be opened so
that the file can be opened using the appropriate helper application (not
Macintosh).

2.

By clicking on the file in the list of Attachments and selecting
‘Download File’ from the Operations menu. The file is saved to your
hard disk, but no attempt is made to open it using a helper application.
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Attaching Notes or Comments to Records
You can attach notes or comments to records. To do this, open the record in
question and click the [Attachments] button. Select ‘Create Note’ from the
Operations menu. A window will open, where you can type in your
comment.

Click [Save] to save. The note will appear in the list of Attachments with the
prefix “Note:”. If you want to identify the note with a name, refer to the
section entitled ‘Changing the Names of Attachments’ below on page 114.
You can attach as many notes as you like to a single record.
Reading and Changing Notes
You can read a note or comment that has been attached to a record in one of
two ways—
1.

By clicking on the note in the list of Attachments and selecting ‘OK’
from the Record menu; and

2.

By double-clicking on the note in the list of Attachments.

Whichever method you use, the note will be opened in its own window
where you can read or edit it.
Printing Notes
A note or comment that has been attached to a record can be printed when
the record is printed. For example, a note that has been attached to an Invoice
can be printed on the Invoice document. If more than one note has been
attached to a record, only the first note will be printed.
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If you want notes and comments to be printed in this way, you should include
the “Note” field in each of your Form designs. Form design in fully
described on page 222 in Chapter 5, ‘Settings’.
Changing the Names of Attachments
When you attach a file to a record, its file name will be shown in the list of
attachments. When you attach a note to a record, it is not immediately given
its own name in the list.
If you want to rename a file or note, highlight it in the list of Attachments
and select ‘Edit Link Comment’ from the Operations menu. A window opens
where you can type in a new name.

Click [Save] to save and close the window, or [Cancel] if you don't want to
save changes. You may have to close and re-open the list of Attachments for
the change to take effect.
Attaching Records to Other Records
You can attach records to other records by dragging and dropping from the
browse window of one register onto the [Attachments] button of another. For
example, to attach a Customer record to an Invoice, open the Invoice in a
record window and then open the ‘Customers: Browse’ window. Find the
correct Customer in the list, click on the Customer Number and drag it to the
[Attachments] button of the Invoice. The Customer record will then appear in
the Invoice’s list of attachments. Alternatively, if the Customer record is
already open, you can drag its [Attachments] button onto that of the Invoice.
You can also select a range of Customer records in the browse window by
clicking while holding down the Shift key, and then drag them all to the
[Attachments] button.
Later, when viewing the Customer record in the example above, you might
wish to see which other records it has been attached to. Open the list of
Attachments and select ‘Show To Links’ from the Operations menu. The
records the Customer has been attached to will be listed below a dotted line.
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Viewing Attached Records
You can read a record that has been attached to another record in one of three
ways—
1.

By clicking on the file in the list of Attachments and selecting ‘Open
Record’ from the Operations menu;

2.

By clicking on the record in the list of Attachments and selecting ‘OK’
from the Record menu (or pressing the Enter key); and

3.

By double-clicking on the record in the list of Attachments.

Whichever method you use, the linked record is opened in its own window
where you can read or edit it in the usual manner.
Attaching Reports to Records
To attach a report to a record, first print the report to screen, and open the
record in question. The Button Bar of the report window contains an
[Attachments] button—

Drag this button to the [Attachments] button of the record. The report will be
attached to the record. It will appear in the list of Attachments with the name
“File: report”. Please refer to the ‘Changing the Names of Attachments’
section above on page 114 for details about changing this name.
When you attach a report to a record, the report is first printed to file and that
file is then attached to the record. The report file is stored in the “Attach”
folder that is in the same folder as your FirstOffice application. If you need to
read the report later, you will effectively be reading the file, not producing
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the report again. The information it contains will be correct for the moment
when it was originally produced, not for the moment when you are reading it.
This may be useful if you have attached the report to a record for later
discussion with another member of staff. When you read the report later, it
will be opened in a standard report window, so you can select ‘Recalculate’
from the Operations menu if you need to update the report to include the
latest information in the database.

!

The “Attach” folder must be present
in the folder containing your
FirstOffice application if you want to
attach reports to records. Do not
rename any of the files in the
“Attach” folder.

Reading Reports
You can read a report that has been attached to a record in one of two ways.
Whichever method you use, the report will be opened in a standard report
window.
1.

By double-clicking on the report in the list of Attachments.

2.

By clicking on the file in the list of Attachments and selecting ‘Open
Record’ from the Operations menu.

Removing Attachments
To remove an attachment of any kind from a record, highlight it in the list of
Attachments and select ‘Clear’ from the Edit menu.
Copying Attachments from one Record to Another
You can copy an Attachment of any kind from one record to another as
follows—
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1.

Open the record with the Attachment (the ‘source’ record) and click its
[Attachments] button.

2.

Open the record that is to receive the Attachment (the ‘destination’
record).

3.

Drag the Attachment from the list of Attachments to the [Attachments]
button of the ‘destination’ record (or to its list of Attachments).

4.

Hold down the Shift key while dragging if you do not want to remove
the Attachment from the ‘source’ record.
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Organising Attachments: Archives
When a record has many Attachments, you can organise them into Archives.
An Archive is a folder that can contain Attachments of all kinds, including
other Archives.
1.

Open the list of Attachments.

2.

Select ‘Create Archive’ from the Operations menu. A new Archive will
appear at the top of the list of Attachments, named “Archive: New”.

3.

Move the Attachments into the Archive by dragging and dropping onto
“Archive: New”.

4.

If you want to work with an Attachment that is in an Archive, doubleclick the Archive. A new window is opened, listing the Attachments that
are in the Archive. This window has the same properties, features and
functions as the main list of Attachments, so you can work with it in the
manner described in the preceding sections.
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5.

If you want to rename the Archive, first open it as described in step 4
above and then select ‘Rename Archive’ from the Operations menu.

Enter the new Name of the Archive and click [Save]. The new name will
replace the text “New,” both in the title bar of the Archive and in the
main list of Attachments—
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6.

You can remove an Attachment from an Archive in one of two ways. If
you want the Attachment to remain attached to the record, drag it to the
main list of Attachments or to another Archive. To remove the
Attachment altogether, click on it and select ‘Clear’ from the Edit menu.

7.

To remove an Archive, click on it in the main list of Attachments and
select ‘Clear’ from the Edit menu. You can only remove empty
Archives. To empty an Archive, you must remove its contents item by
item as described in step 6 above.
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Personal Desktop
As well as being able to connect files, notes or records to any record in
FirstOffice (as described above), you can also attach them to your Master
Control panel. They will be listed in the area on the right of the Master
Control panel, known as the “Personal Desktop”. You can also list important
reports, documents, Maintenance functions, settings and registers in the
Personal Desktop. You can therefore configure your Personal Desktop so that
it gives you immediate access to the areas of FirstOffice that are most
important to you (i.e. removing the need to find records in browse windows
and find reports in list windows). The Personal Desktop is therefore similar
to a list of Bookmarks in a browser.
If you want to use the Personal Desktop, you must first activate the Personal
Desktop feature. To do this, open the Persons setting, highlight your record
in the ‘Persons: Browse’ window and choose ‘Activate Personal Desktop’
from the Operations menu of the ‘Persons: Browse’ window. You can also
use this function from the Operations menu of the Master Control panel.

!

You must activate the Personal
Desktop before you can use it.
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Once you have a Mailbox, your name will be shown in the title bar of the
Master Control panel, and the contents of your Personal Desktop will be
listed in the area on the right—
Company identifier and
name of current user

Links to one report and one
document. Double-click to activate

Archives: used to ensure there is a managable
number of objects in the Personal Desktop.
Double-click to view contents

Double-click to
open Invoice
register

Double-click to
open individual
Invoice

The contents of your Personal Desktop cannot be viewed by another user. So,
if someone else logs in to FirstOffice on your machine, they will see their
Personal Desktop, not yours.
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Records in your Personal Desktop
You can place records in your Personal Desktop using the following
methods—
1.

By dragging the record from its browse window and dropping it on the
Personal Desktop. For example, to place a Customer record in the
Personal Desktop, open the ‘Customers: Browse’ window and find the
correct Customer in the list. Click on the Customer Number and drag it
to the Personal Desktop. You can also select a range of Customer
records in the browse window by clicking while holding down the Shift
key, and then drag them all to the Personal Desktop.

2.

By opening the record and dragging its [Attachments] button onto the
Personal Desktop.

Records are shown in the Personal Desktop with the name of the register
followed by the record identifier. In the illustration above, the penultimate
item (“Invoice: 970133”) is an example (970133 is the Invoice Number).
The illustration also shows that the Personal Desktop can contain records
from different Companies. In the illustration, the current Company is
Company H (shown in the title bar of the Master Control panel, next to the
name of the current user). “H” is short for Holding Company in the example
database. The last item in the Personal Desktop in the illustration (“S:
Invoice: 912”) is an Invoice that belongs to Company S (a Subsidiary
Company). Any record that does not belong to the current Company will be
shown in the Personal Desktop with its Company Short Code before the
name of the register. So, in this example, if the current user were to quit
FirstOffice and restart, selecting Company S, then Invoice 970116 would
appear in the Personal Desktop as “H: Invoice: 970133” and Invoice 912
would appear simply as “Invoice: 912”.
You can open a record in the Personal Desktop in one of three ways—
1.

By clicking on the record in the Personal Desktop and selecting ‘Open
Record’ from the Operations menu;

2.

By clicking on the record in the Personal Desktop and selecting ‘OK’
from the Record menu (or pressing the Enter key); and

3.

By double-clicking on the record in the Personal Desktop.

Whichever method you use, the record is opened in its own window where
you can read or edit it in the usual manner. If you choose to open a record
that is not in the current Company, you will be asked to log in to the relevant
Company before the record is opened.
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Settings, Reports, Documents and Maintenance functions in your
Personal Desktop
To place a setting, report, document or Maintenance function in your
Personal Desktop, simply open the appropriate list window and then drag an
item from the list to the Personal Desktop. This method can also be used for
import and export functions.
For example, to place the Periodic Customer Statement in your Personal
Desktop (as shown in the example illustration above), first select ‘Reports’
from the File menu (or click [Reports] in the Master Control panel). Click on
‘Periodic Customer Statement’ in the list and drag this text to your Personal
Desktop.
To work with a setting, report, document or Maintenance function, use one of
these methods—
1.

Click on the item in the Personal Desktop and select ‘Open Record’ from
the Operations menu;

2.

Click on the item in the Personal Desktop and select ‘OK’ from the
Record menu (or press the Enter key); and

3.

Double-click on the item in the Personal Desktop.

Whichever method you use, the setting or the specification window for the
report, document or Maintenance function will open. You can also attach a
report itself to your Personal Desktop: please refer to the ‘Reports in your
Personal Desktop’ section below on page 124.
Registers in your Personal Desktop
To place a register in your Personal Desktop, simply drag it from the Master
Control panel to the Personal Desktop. For example, to place the Invoice
register in your Personal Desktop (as shown in the example illustration
above), click on the [Invoices] button in the Master Control panel and drag it
to your Personal Desktop.
To work with a register, use one of these methods—
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1.

Click on the item in the Personal Desktop and select ‘Open Record’ from
the Operations menu;

2.

Click on the item in the Personal Desktop and select ‘OK’ from the
Record menu (or press the Enter key); and

3.

Double-click on the item in the Personal Desktop.
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Whichever method you use, the normal browse window for the register in
question will be opened. If, as in the example illustrated above, the database
contains more than one Company, the browse window will list the records in
the register in the current Company.
Notes and Comments in your Personal Desktop
You can place notes or comments in your Personal Desktop. To do this, bring
the Master Control panel to the front and select ‘Create Note’ from the
Operations menu. A window will open, where you can type in your
comment.

Click [Save] to save. The note will appear in your Personal Desktop with the
prefix “Note:”. If you want to identify the note with a name, refer to the
section entitled ‘Changing the Names of Items in your Personal Desktop’
immediately below. You can place as many notes as you like in your
Personal Desktop.
You can read a note or comment in your Personal Desktop in one of two
ways—
1.

By clicking on the note in the Personal Desktop and selecting ‘OK’ from
the Record menu; and

2.

By double-clicking on the note in the Personal Desktop.

Whichever method you use, the note is opened in its own window where you
can read or edit it.
Changing the Names of Items in your Personal Desktop
When you place a file in your Personal Desktop, its file name will be shown
in the list of attachments. When you place a note in your Personal Desktop, it
will not immediately be given its own name in the list.
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If you want to rename a file or note, highlight it in your Personal Desktop
and select ‘Edit Link Comment’ from the Operations menu. A window opens
where you can type in a new name.

Click [Save] to save and close the window, or [Cancel] if you don't want to
save changes.
Reports in your Personal Desktop
To place a report in your Personal Desktop, first print the report to screen.
The Button Bar of the report window contains an [Attachments] button:
simply drag this button to the Personal Desktop.
To work with a report, use one of these methods—
1.

Click on the item in the Personal Desktop and select ‘Open Record’ from
the Operations menu;

2.

Click on the item in the Personal Desktop and select ‘OK’ from the
Record menu (or press the Enter key); and

3.

Double-click on the item in the Personal Desktop.

Whichever method you use, the report will be opened in a standard report
window.
When you attach a report to your Personal Desktop, it will appear in the
Personal Desktop with the name “File: report”. Please refer to the ‘Changing
the Names of Items in your Personal Desktop’ section above on page 123 for
details about changing this name.
When you attach a report to the Personal Desktop, the report is first printed
to file and that file is then attached to the Personal Desktop. The report file is
stored in the “Attach” folder that is in the same folder as your FirstOffice
application. If you need to read the report later, you will effectively be
reading the file, not producing the report again. The information it contains
will be correct for the moment when it was originally produced, not for the
moment when you are reading it. The report will be opened in a standard
report window, so you can select ‘Recalculate’ from the Operations menu if
you need to update the report to include the latest information in the
database.
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!

The “Attach” folder must be present
in the folder containing your
FirstOffice application if you want to
attach reports to your Personal
Desktop. Do not rename any of the
files in the “Attach” folder.

Removing Items from your Personal Desktop
To remove an item of any kind from your Personal Desktop, highlight it and
select ‘Clear’ from the Edit menu.
Organising Items from your Personal Desktop: Archives
When you have many items in your Personal Desktop, you can organise them
into Archives. An Archive is a folder that can contain Attachments of all
kinds, including other Archives.
1.

Bring the Master Control Panel to the front by clicking on it, by using
the Ctrl-M/-M keyboard shortcut or by selecting ‘Master Control’
from the File menu.

2.

Select ‘Create Archive’ from the Operations menu. A new Archive will
appear at towards the top of the Personal Desktop, named “Archive:
New”.

125

HansaWorld FirstOffice Start

126

3.

Move the relevant items into the Archive by dragging and dropping onto
“Archive: New”.

4.

If you want to work with an item that is in an Archive, double-click the
Archive. A new window is opened, listing the items that are in the
Archive. This window has the same properties, features and functions as
a list of Attachments, so you can work with it in the manner described in
the ‘Attachments’ section above on page 117.

5.

If you want to rename the Archive, first open it as described in step 4
above and then select ‘Rename Archive’ from the Operations menu.
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Enter the new Name of the Archive and click [Save]. The new name will
replace the text “New,” both in the title bar of the Archive and in the
Personal Desktop—

6.

You can remove an item from an Archive in one of two ways. First, you
can drag it to the Personal Desktop or to another Archive. Otherwise, to
remove the item altogether, click on it and select ‘Clear’ from the Edit
menu.

7.

To remove an Archive, click on it in the Personal Desktop and select
‘Clear’ from the Edit menu. You can only remove empty Archives. To
empty an Archive, you must remove its contents item by item as
described in step 6 above.
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Keyboard Shortcuts
The following keyboard shortcuts are available in FirstOffice—
Menu

Function

Windows/Linux

Macintosh

File Menu

Company
Master Control
Exports
Imports
Reports
Documents
Settings
Print (Printer Icon)
Quit

Ctrl-O
Ctrl-M
Ctrl-E

-O
-M
-E
-Shift-I
-R
-D
-S
-P
-Q

Edit Menu

Undo
Cut
Copy
Paste
Select All

Ctrl-Z
Ctrl-X
Ctrl-C
Ctrl-V

-Z
-X
-C
-V
-A

Record Menu

Next ([] button)
PgDn
Prev ([] button)
PgUp
OK ([Save], [Run] buttons) Shift-Enter
New ([New] button)
Ctrl-N
Duplicate ([Duplicate] button)
Ctrl-K
Delete
Ctrl-1 to 8

-+
-Shift-Enter
-N
-Y
-Shift-D
-1 to 8

Save Normal Position
Restore Normal Position

-Shift-S
-Shift-T

Registers
Window Menu

Browse Window Sort Column
Record Window OK check box on/off
Change Tabs
Paste Special
Other
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Ctrl-R
Ctrl-D
Ctrl-S
Ctrl-P
Alt-F4

Ctrl-Shift-highlighted letter
Ctrl-Shift-O
-Alt-O
Ctrl-Shift-1 to 3
-Alt-1 to 3
-highlighted letter
Ctrl-Return
-Return

Modify Linked Record
F2
Close Window
Ctrl-F4 or Esc
Close All Windows Use Window menu
Change Window
Ctrl-Tab

-Shift-V
-W or Esc
Alt-Close Box
-Shift-N
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Chapter 3: Accounting Principles
Managing your own business is often a rewarding undertaking, but with it
come a number of obligations. One is the requirement to keep your accounts
up to a certain standard. The legal requirements differ with the type of
business and the country of operation, but regardless of these there can be
great advantages in having your books in order. In this chapter some of the
basic concepts used in accounting, and their integration into FirstOffice, are
described.

Internal and External Documents
There are two basic types of documents produced by an accounting system:
external and internal documents. External documents, such as invoices,
payment vouchers, VAT reports and tax returns are produced because
someone outside the business needs them. These are termed ‘Documents’ in
FirstOffice. Internal documents are used inside your company to make
decisions about different things. Examples are price information, sales
statistics, credit limits, payment forecasts etc. These are termed ‘Reports’ in
FirstOffice.
Accounting material should be handled with care. You need the information
it provides to control and to develop your business, and you are also required
by law to keep it up to date and archived in a certain way.
Both the reports handed in to authorities, banks etc. and those you make for
your own use are based on a basic series of transactions. The records of these
basic transactions (sales invoices, cash ledger vouchers, purchase invoices,
bank statements, personnel records and loans) are found among the
documents of any business.
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Transaction Records
A transaction record is the proof of a transaction, e.g. a receipt for something
you have bought, or a bank statement showing that an invoice has been paid
by one of your customers. Every event in the business that involves its
finances should be supported by a transaction record.
All financial events should be recorded in date order as they occur. When
each event is recorded in the accounts, a transaction is created. The
transaction classifies the event according to certain accounting rules,
allowing the production of reports and the later recollection of the event.
Transactions are recorded in a daily journal and each is distinguished by a
unique sequence number. Their supporting documents (the hard copies of the
transactions) are kept in a file, marked with the same sequence numbers (and
with the date on which the transaction occurred). The transaction should also
contain a code, or account, classifying its nature. This is where your Chart of
Accounts comes in as a tool for the systematic recording of financial events.

Transactions in FirstOffice
FirstOffice features a high level of integration between the different
transaction registers. Whenever you process a Sales or Purchase Ledger
transaction, an equivalent Nominal Ledger Transaction is created
automatically. For example, when you approve an Invoice and send it to a
Customer, a Nominal Ledger Transaction is created automatically to post
amounts to the Sales, Debtor and VAT Accounts. Simultaneously, the Sales
Ledger and all reports are updated. Similarly, when you receive a payment,
you will update the Sales Ledger, and an automatic Nominal Ledger
Transaction will update the Debtor Account and the Bank or Cash Account
as appropriate. In general terms, a record that causes a Nominal Ledger
Transaction to be created (e.g. an Invoice or stock movement of some kind)
is usually referred to as a “sub system record” or “sub system transaction” in
FirstOffice and in this manual.
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Integration
Sales Ledger

Purchase Ledger
Nominal Ledger

Through a large number of settings and parameters, you can set up the
accounting environment so that the correct Sales Accounts, Cost Accounts
etc. are updated when necessary.
Below are described some of the more common transactions.
Sales Invoices
Invoices are demands for payment sent to Customers. The raising of an
Invoice causes a Nominal Ledger Transaction to be created which debits the
Debtor Account (which keeps a tally of how much your company is owed),
credits a Sales Account (it is normal practice to maintain more than one Sales
Account to keep a record of the sales of different types of product) and, in
most cases, credits a VAT Account. Once Invoices have been raised in the
Sales Ledger, the creation of the Nominal Ledger Transaction is handled
automatically in FirstOffice. Below is shown a typical such Transaction.
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FirstOffice has a number of methods whereby the Accounts used in this
Transaction can be chosen in such a way as to reflect the accounting needs of
different situations. Different Sales Accounts can be used for individual
Items, and the VAT Account can be controlled through the VAT Code. The
number of options is great, and they are described in detail in this section.
Each individual Invoice, when approved, determines how the consequent
Nominal Ledger Transaction is to be structured. The Accounts used are
chosen as follows—

Sales Account
The Sales Accounts in the Nominal Ledger are used to record the levels of
sales of different types of Items. Different Invoice rows can have different
Sales Accounts.
For each row on an Invoice, the Sales Account is chosen as follows—
1.

When you enter an Item Code, if there is a Price List applying to the
Invoice and there is a record in the Prices setting for that Item/Price List
combination, FirstOffice takes the Sales Account from there. If this
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Sales Account is blank, or there is no appropriate record in the Prices
setting—
2.

FirstOffice uses the Sales Account for the relevant Item (taken from the
Item register). If this is blank—

3.

FirstOffice uses the Sales Account entered in the Account Usage S/L
setting for the zone to which the Customer belongs. There are three
zones (Domestic, EU and Export), and each can have a different Sales
Account.

If the selected Account is missing from the Chart of Accounts, FirstOffice
will display the error message: “Sales Account missing, check Account
Usage S/L”.

VAT Account
When you enter an Invoice, you must specify a VAT Code in each row. This
code refers to a specific VAT Code record, which will determine the Output
VAT Account in the subsequent Nominal Ledger Transaction and the rate at
which VAT will be charged. VAT Code records are set up using the VAT
Codes setting.
When you enter Invoice rows, you cannot leave the VAT Code field (marked
‘V-Cd’) blank. FirstOffice places a default in the field, chosen as follows—
1.

When you enter an Item Code, FirstOffice uses the VAT Code entered
for the relevant Item in the Item register. If this is blank, or if no Item
Code has been entered to the Invoice row—

2.

FirstOffice uses the VAT Code entered in the Account Usage S/L setting
for the zone to which the Customer belongs.

If the selected VAT Code is missing from the VAT Codes setting, FirstOffice
will display the error message: “Code not registered”.

Debtor Control Account
When a Nominal Ledger Transaction is generated from an Invoice, the
Debtor Account is not determined from the Invoice itself (unlike the Sales
and VAT Accounts described above). Instead, it is determined using the
Debtor (or, if the Invoice is a cash Invoice, the Cash) Account entered in the
Account Usage S/L setting.
If the selected Account is missing from the Chart of Accounts, FirstOffice
will display the error message: “Debtor Account missing, check Account
Usage S/L”.
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Receipts
When a Customer makes a payment against an Invoice, the transaction is
known as a Receipt. In the Nominal Ledger, the raising of a Receipt credits
the Debtor Account and debits the Bank or Cash Account. When you enter a
Receipt, you will allocate it to the appropriate Invoice(s), and the
consequences in the Nominal Ledger will be handled automatically.
Normally, a Receipt will generate a Nominal Ledger Transaction like this—

When Nominal Ledger Transactions are generated from Receipts, the
Accounts used are selected as follows.

Debtor Control Account
The Debtor Control Account for the Invoice being paid will be transferred to
the Receipt. For details of how this is calculated, please refer to the ‘Debtor
Control Account’ section under ‘Sales Invoices’ above on page 134.

Bank or Cash Account
The Bank or Cash Account posting will be determined from the Payment
Modes setting. This is used to store different payment methods, such as
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cheque, cash, credit card. Each payment method can be attached to a
different Account, perhaps reflecting the usage of different bank accounts for
each type of payment.
Purchase Invoices
Purchase Invoices are demands for your company to make payments. A
Nominal Ledger Transaction created from a Purchase Invoice will normally
affect three Accounts: the Creditor Account will be credited, a Purchase
Account will be debited and, in most cases, the VAT Account will also be
debited. Defaults for the Accounts affected are taken from the Account
Usage P/L setting, and they are selected according to the priority rules
described below.

Purchase/Cost Account
The Purchase Accounts (also known as Cost Accounts) in the Nominal
Ledger are used to record the levels of purchases of different types of Items.
When you enter Purchase Invoices, you should enter a Purchase Account in
each row (in the column marked ‘Account’). Different rows can have
different Purchase Accounts.
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FirstOffice can in some instances offer a default Purchase Account for the
Account field in the first row of a Purchase Invoice. This will be taken from
the Cost Account specified on the ‘Account’ card of the Customer record for
the Supplier. You might specify such a default for Suppliers of services (such
as electricity or telephone services), whose Purchase Invoices are always
posted to the same Account.

VAT Account
When you enter a Purchase Invoice, you must specify a VAT Code in each
row. This code refers to a specific VAT Code record, which will determine
the Input VAT Account in the subsequent Nominal Ledger Transaction and
the rate at which VAT will be charged. VAT Code records are set up using
the VAT Codes setting.
When you enter Purchase Invoice rows, you cannot leave the VAT Code
field (marked ‘V-Cd’) blank. The default is placed in this field as follows—
1.

FirstOffice uses the VAT Code specified for the Account. If this is
blank—

2.

The VAT Code specified in the Account Usage P/L setting is used.

If the selected VAT Code is missing from the VAT Codes setting, FirstOffice
will display the error message: “Code not registered”.

Creditor Control Account
When a Nominal Ledger Transaction is generated from a Purchase Invoice,
the Creditor Account is taken from the Creditor (or, if the Invoice is a cash
Invoice, the Cash) Account entered in the Account Usage P/L setting.
Payments
A Payment is the Purchase Ledger equivalent of a Receipt: it is the
transaction that occurs when you pay a supplier’s Purchase Invoice. In the
Nominal Ledger, the raising of a Payment debits the Creditor Account and
credits the Bank or Cash Account. When you enter a Payment, you will
allocate it against the appropriate Invoice(s), and the consequences in the
Nominal Ledger will be handled automatically.
When Nominal Ledger Transactions are generated from Payments, the
Accounts used are selected as follows.

Creditor Control Account
The Creditor Control Account for the Purchase Invoice being paid will be
transferred to the Payment. For details of how this is calculated, please refer
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to the ‘Creditor Control Account’ section under ‘Purchase Invoices’ above
on page 137.

Bank or Cash Account
The Bank or Cash Account posting will be determined from the Payment
Modes setting. This is used to store different payment methods, such as
cheque, cash, credit card. Each payment method can be attached to a
different Account, perhaps reflecting the use of different bank accounts.
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Chart of Accounts
Accounts are the Nominal Ledger headings that you use to classify all
financial transactions: each Nominal Ledger Transaction described above
posts to two or more Accounts. In fact each Nominal Ledger Transaction can
be defined by which Accounts these are. The organisation of these Accounts
is known as a ‘Chart of Accounts’: a systematic list of how assets, liabilities,
income and expenses are to be classified and thus the basis for your
accounting reports. The logic used in the classification determines the
usefulness of your reports, and the drawing up of a satisfactory Chart of
Accounts requires careful consideration.
In designing a Chart of Accounts, it is usual practice to group Accounts
together according to type. For example, all Sales Accounts should have
similar codes, different Bank Accounts should have similar codes and so on.
This will ensure that they appear together in reports. Room should be left so
that new Accounts, the need for which is currently unforeseen, can be
inserted in the right place. If your business develops into new products, for
example, you should be able to create Sales Accounts for those new products
with similar codes to the existing Sales Accounts.
In traditional accounting systems, the Chart is divided into account classes,
following a decimal classification. Two or three classes are reserved for
Balance Sheet Accounts, one class is normally reserved for internal
accounting and year-end operations, and the remaining five or six classes are
used for revenue and cost classification.
Typical Charts of Accounts, including that supplied as a template with
FirstOffice, follow the model illustrated below. The Accounts are usually
divided into two groups, named after the report in which they appear.
Profit & Loss

This report shows the trading profit or loss of your
business, usually at the end of a month or year.

Balance Sheet

This report shows the assets, liabilities and capital of
your business at the moment of printing.
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Sample Structure of Chart of Accounts
Account
Number
Range

Account
Type

Sales

100-199

Income

Cost of Sales

200-299

Expense

300-599

Expense

Fixed Assets

600-699

Asset

Current Assets

700-799

Asset

Current Liabilities

800-899

Liability

Description

Profit & Loss (P & L)

Gross Profit = Sales - Cost of Sales
Overheads
Net Profit = Gross Profit - Overheads

Balance Sheet

Net Current Assets = Current Assets - Current Liabilities
Long Term Liabilities

900-949

Liability

Total Net Assets = Fixed Assets + Net Current Assets - Long Term Liabilties
Equity

950-999

Equity

Profit/Loss Year To Date

Net Profit
from P & L

Income

Total Net Assets = Equity + Profit/Loss Year To Date

!
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Your Chart of Accounts should be
drawn up in consultation with your
accountant or financial adviser.
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Who needs to know about your business
There are several parties who have an interest in your accounts: you, other
owners, creditors and banks, employees and not least the tax authorities.
Your auditor’s job is to certify your accounts on behalf of all the interested
parties. He or she will check your books to certify that they give a “true and
fair” representation of the state of affairs.
Sometimes it feels as if all this apparatus of reports and accounts is just too
much trouble. Used in the right way, however, a good accounting system
improves the control of the business. There are, indeed, more examples of
companies that have failed because of bad accounting than of too good…

Practical use of accounting information
Accounting information is useful in many situations. You can use it as a
foundation for your budgeting, when you want to find out if a certain deal is
profitable or not or to monitor the performance of a department, a market
segment etc.

Getting capital
From time to time you need to persuade banks or other financiers that your
business is solid and profitable, e.g. when you need to borrow money for an
investment. A good accounting system allows you to find the information
they require quickly, and to make a credible presentation.

Tax returns
Your accounts provide all the information needed to produce the different
types of tax returns.

VAT declaration
All VAT registered companies must produce a number of periodical reports,
of which the VAT return is the most important. If you are above the
threshold amount for trade within EU, there are some other reports that need
to be made.
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The VAT return comes from your accounts. It follows a prescribed format,
and your accounts should reflect the VAT requirements, to make it easy to
produce the report.
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The End of a Financial Year
At the end of the financial year, the books are closed and a new year is
started. The final accounts are produced, the auditors will produce their
report, and management will produce their report to the owners’ annual
meeting. After approval, in the case of limited companies, the annual report
is filed with the registrar of companies.
To end a financial year and start a new one in FirstOffice, follow these steps.
Companies will have their own methods for recording profit/loss at the end
of a financial year. A typical method is described in steps 4-9 below: this
method may not be suitable for every company in every country. Please refer
to your financial adviser for more advice on this subject.
1.

If you are registered for VAT, the first step should be to print a VAT
Report for the final quarter of the year (and separately for earlier
quarters if this has not already been done).
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2.

For each quarter, you should then enter a Transaction in the Transaction
register transferring the VAT amount payable/receivable into the VAT
Payments Account (835 in the Chart of Accounts supplied with
FirstOffice). This Transaction would debit the VAT Outputs Payable
Account (830) and credit the VAT Inputs Receivable Account (831),
with a balancing posting to the VAT Payments Account. You must enter
this Transaction in the quarter to which it belongs, preferably as the last
Transaction of the period.

You can transfer the amount payable/receivable from/to your bank
account using a further Transaction when payment is made/received.
3.

Print out the following reports, using the whole year as the report period
in each case. These will provide both a hard copy record of the year’s
business and the basis for the end-of-year work that will now be carried
out by your auditors.

Nominal Ledger
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The Nominal Ledger Report is an important part of the
final accounts of a business. It is a list of every
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Transaction, classified by Account and listed in the
order in which they were entered.
Transaction Journal
The Transaction Journal is a list of every Transaction in
the accounts, in Transaction Number order.
Profit & Loss

The Profit and Loss report summarises the income and
expenditure (and therefore the operating profit or loss)
of the business during the fiscal year. The result shown
on the Profit & Loss report should agree with (‘balance’)
the result on the Balance Sheet.

Balance Sheet

The Balance Sheet shows the financial status - at a
particular point in time - of the company showing
Assets, Liabilities and Equity capital.

System Documentation
The System Documentation report describes the design
of the accounting system being used. This includes
descriptions of the Chart of Accounts, accounting rules
etc. This allows an outsider to understand how you have
arrived at the final accounts.
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4.

Ensure your Chart of Accounts (i.e. Accounts setting) includes Accounts
defined as shown in the illustration—

5.

The Accounts defined in step 4 above should not appear in the
Definitions for your Profit & Loss report, but should be part of the profit
calculation in the Balance Sheet. In the sample Chart of Accounts
supplied with FirstOffice, these are lines 90, 100 and 105 of the Balance
Sheet Definition. To check this, first select ‘Settings’ from the File menu
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and double-click ‘Report Settings’ in the subsequent list. Then, highlight
‘Balance Sheet’ in the list on the left-hand side of the ‘Report Settings’
window and click the [Definition] button. The following window
opens—
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Double-click in turn on lines 90, 100 and 105 (or the equivalents if you
are not using the sample Chart of Accounts and/or Balance Sheet report
definition supplied with FirstOffice) and ensure they are defined as
shown—
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Line 90 in the sample Balance Sheet Definition is the equity calculation,
it causes the balances of all Accounts between 950 and 970 to be shown
in the Balance Sheet, together with a total figure for equity.
Line 100 in the sample Balance Sheet Definition is the profit calculation.
This line does not have any Text and therefore it will not be printed in
the report.
Line 105 prints the result of the calculation in line 100.
6.

Once your auditors have concluded their work and any consequent
Transactions have been entered, refer to step 3 above and print out the
reports again, as final records of the year just ended. These will be the
basis for the end-of-year accounts presented to the owners or directors.
The Net Profit in the Profit & Loss Report should be the same as the
Profit/Loss this YTD shown in the Balance Sheet. Make a note of this
figure.
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7.

You should now post the profit or loss for the year just ended to the
Result of Current Fiscal Year Account (Account 960 in the sample Chart
of Accounts and in step 4 above). Do this by entering a new record to the
Transaction register dated the last day of the year just ended. If your
company made a profit, this Transaction should debit the Special
Account for Y/E profit Postings (Account 99999 in step 4 above) and
credit the Result of Current Fiscal Year Account with the value noted in
step 6. If your company made a loss, the debits and credits should be
reversed.

8.

Save the Transaction and print the Balance Sheet and Trial Balance to
screen. You should now find that the YTD Profit figure on the Balance
Sheet is zero, and the Balance Sheet should balance. Finally, check that
your Trial Balance report for the last year still balances.

9.

You should now bring the profit/loss figure forward to the next year. Do
this by entering a new record to the Transaction register dated the first
day of the new year (you will need to update the Fiscal Years setting as
described in step 10 below before you can do this). If your company
made a profit, this Transaction should debit the Result of Current Fiscal
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Year Account and credit the Retained Earnings Account (Account 970 in
step 4 above) with the value noted in step 6. If your company made a
loss, the debits and credits should be reversed.

The result of the two Transactions in steps 7 and 9 is that the forward
balance for Account 960 will be the result of the previous year in the
Balance Sheet for the next year. The final balance for Account 970 will
be the accumulated results of all previous years in the Balance Sheet for
the next year.
10. Finally, you should ensure you are ready for the new year. Using the
Fiscal Years setting, register the new financial year on the first blank
line. Do not insert the new year at the top of the list because Fiscal Years
have to be listed in chronological order. Do not remove past Fiscal
Years. Click [Save] to save.
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Further details of each of these steps can be seen in the sections describing
the respective functions in the ‘Settings’, ‘Transaction Registers’ and
‘Reports’ chapters elsewhere in this manual.
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Chapter 4: Starting Work with FirstOffice
Entering Data and Opening Balances
If you have been following this manual in sequence, you should by now have
created a new database into which you have entered information about your
company, the current fiscal year, a set of VAT Codes and a Chart of
Accounts. If this is not the case, please turn back to the ‘Starting FirstOffice’
section on page 33 of Chapter 1, ‘Introduction and Installation’, before
proceeding.
Settings
As you start using each register for the first time, it is a good idea to check
the different settings that are used by that register. Some settings have default
values that you should be aware of and may wish to change, and some
represent a special functionality that you might be able to use.

!

Remember, most settings are
imported automatically when a new
database is created. If you alter the
Chart of Accounts, you will probably
have to change any settings that use
Account Codes as well.

Persons
One of your first tasks in creating a new database should be to record details
of yourself and anyone else that you want to be able to use your copy of
FirstOffice. You will do this using the Persons setting. One reason for doing
this is to protect your data: the Persons setting allows you to assign a
password to each user. It's a good idea to do this even in a single-user system
like FirstOffice: protecting your database with a password might prove to be
a wise precaution if your computer is stolen.
To enter your details (and those of anyone else that will be able to use your
copy of FirstOffice) to the Persons setting, follow these steps—
1.
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Open the Persons setting by clicking the [Settings] button in the Master
Control panel and double-clicking ‘Persons’ in the subsequent list. If you
are using a new database, a blank browse window will appear.
Otherwise, it will list all Persons previously entered.
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2.

Click the [New] button in the Button Bar at the top of the browse
window.
Use the ‘Person: New’ window shown below to enter information about
a member of staff. For full details about each field on the screen, please
refer to page 243 in Chapter 5, ‘Settings’, later in this manual.

When you enter a Person’s initials in the Signature field, note that where
there is more than one Company in the database, records in the Persons
setting are specific to the Company in which they were entered. If you
will be using the Personal Desktop, you should enter Person records for
yourself in each Company with the same Signature (initials). This will
allow you to see your Personal Desktop in each Company. If there are
two or more different Persons in different Companies with the same
Signature, they will not be able to have their own Personal Desktop.
3.

Click the [Save] button in the top right-hand corner of the window. The
record is saved in the Persons setting.

4.

The window title changes to ‘Person: Inspect’, giving you a chance to
check you have not made any mistakes in entering the record.

5.

Close the record by clicking the close box or using the Ctrl-F4
(Windows and Linux) or -W (Macintosh) keyboard shortcut.

6.

If you have a number of personnel to enter, click [New] instead of [Save]
at step 3 above (or use the Ctrl-N/-N keyboard shortcut). The Person
record is saved and closed, and a blank window is opened, allowing you
to enter another record straight away.

7.

When you close the last Person record at step 5 above, you will be
returned to the ‘Persons: Browse’ window, which now lists the members
of staff that you have just registered. Click on each one in turn and
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allocate a password by selecting ‘Change Password’ from the Operations
menu.
If you want to use the Personal Desktop, you should now activate it for each
Person. With the ‘Persons: Browse’ window still open, click on each Person
in turn and then select ‘Activate Personal Desktop’ from the Operations
menu. The Personal Desktop is fully described on page 119 in Chapter 2,
‘Work Area’.
Entering the First Customer
FirstOffice keeps all information about Customers and Suppliers together in
a single register, the Customer register, with one record for each company.
All other companies (e.g. leasing companies, factoring companies, sales
leads, etc) should be stored here as well.
Before recording companies in the Customer register, you should first make
sure all relevant Payment Terms (used to calculate Due Dates in Invoices)
have been entered in the Payment Terms setting. You may also wish to
define Customer and Supplier Categories (used to group together companies
of a similar type). These are all described in Chapter 5, ‘Settings’ (pages 240,
217 and 257 respectively).
To enter your first record in the Customer register, follow these steps—
1.

Open the Customer register by clicking the [Customers] button in the
Master Control panel. If you are using a new database, a blank browse
window will appear. Otherwise, it will list all Customers previously
entered.

2.

Click the [New] button in the Button Bar at the top of the browse
window.
Use the ‘Customer: New’ window shown below to enter data about the
company. For full details about each field on the screen, please refer to
the ‘Customers and Suppliers’ section on page 267 in Chapter 6, ‘Base
Registers’.
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3.

Click the tabs (named ‘Contact’, ‘Terms’ and ‘Account’) to enter more
information about the Customer.

4.

Click the [Save] button in the top right-hand corner of the window. The
Customer is saved in the Customer register.

5.

The window title changes to ‘Customer: Inspect’, giving you a chance to
check you have not made any mistakes in entering the record.

6.

Close the record by clicking the close box or using the Ctrl-F4
(Windows) or -W (Macintosh) keyboard shortcut.

7.

If you have a number of Customers to enter, click [New] instead of
[Save] at step 4 above. The Customer is saved and closed, and a blank
window is opened, allowing you to enter another Customer straight
away.

It is a good idea to repeat the above process for a few Customers in order to
familiarise yourself both with the data entry process and with the Customer
entry screen. However, if you are changing to FirstOffice from another
computer program, it is likely that you will want to import your Customers
from a text file created by your old system. If you wish to do this, please
follow the import instructions described in the section ‘Setting up a Basic
Accounts System’ on page 48 in Chapter 1, ‘Introduction and Installation’, to
import your text file. This procedure, although described there as being used
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to import a Chart of Accounts, is in fact an all-encompassing import function
which will bring in whatever is in the selected text file and save it in the
appropriate place in FirstOffice. For details of the composition of the text
file, please refer to your FirstOffice representative.
Entering the First Item
FirstOffice keeps all information about Items and prices in an Item register,
with one record for each Item. The Item register contains basic data about all
products and services sold by your business.
To enter your first Item, click the [Items] button in the Master Control panel
to open the Item register. Then, follow the same basic process described
above on page 156, under ‘Entering the First Customer’.
For full details about each field in the ‘Item: New’ window, please refer to
the ‘Items’ section on page 294 in Chapter 6, ‘Base Registers’.
If you wish to import Items from your old accounts system, please follow the
import instructions described in the section ‘Setting up a Basic Accounts
System’ on page 48 of Chapter 1, ‘Introduction and Installation’, to import a
text file created by that system. For details of the composition of this text
file, please refer to your FirstOffice representative.
Entering Opening Balances
Unless you are starting a new business and intend to use FirstOffice to
administer your accounts from the first day, you will need to enter some
opening balances. If you are starting to use FirstOffice at the beginning of the
fiscal year, these opening balances will take the form of the closing balances
for each Account for the end of the previous year. If you are starting to use
FirstOffice in the middle of the fiscal year, there will be two components to
opening balance figures: the closing balances for each Account for the end of
the previous year and Account balances for the current year to date.
To carry out this task, you should equip yourself with as much information as
you can in the form of transaction data and reports produced by the old
system, in order to make this task as easy as possible.
We recommend that you change during a current financial year. You should
enter Account balances for the previous year and then enter individually all
current year transactions registered so far. This will a) make you familiar
with FirstOffice, and b) automatically give you a check of the old
transactions.
You should already have specified the current financial year and entered the
Chart of Accounts and VAT Codes you wish to use. Normally you will be
able to use the Chart of Accounts included in the program. If this is not
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suitable, you can import your own chart from a text file or enter it manually.
For more instructions about this process, please refer to the section entitled
‘Setting up a Basic Accounts System’ on page 48 in Chapter 1, ‘Introduction
and Installation’.
Once you have entered your Fiscal Year, Chart of Accounts and VAT Codes,
it’s a good idea to enter all the opening balances at once and, in any case, this
process should be completed before you start to enter new Transactions. Note
that it is possible to change the opening balances at any time during the
financial year.
When entering opening balances, the level of detail is up to you. Factors
influencing this decision may be the number of Transactions, the time
available to enter these Transactions, whether they can be imported
(otherwise, you will have to enter them manually) and the level of detail
required in your reports. It might be that you enter or import all Transactions
individually (in the form of Invoices, Receipts, Purchase Invoices, Payments
and Nominal Ledger Transactions) or it might be that you enter a single
opening balance for each Account. Full details covering the necessary data
entry processes follow in the next sections.
Once you have entered your opening balances in their chosen form, print the
reports you usually use and compare them with the reports from your old
system. These reports should include the Trial Balance, Profit & Loss and
Balance Sheet, and lists of Debtors and Creditors using the Sales and
Purchase Ledger reports respectively.
Opening Balances in the Sales Ledger
It is worth repeating that there can be two components to opening balance
figures in the Sales Ledger: the final Customer balances from the previous
fiscal year and, if you will be starting to use FirstOffice in the middle of a
fiscal year, Customer balances for the current year to date.
In considering Customer balances from the previous year, it is only necessary
to take account of those that are open (i.e. unpaid). These can be entered in
one of two ways—
•

as a single outstanding balance for each Customer; or

•

as separate outstanding Invoices per Customer.

In considering Customer balances for the current year to date, the following
options are available—
•

the minimum is to enter a balance for each Customer as a single figure
(in fact, you will need to enter an Invoice total and a Receipt total,
representing totals for the current fiscal year to date, enabling you to
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reconcile your bank account and to keep your Periodic Customer
Statement report accurate);
•

the opposite extreme is to enter all Invoices raised so far in the current
fiscal year, and all Receipts;

•

a compromise route to reduce the amount of work required is to enter
monthly Invoice and Receipt balances for each Customer;

•

a final option, available if you are changing to FirstOffice from an older
computerised system, is to import the current year’s Invoices and
Receipts from a text file. Please refer to your local FirstOffice
representative if you would like to consider this option.

In deciding which procedure to use, one factor to consider is credit control. If
you need to produce statements that show details of previous Invoices, it will
not be enough to simply enter a total balance for each Customer. Instead, you
will need to enter individual Invoices and Receipts. If, however, you do not
issue statements or it is acceptable for a single opening balance figure to
appear on your statements, entering a single opening balance figure per
Customer will be sufficient. If you do not issue Invoices or you do not give
credit (i.e. if your business is wholly cash-based), it may not be necessary to
enter any opening balances at all in the Sales Ledger.
If you need to enter opening balances in the Sales Ledger, you should first
ensure that all Customers have been entered using the process described in
the section entitled ‘Entering the First Customer’ above on page 156. If you
are entering individual Invoices, you should also ensure that all Items have
also been entered. Depending on your old system, you may be able to import
this information from text files. Finally, if you are entering Receipts in any
form (i.e. individual Receipts, or monthly or year-to-date Receipts) make
sure all relevant Payment Modes have been entered, so that the Receipt
amounts can be posted to the correct Bank or Cash Account. Payment Modes
are described below on page 161.

Sales Ledger Opening Balances and the Nominal Ledger
Enter Sales Ledger opening balances in the form of Invoices and Receipts.
When these are approved and saved, postings will be made to the Debtor,
Sales, VAT and Bank or Cash Accounts. This means that all Sales (and
Purchase) Ledger opening balances must be entered before the Nominal
Ledger opening balances, to prevent posting to these Accounts twice.
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Payment Modes
Before entering Sales Ledger opening balances, there is a single setting that
needs to be considered if you will be entering Receipts for the fiscal year to
date.
Click the [Settings] button in the Master Control panel and then double-click
‘Payment Modes’ in the ‘Settings’ list.

Payment Modes represent the different methods that your Customers will use
to pay your Invoices and that you will use to pay your Suppliers. Typical
examples are cash, cheque, direct debit and credit card. If necessary,
FirstOffice allows each Payment Mode to debit a different Account and to be
paid into a different bank account.
If you have used the accounts template supplied with FirstOffice, you will
find that the basic Payment Modes have already been entered. If you have
modified the Chart of Accounts supplied, or you have created your own,
ensure that the Account Code shown in the second column now refers to the
correct Account (remember, you can use ‘Paste Special’ if necessary).
To create a new Payment Mode, simply click in the first blank row and enter
a unique Code. Then enter the other details as appropriate, referring to page
238 in Chapter 5, ‘Settings’, if necessary. Click [Save] when you have
finished.
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Opening Balances
The process described below applies to the entering of opening balances both
from the previous fiscal year and for the current year to date.
You are now ready to enter the first Invoice. If you are entering a single
opening balance figure per Customer, either for the previous fiscal year or for
the current year to date, you will need to do this by entering it in an Invoice.
If so, omit step 6 in the following procedure. Do this—
1.

Click the [Invoices] button in the Master Control panel to open the
Invoice register.

2.

Click [New] in the Button Bar.

3.

In the ‘Invoice: New’ window three fields are already filled in: the
Invoice Number and the Invoice and Transaction Dates (which show the
current date taken from the system clock).
If you are entering a single opening balance figure for each Customer,
you might like to use a separate numbering sequence for opening
balances. Change the Invoice Number of the first opening balance
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Invoice: all subsequent Invoices will follow in that sequence. Then,
when entering the first ‘real’ Invoice, change its Number to switch to
another sequence. If you are entering individual Invoices, you will need
to use the Invoice Number and Date of the original Invoice.
4.

Place the insertion point in the Customer field and select ‘Paste Special’
from the Edit menu or use the shortcut (Ctrl-Return - Windows or Return - Macintosh). The ‘Paste Customer’ window appears, showing a
list of the Customers recorded in the Customer register. Select a
Customer by clicking on its row and press the Return key twice. The
first pressing causes the Customer Number to be transferred to the field
in the Invoice, and the second will move all information about the
Customer (Name, Address etc.) to the Invoice.

5.

Use the Return key to move the insertion point to the Date field. In the
case of Customer balances from the end of the previous fiscal year,
ensure that this is set to the last date of the previous fiscal year.

6.

If you are entering individual Invoices, move the insertion point to the
Item field and press Ctrl-Return or -Return again. Select the correct
Item from the list and press Return twice. The insertion point is moved
to the Qty field. Enter the number of items ordered, and press Return.
Check that the Unit Price is correct and repeat for each item on the
Invoice.

7.

If you are entering single opening balances, move the insertion point to
the Qty field and enter a quantity of 1. Press Return and enter the text
“Opening Balance” in the Description field. Enter an amount (excluding
VAT) in the Unit Price field.

8.

Until you are familiar with the Invoice screen, it is a good idea to check
that every field is correct. Clicking the named tabs marked ‘Terms’,
‘Items’ and ‘Address’ causes different information about the Invoice to
be shown. Pay particular attention to the VAT Code field: its default is
taken from the Item record or, if not specified there, from the Account
Usage S/L setting. It will be the latter in the case of single opening
balances, as then you are not referring to the Item register. Note too that,
in the case of single opening balances, these amounts will be posted to
the Sales Account specified in the Account Usage S/L setting.

9.

At the bottom of the Invoice the total is shown, together with the VAT
amount and the total payable amount.
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10. Click [Save] to save the Invoice.
The window title changes to ‘Invoice: Inspect’. You can now correct any
mistakes before you click the OK check box. With the OK box checked,
clicking the [Save] button in the Button Bar approves the Invoice and
commits it to your Sales Ledger. After this you may not change the
individual fields. Invoices must be approved before Receipts can be
allocated to them and to appear in the Periodic Customer Statement.
11. Finish with [New] if you wish to enter another Invoice. Or, if you are
entering all Invoices for the current fiscal year, click [Duplicate]. This
will create a new Invoice which will be a copy of the one just saved.
This will save you having to enter Customer details, etc, again if they are
the same.
12. Finish with [Save] when you have entered the last Invoice, and close the
window by clicking the close box.

Entering Receipts
As with entering Invoices, you can get a lot of help with entering your
Receipts using FirstOffice’s built-in shortcuts. Perhaps the most useful tool is
the ‘Paste Special’ command. ‘Paste Special’ can be used whenever you
enter data in a field that refers to a register or setting in FirstOffice.
There is no need to enter any Receipts from the previous fiscal year, because
you should only have entered outstanding Invoices from that year. You
should only follow the steps described below for Receipts from the current
year to date, and thus they are only applicable if you are starting to use
FirstOffice in the middle of a fiscal year.
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1.

Open the ‘Receipts: Browse’ window by clicking the [Receipts] button
in the Master Control panel.

2.

Click [New] or use the keyboard shortcut Ctrl-N (Windows) or -N
(Macintosh).

3.

The ‘Receipt: New’ window is shown. You can use a single window to
enter all your Receipts from the earlier part of the year, providing that
they use the same Payment Mode (i.e. post to the same Bank or Cash
Account).
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4.

Enter the data in the top of the window. Select a Payment Mode using
‘Paste Special’ to open the list of Payment Modes you created earlier.
Make sure the Transaction Date is correct.

5.

For each Receipt, enter the Invoice Number in the first column (or use
‘Paste Special’ to choose from the unpaid Invoices) and press the Return
key.

6.

If you have an Invoice that is part-paid, alter the Received Value field to
show the amount paid.

7.

When you have entered every receipt, you should manually check what
you have entered. If you find any errors you can change them as needed.
When you are satisfied, click the OK check box.

8.

If you select [New] again, or click [Save], the Receipt is approved and
after this may not deleted or changed.
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Opening Balances in the Purchase Ledger
When entering opening balances in the Purchase Ledger, you should follow
the same basic decisions and procedures described in the Sales Ledger
section above on page 159, using the Purchase Invoice and Payment
registers.
Opening Balances in the Nominal Ledger
The task of entering Nominal Ledger opening balances has two stages. First,
it is recommended that you enter balances for each Account as they stood at
the end of the previous fiscal year. Use the Balances Brought Forward setting
for this task. This information should be available on the Trial Balance report
obtained from your old system. The second stage, applicable only if you are
changing to FirstOffice in the middle of a financial year, is to enter the
Transactions for the current year to date, using the Transaction register.
In considering Account balances for the current year to date, the following
options are available—
1.

the minimum is to enter a balance for each Account as a single figure;

2.

the opposite extreme is individually to enter all Transactions raised so far
in the current fiscal year;

3.

a compromise route to reduce the amount of work required is to enter
monthly Account balances;

4.

a final option, available if you are changing to FirstOffice from an older
computerised system, is to import the current year’s Invoices and
Receipts from a text file. Please refer to your local FirstOffice
representative if you would like to consider this option.

If you decide to use option 1 or 3, you should copy the Account balances
from Trial Balance reports printed from your old system.
The following section assumes you have already defined a Chart of Accounts
and a set of VAT Codes.
If you need to enter Sales and Purchase Ledger opening balances, this must
be done (as described in the previous sections of this chapter starting on page
159) before entering Nominal Ledger opening balances. If you are not
entering Sales and Purchase Ledger opening balances, follow the sequence
below from step 3 onwards.
Once this has been done, follow these steps—
1.
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Print out a Trial Balance report for the previous year. Please turn to page
171 below for details about printing a Trial Balance report.
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2.

You will probably find that the only Accounts showing balances are the
Debtor, Creditor, Sales, Purchase and Bank and Cash Accounts.
Compare these figures with those on the Trail Balance for the
corresponding period produced from your old system. It is likely that the
balances for the Debtor, Creditor, Sales and Purchase Accounts will
match, and the Bank and Cash Accounts probably will not match. When
entering opening balances, values should not be entered for these
Accounts unless there is a difference between the two Trial Balance
reports. If so, only figures representing that difference should be entered.
This will ensure that a Trial Balance printed after the General Ledger
opening balances have been entered will exactly match that produced
from the old system.

!

Take great care when entering
opening balances to the Debtor,
Creditor, Sales, Purchase and Bank
and Cash Accounts. Avoid posting
the same amount twice (from the
Sales or Purchase Ledger and from
the Nominal Ledger). This will
immediately render your accounts
inaccurate.

3.

You are now ready to enter Account balances as they stood at the end of
the previous financial year to the Nominal Ledger. Click the [Settings]
button in the Master Control panel.

4.

Double-click ‘Brought Forward Balances’ in the ‘Settings’ list.

5.

Click [New] on the Button Bar.

6.

Enter the information as shown in the following illustration. Full details
of the fields are to be found in the section on page 206 in Chapter 5,
‘Settings’, covering the Brought Forward Balances setting. It is
recommended that you choose a Transaction Date that is at the end of
the previous fiscal year and that is, in any case, prior to the date when
you will be starting work with FirstOffice.
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7.

The Brought Forward Balances screen does not have an OK check box,
so Account Balances are updated as soon as the Balances are saved.
Therefore, before clicking [Save], make sure that no mistakes have been
made. One check is that the Debit and Credit totals are the same. If you
discover a mistake at a later date, you will be able to correct the record
without difficulty.

8.

Finish with [New] (or use the Ctrl-N/-N keyboard shortcut) if you
wish to enter more Balances.

9.

Finish with [Save] when you have entered the last Balance. Then, close
the record using the close box.

10. Close the ‘Brought Forward Balances: Browse’ window and then the
‘Settings’ list, in both cases by using the close box.
11. Once you have entered all opening balances, print out a Trial Balance for
the previous year and compare it with that obtained from your old
system. Any discrepancies should be investigated immediately: any
delay will make this more difficult.
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If you are starting to use FirstOffice in the middle of a financial year, you
should now enter the current year’s Transactions.
As discussed earlier in this section, these can be entered as individual
Transactions or Account balances. If you choose the former, enter the
Transactions from the original documentation, and do not copy them from
Transaction Journal reports produced from your old system. This will ensure
that you do not enter any Transactions that relate to the Sales or Purchase
Ledgers. If you choose the latter and you need to enter Sales and Purchase
Ledger opening balances, these must be entered first (as described in the
previous sections of this chapter starting on page 159).
Once this has been done, follow these steps. Again, if you are not entering
Sales and Purchase Ledger opening balances, or if you are entering
individual Transactions, follow the sequence from step iii onwards—
i.

Print out a Trial Balance report for the current year to date. Please turn to
the section below on page 171 for details about printing a Trial Balance
report.

ii. Again, as described in step 2 above, compare this report with the Trial
Balance for the corresponding period produced from your old system.
Where an Account has a balance, the figure entered should be the
difference between the old Trial Balance amounts and the new Trial
Balance amounts.
iii. Click the [Transactions] button in the Master Control panel.
iv. Click [New] on the Button Bar.
v.

Enter the information as shown in the following illustration. Full details
of the fields are to be found on page 358 in Chapter 7, ‘Transaction
Registers’. Ensure you use the same Transaction Date that was used
when entering the Transaction to your previous system. If you are
entering a single balance figure for each Account, the date should be the
last date of use of your previous system.
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vi. The Transaction screen does not have an OK check box, so Account
Balances are updated as soon as the Transaction is saved. Therefore,
before clicking [Save], make sure that no mistakes have been made. One
check is that the Debit and Credit totals are the same.
vii. Finish with [New] (or use the Ctrl-N/-N keyboard shortcut) if you
wish to enter more Transactions.
You can use another feature when you need to enter several Transactions
quickly in one sitting and don’t want to interrupt your typing by reaching
for the mouse. Enter the debits in a Transaction first and then, with the
cursor in the Credit field in the final credit row, press the Return or Enter
key twice. The first pressing causes FirstOffice to enter the correct credit
amount to balance the entry for you. The second saves, closes and
commits the Transaction to the Nominal Ledger and opens a new,
empty, Transaction.
viii. Finish with [Save] when you have entered the last Transaction. Then,
close the record using the close box.
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ix. Close the ‘Transactions: Browse‘ window and then the ‘Settings’ list, in
both cases by using the close box.
x.

Once you have entered all Balances and Transactions, print out a Trial
Balance and compare it with that obtained from your old system. Any
discrepancies should be investigated immediately: any delay will make
this more difficult.

Importing Opening Balances
If you are changing to FirstOffice from another computer program, it is likely
that you will want to import opening balances for all three ledgers from text
files created by your old system. If you wish to do this, please follow the
import instructions described in the section ‘Setting up a Basic Accounts
System’ on page 48 in Chapter 1, ‘Introduction and Installation’, to import
your text file. This procedure, although described there as one used to import
a Chart of Accounts, is in fact an all-encompassing import function which
will bring in whatever is in the selected text file and save it in the appropriate
place in FirstOffice. For details of the composition of the text files, please
refer to your FirstOffice representative. Ensure that they contain opening
balances as they were at the beginning of the fiscal year and all subsequent
transactions as described in the previous sections.
Printing Reports
FirstOffice can produce many different reports. A detailed description of
these will be found in Chapter 10, ‘Reports’. You should, however, always
print a Transaction Journal for the Transactions entered during one work
session. The same goes for the Journals report, which produces lists of
Invoices, Receipts, Purchase Invoices and Payments entered during the work
session.
Having completed the process of entering your opening balances, you should
now print a Trial Balance and compare it with a Trial Balance produced from
your old system.
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To print a Trial Balance, follow these steps—
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1.

Click the [Reports] button in the Master Control panel.

2.

The ‘Reports’ list opens, showing the reports available in FirstOffice—

3.

Scroll down to find ‘Trial Balance’ and highlight it by clicking, or press
the “T” key twice and then press the Return or Enter key. The ‘Specify
Trial Balance’ window appears.

4.

In the ‘Specify Trial Balance’ window, enter the range of transactions
you wish to print. To report on your opening balances, you should enter
a period from the beginning of the current fiscal year to the current date.
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Separate the start and end dates of this period using a colon (:), as shown
in the illustration. You can leave all the other fields blank, ensuring that
all Accounts etc will be included in the report.
5.

Use the Media options at the bottom of the window to choose a print
destination (for example, ‘Printer’ or ‘Screen’), and click the [Run]
button to produce the report.

6.

If you printed to screen and now wish to print on a printer, simply click
the Printer icon in the Button Bar of the report window.

173

HansaWorld
FirstOffice
Start
Settings

HansaWorld FirstOffice Start

Chapter 5: Settings
Settings allow you to tailor FirstOffice’s operation to your requirements.
Many settings take the form of preferences: examples include Account Usage
S/L and Account Usage P/L, which you can use to inform FirstOffice which
Account is to be used in a particular situation (e.g. the Debtor and Creditor
Accounts). Other settings require a number of records to be entered: this
information tends to be used in ‘look-up’ tables (i.e. ‘Paste Special’
windows) from the main registers.
To edit or add to a setting, elect ‘Settings’ from the File menu or click the
[Settings] button in the Master Control panel. You can also use the keyboard
shortcut Ctrl-S (Windows) or -S (Macintosh).
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The ‘Settings’ list window opens, showing the various settings or preferences
available in FirstOffice—

Double-click any of the items in the list to view, change or add to any of the
settings.
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Types of Setting
The settings in FirstOffice can be divided into three groups—
1.

Settings of this type take the form of a single screen where you can set
preferences to determine exactly how FirstOffice is to operate in a
certain situation. Examples of such settings include Account Usage S/L
and P/L, Company Info and Locking.

When you open one of these settings from the ‘Settings’ list, you can
change any of the fields as required. To save changes and close the
window, click the [Save] button. To close the window without saving
changes, click the close box.
2.
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Settings of the second type contain a number of records that are
displayed in a grid. When working in one of the main registers, you may
have to refer to a particular record in a setting of this type: the ‘Paste
Special’ look-up function is provided to make this task as easy as
possible. Examples of such settings include Payment Modes and VAT
Codes.
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When you open one of these settings from the ‘Settings’ list, you can
change any of the fields in the existing records as required. To add new
records to the list, click in any field in the first blank row and enter
appropriate text. To remove a record, click on the row number on the left
of the row containing the record and press the Backspace key. To insert a
row, click on the row number where the insertion is to be made and press
Return. To save changes to all records in the grid and close the window,
click the [Save] button. To close the window without saving changes,
click the close box.
3.

Settings of the final type also contain a number of records, but behave in
a similar manner to the main registers in that their contents are displayed
in a browse window and have to be opened in a record window for
editing. Again, when working in one of the main registers, you may have
to refer to a particular record in a setting of this type using the ‘Paste
Special’ look-up function. Examples of such settings include
Autotransactions, Forms and Persons.
When you open one of these settings from the ‘Settings’ list, the browse
window is displayed, listing the records already entered.
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Double-click an item in the list to edit it, or add a new record by clicking
the [New] button in the Button Bar. Alternatively, highlight a record
similar to the one you want to enter and click [Duplicate] on the Button
Bar. A record window is then opened, allowing you to change the
existing record or enter the new one.

To save changes, click the [Save] button. To close the window without
saving changes, click the close box. The browse window can also be
closed using the close box.
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Account Usage P/L
In this setting you will determine which Accounts are to be used as defaults
by your Purchase Ledger transactions (i.e. Purchase Invoices and Payments).
These defaults will be used in the absence of Accounts or VAT Codes being
specified elsewhere (for example, for the Items or Suppliers used in the
transactions). A complete description of how FirstOffice selects these
defaults can be found on page 136 in Chapter 3, ‘Accounting Principles’.
Account numbers used here must be defined in the Accounts setting,
otherwise FirstOffice will not be able to create transactions.
If you have imported the sample Chart of Accounts supplied with FirstOffice,
you will find that most of the fields in the Account Usage P/L setting contain
suggested values. If you have modified this Chart of Accounts or have used
your own, you must ensure that these values are replaced with the correct
Accounts.
To open this setting, click [Settings] in the Master Control panel or select
‘Settings’ from the File menu, and then double-click ‘Account Usage P/L’ in
the ‘Settings’ list. Fill in the fields as described below. Then, to save changes
and close the window, click the [Save] button. To close the window without
saving changes, click the close box.

Creditors

Paste Special

Accounts setting

When you approve a Purchase Invoice is approved (i.e.
post it to the Nominal Ledger), its value including VAT
will be credited to a Creditor Account. When you enter a
Payment, its value will be debited to the same Account.
This Account therefore shows how much your company
owes at a particular time.
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Enter here the Account Code of the Account that you
wish to be used as your Creditor Account. It will be
overridden if a separate such Account has been specified
for the Supplier or its Supplier Category.
Bank Fee

Paste Special

Accounts setting

Enter here the Account Code of the Account to be
debited by any bank changes you may incur when
issuing Payments.
Cash

Paste Special

Accounts setting

The Account entered here will be credited instead of the
Creditor Account whenever you approve a cash purchase
(Cash Note). Please refer to the section below on page
241 describing the Payment Terms setting for details of
Cash Notes.
The Account specified here will be overridden if a
separate such Account has been specified for the
Payment Term used in the Cash Note.
On Account A/C

Paste Special

Accounts setting

You can issue a Payment to a particular Supplier without
reference to a specific Invoice (an “On Account”
Payment). You may want to use a special account for
such Payments. Specify that Account here, and switch
on the On Account check box on the ‘Terms’ card of the
Customer record for the Supplier in question. When you
enter and approve an On Account Payment, its value will
be debited to this Account.
Dom. VAT Code, EU VAT Code, Export VAT Code
Paste Special

VAT Codes setting

VAT Codes determine the VAT Account that will be
used when a Purchase Invoice is posted to the Nominal
Ledger and the rate at which VAT will be charged. VAT
Code records are set up using the VAT Codes setting.
You can specify a separate VAT Code for each Account.
Enter here the VAT Code that you wish to be used as a
default, to be used whenever an Account that does not
have its own VAT Code is used in a Purchase Invoice.
Normally, if most of your company’s Suppliers are
registered for VAT, this will be the VAT Code
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representing the standard rate. Otherwise, it will be a
zero rate VAT Code.
You should define three default VAT Codes: which one
will be used in a particular Purchase Invoice will depend
on the Zone of the Suppler concerned (set on the
‘Account’ card of the Customer record for the Supplier).
Post Payment VAT
This option allows you to post VAT from Payments and
On Account Payments. An On Account Payment is a
Payment with no Purchase Invoice Number. This is a
requirement in Latvia and for users of the Cash VAT
scheme in the UK. If you need to use this option, you
should enter I/P Accounts for all your VAT Codes (in
the VAT Codes setting).
UK Cash VAT users only should also switch on the Post
Receipt VAT option in the Account Usage S/L setting
and specify O/P Accounts for all VAT Codes. The Cash
VAT scheme is described in the section describing the
VAT Codes setting below on page 261.
Users in Poland can also use this option and the Post
Receipt VAT option in the Sales Ledger.
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Account Usage S/L
In this setting you will determine the default Accounts and VAT Codes for
use by your Sales Ledger transactions (i.e. Invoices and Receipts). These
defaults will be used in the absence of Accounts or VAT Codes being
specified elsewhere (for example, for the Items or Customers used in the
transactions). A complete description of how FirstOffice selects these
defaults can be found on page 132 in Chapter 3, ‘Accounting Principles’.
If you have imported the sample Chart of Accounts supplied with FirstOffice,
you will find that most of the fields in the Account Usage S/L setting contain
suggested values. If you have modified this Chart of Accounts or have used
your own, you must ensure that these values are replaced with the correct
Accounts.

!

The Account numbers in this setting
must also be in the Chart of
Accounts. Otherwise, FirstOffice will
not verify and accept the transactions
controlled by this setting. You must
either add the Accounts to the Chart
of Accounts (i.e. the Accounts
setting), or change the Account
numbers in this setting to Accounts
that do exist in the Chart of Accounts.

To open this setting, click [Settings] in the Master Control panel or select
‘Settings’ from the File menu, and then double-click ‘Account Usage S/L’ in
the ‘Settings’ list. Fill in the fields as described below. Then, to save changes
and close the window, click the [Save] button. To close the window without
saving changes, click the close box.
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Debtors

Paste Special

Accounts setting

When you approve an Invoice (i.e. post it to the Nominal
Ledger), its value including VAT will be debited to a
Debtor Account. When you enter a Receipt, its value
will be credited to the same Account. This Account
therefore shows how much your company is owed at a
particular time.
Enter here the Account Code of the Account that you
wish to be used as your Debtor Account.
Round Off

Paste Special

Accounts setting

The total and VAT amounts of each Invoice will be
rounded off according to rules set in the Round Off
setting. Whenever you approve an Invoice, any amount
lost or gained by this rounding process will be posted to
the Account whose Code has been entered here.
This Account can only be defined in the Account Usage
S/L setting and is therefore used in Transactions
generated from Purchase Invoices as well.
Write Off

Paste Special

Accounts setting

The Account specified here will be debited by bad debts
written off by the ‘New Write-off’ Operations menu
function on the Receipt screen.
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Base Currency Round Off
Paste Special

Accounts setting

This Account is not used in FirstOffice, but you must
specify a valid Account before you can save the Account
Usage S/L setting.
On Account A/C

Paste Special

Accounts setting

If you receive On Account Receipts from a particular
Customer without reference to a specific Invoice
(usually before you have raised the Invoice), you may
want to use a special Account for such Receipts. Specify
that Account here, and switch on the On Account check
box on the ‘Terms’ card of the Customer in question.
When you enter and approve an On Account Receipt, its
value will be credited to this Account.
Bank Fee

Paste Special

Accounts setting

Enter here the Account Code of the Account to be
credited by any bank charges that you may incur when
banking Receipts.
Dom. Sales A/C, EU Sales A/C, Export Sales A/C
Paste Special

Accounts setting

When an Invoice is approved, the values excluding VAT
of the Items are individually credited to a Sales Account.
It can be useful to maintain more than one Sales Account
to keep a record of the sales of different types of
product. For this reason, you can specify a separate Sales
Account for each Item. Enter here the Account Code of
the Account that you wish to be used as your default
Sales Account, to be credited whenever you sell an Item
that does not have its own Sales Account (and if you use
a Price that does not have a Sales Account).
You should define three default Sales Accounts should
be set: which one will be used in a particular Invoice will
depend on the Zone of the Customer concerned (set on
the ‘Account’ card of the Customer record). If you leave
the EU and Export Sales Accounts empty, the Domestic
Sales Account will be used for all sales, irrespective of
Zone.
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Cash

Paste Special

Accounts setting

The Account entered here will be debited instead of the
Debtor Account whenever you approve a cash sale (Cash
Note). Please refer to the section below on page 241
describing the Payment Terms setting for details of Cash
Notes.
The Account specified here will be overridden if a
separate such Account has been specified for the
Payment Term used in the Cash Note.
Dom. VAT Code, EU VAT Code, Export VAT Code
Paste Special

VAT Codes setting

VAT Codes determine the VAT Account that will be
used when an Invoice is posted to the Nominal Ledger
and the rate at which VAT will be charged. VAT Code
records are set up using the VAT Codes setting.
You can specify a separate VAT Code for each Item.
Enter here the VAT Code that you wish to be used as a
default, to be used whenever you sell an Item that does
not have its own VAT Code. Normally, if your company
is registered for VAT, this will be the VAT Code
representing the standard rate. Otherwise, it will be a
zero rate VAT Code.
You should define three default VAT Codes: which one
will be used in a particular Invoice will depend on the
Zone of the Customer concerned (set on the ‘Account’
card of the Customer record).
Note that, for Customers in the “Inside EU” and
“Outside EU” Zones, VAT will not be charged on any
Invoices raised, irrespective of the VAT Code specified
here. If you want to charge VAT to such Customers,
place them in the Inside EU (Post VAT)” and “Outside
EU (Post VAT)” Zones.
Post Receipt VAT
This option allows you to account for VAT based on
Receipts (rather than Invoices) and On Account
Receipts. An On Account Receipt is a Receipt with no
Invoice Number. If you need to use this option, you
should enter O/P Accounts for all your VAT Codes (in
the VAT Codes setting).
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The accounting of VAT based on Receipts is a
requirement in the UK for users of the Cash VAT
scheme. If you are using the UK Cash VAT scheme, you
should also ensure the equivalent option in the Account
Usage P/L setting is switched on. The Cash VAT
scheme is described in the section describing the VAT
Codes setting below on page 261. Users in Poland can
also use this option and the Post Payment VAT option in
the Purchase Ledger.
Users in Latvia should leave this option switched off but
should turn on the Post Payment VAT option in the
Account Usage P/L setting.
This option cannot be used in Russia.
Base Price
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Accounts
This is where you define the Chart of Accounts. Each Account has a number
and a name, and belongs to a class of Accounts.
FirstOffice does not have any hard-coded Accounts. You must define a Chart
of Accounts, or import an existing one. The simplest method is to use the
standard Chart of Accounts supplied with FirstOffice. Please refer to the
section entitled ‘Setting up a Basic Accounts System’ on page 48 in the first
chapter of this manual for details of how to do this.

!

If you use your own Chart of
Accounts, or modify the one supplied
with FirstOffice, it is important to
ensure that every Account used in the
settings and report definitions is a
valid Account that exists in your
Chart of Accounts.

In FirstOffice you always have access to the Chart of Accounts through the
‘Paste Special’ feature, for example when you enter Transactions and cannot
remember an Account Number.
In the Accounts setting you can—
•

Show all Accounts on screen

•

Search for a certain Account

•

Inspect or change a certain Account

•

Create new Accounts

•

Remove Accounts you don’t need

•

Print the Chart of Accounts.

Showing all Accounts on screen
To open the Accounts setting, double-click ‘Accounts’ in the ‘Settings’ list.
The ‘Accounts: Browse’ window is opened, showing Accounts that have
already been entered.
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The list contains two columns: Account Number and Account Name. The list
is sorted by the column whose heading is coloured blue. Click on the other
column heading if you want to change the sort order, and double-click on the
column heading to reverse the sort order.

Searching for an Account
In the ‘Accounts: Browse’ window shown above, you can scroll up and down
through the list of Accounts as usual. You can also search for a particular
Account by entering the first few characters of its Number or Name in the
Search field in the top right-hand corner of the window. Enter a Name if the
list is sorted by Name, a Number otherwise. FirstOffice will find the first
record that matches the text you have entered.
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Inspecting or Changing an Account
If you want to look at the details of an Account, double-click its name in the
‘Accounts: Browse’ window to open the Account record.

The ‘Account: Inspect’ window contains the following information—
Account

The unique number of the Account. You can use up to
ten characters, with a minimum of two.
Once you have saved the record, you cannot change the
Account Number simply by typing into the field. If you
need to change an Account Number, use the Conversions
- Master and Conversions - Accounts settings, described
below on page 213. These settings will change the
Account Number both here and in all other registers
where the Account has been used.

Name

The name or description of the Account.

Auto. Trans.

Paste Special

Autotransactions setting

You can link an Autotransaction with a particular
Account by entering the code of the Autotransaction in
this field. When you enter the Account number in a
Transaction record, the Autotransaction will be entered
on the following rows automatically.
VAT Code

Paste Special

VAT Codes setting

You can assign a VAT Code to each Account. It will be
used automatically every time you use the Account in a
Purchase Invoice or Nominal Ledger Transaction.
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Account Type

An Account can belong to one of five types: Assets,
Liabilities, Equity, Revenues or Expenses. This
information is used to control how the balance of this
Account will be stored, as a negative or a positive figure.
Assets and costs are treated as positive values, while
accounts for liabilities, equity, and incomes are treated
as negative.

Normal Amount

Click one or both of the check boxes to indicate what
type of posting is the usual for the Account. If you use
this option, and try to debit an Account usually used for
credit or vice versa, FirstOffice will alert you to the
possible error.

Closed

Check this box if you want to close the Account for
further Transactions. You will no longer be able to use
it, and it will not appear in the ‘Paste Special’ selection
window. If you want to open the Account again later,
you simply click in the box again to remove the check
mark.

Entering an Account
There are two ways to add new Accounts to the Chart of Accounts: creating a
new Account or copying and then editing an existing one.
In the ‘Accounts: Browse’ window, click [New] in the Button Bar, or
highlight the Account to be copied and click [Duplicate] in the Button Bar.
The ‘Account: New’ window appears. This is as described in the previous
section.
Enter the new information or change the copied record as appropriate. Click
[Save] to save the new record or [Cancel] to close without saving the record.

Deleting Accounts
You can delete an Account from the Chart of Accounts, as long as it has not
been used in any Transactions.
In the ‘Accounts: Browse’ window, double-click the Account you want to
delete. This opens the ‘Account: Inspect’ window.
Select ‘Delete’ from the Record menu. The Account is deleted and the
previous Account in the list is shown.
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!

You cannot undo the deletion of an
Account. Used Accounts cannot be
deleted.

Printing the Chart of Accounts
The Chart of Accounts can be printed using the ‘System Documentation’
report, fully described on page 460 in Chapter 10, ‘Reports’.
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Activity Classes
Activity Classes are broad classifications of the various tasks recorded in the
Activity register. Each time you enter an Activity, you should give it an
Activity Type, which should represent a specific job or task (e.g. sales call,
sales appointment or internal meeting). In turn, you can group Activity Types
of a broadly similar nature (e.g. all those to do with sales, or all those to do
with administration) together by assigning each one to the same Activity
Class.

When you double-click ‘Activity Classes’ in the ‘Settings’ list, the ‘Activity
Classes: Browse’ window opens, listing the available Activity Classes: to
enter a new item, click the [New] button in the Button Bar. The ‘Activity
Class: New’ window appears: enter the details as appropriate and click [Save]
to save the new record.
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Code

This is the unique code that identifies this particular
Activity Class. It can consist of up to five alphanumeric
characters.

Calendar Colour Paste Special

Choices of possible entries

All Activities with Activity Types belonging to the same
Activity Class will appear in the same colour in the
Calendar. Choose that colour using this field.
Comment

Assign a descriptive name to the Activity Class. This is
shown in the ‘Activity Classes: Browse’ window and the
‘Paste Special’ list.

Force Entry of
Check one or both of these boxes if you would like it to
be compulsory for a Customer and or Cost (Time) to be
entered to all Activities with Activity Types belonging to
this Activity Class.
Calendar Type

Use these options to control how Activities with Activity
Types belonging to this Activity Class are shown in the
Calendar. Please refer to the section below on page 389
describing the ‘Time’ card of the Activity screen for
details of each option.

Do not allow Activities in the same Time Range
Use this option if you want to prevent double-booking in
the Calendar. You must also use the Force Entry of Time
option above.
The double-booking check will be made whenever you
enter a Time Activity with an Activity Type belonging to
this Activity Class. You will not be able to save the
Activity if it clashes with an existing Time Activity with
any Activity Type (i.e. not necessarily one belonging to
this Class) and with the same Person.
For example, you have recorded a Time Activity that
starts at 09:00 and ends at 12:00. You will not be able to
save a second Activity if its Start and/or End Time are
between these times. The End Time of the earlier
Activity and the Start Time of the later one can be the
same, so in this example the second Activity can begin at
12:00 (but not 11:59:59).

195

HansaWorld FirstOffice Start

Activity Types
Use Activity Types to classify Activities. Each Activity Type should
represent a specific job or task (e.g. sales call, sales appointment or internal
meeting). You should give every the same Activity Type to every Activity
recording the same task.
You should try to keep the number of Activity Types as small as possible,
while taking great care to make them mutually exclusive. You can group
Activity Types of a broadly similar nature (e.g. all those to do with sales, or
all those to do with administration) can be grouped together by assigning
each one to the same Activity Class (described above on page 194).

On double-clicking ‘Activity Types’ in the ‘Settings’ list, the ‘Activity
Types: Browse’ window opens, listing the available Activity Types: to enter
a new item, click the [New] button in the Button Bar. The ‘Activity Type:
New’ window appears: enter the details as appropriate and click [Save] to
save the new record.

Code
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It is recommended that the Codes of all Activity Types
of the same Class begin with the same character, so that
they appear together in the ‘Paste Special’ list, making
selection of the correct one easy.
Class

Paste Special

Activity Classes setting

You can group Activity Types of a broadly similar
nature (e.g. all those to do with sales, or all those to do
with administration) together by assigning each one to
the same Activity Class (described above on page 194).
All Activities with Activity Types belonging to the same
Activity Class will appear in the same colour in the
Calendar. You can also force a Customer and/or Cost
(Time) to be entered for Activities of the same Class.
Comment

Assign a descriptive name to the Activity Type. This is
shown in the ‘Activity Types: Browse’ window and the
‘Paste Special’ list: it should therefore be descriptive
enough to make the selection of the correct Activity
Type easy for all users.
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Autotransactions
Autotransactions are templates for accounting, which you can use to simplify
the entering of Nominal, Sales and Purchase Ledger Transactions.
When a certain type of Transaction occurs repeatedly, you can create a
template in which you put all the recurring data once and for all, e.g. a certain
combination of Account numbers. Next time you wish to enter this type of
Transaction, you can select the automatic function instead. This will create a
ready-made Transaction, except for the data that is unique for this particular
entry. Examples might include overhead allocations and recurring journals.
Autotransactions can thus save labour and ensure that the correct Accounts
are used every time.

Creating a new Autotransaction
Open the ‘Settings’ list by clicking the [Settings] button in the Master
Control panel or by selecting ‘Settings’ from the File menu. Then, doubleclick ‘Autotransactions’ in the ‘Settings’ list. A list of existing
Autotransactions appears. Click [New] in the Button Bar to enter a new
record. When the Autotransaction has been entered, save it using the [Save]
button and close the window by clicking the close box. Then, close the
browse window using the close box again.
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Code

This is the code that identifies this particular template.
The code can consist of up to six alphanumeric
characters. Each template must have a unique code, and
you should use codes that do not duplicate Account
numbers.
When entering Nominal Ledger Transactions, specify
this code instead of an Account to signify that this
Autotransaction is to be used.

Name

Assign a descriptive name to the template, e.g. “Sales
VAT included”. The name is then shown in the
‘Autotransactions: Browse’ window.

Account

Paste Special

Accounts setting

Enter the Account numbers for the template, one per
row.
You can enter the hash sign (#) to this field, to signify
that the Account number, Description and amount are to
be copied from the preceding line of the Transaction
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when you use the template. # is obtained using Alt-3 on
a UK Macintosh keyboard.
You can enter the exclamation mark (!) to this field, to
signify that the previous line of the Transaction is to be
overwritten by the result of the Autotransaction. See the
following example for a detailed description of how this
works.
You can link an Autotransaction with a particular
Account number. Enter the code of the Autotransaction
in the Auto. Trans. field of the Account record (in the
Accounts setting). When you enter the Account number
in a Transaction record, the Autotransaction will be
entered on the following rows automatically.
Description

Enter text to describe each Transaction here. You can
also enter a # sign to copy text from the preceding line of
the Transaction.

Debit, Credit

You can either enter a fixed amount here (e.g. a salary or
a rent), or a formula for a calculation. You can enter a
percentage as a number followed by a % sign. The
Autotransaction will then apply the specified percentage
to the amount on the preceding line of the Transaction. If
you enter a number followed by two % signs (e.g.
30%%), the result of the percentage calculation will be
rounded to the nearest whole number.
If you enter the amount or percentage in the Debit field,
the calculated amount will be entered in the same
column as the original amount. If you enter it in the
Credit field, the calculated amount will be entered in the
opposite column.
You can balance all the preceding lines of the
Transaction by entering an equal sign (=) in the Debit or
Credit field.

V-Cd

Paste Special

VAT Codes setting

Enter any VAT Code to be entered to the Transaction
row. This can be used to control the definition of reports.
The following example shows a template that distributes an amount across
four Accounts on a percentage basis after you have entered that amount in a
Transaction. You might use such a template to allocate shares of overhead
costs to Accounts representing four departments.

200

Chapter 5: Settings - Autotransactions

The first row contains an exclamation mark in the Account field and a
percentage in the Debit field. The exclamation mark indicates that when the
Autotransaction is specified in a Transaction, the amount of the previous row
of the Transaction is to be overwritten by a figure determined by the
application of the Autotransaction (in this case, by a percentage of the
original figure). That figure will be on the same side (debit or credit) as the
original, as the percentage has been entered to the Debit field of the
Autotransaction. In other words, the original figure entered will be reduced
by 90%. The # sign in the Description field signifies that the original
Description will be retained.
The second line of the Autotransaction will again refer to the original figure
and calculate a percentage from it, on the same side (debit or credit) as the
original, using a new line in the Transaction. This figure will be posted to
Account 431. The third and fourth lines of the Autotransaction will have a
similar effect, creating new lines in the Transaction with different
percentages of the original figure, posting to Accounts 432 and 433
respectively.
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The fifth line calculates VAT from the original figure at the standard rate of
17.5% and places it in a new row in the Transaction, posting to the VAT
Inputs Receivable Account on the same side (debit or credit) as the original
figure.
The final line of the Autotransaction contains an Account number and an
equal sign (=) in the Credit field. This signifies that the sum of the previous
lines of the Transaction is to be posted to that Account. The posting will be
on the opposite side (debit or credit) to the original figure, since the equal
sign is in the Credit field.
When you enter a Transaction, begin by entering the Account code for the
relevant expense category, and the amount excluding VAT. On the second
row, enter the code of the Autotransaction in the Account field.
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Press Return. The Autotransaction is entered by FirstOffice, and the amounts
are recalculated as follows—

The example Autotransaction is designed to be used from the Nominal
Ledger and is therefore double-sided to produce a balancing Transaction.
It may be that you will enter many overhead costs will be entered in the
Purchase Invoice register from the Suppliers’ Purchase Invoices. You can
enter Autotransaction Codes to the Account field of a Purchase Invoice row
in the same way as illustrated above for Transactions, so in our example
Purchase Invoices can also be distributed across departments. However, the
Autotransaction that you use in this situation should be single-sided: it should
not have the final balancing line posting to the Bank Account. When you post
the Purchase Invoice to the Nominal Ledger, a balancing posting to a
Creditor Account will be made automatically as normal. Payment will reach
the Bank Account when the Purchase Invoice is paid. In addition, any
Autotransaction used in the Purchase Ledger will not need to calculate VAT
because that will be handled by the VAT Code.
You can also enter single-sided Autotransactions in the Account field in a
Sales Invoice row.
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Creating a new Autotransaction from an existing one
1.

Open the ‘Settings’ list and double-click ‘Autotransactions’.
The ‘Autotransactions: Browse’ window opens, listing existing records.

2.

Click the Autotransaction you want to copy, and click [Duplicate] in the
Button Bar. Alternatively, double-click the existing Autotransaction and,
when it opens, click [Duplicate]. A copy of the selected Autotransaction
is shown in the window. The title bar reads “Autotransactions: New”,
indicating that a new record has been created but not yet saved.

3.

Edit the Autotransaction in the usual way, and enter the missing
information. The new Autotransaction must be given a new, unique
Code.

4.

Save the record using the [Save] button or click [Cancel] to discard the
record. Close the window by clicking the close box.

Changing an Autotransaction
1.

Open the ‘Settings’ list and double-click ‘Autotransactions’.
The ‘Autotransactions: Browse’ window opens, containing a list of the
Autotransactions you have defined.

2.

Find the Autotransaction you need to change. If necessary, click in the
Search field in the top right-hand corner of the window, enter the Code
of the Autotransaction you want to find and press Return.

3.

Press the Enter key or double-click the row.
The Autotransaction is opened in a window with the title
‘Autotransactions: Inspect’.
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4.

Edit the Autotransaction in the usual way, and enter the missing
information.

5.

Confirm by clicking the [Save] button or discard the changes using the
[Cancel] button. Close the window by clicking the close box.
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Deleting an Autotransaction
1.

Open the ‘Settings’ list and double-click ‘Autotransactions’.
The ‘Autotransactions: Browse’ window opens.

2.

Find the Autotransaction you are interested in, using the Search field in
the top right-hand corner of the window as described above if necessary.

3.

Press the Enter key or double-click the row. The Autotransaction is
opened in a window with the title ‘Autotransactions: Inspect’.

4.

Select ‘Delete’ from the Records menu. The Autotransaction is
permanently deleted. The previous Autotransaction in the list is shown.

5.

Click the close box.

!

You cannot undo the deletion of an
Autotransaction.

Bank Files
In Denmark, Norway and Sweden it is common practice to pay Suppliers by
electronic credit transfer. This setting is used in those countries to define the
format of the export files to be sent to banks instructing them of the payments
to be made. Please refer to your local FirstOffice representatives for full
details.
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Brought Forward Balances (Opening
Balances)
This setting holds the opening balances for all Accounts.
To enter opening balances, follow these steps—
1.

Open the ‘Settings’ list and double-click ‘Brought Forward Balances’.

2.

Double-click the record you want to work with or click [New] to open a
new one.

3.

Enter opening balance information as follows—

No
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You can change this Number, but not to one that has
already been used, and not once the opening balance
record has been saved.
Trans Date

The date of the opening balance transaction.

Text

A short description of the opening balance record.

Difference

Any difference between the sums of Debited and
Credited amounts is shown here: the two sums must be
the same before the opening balance record can be
saved. A balancing entry shows a zero balance.

Total

These two fields show the sums of Debits and Credits for
this Transaction.

The remainder of the screen contains the rows where the individual
Account balances are entered. The debit and credit totals must be the
same before the record can be saved.
To add rows, click in any field in the first blank row and enter
appropriate text. To remove a row, click on the row number on the left of
the row and press the Backspace key. To insert a row, click on the row
number where the insertion is to be made and press Return.
Account

Paste Special

Accounts setting

Specify here the Account whose opening balance is
being recorded in the row.
Description

A default Description is brought in from the Account
record. You can change it if necessary.

Debit, Credit

For each row, specify a debit or credit opening balance
amount. The debits total must equal the credits total
before the record can be saved: each record must
therefore have at least two rows.

4.

Click [Save] to save the record and then close it by clicking the close
box.

Check the data by printing the Trial Balance report. The Total Balance on the
last line should show 0.00 in the opening balance column.
For a more detailed description about entering opening balances, please refer
to page 166 in Chapter 4, ‘Starting Work’.

207

HansaWorld FirstOffice Start

Companies
If your business is one where there are separate departments or subsidiary
companies that keep separate accounts, these can be set up as separate
accounting entities in FirstOffice using the Companies setting. Each
department or subsidiary is termed a ‘Company’. If you set up more than one
Company in FirstOffice, each will be completely separate: there will be no
common information, although you can copy from one to another using the
export and import functions. Separate account balances will be maintained,
and each Company within a database can be backed up separately or together.
You can have up to four Companies in a FirstOffice database.
Note that you should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.
On launching FirstOffice for the first time, your first task will normally be to
create a Company. Please refer to page 34 for full details.

!

You must ensure you have at least
one Company as your first task in
using FirstOffice.

The number of Companies that you can create is restricted by the
Configuration setting. In a new database, this number will a lways be one. If
you need more than one Company, it is advisable to enter as many
Companies as you need straight away, so that you only need apply for an
Enabler Key once. The Enabler Key is dependent upon the number of
Companies entered, so you will need to apply for a new one if you add a new
Company later. Remember that each Company will maintain completely
separate accounts, so there is no need to create separate Companies for
departments that are part of the same accounting whole.

Entering Companies
This is the first task to be completed when creating a FirstOffice database.
The process is fully described on page 34 in the first chapter of this manual.
If you have been working with a FirstOffice database for some time and need
to change or add to the information in the Companies setting, click the
[Companies] button in the Master Control panel, and, in the subsequent
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window, select ‘Open Company Register’ from the Operations menu. The
‘Companies: Inspect’ window appears: this is the same as that used to enter
Companies when starting to use FirstOffice. Please refer to page 42 in the
first chapter of this manual for details. You can also open the ‘Companies:
Inspect’ window by double-clicking ‘Companies’ in the ‘Settings’ list.
You can add new Companies at any time (up to a maximum of four), but
remember that doing so will mean that you will need to apply to your
FirstOffice representative for a new Enabler Key.
For security reasons, FirstOffice will shut down after any changes or
additions have been made in the Companies setting Restart the program to
continue working.

!

The “Default.txt” file must be present
when adding Companies.

Working with Companies
If you have set up more than one Company, you will need to inform
FirstOffice which one you would like to work with each time you start work.
Whenever you launch FirstOffice, the ‘Select Company’ list window will
appear automatically—

Highlight the Company you wish to work with and press the Enter key (or
double-click on the Company in the list).
If you need to change Companies in the middle of a work session, there is no
need to quit FirstOffice and restart. Instead, go to the File menu and select
‘Company’, or click the [Companies] button in the Master Control panel. The
‘Select Company’ list will appear, where you can choose a new Company to
work with.
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Company Info
Use this setting to record your company’s name and address, and other
particulars such as phone and fax numbers, and the bank and bank account
number. This information will be printed as appropriate on all documents.
To open the Company Info setting, first open the ‘Settings’ list and then
double-click ‘Company Info’. The ‘Company Info: Inspect’ window is
opened.
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Apart from the Company Name, Address etc, you should enter the following
information in this setting—
Reg Card

Bank 1, Bank 2 You should enter your company’s main bank account
number(s) here. This information can then be printed on
any appropriate documentation.
Bank Customer ID
This is an ID number used for automatic (modem)
communication with certain credit institutions in some
countries. Please contact your local FirstOffice
representative for details.
Edit Font, Report Font, Report Font Size
Paste Special

Fonts in your system

These fields allow you to select different fonts for use on
screen and in reports respectively. If you leave these
fields empty, FirstOffice’s default fonts will be used.
These fonts are selected for maximum readability, and
you should only change them if you have good reasons
to do so. In non-English versions of FirstOffice, use
these fields to select fonts with special character sets.
VAT Law

Paste Special

Choices of possible entries

Use this field to ensure the behaviour of FirstOffice
conforms to the local accounting conventions in your

211

HansaWorld FirstOffice Start

country. If your country is not listed in the ‘Paste
Special’ list, choose the “Default” option.
Character Set

Paste Special

Choices of possible entries

This field is used to control sorting in FirstOffice. In
countries where the alphabet differs to that of the
UK/US, sorting by ASCII codes produces a list that is
not in the correct alphabetical order: use this field to
overcome this problem.
Confirm the entry by clicking [Save], or cancel it by closing the window
using the close box.

Configuration
Use this setting to register how many Companies there are in your FirstOffice
database. Once you have done this, FirstOffice will generate a Control Code,
which you should quote when you need to obtain an Enabler Key. The setting
is fully described in the sections entitled ‘Adding New Companies’ and ‘The
Enabler Key’ on pages 40 and 43 respectively in the first chapter of this
manual.
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Conversions - Master, Conversions Accounts
These settings allow you to move all postings to one or more Accounts to
another Account. For example, you might have been using Account 100 for
sales of a particular product, but for some reason you want to use Account
102 instead. These settings allows you to change Account 100 wherever it
appears in the Transaction register to Account 102 and to recalculate all
previous entries to the old Account, so that they will appear under the new
Account in all reports. To do this recoding you must follow the steps
below—
1.

Make a back-up of your entire database and quit FirstOffice.

2.

Remove the FirstOffice database file (named “1Office.HDB”) from the
folder or directory containing your FirstOffice application. Ensure,
however, that the “DBDef.txt” and “Default.txt” files are present.

3.

Launch FirstOffice again. Because there is now no “1Office.HDB” file, a
new database is created. Enter new Company information to the dialogue
(a Code and Name is sufficient): click [Save] and double-click the new
Company in the subsequent list.

4.

When the ‘Import files available’ window appears, close it by clicking
the close box. Do not import anything yet.

5.

Open the ‘Settings’ list by clicking the [Settings] button in the Master
Control panel or by selecting ‘Settings’ from the File menu. Double-click
‘Conversions - Accounts’ in the subsequent list. Enter the old and new
Account numbers one by one in the window as shown in the illustration.
Finish by saving the setting by clicking [Save].
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6.

From the ‘Settings’ list, select ‘Conversions - Master’ and enter a check
mark in the Convert Accounts check box. Save the setting by clicking
[Save].

7.

Select ‘Imports’ from the File menu and import the back-up using the
‘Automatic’ or ‘Automatic, manual file search’ import routines. Quit
FirstOffice and restart if so prompted.

8.

The routine will renumber the Account records in the Accounts setting as
required. In the example, Account 100 will be given the new number of
102. If Account 102 already existed, the old Account (100) would be
deleted. Check the Accounts setting to make sure that this has happened.

9.

Produce a Nominal Ledger report for one of the new Accounts and check
that all the Transactions have been converted as you expected.

10. You must now inspect and change all report definitions in the Nominal
Ledger where the old Account number has been used.
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11. Return to the Conversions - Master setting and turn off the option to
Convert Accounts.
12. Return to the Conversions - Accounts setting and delete everything line
by line.
During the import of the back-up file, all references to the old Account
numbers will be replaced in all transactions (including Sales and Purchase
Ledger transactions) and in all settings (including Account Usage S/L and
Payment Modes).
Note that if you have more than one Company in your database, the
conversion will apply to all Companies in that database. If you want the
conversion to take place in one Company only, follow the procedure
described above with the following differences—
i.

Before step 1, and working in the Company where the conversion is to
take place, enter the old and new Account numbers one by one in the
Conversions - Accounts setting. Check that the setting is empty in all
other Companies, or, if you want a different conversion to take place in
another Company, enter old and new Account numbers in that Company
as necessary.

ii. Omit step 5.
So, if the Conversions - Accounts setting in all Companies is empty when the
original database is exported in step 1, any conversion on import will be
determined by what you enter to the setting in step 5. If the Conversions Accounts setting in a particular Company is not empty when the original
database is exported, its contents in that Company only will override what
you enter to the setting in step 5. Therefore, it's important to empty the
Conversions - Accounts setting after conversion in all Companies in step 12:
this is not done automatically. If you do not do this, the conversion may have
unexpected results the next time you carry it out.

Conversions - Master, Conversions Suppliers
The Conversions - Suppliers setting is described in the section entitled
‘Combining Customers and Suppliers’ on page 279 in Chapter 6, ‘Base
Registers’.
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Credit Limit

This setting allows you to control the actions when the credit limit of a
Customer has been (or is about to be) exceeded.
If you choose the first option, a warning will appear when you enter an
Invoice and try to use a Customer that has already exceeded their credit limit.
If you choose the second option, you will not be able to save an Invoice if it
will take the Customer over their credit limit.
Credit limit checking will not take place for a Customer that has not been
given a credit limit. If you want to allow a Customer no credit at all, set their
Credit Limit to 0.01.
To open this setting, click [Settings] in the Master Control panel or select
‘Settings’ from the File menu, and then double-click ‘Credit Limit’ in the
‘Settings’ list. Check the boxes as appropriate and then, to save changes and
close the window, click the [Save] button. To close the window without
saving changes, click the close box.
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Customer Categories
You can group Customers of a similar type together using Customer
Categories. This can help with reporting: several reports allow you to list
Customers belonging to a particular Category.
To work with Customer Categories, first select ‘Settings’ from the File menu
or click the [Settings] button in the Master Control panel. Double-click
‘Customer Categories’ in the resulting list. Then click [New] to open a new
record, or double-click an existing record to modify it.

Code

Specify a unique code, by which the Customer Category
may be identified from the Customer screen and
elsewhere in FirstOffice.

Description

Enter text describing the Customer Category here.
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Date and Numeric Format
Use this setting to ensure your FirstOffice installation displays and prints
dates and numbers using your preferred date and number formats.

Internally, FirstOffice features full Year 2000 compatibility: all dates are
stored with four-digit years (e.g. “2005”). If you switch on the Century check
box, FirstOffice will display the century digits in all dates. However, you do
not have to type the extra two century digits, they will be added automatically
by FirstOffice. If you enter “100405” in a date field, FirstOffice will change
it to “10-04-2005”.
In the current version of FirstOffice, the Century check box must be checked
for the long dates to appear in back-up and in FirstOffice’s different Export
files. If the box is not checked, all dates in the exported files will be written
as short dates, without the century digits. This will create a problem if you
later import a back-up or an export file containing dates from both centuries.
Our recommendation is always to check the Century box. This will make
certain that your FirstOffice program will behave correctly, both internally
and when you communicate with other applications.
To open this setting, click [Settings] in the Master Control panel or select
‘Settings’ from the File menu, and then double-click ‘Date and Numeric
Format’ in the ‘Settings’ list. Consider each option as described above. Then,
to save changes and close the window, click the [Save] button. To close the
window without saving changes, click the close box.
Whenever a change is made to this setting, its effect will be immediate and
universal.
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Dates and Export Files
Be careful when opening a FirstOffice Export file with Microsoft Excel with
the intention of editing it before importing it to a new database. Under certain
circumstances, Excel will, when opening a text file, convert some variables
that it interprets as dates into its own internal date format. Where you are
expecting a date to appear in the spreadsheet you may see a number such as
“35475”. When you save the spreadsheet again as a text file these variables
will not be converted back to date format. So, if you import this text file to
FirstOffice, the dates will be wrong. To avoid this problem, make sure you
use the third step of Excel’s Import Wizard to set all imported columns to
‘text’ format (highlight all the columns in the Data Preview area using the
Shift key and select ‘Text’ as the Column Data Format).

You cannot open files created using the ‘Database Text Backup’ and
‘Company Text Backup’ functions in Excel as they are not text files.

Electronic Invoicing
This setting is used in Finland. Please refer to your local FirstOffice
representative for details.
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Fiscal Years
FirstOffice has a multi-year database. In this setting you can define several
financial years. Each year must have a Code, and can be between 6 and 18
months in duration. The Code will be used as a prefix for Transactions
entered directly to the Transaction register.
To open this setting, click [Settings] in the Master Control panel or select
‘Settings’ from the File menu, and then double-click ‘Fiscal Years’ in the
‘Settings’ list. To save changes and close the window, click the [Save]
button. To close the window without saving changes, click the close box.
Note that you should always list your Fiscal Years should always be listed in
chronological order as shown in the illustration. You should not attempt to
insert a new Fiscal Year at the top of the list, and you should not remove past
Fiscal Years.

FirstOffice will issue a warning whenever you try to post a transaction whose
date does not fall in a Fiscal Year as defined in this setting.

220

Chapter 5: Settings - Form Settings

Form Settings
Use this setting to control how addresses are printed in documents (in the
Address field).

Print Blank Lines By default, blank lines in addresses are not printed in
documents. Use this option if you want the blank lines to
be printed.
Organisation Name
Use this option if you want the Customer Name to be
printed as the first line of the address.
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Forms
Various documents can be printed from FirstOffice, including Invoices,
Credit Notes, Cash Notes and Customer Labels. You can design your own
formats or layouts to be used when printing these documents, using
FirstOffice’s built-in forms editor.
To open the editor, open the ‘Settings’ list by clicking the [Settings] button in
the Master Control panel or by selecting ‘Settings’ from the File menu. Then,
double-click ‘Forms‘ in the list. The ‘Forms: Browse’ window opens,
showing the Forms that are already in the system.

To change an existing Form, double-click on its Code in the list, or click
[New] or [Duplicate] in the Button Bar to create a new Form. When you have
designed the Form, click [Save] in the Button Bar to save it in the normal
way.
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The ‘Form: Inspect’ window shows the selected Form or document. At the
top of the window there are five buttons: [Text], [Line], [Frame], [Field] and
[Picture]. In the editing area, each printing object in the Form is shown either
as a framed box, or as text. You can select an object by clicking on it with the
mouse and then drag it to another place, re-size it etc. as in most drawing
programs.

Editing Objects
To edit an object, double-click on it with the mouse. This will open a
dialogue box, where you can perform certain editing functions. These are
described for each object type below. For all object types, use the fields Left,
Top, Right and Bottom fields to set the location in pixels of the four sides of
the object. The Justification options allow you to justify the text as you wish.
Style refers to the Styles setting, where you can set font, font size and font
style.
Text Objects
To add a new text element to the Form, click the [Text] button and then draw
the object where you want the text to appear.
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When you release the mouse button, the following dialogue box will
appear—

Text

The text that is to be printed on the Form. This can be up
to 80 characters long, but it is limited to one line. To
create a text area with more than one line, use the
appropriate number of separate one-line text objects.

Left, Top, Right, Bottom
Use these fields to specify the size and position of the
text box that is to contain the text. When you create a
new text box, the measurements of the box that you have
just drawn will appear here.
Style

Paste Special

Styles setting

Use this field to assign a font and font style to the text.
Styles are defined using a separate setting that is fully
described below on page 255. If you do not enter a Style
here, the first record in the Styles setting will be used.
Justification

Use these options to specify where the text will appear
inside the text box.

Exclude from page
Please refer to the ‘Single- and Multi-Page Forms’
section below on page 229 for details about these
options.
Click [OK] to close. The text field is visible on the screen, and you can move
it across the Form with the mouse.
To edit a text object once it has been created, double-click it to open the
‘Text’ dialogue box.
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Lines and Frames
Use these tool buttons to draw lines and frames on the Form. Click either
button and then draw the object. When you release the mouse button, a
dialogue box will appear where you can indicate the width in pixels of the
line or frame.
Fields
A field is an area on the Form where information from FirstOffice’s database
is to be printed. The following example from an Invoice Form explains
how—

Fields appear as framed boxes containing the field name, e.g. “Invoice Due
Date”. The box frames are for identification only: they will not be printed.
You can use the [Frame] button to add a printing frame if necessary. Above
each field is a text object (created using the [Text] button as described above
on page 223) that identifies the information shown in the field. These would
not be necessary if the Form is to be printed on pre-printed stationery.
To add a field, click the [Field] button, and mark the position of the field. A
dialogue box opens—

Enter the Field Name (use ‘Paste Special’ to see all available Field Names for
the Document Type), and paste a style in the Style field. Some fields consist
of more than one line (e.g. Comment fields, and the fields listing the Items in
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Orders and Invoices). You can modify the spacing between lines (in pixels)
using the Spacing field. Usually the number of pixels that you specify here
should be the same as the font size. If you leave this field empty, the lines of
text may be printed on top of each other.
In the case of matrix fields (for example, those printing the Items in
Invoices), you should enter “1” as the Format (as well as specifying a vertical
Spacing). If you do not do this, the printed matrix columns may not be
aligned correctly if the first row only contains text.
Click [OK] to save.
Document Types are described in the section covering the ‘Properties’
Operations menu function below on page 227.

Notes and Comments
Usually each field that you place in a Form corresponds to a field in the
original record. For example, the Customer Number field in the illustration
above will print the contents of the Customer Number field in each Invoice.
An exception is the “Note” field. If you include the “Note” field in your Form
design, this will print the first note or comment that you attach to the original
record using the Attachments feature.
Pictures
Use the [Picture] button to include a picture in your design. As with other
tools, click the button and draw a frame for the picture on the Form. A
dialogue box then appears. In the Picture Name field, enter the file name of
the picture as it is on your hard disk. The picture must be stored in the same
directory or folder as the FirstOffice database and application. You can use
‘Paste Special’ to ensure that the file name is spelt correctly, but this method
will bring in the full path name of the picture. It is recommended that you
remove the path name to leave the file name only. If you do not remove the
path name, it will become incorrect if you move your FirstOffice folder and
as a result the picture will no longer be printed.
In the Windows environment, files of BMP format are supported. For
Macintosh users, EPS and PICT formats are supported. For Linux users, files
of BMP and EPS format are supported. If a picture does not print, opening it
in Adobe Photoshop and saving it may correct the problem. The name of the
picture file must have an extension, and both the name and extension must be
in uppercase characters. The file should be smaller than 200K.

226

Chapter 5: Settings - Forms

Operations Menu

Properties
This menu command opens the ‘Form Properties’ dialogue box. Here you can
record the basic specification for the Form currently being edited.

Code

A unique code for the Form. If you have created a new
Form by copying a template, you must enter a new Code
here before you can save it.

Comment

A description of the Form, e.g. Invoice.

Matrix Rows On Please refer to the ‘Single- and Multi-Page Forms’
section below on page 229 for details about these
options.
Document Type Using ‘Paste Special’, enter one of the available
Document Types into this field. When the time comes to
add fields to the Form, only the fields available for that
Document Type will be available in the ‘Paste Special’
list in the ‘Field’ dialogue box.
Printer Dialog

Check this box to force a printer dialogue to be shown
each time the Form is printed.
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PC Printer
If you are using a dot matrix printer, use this dialogue box to define the page
size.

A dot matrix printer needs certain settings for printing on continuous
stationery. If you are printing a document to pre-printed forms, you may need
to define the number of rows in the page, the number of visible rows and the
left margin for the forms used.
Copies

Use this function to specify how many copies should be printed each time the
Form is used, the headings to be printed on each copy and the printer tray
from which each copy is to be printed. If you want the headings to be printed,
be sure to include the Copy Type field in your Form design. In the example
illustrated above, we have specified that two copies of each Invoice will be
printed: one marked “Office” and one “Customer”. Only one copy (marked
“Office”) will be printed if the Invoice is not approved, and if an approved
Invoice has already been printed.
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Send to Back
If you wish certain objects on the Form to appear behind other objects, select
them and select this function.
View All, First Only, Middle Only, Last Only, Single Page Only
These functions are described in the next section, ‘Single- and Multi-Page
Forms’.

Single- and Multi-Page Forms
When you design a Form, you should consider what is to happen when the
printing of a document requires more than one page. Two options are
available—
1.

The “simple” option, where the same page design is used for each page.

2.

The “multi-page” option allows the use of up to four page designs, as
follows—
First

The first page of a multi-page document.

Middle

In a multi-page document, the pages between the
first and last pages.

Last

The last page of a multi-page document.

Single

The sole page of a single-page document.

Usually, the First and Single page designs will be the same.
When you add an object of any kind (i.e. text, line, frame or field) to a Form
design, you can use the Exclude From Page check boxes to specify the pages
on which the object is to be printed. If you do not check any of these boxes,
the object will be printed on every page. This will be the case when using the
“simple” option. If you want the object to be printed on certain pages only,
check one or more of the boxes. For example, if the object is to be printed on
all pages except the first, check the First box. If it is only to be printed on the
first page, check all boxes except the First box (i.e. it will be excluded from
all pages except the first).
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The text object in the illustration below will be printed on the first page
only—

To help with the design process, you can choose to display the objects from a
particular page. To do this, select ‘First Only’, ‘Middle Only’, ‘Last Only’ or
‘Single Page Only’ as appropriate from the Operations menu. For example,
select ‘First Only’ to view the objects that are to be printed on the first page
(i.e. those whose First box has not been checked). Select ‘View All’ to see all
objects, irrespective of the page on which they are to be printed.
The number of pages printed will vary from record to record, depending on
the number of rows that the record has. An Invoice with one Item will be
printed on a single page (i.e. using those objects whose Single box is not
checked). An Invoice with 100 Items (i.e. 100 rows) will be printed over
several pages. You should specify the maximum number of rows that can be
printed on each page by selecting ‘Properties’ from the Operations menu.
This opens the ‘Form Properties’ window, which has four fields under the
overall heading of Matrix Rows On—

In the case of the “simple” option, you should enter the same number to each
of these four fields. Otherwise, enter different numbers as appropriate. For
example, in an Invoice Form, First and Single are set to 5, Middle to 6 and
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Last to 7. Invoices will be printed as follows, depending on the number of
rows—
Invoice rows

Pages

Up to 5
5-12
13-19
19-25

1
2
3
4

Type of Page
Single
First and Last
First, Middle and Last
First, 2 x Middle, Last

Printing Forms
Documents can be printed in one of two ways—
1.

With a record open, by clicking the Printer icon; and

2.

By selecting ’Documents’ from the File menu or by clicking the
[Documents] button in the Master Control panel and then doubleclicking an item in the ‘Documents” list.

Before you can print a document, you should inform FirstOffice which Form
is to be used by that document. You should do this by attaching a Form to an
item in the ‘Documents’ list. This is only necessary if you have given your
Forms new Form Codes using the ‘Properties’ Operations menu function.
For example, when printing an Invoice, FirstOffice, by default, will use a
Form with the Form Code of “INVOICE”. A template Form with this Code is
supplied with FirstOffice. If you have used this template as a basis for
designing your own invoice form and haven’t changed the Form Code, the
new design will be used automatically. However, if you have changed the
Form Code to, for example, “INVOICE1”, you should inform FirstOffice that
this is now the Form to be used for printing Invoices.
To do this, follow these steps—
1.

Click the [Documents] button in the Master Control panel. The
‘Documents’ list window is opened showing a list of available
documents. Highlight ‘Invoices’.

2.

Select ‘Define Document’ from the Operations menu.

3.

In the first row, “INVOICE” will be shown in the Form field. Change
this to the Form Code of your new invoice Form (“INVOICE1” in the
example). Use the ‘Paste Special’ feature to see the available forms in
your Forms setting and to ensure the spelling is correct.

4.

Click [Save] to save the Invoice definition. From now on, whenever
Invoices are printed, the “INVOICE1” Form will be used.
231

HansaWorld FirstOffice Start

You can also use ‘Define Document’ (steps 3 and 4 above) to specify that
more than one Form is to be printed (for example, you might require that a
Delivery Note is printed with each Invoice).
The ‘Define Document’ function is available for all of the documents printed
by FirstOffice, allowing a high level of flexibility in the production of printed
output from FirstOffice.

Related Items
The Styles setting is used to define the various type styles, fonts, etc available
for use when designing Forms.
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Info on Customer Status Report
You can use this setting to specify what will be shown in the Customer Status
Report when it is produced by different users using the Operations menu
function of the ‘Customers: Browse’ and ‘Customer: Inspect’ windows.
You can save a separate record in this setting for each Person, so each user
can customise the report to their particular requirements. These records are
listed when you double-click ‘Info on Customer Status Report’ in the
‘Settings’ list. To create a new record, click the [New] button in the Button
Bar, or highlight a record in the list that is similar to the one that you are
about to create and click [Duplicate].
The following window opens—

User

Paste Special

Persons setting

Enter the user’s initials in the User field, using ‘Paste
Special’ if necessary. FirstOffice will prevent you from
entering more than one record for a particular Person.
Include Invoices

Check this box if Invoices are to be listed in Customer
Status Reports produced by the Person entered in the
User field above. You should also check the All Open
box.

All Open

Check this box if open (unpaid) Invoices are to be listed.

Internet Enablers
Please refer to the section entitled ‘The Enabler Key’ on page 43 in the first
chapter of this manual for full details of this setting.
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Item Groups
It can be practical to organise Items of similar kinds into Item Groups. This
option gives you more flexibility in reporting.
To work with Item Groups, first select ‘Settings’ from the File menu or click
the [Settings] button in the Master Control panel. Double-click ‘Item Groups’
in the ‘Settings’ list. Then click [New] to open a new record, or double-click
an existing record to modify it.
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No.

Enter the code or number identifying this Item Group.
You can use any combination of letters and numbers.
There is a maximum of five characters.

Name

Enter the name or description of the Item Group.
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Local Machine
This setting contains a few options that you can use to control the behaviour
of FirstOffice.
To open this setting, click [Settings] in the Master Control panel or select
‘Settings’ from the File menu, and then double-click ‘Local Machine’ in the
‘Settings’ list. Fill in the fields as described below. Then, to save changes and
close the window, click the [Save] button. To close the window without
saving changes, click the close box.

Default Export Codepage
Paste Special

Choices of possible options

By default, text files exported from a FirstOffice
database will contain Unicode characters. However, if
you want these text files to use a different character set,
change the Default Export Codepage here, using ‘Paste
Special’ to choose from a list of options. This can be
useful if you want to check or edit a text file using a
program that cannot read Unicode. This feature does not
apply to every Export function in FirstOffice.
Prompt when deleting
When you delete records using the ‘Delete’ command,
you are usually not asked if you are sure you want to go
ahead with the deletion. If you would like such a
warning to appear, switch on this option.
Don't display Tool Tips
Check this box if you do not want Tool Tips to appear
when you move the mouse onto a field, check box or
radio button. Quit FirstOffice and restart for the change
to take effect.
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Locking
This setting allows you to close an accounting period to prevent the further
entry of new or corrected transactions. You will do this by specifying a cutoff date: no transactions whose Transaction Date is on or before this cut-off
date will be permitted. Because Locking is carried out by specifying a single
date, months or periods must be locked chronologically. Once a cut-off date
has been entered, FirstOffice will not allow you to enter an earlier date to the
same field.
FirstOffice does not force you to close months or periods, but this setting
allows you to do so if necessary.
To open this setting, click [Settings] in the Master Control panel or select
‘Settings’ from the File menu, and then double-click ‘Locking’ in the
‘Settings’ list. Fill in the fields as described below. Then, to save changes and
close the window, click the [Save] button. To close the window without
saving changes, click the close box.

Lock Transactions
If you enter a date in this field, the entry of Transactions
whose Transaction Date is on or before this date will not
be permitted. This applies only to Transactions entered
directly to the Transaction register.
If you discover that a Transaction that falls within a
closed month contains an error, you can only correct it
using the ‘Correction Mark’ function. Please refer to the
‘Correcting Transactions’ section on page 365 in
Chapter 7, ‘Transaction Registers’, for full details.
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If you try to enter a Transaction whose Transaction Date
is on or before the Lock Transactions date, the following
warning will appear—

Warn on Sales Invoices
If you enter a date in this field, a warning will be
displayed when you enter an Invoice whose Transaction
Date is on or before this date. You will still be able to
save the Invoice.
If you try to enter an Invoice whose Transaction Date is
on or before the Warn on Sales Invoice date, the
following warning will appear—

Warn on Purchase Invoices
If you enter a date in this field, a warning will be
displayed when you enter a Purchase Invoice whose
Transaction Date is on or before this date. You will be
able to save the Invoice.
Warn on Others If you enter a date in this field, a warning will be
displayed when you enter a Payment or Receipt whose
Transaction Date is on or before this date. You will still
be able to save the record.

!

After locking the accounts at a
certain date, you may not move the
date backwards, you will not be able
to enter Transactions with earlier
dates, and you may not alter earlier
Transactions.
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Payment Modes
Payment Modes represent the different methods by which your Invoices will
be paid by your Customers (and by which you will pay your Suppliers).
Typical examples are cash, cheque, direct debit and credit card. For many
businesses, the difference between such payment methods in terms of the
way they are accounted for is minimal, but where appropriate, FirstOffice
does allow each Payment Mode to debit a different Account and to be paid
into a different bank account.
To open this setting, click [Settings] in the Master Control panel or select
‘Settings’ from the File menu, and then double-click ‘Payment Modes’ in the
‘Settings’ list. Fill in the fields as described below. Then, to save changes and
close the window, click the [Save] button. To close the window without
saving changes, click the close box.
You can enter as many different Payment Modes as you need, using the grid
on the ‘Payment Modes’ screen. To add a Payment Mode, click in the Code
field of the first blank row and enter appropriate text. To remove a Payment
Mode, click on the row number on the left of the row and press the
Backspace key.

Code

Enter a unique code by which the Payment Mode is to be
identified from elsewhere in FirstOffice.

Account

Paste Special

Accounts setting

Specify here the cash, bank or other Account to be
debited by any Receipt and credited by any Payment
using the Payment Mode.
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Bank A/C No

Specify here the bank account number used for this
Payment Mode.

Comment

The name of the Payment Mode. This will be shown in
the ‘Paste Special’ list, so it should be descriptive
enough to make the selection of the correct Payment
Mode easy for all users.
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Payment Terms
Different Invoices and Purchase Invoices can be assigned different terms for
payment: last date for payment, Cash or Credit Note etc.
To open this setting, click [Settings] in the Master Control panel or select
‘Settings’ from the File menu, and then double-click ‘Payment Terms’ in the
‘Settings’ list. The ‘Payment Terms: Browse’ window is opened, showing all
Payment Terms previously entered.

Double-click a Payment Term in the list to edit it, or add a new term by
clicking the [New] button in the Button Bar.

Code
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Enter the unique code by which the Payment Terms
record is to be identified from elsewhere in FirstOffice.
The Code may consist of one or two characters, and both
numbers and letters can be used.
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Text

Enter the name for the Payment Term, to be shown in the
‘ Payment Terms: Browse’ window and the ‘Paste
Special’ list.

Net Days

The credit period in days. When this Payment Term is
used in Invoices and Purchase Invoices, the value
entered here will be added to the Invoice Date to
calculate the Due Date.

Cash Account

Paste Special

Accounts setting

If the Type is set to “Cash”, enter the Account to be
debited (when a cash sale is approved) or credited (when
a cash purchase is approved). If this is blank, the Cash
Account in the Account Usage S/L or P/L setting
respectively will be used. Cash Notes are described
below in the section describing the “Cash” Type.
Type

The Payment Terms can belong to one of three types.
The type determines how the due date is calculated.
Normal

A normal payment. The value in the Net Days
field will be added to the Invoice Date to
calculate the Due Date.

Credit

This type is used for Credit Notes, to make sure
that the Sales and Purchase Ledgers are updated
correctly. You should have at least one Payment
Term record of this type if you wish to raise
Credit Notes.

Cash

This type is used for cash payment. The number
of days is not relevant. Invoices with this
Payment Term are known as Cash Notes.
In the Sales Ledger, when you approve a Cash
Note, a Nominal Ledger Transaction will be
created which debits the Cash Account (or, if that
is blank, the Cash Account in the Account Usage
S/L setting) and credits the appropriate Sales
Account for each Item on the Invoice. Therefore,
no posting to a Debtor Account is made as the
Cash Note is immediately treated as paid. There
is no need to enter a Receipt.
Cash Notes behave in a similar fashion in the
Purchase Ledger. In this case, the Cash Account
(or, if that is blank, the Cash Account in the
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Account Usage P/L setting) is credited. There is
no need to enter a Payment.
When you have entered the Payment Term record, save it using the [Save]
button and close the window by clicking the close box. Then, close the
browse window using the close box again.
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Persons
This setting holds information about Persons, i.e. users, employees, sales
persons etc. You can use it as part of your FirstOffice security system: each
Person can be given their own password. Once you have entered at least one
record to the setting, starting FirstOffice will require the entry of a Person’s
initials and, if appropriate, a password.
To open the Persons setting, click [Settings] in the Master Control panel or
select ‘Settings’ from the File menu, and then double-click ‘Persons’ in the
‘Settings’ list. The ‘Persons: Browse’ window is opened, showing Persons
that have already been entered.

Double-click a Person in the list to edit it. To enter a new record, click [New]
in the Button Bar or use the Ctrl-N (Windows) or -N (Macintosh) keyboard
shortcut. Alternatively, select a Person similar to the one you want to enter
and click [Duplicate] on the Button Bar.
The ‘Person: New’ window is opened, empty if you clicked [New] or with a
copy of the copied Person.
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Signature

Enter the Person’s initials to be used when logging on, or
to identify the Person from elsewhere in FirstOffice.
If there is more than one Company in the database,
records in the Persons setting (as with all registers and
settings) are specific to the Company in which they are
entered. However, if you will be using the Personal
Desktop, you should enter Person records for yourself in
each Company with the same Signature (initials). This
will allow you to see your Personal Desktop in each
Company. If there are two or more Persons in different
Companies with the same initials, they will not be able
to have their own Personal Desktop.

Name

The name of the Person.

Job Description

A short job description or title.

Our Reference

Using the Our Ref field, you can assign a short (up to 20
characters) reference text for the individual. This text
will appear in the Our Ref field of all Invoices entered
by this Person.

When the Person record is complete, save it using the [Save] button and close
the window by clicking the close box. Then, close the browse window using
the close box again.

!
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As soon as you have entered a single
Person in the Persons setting, the
password dialogue will appear each
time you start FirstOffice.
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Operations Menu

The Operations menu for Persons is shown above. It is available for the
‘Persons: Browse’ window: highlight a Person in the list before selecting the
function.
Change Password
Once you have recorded a user or employee to the Persons setting, they will
be able to log in to and use your FirstOffice database. For security reasons,
therefore, it is recommended that all Persons have their own passwords and
that these are changed from time to time.
You can assign Passwords to Persons as you add them to the Persons setting.
If you do not do this, each Person will be asked to set a password the first
time they log in. To set a password for a Person as you add them to the
Persons setting (or to change a password at any other time, for example if a
Person leaves the company), highlight their name in the ‘Persons: Browse’
window and select ‘Change Password’ from the Operations menu. The
following window is opened—

Type in the new password twice to ensure that it is correct. Click [Save] to
close the window and save: use the close box if you do not want to save
changes. The password is case-sensitive.
You can also change your password from the Master Control panel by
selecting ‘Change Password’ from the Operations menu. Then, follow the
instructions above.

245

HansaWorld FirstOffice Start

To Do List
The To Do List is a list of Activities sorted by Start Date and Time. Its main
purpose is to list Activities that have not yet been completed to provide a
check list of tasks to be undertaken.
When printed to screen, the To Do List has FirstOffice’s Drill-down feature.
Click on the Activity Text of any Activity in the report to open that Activity.
You can then remind yourself of the details of the Activity before carrying it
out. When the task has been completed, you can mark the Activity as Done,
thus effectively removing it from the To Do List.
When you select this function from the Operations menu of the ‘Persons:
Browse’ window, a To Do List for the Person highlighted in the ‘Persons:
Browse’ window is immediately printed to screen, showing To Do Activities
in Start Date and Time order. To Do Activities are Activities whose Task
Type is To Do and whose Done box is not checked. The report period is the
current year.
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This screen version of the report contains a number of text buttons, as
follows—
Detailed

Click “Detailed” to show for each Activity any text that
has been entered to the grid on the ‘Text’ card.

Include Done

Clicking here will cause Done Activities to be shown in
the report (i.e. Activities whose Done boxes are
checked). These are shown in a second section of the
report, and the text “OK” appears in the right-hand
column beside each one.

Activity Text

Click the Text of any Activity to open that Activity
record. If the To Do List report is showing To Do
Activities only and you mark an Activity as Done, select
‘Recalculate’ from the Operations menu to remove it
from the report.

Contact Name

Click a Contact Name to open the relevant Customer
record.
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To print the To Do List to a printer, first print it to screen and then click the
Printer icon or select ‘Print’ from the File menu.
Please refer to page 386 in Chapter 8, ‘Personal Registers’, for a full
description of Activities.
Activate Personal Desktop
Select this function for each Person if you want them to be able to use the
Personal Desktop. Please refer to page 119 in Chapter 2, ‘Work Area’, for
more details about the Personal Desktop.
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Price Lists and Prices
Introduction
FirstOffice has a powerful set of functions to handle different types of Price
Lists in a business. These functions allow you to manage several alternative
Price Lists listing all or some of the goods or services you offer to Customers.
Different Price Lists can be connected with specific Customers. The number
of alternatives is great, but as always is the case with great flexibility, it is
necessary to know and understand the tools and techniques to set up a
specific pricing structure.
You can record the normal selling price of each Item using the Price field in
the Item register. In many cases, this will be the only price used. If each Item
is always sold at the same price (or with an ad hoc discount), whoever the
Customer, you will be able to rely on the Item's Price and not worry about the
Price List feature.

Structure of Price Lists
FirstOffice allows you to assign different Prices to individual Items so that
each Price is associated with a particular Price List. For example, many retail
outlets have different prices for their retail and trade Customers, or different
retail and educational prices. You might then have separate retail, trade and
educational Price Lists, each of which is available to the appropriate kind of
Customer. When you enter a Customer in an Invoice, the appropriate Price
List will be used and so the correct prices will be selected automatically.
In planning such a price structure, follow these steps—
1.

Enter the Items with their normal selling prices, using the Item register as
described on page 294 in Chapter 6, ‘Base Registers’.

2.

Define each Price List (in our example, retail, trade and educational)
using the Price Lists setting.

3.

The Items that are to appear on the Price Lists should now be attached as
necessary. For each Item on each Price List, enter a record to the Prices
setting with an appropriate price. In our example, for each Item three
Price records should be entered, containing the retail, trade and education
prices. If a Price List is specified for a Customer that you then use in an
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Invoice, FirstOffice searches in the Prices setting for the appropriate, and
unique, record representing the particular Item for that Price List.
4.

You can now assign a Price List to each Customer. When you enter an
Invoice for a particular Customer, the specified Price List will be used
automatically. If you sell an Item that is not on the appropriate Price List,
the Price from the Item register will be used.

Below, steps 2 and 3 are described in detail.

Price Lists
To define a new Price List, first click the [Settings] button in the Master
Control panel or select ‘Settings’ from the File menu. Double-click ‘Price
Lists’ in the ‘Settings’ list and click [New].

Code

Enter a unique code here, by which this Price List will be
identified elsewhere in FirstOffice.

Description

Name the Price List here.

VAT

Choose the Exclusive option if the prices are to exclude
VAT, and the Inclusive option if they are to include
VAT. If you use an ‘Inclusive’ Price List in an Invoice,
the Unit Price, Sum and Total figures will all include
VAT, but if you use an ‘Exclusive’ Price List, the Unit
Price and Sum figures will exclude VAT. In both cases,
VAT will be calculated using, in order of preference, the
VAT Code specified for the Item or in the Account
Usage S/L setting.

The Prices Setting
You can have several different Prices for each Item. Enter each Price as a
separate record in the Prices setting, one record for each Price for each Item.
You should do this after you have defined your Items and Price Lists.
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You should ensure that there is a single, unique, Price record for each
Item/Price List combination, making the use of Price Lists in Invoices
extremely fast. FirstOffice will prevent you entering a Price record for an
Item/Price List combination if one already exists by displaying the error
message “Already Registered”.
To enter a new Price record, open the Prices setting by double-clicking
‘Prices’ in the ‘Settings’ list, and then click [New]. Enter the Item Number of
an existing Item, using ‘Paste Special’ if necessary to select from a list of
Items, and press Return. The Item Name from the Item register is shown in
the Comment field. Enter the required Price, specify a Price List, again using
‘Paste Special’, and click [Save].

When you create an Invoice in the name of a particular Customer, the Price
List specified for that Customer will determine the Prices used. Prices from
the appropriate Price List will be offered as a default whenever the Customer
receives an Invoice.
If you specify a Sales Account in a Price record, that Account will be used in
Invoices where pricing is determined by that Price (i.e. by the unique Price
record for the Item/Price List combination). This Account will be used
instead of any Account specified for the Item and in the Account Usage S/L
setting.
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Report Settings
The appearance and format of the Balance Sheet, Profit & Loss Report and
VAT Report can be changed to suit your specific requirements. This is
known as changing the report’s definition.
To change a report definition, first select ‘Settings’ from the File menu and
double-click ‘Report Settings’ in the subsequent list. Then, highlight a report
name in the list on the left-hand side of the ‘Report Settings’ window and
click the [Definition] button. The subsequent definitions windows are
described in the sections covering the particular reports in Chapter 10,
‘Reports’ (pages 424, 452 and 467 respectively).

The [Definition] button can only be used with the three reports named above.
The remaining two buttons can be used with all reports. Highlight a report in
the list and then click a button, as described below. When you have finished,
close the ‘Report Settings’ window by clicking the close box.
Page Setup, Remove Page Setup
The [Page Setup] button allows you to set the page size,
number of copies and other printer options for the
highlighted report. These settings will be used whenever
the report is printed. Windows users can also use this
function to choose the printer on which the report is to
be printed. Click the [Remove Page Setup] button to
revert to standard.
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Reporting Periods
This setting allows you to name and define certain time periods. These should
be the periods that you will commonly use when producing reports: using
‘Paste Special’ from the Period field of a report specification window will
bring up a list of the Report Periods entered using this setting. For example, if
you want to produce monthly reports you should define each month as a
separate period in this setting.

Once memorised, the Code can be used as a fast way of choosing a Report
Period. For example, using the Report Periods illustrated above, type
“Q1CY” in the Period field of a report specification window when you want
the report to cover the period “1/1/2005:31/3/2005”.
To enter a new Reporting Period, simply click in the first blank line and enter
details as appropriate. Click [Save] to save and close, or the close box to
close without saving changes.
Note that the Reporting Period in the first row of this setting will be offered
as a default wherever a Reporting Period is required. You might therefore
like to change the first row from time to time so that a useful option is always
offered as a default. To delete the old first row once it is no longer useful,
click on the row number and press the Backspace key. To insert a new record
on the first row, click on the row number and press the Return key.
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Round Off
Use this setting to control the way calculations are rounded off. Any amounts
lost or gained from the rounding off process are posted to the Round Off
Account specified in the Account Usage S/L setting. This Account is used in
Transactions generated both from Sales Invoices and from Purchase Invoices.
To open this setting, click [Settings] in the Master Control panel or select
‘Settings’ from the File menu, and then double-click ‘Round Off’ in the
‘Settings’ list.

Totals

This group of options sets the rule for rounding off Total
figures (i.e. including VAT) in Invoices.

VAT

This group of options allows you to use a different
rounding off rule for VAT. This rule applies to both
Invoices and Purchase Invoices.

Click [Save] to save any changes and close, or the close box to close without
saving changes.
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Styles
This setting allows you to define the different font Styles to be used in the
Fields and Text objects in your Forms, ensuring a consistency of appearance.
Double-click ‘Styles’ in the ‘Settings’ list to open the ‘Styles: Browse’
window and see a list of the defined Styles.

Double-click a Style in the list to edit it. To enter a new record, click [New]
in the Button Bar or use the Ctrl-N (Windows) or -N (Macintosh) keyboard
shortcut. Alternatively, click on a Style similar to the one you want to enter
and click [Duplicate] on the Button Bar.
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Code

The code for the Style.

Comment

Any description.

Mac/Windows/Linux Font
Paste Special

Fonts available on your
computer

The name of the font file, as it appears in the Windows
directory or the System folder.
Mac/Windows/Linux Size
The font size in points.
Styles

Select one of the available style types.

Do not use ANSI character set
Use this option if the Style is to use a non-standard
character set (for example, that used in barcodes).
Set the Font, Size and Style for Linux, Macintosh or Windows, depending on
the type of machine you are using.
When the Style is complete, save it using the [Save] button and close the
window by clicking the close box. Then, close the browse window using the
close box again.
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Supplier Categories
You can group Suppliers of a similar type together using Supplier Categories.
All Suppliers of the same Category can be given the same default Creditor
Account, saving you the work of having to specify this for all Suppliers
individually.
If you specify a Creditor Account both for a Supplier Category and for a
Supplier that belongs to that Category, the Creditor Account entered for the
Supplier will take precedence. If you do not specify a Creditor Account for a
Category or a Supplier, the Creditor Account specified in the Account Usage
P/L setting will be used.
To work with Supplier Categories, first select ‘Settings’ from the File menu
or click [Settings] in the Master Control panel. Double-click ‘Supplier
Categories’ in the resulting list. The ‘Supplier Categories: Browse’ window is
displayed, showing all Categories previously entered. Click [New] to enter a
new record, and [Save] to save it.

Suppliers (Old Register)
This setting is described in the section entitled ‘Combining Customers and
Suppliers’ on page 279 in Chapter 6, ‘Base Registers’.
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Text Types
When you enter Activities, you can record notes and comments in the grid on
the ‘Text’ card. If you define various standard texts in this setting, you can
access them from the grid in the Activity record using ‘Paste Special’,
reducing the typing load.

The ‘Text Types: Browse’ window lists the available Text Types: to enter a
new item, click the [New] button in the Button Bar. The ‘Text Type: New’
window appears: enter the details as appropriate and click [Save] to save the
new record.

Timed Operations
This setting allows you to set a time when your FirstOffice database will be
backed up automatically, on a daily basis. Please refer to the ‘Automatic
Timed Back-ups’ section on page 54 in Chapter 1, ‘Introduction and
Installation’, for details.
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Transaction Settings
This setting contains one option—

Allow Trans. Date changing
Invoices and Receipts contain separate fields for
registration date and transaction date. In some countries,
these dates can be different, while in other countries they
have to be the same. For example, in an Invoice, in some
countries, the Invoice Date can be different to the
Transaction Date. This can mean there will be a
difference between your Sales and Nominal Ledgers.
Use this option if you would like to allow different
registration and transaction dates.
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VAT Codes
In order to comply with VAT regulations it is necessary to differentiate
between domestic, EU and external trade. To solve this, FirstOffice makes
use of VAT Codes, whereby any number of VAT Codes with different
accounting specifications can be defined.
VAT Codes can be assigned to Customers, Suppliers and also to individual
Sales and Purchase Accounts. The VAT Codes help FirstOffice to use the
correct VAT percentage, to control the Nominal Ledger accounting and to
provide VAT statistics. The standard VAT Codes used in the UK are supplied
with the program.
To edit the VAT Codes, double-click ‘VAT Codes’ in the ‘Settings’ list. The
following window appears—

To edit a VAT Code record, simply click in the field to be changed and
overtype the existing entry. To add a new VAT Code record, scroll down to
the first blank line. The information required for each VAT Code record is as
follows—
Code

Each VAT Code record should be identified by a unique
Code.

Excl %

Specify the percentage to be applied to a figure that
excludes VAT in order to calculate the VAT amount.
You must specify an Input or Output Account if the
percentage is zero, as shown in the illustration above.

Incl %
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Outp A/C

Paste Special

Accounts setting

Specify here the VAT Outputs Account to be credited
whenever this VAT Code is used in a sales transaction.
In any Nominal Ledger Transaction resulting from
Purchase Invoices from the EU Zone, VAT is debited to
the Input Account of the selected VAT Code and
credited to the Output Account. Therefore, it is
recommended that you use a dedicated VAT Code for
VAT on EU Acquisitions, with an Output Account that
is not used in any other VAT Code.
O/P A/C

Paste Special

Accounts setting

This field is only used if you are using the Post Receipt
VAT option in the Account Usage S/L setting. Users of
the Cash VAT scheme in the UK will need to use this
option, while users in Poland may need to use it.
If you are using the Post Receipt VAT option, your
output VAT liability is calculated from your Receipts,
not from your Invoices. In this case, the Outp A/C will
be treated as a preliminary VAT Output Account, to be
credited whenever an Invoice is approved. When the
Invoice is paid, the Transaction from the Receipt will
include an extra VAT element, in which the VAT is
moved from the Outp A/C to the O/P A/C. This therefore
becomes the final VAT Output Account. The Post
Receipt VAT option also posts VAT from On Account
VAT Receipts (Receipts with no Invoice Number or
Prepayment Number).
If you are using this feature, don’t forget to alter the
definition of the VAT Report so that it uses this Account
and not the Outp Account.
Inp A/C

Paste Special

Accounts setting

Specify here the VAT Inputs Account to be debited
whenever this VAT Code is used in a purchase
transaction.
I/P A/C

Paste Special

Accounts setting

This field is only used if you are using the Post Payment
VAT option in the Account Usage P/L setting. This will
be the case for users in Latvia and for users of the Cash
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VAT scheme in the UK and may be the case for users in
Poland.
If you are using the Post Payment VAT option, the
value of the input VAT that you can reclaim is
calculated from your Payments, not from your Purchase
Invoices. In this case, the Inp A/C will be treated as a
preliminary VAT Input Account, to be debited whenever
a Purchase Invoice is approved. When the Purchase
Invoice is paid, the Transaction from the Payment will
include an extra VAT element, in which the VAT is
moved from the Inp A/C to the I/P A/C. This therefore
becomes the final VAT Input Account.
Description

The description entered here will appear in the ‘Paste
Special’ list, so should be detailed enough to ensure the
correct VAT Code is always chosen.

To save changes and close the window, click the [Save] button. To close the
window without saving changes, click the close box.
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Weeks
This setting is used to define the Week Numbers that are shown in the sixmonthly and monthly Calendar views (described on page 402 in Chapter 8,
‘Personal Registers’). Week Numbers can vary from country to country and
depending on when the year started.
FirstOffice supports a single Week record. To enter it, double-click ‘Weeks’
in the ‘Settings’ list and then click [New] when the browse window appears.
If a Week record already exists, it will be shown in the browse window.
Double-click to edit.

Complete the grid for each year of use as shown in the illustration (there is no
need to have the years in order, but you should only enter each year once).
Click [Save] in the Button Bar to save, and then click the close box to save
the record.
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Chapter 6: Base Registers
Base registers typically contain information that is then used elsewhere. This
information will not itself be changed very often. For example, the Customer
register is effectively a list of Customer names and addresses that will be
referred to from the Calendar and from Invoices and Receipts.
FirstOffice contains three base registers. You can open them by clicking the
buttons in the Master Control panel—

Each base register is now described in detail.
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Customers and Suppliers
Information about your Customers, Suppliers and all other companies with
whom you have some contact is stored in the Customer register. Storing
Customers, Suppliers and other companies together in one register means that
you can make full use of the Calendar and Task Manager with companies of
all kinds. It also means that you will only have to maintain a single record for
a company who is both a Customer and a Supplier.
Throughout these manuals (including in the index), the term “Customer” is
usually used when describing the use of a record in the Customer register in a
sales context, while “Supplier” is used in a purchase context. “Supplier”
implies that the Supplier box in the header of the Customer record has been
checked.
On the sales side, you can group Customers of a similar type together using
Customer Categories. Similarly, on the purchase side you can group
Suppliers of a similar type together using Supplier Categories. All Suppliers
belonging to the same Category can be given the same default Creditor
Account, saving you the work of having to specify this for all Suppliers
individually. A company that is both a Customer and Supplier can belong
both to a Customer Category and to a Supplier Category.
Prior to FirstOffice version 4.1, Customers and Suppliers were stored in
separate registers. In this version, the two registers were made into one.
When you update to this or a later version, you can use the ‘Convert
Suppliers to Customers’ Maintenance function to bring the information in the
two registers together. This is described in the section entitled ‘Combining
Customers and Suppliers’ below on page 279.
To open the Customer register, click the [Customers] button in the Master
Control panel. You can also use the Ctrl-6 (Windows and Linux) or -8
(Macintosh) keyboard shortcuts.

The ‘Customers: Browse’ window is opened, showing all Customers already
entered.
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To enter a new record in the Customer register, click [New] in the Button Bar
or use the Ctrl-N (Windows) or  -N (Macintosh) keyboard shortcut.
Alternatively, select a Customer similar to the one you want to enter and
click [Duplicate] on the Button Bar.
The ‘Customer: New’ window is shown, empty if you clicked [New] or with
a copy of the copied record. Complete the Customer record as appropriate,
then save it using the [Save] button and close the window by clicking the
close box. Then, close the browse window using the close box again.
Since the amount of information stored about each company will not fit in a
single window, the Customer screen has been divided into three cards. At the
top of each is the header. This contains the Customer Number, Customer and
Supplier Categories, Customer and Supplier check boxes and Name. There
are three named buttons (‘tabs’) in the header.

By clicking the tabs you can navigate between cards. The header is always
visible, as a reminder of the Customer you are working with.
Below, the Customer screen is described field by field. The entry of
Customer information often requires reference to settings using ‘Paste
Special’. Where use of ‘Paste Special’ is appropriate, this is indicated in the
text. Please refer to Chapter 5, ‘Settings’, for full details of each setting.

268

Chapter 6: Base Registers - Customers and Suppliers

Header

No.

Enter the unique code you are assigning to this company:
this is the means by which this company will be
identified elsewhere in FirstOffice. The field holds up to
20 letters and/or numbers. FirstOffice offers a default
based on the Customer Number of the previous record
entered. Once you have saved the record, you cannot
change the Customer Number.

Cust. Category

Paste Special

Customer Categories setting

Supp. Category

Paste Special

Supplier Categories setting

If the company is a Customer, you can assign it to a
Customer Category. If it is a Supplier, you can assign it
to a Supplier Category.
Customer Categories enable you to classify similar
Customers together. Several reports allow you to list
Customers belonging to a particular Category.
Supplier Categories enable you to classify similar
Suppliers together. All Suppliers belonging to the same
Category can use the same default Creditor Account,
saving you the work of having to specify these for each
Supplier individually.
Name

Enter the Name of the company.
If you want the Customer Name to be printed as part of
the address in all documents, use the Organisation Name
option in the Form Settings setting.

Customer, Supplier
Check one or both of these boxes to indicate whether the
company you are entering is a Customer or a Supplier or
both.
If you have marked a company as a Customer only, you
will be able to use it in Sales Invoices and Receipts, but
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not in any purchase registers. Similarly, if you have
marked it as a Supplier only, you will be able to use it in
Purchase Invoices and Payments, but not in any sales
registers. Both Customers and Suppliers can be used in
Activities (i.e. in the Calendar and Task Manager).
If you originally opened the Customer register by
clicking the [New] button in the ‘Paste Special’ window
listing Customers, these check boxes will be set
automatically depending on the context. For example, if
you entered a Sales Invoice, activated ‘Paste Special’
from the Customer field and clicked [New], the new
record will be marked as a Customer.
Once you have marked a company as a Customer and
you have issued at least one Sales Invoice to that
company, you will not be able to remove the check from
the Customer box. Similarly, if you have marked a
company as a Supplier and you have received at least
one Purchase Invoice from that company, you will not
be able to remove the check from the Supplier box.
Throughout this manual (including in the index), the
term “Customer” has been used when referring to
companies marked as Customers, and the term
“Supplier” refers to companies marked as Suppliers.
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Contact Card

Address

Enter here the address to which Invoices and Payments
are to be sent.

Contact

Paste Special

Contact Person register

Used as default in

Sales Invoices

You can enter the name of your main contact person
here: it will be transferred as a default entry whenever
this Customer record is used in a transaction. The ‘Paste
Special’ selection list will only show contact names for
the Customer in question (identified by Customer
Number).
Telephone, Fax Email, Skype Name
Enter the company’s main telephone, fax numbers, email
address and Skype name here. You should enter
extensions, direct line and mobile numbers, e-mail
addresses and Skype Names for each contact in the
Contact Person register.
If you need to contact the company and you are using
Windows, click the [Communicate] button in the Button
Bar—
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The following window opens, containing the company’s
contact details—

Subject to your computer or network having the suitable
connection software and hardware, click on a contact
method in the list on the left, and then click the
appropriate button on the right. The Skype application
will be started automatically, allowing you to call using
Skype or SkypeOut (if you clicked on a telephone
number). A new Activity window will also be opened,
allowing you to record the details of the call or contact
immediately.
Web Site

If the company has a website, enter its address (URL)
here.

VAT Reg No.

It is important that the Customer’s VAT Number is
recorded here if they are in the “Within EU” Zone as this
information is required for EU VAT reporting purposes.

Reg No

If the Customer is a limited company, enter their
Company Registration Number here.

Terms Card
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Sales Credit Limit
Specify here the Credit Limit that you have granted to
this company. You can use the Credit Limit setting to
warn against or prevent the entering of Invoices for
Customers who have exceeded their Credit Limit.
If you want to allow a company no credit at all, set their
Sales Credit Limit to 0.01.
Purch. Credit Limit
Specify the Credit Limit extended to your firm by this
company here. This is for information only.
Sales Pay. Terms Paste Special

Payment Terms setting

Used as default in

Sales Invoices

Paste Special

Payment Terms setting

Used as default in

Purchase Invoices

Purch. Pay. Terms

If the company is a Customer, use the Sales Pay. Terms
field to specify the Payment Terms that your company
offers them. If the company is a Supplier, use the Purch.
Pay. Terms field to specify the Payment Terms that they
offer your company. These will be used to calculate the
Due Date when entering Invoices and Purchase Invoice
in this company’s name and they therefore provide the
basis for the debt-chasing reports provided in
FirstOffice.
Price List

Paste Special

Price Lists setting

Used as default in

Invoices

If you wish to assign a particular Price List to a
Customer, you can do so here. It will determine the
prices used in Sales Invoices for this Customer.
Please refer to the ‘Prices’ section on page 249 in
Chapter 5, ‘Settings’, for full details of how to use this
feature.
On Account

Check this box if the company is a Customer from whom
you want to be able to receive On Account Receipts (i.e.
you want to allow them to pay before you have invoiced
them) and/or the company is a Supplier to whom you
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want to be able to issue On Account Payments (i.e. to be
able to pay them before you receive Invoices). Full
details can be found in the ‘Receipts’ and ‘Payments’
sections of Chapter 7, ‘Transaction Registers’ (pages
326 and 353 respectively).
Before you can enter On Account Receipts, you must
specify an On Account A/C in the Account Usage S/L
setting. This Account will be credited with the value of
these Receipts.
On the purchase side, before you can enter On Account
Payments, you must specify an On Account A/C in the
Account Usage P/L setting. This Account will be debited
with the value of these Payments.
Type

Use these options to specify whether the Customer or
Supplier is a company or a private individual. This will
affect the check that the VAT Number is correct in
Argentina and Paraguay.

Account Card

Comment
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will be shown in some Sales Ledger reports featuring
this Customer.
Bank

Enter the name of the company’s bank or building
society here.

Bank Account

Enter the company’s main bank account number here. If
the company is a Supplier, this bank account number
will be transferred to any Purchase Invoices and
Payments entered in the Supplier’s name.

Creditor A/C

Paste Special

Accounts setting

If you are using a particular Creditor Account for a
certain Supplier, enter its Account number here.
If you leave this field empty the Creditor Account will
be taken from the Supplier Category (if appropriate) or
from the Creditor Account in the Account Usage P/L
setting.
Cost A/C

Paste Special

Accounts setting

When entering Purchase Invoices in the name of this
Supplier, you can determine that a particular Purchase
Account is offered as a default in each Purchase Invoice
row. This can be particularly useful in the case of
specialist Suppliers or Suppliers of services such as
electricity or telephone services, whose Purchase
Invoices are usually debited to the same Account.
If you want to set a default Cost Account (i.e. Purchase
Account) for this Supplier, enter its Account Number
here.
VAT Zone

Used as default in

Sales and Purchase Invoices

Select a Zone for this company. This will be used in
Sales and Purchase Invoices to control VAT calculation
and accounting and the choice of Sales Account.
Separate default sales VAT Codes and Sales Accounts
can be assigned to each Zone in the Account Usage S/L
setting. Separate default purchase VAT Codes can be
assigned to each Zone in the Account Usage P/L setting.
For Customers in the “Within EU” Zone, it is important
that their VAT Number is recorded (see above).
When Sales Invoices are raised for Customers in the
“Inside EU” and “Outside EU” Zones, VAT will not be
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charged, irrespective of the VAT Code. If you want to
charge VAT to such Customers, place them in the Inside
EU (Post VAT)” and “Outside EU (Post VAT)” Zones.
Similarly, on the Purchase Side, VAT will not be
calculated on Purchase Invoices received from Suppliers
in the “Outside EU” Zone. If the Supplier is in the
“Inside EU” Zone, VAT from Purchase Invoices will be
debited to the Input Account from the VAT Code and
credited to the Output Account from the VAT Code. If
you want VAT to be calculated and debited to the Input
Account from the VAT Code in the normal way, place
your Suppliers in the Inside EU (Post VAT)” and
“Outside EU (Post VAT)” Zones.

Editing a Customer
The Customer register must be kept up to date, so it will need editing from
time to time.
In the ‘Customers: Browse’ window that appears when you open the
Customer register, the Customers are initially shown in Customer Number
order. You can change the sort order by clicking on one of the headings. The
underlined heading shows the current sort order.
To search for a specific Customer, enter the text to be found in the Search
field in the top right-hand corner of the window and press Return. The text
should be such that it would appear in the current sort column: to search by
Company Name, for example, sort by Company Name before entering a
Company Name (or its first few characters) to the Search field.
To modify a Customer’s record, double-click on the line in the browse
window. That record will be opened in a window entitled ‘Customer:
Inspect’. The fields in this window are the same as those in the ‘Customer:
New’ window: please refer to the previous section for a detailed description
of each field.
Edit the fields as necessary. Move from field to field with the Return key, or
with the arrow keys. Click [Save] when you have finished, to save changes.
Click the close box to close the Customer record without saving changes.
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Deleting a Customer
Select and open the Customer record in the same way as for editing. Select
‘Delete’ from the Record menu. The Customer is deleted. Note that once
Invoices have been entered in a Customer’s name, that Customer can no
longer be deleted.

!

You cannot undo the deletion of a
Customer record.

Operations Menu

The Operations menu for Customers is shown above. It is available for the
‘Customers: Browse’ window: highlight a Customer in the list before
selecting the function. You can also apply the function to a group of
Customers: highlight the first Customer in the group and then click on the last
while holding down the Shift key. Then select the function. The Operations
menu is also available for the ‘Customer: New’ and ‘Customer: Inspect’
windows.
Customer Status
The ‘Customer Status’ function prints a Customer Status report to screen.
In its basic form, this report shows address and turnover information and lists
all Contact Persons for the Customer currently on screen or for those
Customers highlighted in the browse window. However, if required, you can
also have a list of recent Invoices shown in the report. Use the Info on
Customer Status Report setting to control whether this additional information
will be shown to different users, each of whom can be given a different report
definition.
The Customer Status report has FirstOffice’s Drill-down feature. You can
open many records such as Contact Persons, Customers and Invoices from
the report by clicking in the appropriate places (i.e. on Contact Person names,
Customer Numbers and on Invoice Numbers). Text with the drill-down
feature is shown underlined in the report. The report also contains a [New
Activity] text button that you can click to create an empty new Activity.
The function will have no effect if you try to use it with a company that is not
marked as a Customer.
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Supplier Status
The ‘Supplier Status’ function provides an immediate report listing previous
Invoices and Payments for the Supplier currently on screen or for those
highlighted in the browse window. It also shows total turnover and amount
due figures. The function will have no effect if you try to use it with a
company that is not marked as a Supplier.
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Combining Customers and Suppliers
Prior to FirstOffice version 4.1, Customers and Suppliers were stored in
separate registers. In this version, the two registers were made into one.
When you update from 4.0 or earlier to 4.1 or later, you will need to copy
your Supplier information out of the old Supplier register into the Customer
register. You must do this before you can use your Supplier information
anywhere in the system (e.g. before you can create Purchase Invoices).
In 4.1 and later, the old Supplier register can be found as a setting, called
Suppliers (Old Register). You can edit the Suppliers that are already there
(e.g. change their VAT Numbers as described below), but you cannot add
new Suppliers. New Suppliers can only be added to the new unified
Customer register.
We will illustrate the procedure for converting Suppliers to Customers using
a database containing the following Customers and Suppliers—

Follow these steps—
1.

Before updating to the new version, print the significant Purchase Ledger
reports such as the Purchase Ledger itself and the Periodic Supplier
Statement.
279

HansaWorld FirstOffice Start

2.

Referring to the section entitled ‘Updating from Previous Versions of
FirstOffice’ on page 58 in the first chapter of this manual, update your
database to the new version of FirstOffice.

3.

Back up your database in the usual fashion.

4.

Before you can copy your Suppliers into the Customer register, you
should edit your Supplier register with these goals in mind—
i

If a company is both a Customer and a Supplier, its Customer
Number and its Supplier Number should be the same, and the VAT
Registration Numbers should be the same in both registers. The
conversion process will copy the information about this company in
the Supplier register to the corresponding existing record in the
Customer register.

ii

If a company is a Supplier only, its Supplier Number should be a
number that is not used as a Customer Number in the Customer
register. When the conversion process copies this company into the
Customer register, it will be as a new record, with a Customer
Number that is the same as its Supplier Number. That Customer
Number cannot therefore already be in use.

Start this process by running the Convert Suppliers To Customers report
(do not use the Compare With Conversion - Supplier Settings option).
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The first line of this report will state whether you can copy your Supplier
information into the Customer register immediately. If so (and if the
remainder of the report is empty), proceed to step 6.
The remainder of the report will contain up to four sections listing
changes that you should make in the Supplier register before the
conversion process can copy the information into the Customer register.
The four sections are—
a.

Lists the cases where the Supplier Number is the same as the
Customer Number, but the companies appear to be different (they
have different VAT Registration Numbers, or one or both companies
do not have VAT Numbers). In this case you must change the
Supplier Number, as described in step 5 below (or if they are in fact
the same company you should make sure they have the same VAT
Numbers by clicking on the Customer or Supplier Number in the
report).
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In the example, Customer 002 and Supplier 002 are different
companies. We will therefore give Supplier 002 a different Supplier
Number (one that is not used as a Customer Number).
b.

Lists the cases where the Supplier Number is not the same as the
Customer Number, but the Companies appear to be the same (they
have the same VAT Registration Number). If the companies are
different, you should change the VAT Number in one or both
companies by clicking on the Customer or Supplier Number in the
report. If in fact the companies are the same, you must change the
Supplier Number to be the same as the Customer Number, as
described in step 5 below.
In the example, Customer 003 and Supplier 303 are the same
company. We will renumber Supplier 303 to be Supplier 003, so that
the conversion process can then copy its Supplier information to
Customer 003.

c.

Lists the cases where the Supplier Number is the same as the
Customer Number and the companies appear to be the same (they
have the same VAT Registration Number). If the companies are in
fact the same, you need take no action. If they are different, you
must change the Supplier Number as described in step 5 below, and
you should also change the VAT Number in one or both companies
by clicking on the Customer or Supplier Number in the report.
In the example, Customer 001 and Supplier 001 are the same
company. We will allow the conversion process to copy Supplier
information from Supplier 001 and to attach it to Customer 001.

d.

Lists the cases where the Supplier Number is not the same as the
Customer Number and the Companies have different VAT
Registration Numbers, but they have the same name. If the
companies are different, you need take no action. If they are the
same, you must change the Supplier Number to be the same as the
Customer Number as described in step 5 below, and you should
change its VAT Number to be the same as the Customer’s.
In the example, Customer 004 and Supplier 304 fall into this
category. In fact, they are the same company so we will make their
VAT Numbers agree. Then we will renumber Supplier 304 to be
Supplier 004, so that the conversion process can attach its Supplier
information to Customer 004. Customer 005 and Supplier 305 are
also in this category, but they are different companies. In their case,
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the conversion process can copy Supplier information in to the
Customer register with no intervention.
Customers and Suppliers that do not fall into any of the four categories
described above (i.e. they are clearly separate companies, with no shared
Customer/Supplier Numbers or VAT Numbers) will not be shown in the
report. The conversion process can copy Supplier information in to the
Customer register with no intervention. In the example, a new Customer
record, Customer 503, will be created, to receive information copied
from Supplier 503.
As the basis of comparison is the VAT Registration Number, it is
recommended that you enter VAT Numbers for as many Suppliers and
Customers as possible before producing the report, or from the report by
drilling down. Recalculate the report when you've entered as many VAT
Numbers as possible. When the VAT Number information is as complete
as possible, proceed to step 5.
5.

If the report showed that you need to change some Supplier Numbers, do
this now.
In the example, we need to change three Supplier Numbers—
•

Supplier 002 should be given a new number that is not in use as a
Customer Number. It does not matter what this number is.

•

Supplier 303 should be given number 003 to be the same as
Customer 003, and Supplier 304 should be given number 004.

In brief, this is done by listing the old and new Supplier Numbers in the
Conversions - Suppliers setting. You can do this yourself, or you can
have the ‘Prepare Conversion Suppliers Settings’ Maintenance function
do it for you. Then, export the database to a back-up file, create a new
database, switch on the correct import option in the Conversions - Master
setting and import the back-up file.
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For more detail, follow these steps—
i.

Open the Conversions - Suppliers setting and fill in the conversion
table with Suppliers’ old Numbers in the left-hand column and the
new Numbers that they are to be given on the right—

ii. If you have many Supplier Numbers to change, you can use the
‘Prepare Conversion Suppliers Settings’ Maintenance function to fill
the setting for you.
In essence, this function will assume that a Customer and a Supplier
with the same VAT Number are in fact the same company. It will
then try to ensure that such a company will end up with matching
Customer and Supplier Numbers. Therefore, before using this
function, you should ensure that your Customer and Supplier records
have as many VAT Numbers as possible, as described in step 4
above.
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When you open the ‘Prepare Conversion Suppliers Settings’
Maintenance function, the following dialogue box appears—

General Rules for matching Numbers
These options control how a new Supplier Number will
be assigned to a Supplier falling into category 4a as
described above (Supplier Number is the same as a
Customer Number, but companies are different).
Start from last Customer No.
Creates a new Supplier Number by finding the
last Customer Number and adding 1.
Start from No.

Starts a new number sequence starting by adding
1 to the number you specify in the field to the
right.
Take great care if you use this option. You should
choose a number sequence that is currently not
used in the Customer register or in the old
Supplier register.

Add

Retains the old Supplier Number but adds as a
prefix the character(s) you specify in the field to
the right.
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When Customer with same VAT No. found
These options control how a new Supplier Number will
be assigned to a Supplier falling into category 4b as
described above (VAT Number is shared with a
Customer but Supplier and Customer Numbers are
different).
Convert Supplier No. to Customer No.
The Supplier will be given the Customer Number
of the Customer with the shared VAT Number.
Apply General Rules
The Supplier will be given a new Supplier
Number, created using the option chosen in the
General Rules For Matching Numbers section
above.
When Customer with same VAT No. and same No. found
These options control how a new Supplier Number will
be assigned to a Supplier falling into category 4c as
described above (VAT Number is shared with a
Customer, and Supplier and Customer Numbers are the
same)
Skip

No action will be taken for these Suppliers.

Apply General Rules
The Supplier will be given a new Supplier
Number, created using the option chosen in the
General Rules For Matching Numbers section
above.
Apply these rules to all Suppliers
Check this box if the option chosen in the General Rules
For Matching Numbers section above is to be applied to
all other Suppliers (i.e. if all Suppliers with no possible
match in the Customer register are to be renumbered or
given a prefix as described above).
Click the [Run] button to operate the function. When it has finished,
check the Conversion - Suppliers setting to see that it has been filled
correctly and make any adjustments necessary.
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In the example illustrated above, the top section, General Rules For
Matching Numbers, will apply to Supplier 002. We have chosen a
number sequence beginning at 600, a sequence that is not currently
used in either the Customer or the Supplier registers. The second
section, When Customer With Same VAT No. Found, will apply to
Suppliers 303 and 304. We have specified that these are to become
Suppliers 003 and 004 respectively. Note that this rule will apply to
all Suppliers that share a VAT Number with a Customer. If there are
some Suppliers for whom this was not applicable, we would have to
move them out of this group by changing their VAT Numbers
before running the Maintenance function.
iii. Produce the Convert Suppliers To Customers report again, this time
using the Compare With Conversion - Supplier Setting option. This
option means that the report will check that your Suppliers can be
copied into the Customer register, taking the information in the
Conversions - Suppliers setting into account (i.e. the report will
assume the Suppliers have been renumbered as stated in the
Conversions - Suppliers setting).
If the report suggests further changes, carry them out as already
described.
This is the result in the example database—

287

HansaWorld FirstOffice Start

The report only contains two sections. The first is a reminder that
information from Supplier 001 will be copied to Customer 001. As
we know, they are in fact the same company, so we are happy for
this to happen. The second is a reminder that Supplier 305 and
Customer 005 have the same name and could therefore be the same
company. At the moment, a new Customer 305 will be created, so
they will be treated as being different companies. As we know, they
are in fact different companies, so again we are happy for this to
happen. So, in the example no further changes to the Customer or
Supplier register are necessary and we can proceed to the next step.
Otherwise, the report will provide a reminder that further changes
are needed.
iv. Make a back-up of your entire database in the usual way and quit
FirstOffice.
v.

Create a new database. Open the Conversions - Master setting and
check the Convert Suppliers box.

vi. Import the database text backup. When it has finished, turn off the
option to Convert Suppliers in the Conversions - Master setting, and
empty the Conversions - Suppliers setting.
For more details of steps iv-vi, please refer to the description of the
Conversions - Master setting on page 213 in Chapter 5, ‘Settings’.
vii. Open the Suppliers setting to check the Supplier Numbers have been
updated as expected.
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All related transactions (e.g. Purchase Invoices) will have been
given the new Supplier Numbers as well.
viii. Run the Convert Suppliers to Customers report again. The report
should now state that it is safe to run the ‘Convert Suppliers to
Customers’ Maintenance function.
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6.

Run the ‘Convert Suppliers to Customers’ Maintenance function. This
will copy all Supplier information into the Customer register, and empty
the Suppliers setting.

7.

Check that the Customer register now includes Suppliers and that all the
fields contain the correct information.

8.

Produce the same reports as in step 1 above and check that they match.

If you have several Companies in your database, you should carry out steps 1,
3, 4 and 5i-iii separately in each Company. Make sure that the Conversions Suppliers setting is complete in each Company before carrying out steps 5ivvi, since ideally you only want to do these once for the whole database.
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Contact Persons
When you enter a record in the Customer register, you can record the name of
the main contact person in the Contact field on the ‘Contact’ card. This name
will be brought in as a default whenever the Customer is used in an Invoice.
If you need to enter further Contact Persons for a particular Customer, you
can do so using this register. Then, selecting ‘Paste Special’ from the Attn.
field of an Invoice will list all Contacts for the specified Customer, including
the main contact.
To enter a new Contact Person, click [Contact Persons] in the Master Control
panel, or use the Ctrl-7 (Windows and Linux) or -7 (Macintosh) keyboard
shortcut. The ‘Contact Persons: Browse’ window appears, listing Contacts
already entered.

Double-click on a row to open and change a Contact Person record, or click
[New] in the Button Bar to create a new one.
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Customer No.

Paste Special

Customers and Suppliers in
Customer register

Enter the Customer Number or use the ‘Paste Special’
function. When you press Return, the Customer’s name,
address and other information will be entered into the
appropriate fields.
By default, the ‘Paste Special’ list shows Customers.
Click the [Suppliers] button in the top left-hand corner of
the ‘Paste Special’ window if you need to see Suppliers.
Cust. Name

The Customer Name is entered after you have entered
the Customer Number.

Name

The name of the Contact Person.

Address

FirstOffice will enter the address from the Customer
record. Change to a personal or department address if
necessary.

Tel, Fax, Mobile, Email, Skype Name
Enter the Contact Person’s telephone, mobile and fax
numbers, email address and Skype name here. The
telephone and fax numbers will be copied from the
Customer record.
If you need to contact the company and you are using
Windows, click the [Communicate] button in the Button
Bar—
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The following window opens, containing the company’s
contact details—

Subject to your computer or network having the suitable
connection software and hardware, click on a contact
method in the list on the left, and then click the
appropriate button on the right. The Skype application
will be started automatically, allowing you to call using
Skype or SkypeOut (if you clicked on a telephone
number). A new Activity window will also be opened,
allowing you to record the details of the call or contact
immediately.
Comment

Any comment.
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Items
The Item register is used to store information about the products and services
that you sell.
To open the Item register, click the [Items] button in the Master Control
panel, or use the Ctrl-8 (Windows and Linux) or -8 (Macintosh) keyboard
shortcuts.

The ‘Items: Browse’ window is opened, showing all Items already entered.

To enter a new Item, click [New] in the Button Bar or use the Ctrl-N
(Windows) or -N (Macintosh) keyboard shortcut. Alternatively, select an
Item similar to the one you want to enter and click [Duplicate] on the Button
Bar.
The ‘Item: New’ window is shown, empty if you clicked [New] or with a
copy of the copied Item. Complete the Item record as appropriate, then save it
using the [Save] button and close the window by clicking the close box.
Then, close the browse window using the close box again.
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No.

Enter the unique identification code you are assigning to
this Item. This is the means by which you will identify
the Item when including it in Invoices. The field holds
up to 20 characters.

Group

Paste Special

Item Groups setting

Enter the Item Group to which this Item belongs. Item
Groups enable you to classify similar Items together.
Name

Enter the name or a short description of the Item.

Price

Used as default in

Sales Invoices

Enter the normal sales price for the Item here.
Unit

Specify here the quantity to which the Price refers. In the
majority of cases, this will be a single item, but
otherwise it might be a pair or a dozen.

Sales Accounts

Paste Special

Accounts setting

When you use this Item in an Invoice, one of the three
Sales Accounts entered here will be offered as a default,
depending on the Zone of the Customer. It will override
any Sales Account specified in the Account Usage S/L
setting. If there is a record in the Prices setting for the
appropriate Item/Price List combination with a Sales
Account, that Sales Account will take precedence over
the one entered here.
VAT Codes

Paste Special

VAT Codes setting

When entering Invoices and including this Item, one of
the three VAT Codes entered here will be offered as a
default, depending on the Zone of the Customer. It will
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override any VAT Code specified in the Account Usage
S/L setting.
This Code will determine the rate at which VAT will be
calculated for this Item when it is sold and the Account
to be credited with the VAT amount.

Editing an Item
To edit an Item, open the ‘Items: Browse’ window by clicking the [Items]
button in the Master Control panel.
The Items are initially shown in Item Number order. Change the sort order by
clicking on one of the column headings: the underlined heading shows the
current sort order.
To search for a specific Item, enter the text to be found in the Search field in
the top right-hand corner of the window and press Return. The text should be
such that it would appear in the current sort column: to search by Item
Description, for example, sort by Description before entering a Description
(or its initial letters) to the Search field.
To modify an Item’s record, double-click on the line in the browse window.
That record will be opened in a window entitled ‘Item: Inspect’. The fields in
this window are the same as those in the ‘Item: New’ window: please refer to
the previous section for a detailed description of each field.
Edit the fields as necessary. Move from field to field with the Return key, or
with the arrow keys. Click [Save] when you have finished, to save changes.

Deleting an Item
Select and open the Item record in the same way as for editing. Select
‘Delete’ from the Record menu. The Item is deleted. Note that once an Item
has been included on an Invoice, it can no longer be deleted.

!
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Chapter 7: Transaction Registers
Each transaction register represents a particular type of accounting
transaction. Invoices, Receipts (payments that you receive against Invoices
that you have issued), Purchase Invoices and Payments (that you issue
against Purchase Invoices) are each stored in separate registers. The
Transaction register is used for all other kinds of transaction (e.g. credit card
payments, salaries, transfers between bank accounts).
The Invoice and Receipt registers make up FirstOffice’s Sales Ledger, while
the Purchase Invoice and Payment registers make up the Purchase Ledger.
These four registers are sometimes described as ‘Sub Systems’. When you
enter a record to any one of these registers and then approve and save it, a
corresponding record will be created automatically in the Transaction
register. The Transaction register is FirstOffice’s Nominal Ledger.
FirstOffice contains five transaction registers. You can open them by clicking
the buttons in the Master Control panel—

Each transaction register is now described in detail.
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Invoices
The Invoice register is a record of your company’s sales. Each time you make
a sale, you should enter an Invoice, print it and sent it to the Customer. You
will therefore use the Invoice register for a number of tasks—
•

The printed Invoice sent to the Customer acts as a demand for payment;

•

Unpaid Invoices in the register provide the basis for your debt chasing
reports; and

•

Each Invoice causes a Nominal Ledger Transaction to be created, thus
generating the turnover and debtor figures in your monthly and yearly
management reports. This creation process is automatic, requiring no
intervention or work from you.

Four types of sales transaction can be recorded in the Invoice register—
1.

Standard Invoices, or demands for payment, are issued where the goods
have been delivered or work carried out before payment has been
received. Payments against such Invoices should be recorded in the
Receipt register, described below on page 319.

2.

The Cash Note is issued when you receive payment at the same time as
carrying out the work. When a Cash Note is entered to the Invoice
register, FirstOffice will treat it as having being paid, so there is no need
to enter a separate payment record in the Receipt register. FirstOffice
will also look after the Nominal Ledger implications for you (debiting
the Cash Account rather than the Debtor Account).

3.

A Deposit is the receipt of money before an Invoice has been raised.
Deposits are treated as Cash Notes in FirstOffice.

4.

Credit Notes are used to correct mistakes in Invoices, or to cancel
Invoices that have been raised in error. They are, in effect, negative
Invoices that reduce your turnover and debtor figures. Again, FirstOffice
looks after these Nominal Ledger implications automatically.

The use of the Invoice register, including each of these types of sales
transaction, is now described in detail. Before you start entering Invoices,
however, you must ensure that you have defined the current financial
(accounting) year, using the Fiscal Years setting. This is described on page
220 in Chapter 5, ‘Settings’.
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To open the Invoice register, click the [Invoices] button in the Master Control
panel, or use the Ctrl-1 (Windows and Linux) or -1 (Macintosh) keyboard
shortcuts.

The ‘Invoices: Browse’ window is opened, showing Invoices already entered.

Invoices are numbered consecutively and the Invoice Number is usually
generated by the system. The Invoice Number is followed by a check mark
(if the Invoice is approved), by the Customer Number and Name and the total
amount of the Invoice. Credit Notes have the letter “C” in the value column,
after the amount.
As in all browse windows you can change the sort order by clicking on the
column headings. To reverse any sort, simply click once again on the column
heading. You can also scroll the list with the scroll bars. Finally, you can
search for a record by entering a keyword in the field at the bottom left
corner. FirstOffice will search for the first record matching the keyword in
the same column as the selected sorting order.
There are four things you can do in the Invoice register—
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•

Enter Invoices

•

Inspect Invoices

•

Approve Invoices

•

Print the Invoices
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Entering an Invoice
FirstOffice provides several shortcuts to simplify your work with entering
Invoices. You can for example bring a date into a date field using the ‘Paste
Special’ function. You can also use this function to simplify the entering of
Item Numbers, Customer Numbers, Payment Terms etc.
To enter a new Invoice, first open the ‘Invoices: Browse’ window as
described above. Then click [New] in the Button Bar or use the Ctrl-N
(Windows) or -N (Macintosh) keyboard shortcut. Alternatively, select an
Invoice similar to the one you want to enter and click [Duplicate] on the
Button Bar.
The ‘Invoice: New’ window is opened, empty if you clicked [New] or with a
copy of the copied Invoice. In the case of the copy, the Invoice and
Transaction Dates of the new Invoice will be the current date, not the date of
the copied Invoice, and the Due Date will be recalculated accordingly.
Complete the Invoice record as described below, then save it using the [Save]
button and close the window by clicking the close box. Then, close the
browse window using the close box again.
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!

You are not bound by the values
suggested by FirstOffice. For most
fields you can change the pre-set
values into something that suits you
better. Such changes are valid only
for the Invoice in question.

Since the amount of information stored about each Invoice will not fit on a
single screen, the Invoice window has been divided into three cards. At the
top of each is the header. This contains the Invoice Number, the Customer
Number and Name. At the bottom of the screen is the footer, which contains
various totals. There are three named buttons (‘tabs’) in the header.

By clicking the tabs you can navigate between cards. The header is always
visible, as a reminder of the Customer whose Invoice you are working with.
Header

No.

The Invoice Number of a new Invoice is provided
automatically by FirstOffice following on from the
Number of the last Invoice entered.
When you start using FirstOffice, the Invoice Number
sequence will start at 1 and continue consecutively. If
you want the sequence to start from another number,
change the Number of the first Invoice: FirstOffice will
then continue the sequence from there. You can then
change the Number of any subsequent Invoice if you
want to use another number sequence. Note that you
must change the Invoice Number before you save the
Invoice: it cannot be changed afterwards.

Customer

Paste Special

Customers in Customer register

Enter the Customer Number or use the ‘Paste Special’
function. When you press Return, the Customer’s name,
302

Chapter 7: Transaction Registers - Invoices

address and other information will be entered into the
appropriate fields.
Name

The Customer Name is entered after you have entered
the Customer Number.

Terms Card

Invoice Date

Paste Special

Choose date

The current date according to the computer’s clock is
entered as a default. If you are not using the Allow
Trans. Date Changing option in the Transaction Settings
setting, this must be the same as the Invoice Date and
cannot be changed independently.
Our Ref.

Use this field if you need to identify the Invoice by
means other than the Invoice Number. A default will be
taken from the Our Ref field of the Person record of the
current user.

Payment Terms

Paste Special

Payment Terms setting

Default taken from

Customer (Sales Pay Terms)

Payment Terms entered here will be used to calculate the
Due Date (below), in addition simply to ensuring that the
correct Payment Terms appear on the printed Invoice
document.
Specifying Payment Terms for each Invoice provides the
basis for the debt-chasing reports provided in
FirstOffice.
Payment Terms are also the means by which Cash Notes
and Credit Notes are distinguished from ordinary
Invoices. Using ‘Paste Special’, select a Payment Term
record of the “Cash” or “Credit Note” type respectively.
When the record is then approved and saved, the
appropriate Nominal Ledger Transaction will be created.
In the case of Cash Notes, this will debit the Cash
Account (as specified in the Payment Term record or in
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the Account Usage S/L setting) rather than the Debtor
Account, while in the case of Credit Notes, the
Transaction will be a reversal of the original Invoice
Transaction.
Cash Notes are immediately treated as paid and so will
not appear in your debtor reports. There is no need to
enter a payment against them. If you need to reverse a
Cash Note, use a negative Cash Note, not a Credit Note.
When you select a Payment Term of the “Credit Note”
type, a crediting message will be entered in the first row
of the grid area. Enter the number of the Invoice to be
credited, using ‘Paste Special’ if necessary to bring up a
list of open (unpaid) Invoices.
If an Invoice has a “Cash” or “Credit Note” Payment
Term, the Invoice will not use the standard Invoice
document when printed. Instead, the Cash Note or Credit
Note (respectively) document will be used. Please refer
to the ‘Printing Invoices’ section below on page 311 for
more details.
Attn.

Paste Special

Contact Person register

Default taken from

Customer

Record here the person for whose attention the Invoice is
to be marked.
Due Date

Paste Special

Choose date

This is calculated by FirstOffice using the Invoice Date
and the Payment Terms. It is the date on which the
Invoice becomes due for payment.
Trans. Date

The Transaction Date for the Nominal Ledger
Transaction. This is always the same as the Invoice Date
and cannot be changed independently.

Service Del. Date Paste Special

Choose date

The date the Items on the Invoice were delivered. The
Invoice Date will be placed here when you save the
Invoice for the first time. You can change the date if
necessary. If you created the Invoice by duplicating a
previous one, this date will not be changed to the current
date (as will happen with the Invoice Date).
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Official Ser. No.

In some countries it is a legal requirement to allocate an
official serial number to each Invoice. This number may
be supplied pre-printed on Invoice stationery.

Items Card
Use the grid on the ‘Items’ card to list the invoiced Items. To add rows to an
Invoice, click in any field in the first blank row and enter appropriate text. To
remove a row, click on the row number on the left of the row and press the
Backspace key. To insert a row, click on the row number where the insertion
is to be made and press Return.
You can also bring Items into an Invoice by opening the ‘Items: Browse’
window, selecting a range of Items by clicking while holding down the Shift
key, and then dragging them to the Item field in the first empty Invoice row.
You can also copy a list of Item Numbers from a spreadsheet or word
processor and paste them in the Item field in the first empty row.

Item

Paste Special

Item register

With the cursor in this field, enter the Item Number for
each Item sold. Pricing, descriptive and other
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information will be brought in from the Item record. If
you leave this field blank, you can enter any text in the
Description field, perhaps using the row for additional
comments to be printed on Invoice documentation.
Qty.

Enter the number of units sold. Press Return to calculate
the Sum, and the cursor will move to the Item field on
the next row.
You must specify a Quantity before a Sum can be
calculated for the Invoice row.

Description

Default taken from

Item

This field shows the name of the Item, brought in from
the Item register. If you want to add an extra description,
you can do so: there is room for up to 100 characters of
text. You can also use the next line if necessary.
Unit Price

The Unit Price according to the valid Price List for the
Customer is brought in. If the Customer has no Price List
specified, or the Item is not on the Price List in question,
the Price from the Item record is brought in. This figure
will include VAT if the Price List specified is one that is
Inclusive of VAT or if you have specified in the Account
Usage S/L setting that Prices include VAT.

%

Discount percentage. It can be changed to an adhoc rate
if necessary.

Sum

The total for the row: Quantity multiplied by Unit Price
less Discount. Changing this figure will cause the
Discount Percentage to be recalculated. This figure will
include VAT if the Price List specified is one that is
Inclusive of VAT or if you have specified in the Account
Usage S/L setting that Prices include VAT.

V-Cd

Paste Special

VAT Codes setting

The VAT Code entered here determines the rate at which
VAT will be charged on this Item and the Output VAT
Account to be credited. A default is offered, taken from
the Item record. If none is specified, the default is taken
from the Account Usage S/L setting. You can change
this default in a particular Invoice row if necessary.
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Footer

The Invoice Footer contains various running totals as described below.
Whenever an Invoice row is added or changed, these totals are updated.
OK

Checking this box approves the Invoice and causes it to
be entered in the Sales Ledger. A corresponding
Nominal Ledger Transaction will also be created in the
Transaction register. Because of this consequence, once
this box has been checked and the Invoice saved, you
will no longer be able to make changes to the Invoice.
References in this manual to approved Invoices are to
Invoices whose OK check box has been switched on.

VAT

The VAT total for the Invoice.
This figure is rounded up or down according to rounding
rules set in the Round Off setting. In the Nominal Ledger
Transaction resulting from this Invoice, any amounts lost
or gained in this rounding process are posted to the
Round Off Account specified in the Account Usage S/L
setting.

Sub-Total

The total for the Invoice, excluding VAT.

TOTAL

The total for the Invoice, including VAT.
This figure is rounded up or down according to rounding
rules set in the Round Off setting. In the Nominal Ledger
Transaction resulting from this Invoice, any amounts lost
or gained in this rounding process are posted to the
Round Off Account specified in the Account Usage S/L
setting.

307

HansaWorld FirstOffice Start

Address Card

Address

Default taken from

Customer

The Customer’s address, as entered in the Customer
record. If you need to change something for this Invoice
only, you can do so. Permanent changes should be made
in the Customer register.
VAT Zone

Default taken from

Customer

These radio buttons show the Zone for this Customer,
brought in from the Customer record. The Account
Usage S/L setting allows different defaults for the Sales
Account and the VAT Account to be set up for each
Zone. The setting cannot be changed for this Invoice:
any change should be made in the Customer register
before entering Invoices.
When all Items have been entered, you may want to check the Invoice. Click
the [Save] button to save it and then click the Printer icon in the Button Bar
to print a sample Invoice document. If you want to print to screen, click the
Preview icon.
You will still be able to make changes until you approve the Invoice by
clicking the OK check box. When this is done and the Invoice saved once
again, it will be entered to the Sales Ledger, a Nominal Ledger Transaction
for the Invoice will be created and it will no longer be modifiable.
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Entering an Invoice - Examples
We shall now show how to use the various fields on the Invoice screen with
the help of a few examples.
Open the Invoice register using the button in the Master Control panel. The
‘Invoice: New’ window is shown, with Invoice Number and Date entered.
The cursor is already in the Customer Number field. Press Ctrl-Return
(Windows and Linux) or -Return (Macintosh) to activate the ‘Paste
Special’ feature. This brings up the ‘Paste Customer’ window.
Select a Customer from the list by double-clicking on its name (or by using
the cursor keys and pressing Return). Press Return again and Customer
information such as Name and Address is placed in the appropriate fields on
the Invoice screen.
Press Return again to move the insertion point to the Item field, the top lefthand field in the Invoice rows grid. Again, you can use ‘Paste Special’ to
select an Item. Select an Item by double-clicking. Press Return to bring
information such as the Item Name, Price and VAT Code.
Then, enter the Quantity sold and press Return. The Amount, Tax, Sum and
Totals are calculated automatically, and the insertion point moves to the next
line. Repeat this procedure for each Item on the Invoice.
If the Invoice needs altering, edit the fields in the normal way. As the Invoice
has not been saved, you can also cancel the Invoice entirely by clicking
[Cancel] or the close box. In that case you will be asked to confirm the
cancellation—

If the Invoice had been saved, but not approved, you would still be able to
cancel it completely, using ‘Delete’ on the Record menu.
When you have added all the Items, you may want to check the Invoice.
Click the [Save] button to save it and then click the Printer icon in the Button
Bar to print a sample copy. If you want to print to screen, click the Preview
icon.
Until you have approved the Invoice by checking the OK box and saving,
you can still change it.
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Inspecting and Approving Invoices
Before you send an Invoice to a Customer, you should check and approve it,
to ensure that the Customer is charged for the correct things. Approving an
Invoice causes it to be inserted into your Sales Ledger.
When you approve and save an Invoice, a transaction will be created and
automatically transferred to the Nominal Ledger. This transaction will be
assigned a journal number that is the same as the Invoice Number.
The Sales Ledger is organised so that incoming payments can only be
registered against approved Invoices. There are two ways to approve an
Invoice—
1.

With the Invoice on screen, click the OK check box and then [Save].

2.

Select an Invoice by clicking on it in the ‘Invoices: Browse’ window,
and select ‘OK’ on the Operations menu. By holding down the Shift key
you can highlight a batch of Invoices to approve at a single stroke using
this method.

!

After approving an Invoice, you will
no longer be able to change it.

Nominal Ledger Transactions from Invoices
When you approve and save an Invoice, a Nominal Ledger Transaction will
be generated automatically. Please refer to page 132 in Chapter 3,
‘Accounting Principles’, for full details of this Transaction.
Once the Transaction has been generated, you can look at it straight away
using the ‘Open NL Transaction’ function on the Operations menu.

Error Messages
When you approve Invoices, Transactions are automatically generated and
put in your Nominal Ledger journal.
An error message will appear if an Account or other setting is incorrect. All
Account numbers used by the Invoice, which will have been offered as
defaults from the Account Usage S/L setting, Items or Customers, must exist
in the Accounts setting. The VAT Codes used must be defined.
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While the Invoice is still on screen, you can correct the error, by adding the
missing Account(s) to the Accounts setting or by changing the Account used
in the Invoice.
The program cannot post transactions to non-existent Accounts, to prevent
accounting errors.

Printing Invoices
There are several occasions when you may want to print an Invoice: to view a
test print-out to check the Invoice before you finally approve it; to produce a
copy for your own files, or to send the original Invoice to the Customer.
To do a test print-out, save the Invoice and then click on the Printer icon in
the Button Bar before you approve the Invoice. The Invoice will then be
printed with the text “Test Printout” diagonally printed across the page. This
is to avoid the test being confused with the final version. As you have not yet
approved the Invoice by checking the OK box, you can go back and correct
any errors you may find in the printout. This is also true for Credit Notes.
If you want to print a range of final Invoices, follow the instructions below—
1.

Select ‘Documents’ from the File menu or click the [Documents] button
in the Master Control panel. Then, double-click ‘Invoices’ in the
‘Documents’ list.
The ‘Specify Invoices’ window is shown.
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2.

Enter the Invoice Number for a single Invoice, or the highest and lowest
Invoice Numbers of a range of Invoices separated by a colon (:). Use the
Status options to specify which Invoices are to be printed—

Unprinted Only

This option ignores any Invoices in the range that have
already been printed.

All

Prints all Invoices in the range. Any Invoices previously
printed will have the word “Copy” printed diagonally
across the page.

Original Print

This option also prints all Invoices in range. However,
any Invoices previously printed will be printed again as
though they were original copies, without the word
“Copy”.

Use the Invoice Type check boxes to limit your selection to specific
kinds of Invoice, as described in step 6 below.
3.

Press [Run] in the Button Bar to start the printing, or cancel by closing
the window.

You can also print a single Invoice by clicking on the Printer icon when that
Invoice is shown on the screen. If you want to print to screen, click the
Preview icon.
If you specified in the Invoice Form that several copies are to be printed,
perhaps on different printers, these copies will only be printed the first time
you print an Invoice after approving it. If you print the Invoice again, or print
it before you have approved it, only one copy will be printed. If you need to
print all copies again, you must print the Invoice using the ‘Documents’
function on the File menu, and you should choose the Original option.
Whichever method is used, the Form used is determined as follows—
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1.

Using the Forms setting, design the invoice form and name it
“INVOICE”. Use the ‘Properties’ function on the Operations menu to
assign a Document Type of “Invoice”. A sample Invoice Form is
supplied with FirstOffice: this can be modified to suit your requirements.
Full instructions for using the Forms setting can be found on page 222 in
Chapter 5, ‘Settings’.

2.

Click [Documents] in the Master Control panel or select ‘Documents’
from the File menu. The ‘Documents’ list window is opened: highlight
‘Invoices’.
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3.

Select ‘Define Document’ from the Operations menu.

4.

In the subsequent window, enter “INVOICE” in the Form field of the
first row (you can use ‘Paste Special’ to ensure the spelling is correct).

5.

Click [Save] to save the Invoice Form definition. From now on, the
invoice form that you have designed will be used from the ‘Documents’
function and from the Printer icon, except as described in step 6 below.
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6.

Repeat the previous six steps in turn for the Cash Note and Credit Note
documents. These will be used from the ‘Documents’ function and the
Printer and Preview icons instead of the standard Invoice document in
the following circumstances—

Cash Note

If the Invoice has Payment Terms of the “Cash” type, the
Cash Note document is always used instead of the
Invoice document.

Credit Note

If the Invoice has Payment Terms of the “Credit Note”
type, the Credit Note document is always used instead of
the Invoice document.

In each of the two cases described above, if the document does not have
an associated Form (steps 3-5 above), FirstOffice will give the warning
“Can’t find document”. If you get this warning, check the type of the
Invoice before looking to see which document is missing its Form.

Cash Notes
A Cash Note is an Invoice that is to be treated as being paid. It differs from a
normal Invoice in that it does not affect your Debtor Account or appear on
any of your debt-chasing reports: instead, a debit posting for the Invoice
value is made directly to your Cash Account.
To enter a Cash Note, follow the procedure described above for entering
Invoices, with just one exception: change the Payment Terms (using the
‘Paste Special’ function if necessary) to refer to a Payment Term record of
“Cash” type. You can register such a Payment Term against Customers that
are always issued with Cash Notes (in the Customer register), so that you
don't have to make this change every time.
Click the OK check box when you are sure the Cash Note is correct. As with
ordinary Invoices, you must approve Cash Notes by checking the OK check
box and saving, for them to be entered into the Sales Ledger and for Nominal
Ledger Transactions to be created.

Credit Notes
If you want to credit an Invoice that you have issued, you should do as
follows—
1.
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Click [Invoices] in the Master Control panel. The ‘Invoices: Browse’
window is opened, showing all registered Invoices.
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2.

Click [New] or enter the appropriate keyboard command. Alternatively,
find the Invoice to be credited in the list, highlight it and click
[Duplicate].
The ‘Invoice: New’ window is opened as described above. Enter the
Invoice in the normal way, but change the Payment Terms to “CN”
(Credit). In the first row of the specification area, a crediting message is
entered. Enter the number of the Invoice to be credited, using ‘Paste
Special’ if necessary to bring up a list of open (unpaid) Invoices.
Note: this assumes a Payment Term record with a Code of “CN” and of
type “Credit Note” has been entered using the Payment Terms setting.

3.

On the remaining lines you can enter the items to credit, and by what
amount.

4.

Click the OK check box when you are sure the Credit Note is correct. As
with ordinary Invoices, you must approve Credit Notes using the OK
check box to be entered into the Sales Ledger and for Nominal Ledger
Transactions to be created.
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Crediting Part of an Invoice
Quite often you will need to credit only a part of an Invoice, rather than the
whole Invoice. In most accounting systems, it would be necessary first to
remove the entire original Invoice, and then to re-enter the Items that will be
invoiced.
Since most systems lack the option of copying an Invoice, part crediting can
sometimes take a very long time. FirstOffice offers a very simple and
intuitive way to do this.
To credit part of an Invoice, start by copying the original Invoice, and enter
“CN” in the Payment Terms field. Then proceed as follows—
1.

Simply remove all the rows you do not want to credit. Click on the row
number to the left to highlight the whole row, and press the backspace
key. You will then be left with the rows to credit.

2.

In the case of individual rows requiring a partial credit, simply alter the
Quantity field to show the number to be credited.

3.

Click the OK check box when you are sure the Credit Note is correct and
[Save] to save it.

Credit Notes and Cash Notes
If you need to reverse a Cash Note, you cannot follow the standard crediting
procedure described above. A Credit Note will credit the Debtor Account,
while reversing a Cash Note should credit the Cash Account. Instead you
should enter a new Cash Note (i.e. with a cash Payment Term) with a
negative value.

Operations Menu

The Operations menus for Invoices are shown above. On the left is the
Operations menu for the ‘Invoices: Browse’ window: highlight an Invoice in
the list before selecting the function. You can also apply the function to a
group of Invoices: highlight the first Invoice in the group and then click on
the last while holding down the Shift key. Then select the function. On the
right is the Operations menu for the ‘Invoice: New’ and ‘Invoice: Inspect’
windows.

316

Chapter 7: Transaction Registers - Invoices

OK
This command is available on the Operations menu only from the ‘Invoices:
Browse’ window. It allows you to approve an Invoice and is therefore the
equivalent of checking the OK box in an Invoice record. You can also select
several Invoices (hold down the Shift key to select a range of Invoices in the
list) and approve them all at once. Remember that this action causes
Transactions to be created for each Invoice in the selection and that therefore
once it has been carried out you will no longer be able to modify those
Invoices.
Invoice Status
This command creates a quick report, only available through this menu. This
report summarises all aspects of the Invoice, including Items and payment
history. In the illustration below, the Invoice in question has a Credit Note
against it.

In the Invoice History section, you can click on a transaction number (Invoice
Number or Credit Note Number in the example above) to view that Invoice,
Credit Note or Receipt. You can also click on the Customer Number to open
the Customer record.
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Open NL Transaction
When you approve and save an Invoice, a Nominal Ledger Transaction will
be created. This function allows you to view that Transaction.
On selecting the function, the Transaction will be opened in a new window.
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Receipts
As important as the invoicing itself is the filing of incoming payments in the
Receipts register. It is by keeping the Invoice and Receipt registers up to date
that you can operate an efficient debt-chasing system.

Entering a Receipt
To open the Receipt register, click the [Receipts] button in the Master
Control panel, or use the Ctrl-2 (Windows and Linux) or -2 (Macintosh)
keyboard shortcuts.

The ‘Receipts: Browse’ window is opened, showing Receipts already
entered.

Receipts are numbered consecutively. In the list, the Receipt Number is
followed by a check mark if the Receipt is approved, by the Date, any
Comment and the total value of the Receipt.
To enter a new Receipt, click [New] in the Button Bar or use the Ctrl-N
(Windows) or -N (Macintosh) keyboard shortcut. Alternatively, select a
Receipt similar to the one you want to enter and click [Duplicate] on the
Button Bar.
The ‘Receipt: New’ window is opened, empty if you clicked [New] or with a
copy of the copied Receipt. Complete the Receipt record as described below,
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then save it using the [Save] button and close the window by clicking the
close box. Then, close the browse window using the close box again.
The principle for entering a Receipt is that you know at least—
1.

How much has actually been received; and

2.

any extra fees charged by the bank.

First a run-through of the fields.
No.

The Serial Number of a new Receipt is provided
automatically by FirstOffice following on from the
Number of the last Receipt entered.
When you start using FirstOffice, the Serial Number
sequence will start at 1 and continue consecutively. If
you want the sequence to start from another number,
change the Number of the first Receipt: FirstOffice will
then continue the sequence from there. You can then
change the Number of any subsequent Receipt if you
want to use another number sequence. Note that you
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must change the Serial Number before you save the
Receipt: it cannot be changed afterwards.
Trans. Date

Paste Special

Choose date

The Transaction Date for the Receipt: the date when the
Receipt is posted to your Nominal Ledger.
Payment Mode

Paste Special

Payment Modes setting

The Payment Mode is the method of payment (e.g.
cheque, credit card or cash). It determines the Nominal
Ledger Account that will be debited by the Receipt.
On a single Receipt it is possible to enter payments from
different Customers against different Invoices. However,
it is not possible to enter payments across Payment
Modes.
Comment

Default taken from

Payment Mode

The text for the Payment Mode. This text may be
changed.
Use the grid area that takes up most of the screen to list the Invoices being
paid by the Receipt. A single Receipt can be allocated to several Invoices, but
all payments on a single Receipt must use the same Payment Mode. The
Payment Mode reflects not only the payment method (i.e. cheque, cash or
credit card) but also the Bank Account debited. So, all payments received in a
single day and paid into a particular Bank Account can be entered using a
single Receipt record.
Each record in the Receipt register results in one Nominal Ledger
Transaction, with bank or other institution as debit Account (taken from the
Payment Mode).
You can also bring Invoices into a Receipt by opening the ‘Invoices: Browse’
window, selecting a range of Invoices by clicking while holding down the
Shift key, and then dragging them to the Invoice No field in the first empty
Receipt row. You can also copy a list of Invoice Numbers in a spreadsheet or
word processor and paste them in the Invoice No field in the first empty row.

Flip A
Inv. No.

Paste Special

Open, approved Invoices,
Invoice register

The number of the Invoice being paid. When you enter
an Invoice Number, the Open Invoice Value (the amount
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outstanding) is shown, and this figure is also brought in
to the Received Value field as a default.
Note that when you use ‘Paste Special’, only unpaid
Invoices will appear in the selection list. However,
Invoices against which an unapproved Receipt has been
entered are treated as unpaid and thus will be listed.
Sorting the ‘Paste Special’ selection by Customer will
allow you quickly to find the Invoice that is being paid.
If the Receipt is an On Account Receipt from a
Customer with an account (marked using the On
Account box on the ‘Terms’ card of the Customer
screen) for which an Invoice has not yet been raised,
leave this field blank. This is fully described in the ‘On
Account Receipts’ section below on page 326.
Customer

Paste Special

Customers in Customer register

Default taken from

Invoice

Entered by FirstOffice when you enter an Invoice
Number.
Pay. Date

The date when the payment was made. If you are not
using the Allow Trans. Date Changing option in the
Transaction Settings setting, this date must be the same
as the Transaction Date (in the header) and cannot be
changed independently.

Text

FirstOffice will enter the Customer’s Name, as entered
in the Customer register. You may change this if you
wish.

Open Inv. Value The outstanding amount of the Invoice being paid. This
field cannot be changed.
Received Val

Default taken from

Outstanding amount on Invoice

The amount paid. You can change the default figure in
the event of partial payments or overpayments.

Flip B
VAT Code, VAT Value
These fields are only used if you are using the Post
Receipt VAT option in the Account Usage S/L setting.
This will be the case for users of the Cash VAT scheme
in the UK, and may be the case for users in Poland.
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If you are using the Post Receipt VAT option, your
output VAT liability is calculated from your Receipts,
not from your Invoices. In this case, the VAT Code and
VAT Value will be brought in to these fields
automatically when you enter an Invoice Number on flip
A (the VAT Code comes from the first row of the
Invoice). When you approve and save the Receipt, the
VAT amount will be moved from the temporary VAT
Output Account to the final one (the O/P Account), as
specified in the VAT Codes setting.
The Post Receipt VAT option also adds a VAT element
to On Account Receipts. Once again, the O/P Account
for the VAT Code is credited and the Output Account
for the VAT Code is debited with the VAT amount.
Take care with these fields when entering On Account
Receipts. As On Account Receipts do not have an
Invoice Number, you must enter a VAT Code manually
if you are using the Cash VAT scheme (i.e. if you are
using the Post Receipt VAT option). The VAT Value
will then be calculated from the Received Value. The
Nominal Ledger Transaction resulting from the Receipt
will not have a VAT element if the VAT Code or VAT
Value is blank.

Footer
OK

You can approve a Receipt by clicking this check box.
When you click [Save] to save the Receipt, the Bank
Account specified for the Payment Mode will be debited
and the Debtor Control Account of the Invoice(s) being
paid will be credited. No further modifications to the
Receipt will be possible.
References in this manual to approved Receipts are to
Receipts whose OK check box has been switched on.

Deposited

The sum of the Received Values: the total for this
Receipt.
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Checking and Approving Receipts
Before you approve a Receipt, you should check it to ensure that no mistakes
have been made in entering it to FirstOffice.
Once you have checked it, there are two ways to approve a Receipt—
1.

Click the OK check box with the Receipt on screen and then save it by
clicking [Save].

2.

Select a Receipt by clicking on it in the ‘Receipts: Browse’ window, and
select ‘OK’ on the Operations menu. By holding down the Shift key you
can highlight a batch of Receipts to approve at a single stroke using this
method.

The approval causes the Receipt to be inserted into your Sales Ledger. Except
when expressly instructed otherwise, only approved Receipts are shown in
the reports. Just as with Invoices, a Nominal Ledger Transaction is generated
and passed to the Nominal Ledger when the Receipt is approved.

!

After approving a Receipt, it cannot
be altered.

Nominal Ledger Transactions from Receipts
When a Receipt is approved and saved, a Nominal Ledger Transaction will
be generated automatically. Please refer to page 135 in Chapter 3,
‘Accounting Principles’, for full details of this Transaction.

Operations Menu

The Operations menus for Receipts are shown above. On the left is that for
the ‘Receipts: Browse’ window: highlight one or more Receipts (hold down
the Shift key while clicking) in the list before selecting the function. On the
right is that for the ‘Receipt: New’ and ‘Receipt: Inspect’ windows.
OK
This command is available on the Operations menu only from the ‘Receipts:
Browse’ window. It allows you to approve a Receipt and is therefore the
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equivalent of checking the OK box in a Receipt record. You can also select
several Receipts (hold down the Shift key to select a range of Receipts in the
list) and approve them all at once. Remember that this action causes
Transactions to be created for each Receipt in the selection and that therefore
once it has been carried out you will no longer be able to modify those
Receipts.
New Write-off
You can use this function to write off an Invoice. Specify the Invoice to be
written off and change the Received Value to zero. If you need to record a
partial payment and wish to write off the remainder, change the Received
Value to the value of the partial payment. Press Tab or Return (but make sure
the cursor is in the same row) and then, select this function. A new row will
be created, containing the phrase “Write off”. The Received Value field will
be set to the remaining outstanding amount (i.e. the amount that is to be
written off). This can be changed if you do not want to write off the whole of
the outstanding amount. Approve and save the Receipt in the usual way.
When the Nominal Ledger Transaction is created, the Write Off Account
specified in the Account Usage S/L setting will be debited.
New Fee
You should use this function when you need to pay bank charges.
Start by entering the Invoice number in the left-hand column. Then select
‘New Fee’ from the Operations menu. A new row will be created, containing
the phrase “Fee” and a zero amount. Change the Received Value in this new
row to the value of the bank charge. Approve and save the Receipt in the
usual way. When the Nominal Ledger Transaction is created, the Bank Fee
Account specified in the Account Usage S/L setting will be debited with the
value of the bank charge.
Open NL Transaction
When you approve and save a Receipt, a Nominal Ledger Transaction will be
created. This function allows you to view that Transaction.
On selecting the function, the Transaction will be opened in a new window.
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On Account Receipts
You can use On Account Receipts when you receive payments from
Customers without reference to specific Invoices (usually before you have
raised the Invoices). You can enter these payments to the Receipt register
without specifying an Invoice Number—
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For each Customer likely to pay deposits, switch on the On Account check
box on the ‘Terms’ card. Then specify a separate control or suspense Account
in the Account Usage S/L setting, using the On Account A/C field. In the
example illustration below, the special Account for on account Customers is
806, since receiving a Prepayment creates a liability. The Nominal Ledger
Transaction generated when an On Account Receipt is approved and saved
will credit the Received Value to this Account. The debit Account is taken
from the Payment Mode as usual—
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You can then connect the On Account Receipt to a subsequent Invoice, to
remove it from your Sales and Nominal Ledgers. First, enter and approve the
Invoice as normal and without reference to the On Account Receipt. You
must then register that the Invoice has been paid by the On Account Receipt.
You can do this in a Receipt record as a two-step process—

328

Chapter 7: Transaction Registers - Receipts

In order to update the Sales Ledger correctly, you must enter the payment
information twice as shown above: first as a normal row, and then with a
negative sign as an On Account Receipt. The example Periodic Customer
Statement below shows how the Invoice for 164.50 has been paid by the
earlier On Account Receipt of 1,000. The remainder of the On Account
Receipt is outstanding—
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In the Nominal Ledger, the Invoice is removed from the Debtor Account, and
the balance of the On Account A/C is reduced by the value of the Invoice—

Correcting Mistakes in Receipts
Even with the tightest quality control, it is probable that the occasional
mistake will be made when entering Receipts. Once you have approved a
Receipt, you cannot change it, but you can correct mistakes easily using the
following procedure. It is important that you follow this procedure, to ensure
the Customer’s payment history remains correct.
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1.

In the ‘Receipts: Browse’ window, highlight the Receipt with the error.

2.

Click [Duplicate]. A new Receipt record is created, containing the details
of that copied.

3.

Insert a minus sign in front of the Received Value, ensuring the Received
Value figure itself remains unchanged.

4.

Click the OK check box and save the Receipt.

5.

Enter a new, correct, Receipt.
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Purchase Invoices
The Purchase Invoice register is a record of your company’s purchases. Each
time you make a purchase, you will receive a Purchase Invoice from the
Supplier, which you should enter to the Purchase Invoice register. You will
therefore use this register is thus used for a number of tasks—
•

The Purchase Invoice is a record of the payment demanded from your
company by the Supplier;

•

Unpaid Purchase Invoices in the register provide the basis for your
creditor management reports; and

•

Each Purchase Invoice causes a Nominal Ledger Transaction to be
created, thus generating the overall purchase and creditor figures in your
monthly and yearly management reports. This creation process is
automatic, requiring no intervention or work from you.

Four types of purchase transaction can be recorded in the Purchase Invoice
register—
1.

Standard Purchase Invoices are received where the goods have been
delivered or work carried out before payment has been issued. Payments
against such Purchase Invoices should be recorded in the Payment
register, described below on page 345.

2.

The Cash Note represents the issuing of a payment at the same time as
the work is carried out. When a Cash Note is entered to the Purchase
Invoice register, FirstOffice will treat it as having being paid, so there is
no need to enter a separate payment record in the Payment register.
FirstOffice will also look after the Nominal Ledger implications for you
(crediting the Cash Account rather than the Creditor Account).

3.

A Deposit is the issuing of money before an Invoice has been received.
Deposits are treated as Cash Notes in FirstOffice.

4.

Credit Notes are used to correct mistakes in Purchase Invoices, or to
cancel Invoices that have been raised in error. They are, in effect,
negative Invoices that reduce your overall purchase and creditor figures.
Again, FirstOffice looks after these Nominal Ledger implications
automatically.

The use of the Purchase Invoice register, including each of these types of
purchase transaction, is now described in detail. Before you start entering
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Purchase Invoices, however, you must ensure that you have defined the
current (accounting) year, using the Fiscal Years setting. This is described on
page 220 in Chapter 5, ‘Settings’.
To open the Purchase Invoice register, click the [Purchase Inv] button in the
Master Control panel or use the Ctrl-3 (Windows and Linux) or  - 3
(Macintosh) keyboard shortcuts.

The ‘Purchase Invoices: Browse’ window is opened, showing Purchase
Invoices that have already been entered.

Purchase Invoices are given a unique internal identifying code, using a
consecutive numbering system. This is in addition to any number allocated to
the Invoice by the issuer (the Supplier). The internal number is shown in the
left-hand column, followed by a check mark (if the Purchase Invoice is
approved), the Supplier’s Invoice Number, the issue date and finally by the
Supplier Number and Name. Credit Notes have the letter “C” in the Name
column, after the Supplier’s Name.
As in all browse windows you can change the sort order by clicking on the
column headings. To reverse any sort, simply click once again on the column
heading. You can also scroll the list with the scroll bars. Finally, you can
search for a record by entering a keyword in the field at the bottom left
corner. FirstOffice will search for the first record matching the keyword in
the same column as the selected sorting order.
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Entering a Purchase Invoice
To enter a new Purchase Invoice, open the ‘Purchase Invoices: Browse’
window as described above and click [New] in the Button Bar or use the CtrlN (Windows) or  -N (Macintosh) keyboard shortcut. Alternatively,
highlight a Purchase Invoice similar to the one you want to enter and click
[Duplicate] on the Button Bar.
The ‘Purchase Invoice: New’ window is opened, empty if you clicked [New]
or with a copy of the copied Purchase Invoice. In the case of the copy, the
Invoice and Transaction Dates of the new Purchase Invoice will be the
current date, not the date of the copied Purchase Invoice, and the Supplier
Invoice Number will not be copied. Complete the Purchase Invoice record as
described below, then save it using the [Save] button and close the window
by clicking the close box. Then, close the browse window using the close box
again.

No.

The number of the Invoice in your Purchase Ledger is
provided automatically by FirstOffice following on from
the Number of the last Purchase Invoice entered. Note
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that this is not the number given to the Invoice by the
Supplier but a unique identifier that is used by
FirstOffice whenever it is necessary to refer to the
Invoice.
When you start using FirstOffice, the Purchase Invoice
Number sequence will start at 1 and continue
consecutively. If you want the sequence to start from
another number, change the Number of the first Invoice:
FirstOffice will then continue the sequence from there.
You can then change the Number of any subsequent
Invoice if you want to use another number sequence.
Note that you must change the Invoice Number before
you save the Purchase Invoice: it cannot be changed
afterwards.
Invoice Date

Paste Special

Choose date

This date, together with the Payment Terms, will
determine when the Invoice will become due for
payment. The date of the previous Purchase Invoice
entered is used as a default.
Trans. Date

Paste Special

Choose date

The Transaction Date for the Nominal Ledger
Transaction. You may thus separate Invoice and
Transaction Dates in your ledger. It determines the
accounting period for the Invoice.

!
Supplier

If you enter different Invoice and
Transaction Dates, there will be a
timing difference between the
Purchase and Nominal Ledgers so
long as the Invoice remains unpaid.
This will be apparent when
comparing the Aged Creditors report
with the Creditor Control Account.
Paste Special

Suppliers in Customer register

Enter the Supplier Number or use the ‘Paste Special’
function. When you press Return, the Supplier’s name,
address and other information will be entered into the
appropriate fields.
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Name

The Supplier’s Name is entered after you have entered
the Supplier Number.

TOTAL

The total amount to pay for this Invoice, including any
taxes. Before you can save the Purchase Invoice, this
figure must equal one of the following, depending on the
Zone of the Invoice—

Domestic, Inside EU (Post VAT) and Outside EU (Post VAT)
the sum of the Amounts of the rows plus VAT
before the Purchase Invoice can be saved.
Inside EU

the sum of the Amounts of the rows.

Outside EU

the sum of the Amounts of the rows. No VAT is
calculated in this case.
The Zone is taken from the Customer record for the
Supplier.

VAT

Enter the VAT amount from the Purchase Invoice.
There is no need to enter a figure to this field, but if you
do enter one, it should equal the VAT sum for each row
(shown in the Calculated VAT field in the footer) before
you can save the Purchase Invoice. This field therefore
provides a control figure.
If the Invoice is from the Inside EU or Outside EU
Zones, you should leave this field blank. In the case of
the Inside EU Zone, VAT is calculated using the VAT
Code of each row and is shown in the Calculated VAT
field in the footer.

Supp. Inv. No.

The Supplier’s invoice number.

Bank A/C

Default taken from

Customer

The Supplier’s bank account number is brought in from
the ‘Account’ card of the Customer record for the
Supplier. If necessary, it can be changed to allow
payment to be sent to a different account.
Pay. Terms

Paste Special

Payment Terms setting

Default taken from

Customer (Purch. Pay Terms)

Payment Terms entered here will be used to calculate the
Due Date (below).
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Payment Terms are also the means by which Cash Notes
and Credit Notes are distinguished from ordinary
Invoices. Using ‘Paste Special’, select a Payment Term
record of the “Cash” or “Credit Note” type respectively.
When the record is then approved and saved, the
appropriate Nominal Ledger Transaction will be created.
In the case of Cash Notes, this will credit the Cash
Account (as specified in the Payment Term record or in
the Account Usage P/L setting) rather than the Creditor
Account, while in the case of Credit Notes, the
Transaction will be a reversal of the original Invoice
Transaction.
Cash Notes are immediately treated as paid and so will
not appear in your creditor reports. There is no need to
enter a Payment against them. If you need to reverse a
Cash Note, use a negative Cash Note, not a Credit Note.
When you select a Payment Term of the “Credit Note”
type, enter the number of the Invoice to be credited in
the Credit of Inv. field, using ‘Paste Special’ if necessary
to bring up a list of open (unpaid) Invoices.
Credit of Inv.

Paste Special

Unpaid Purchase Invoices

If you are entering a Purchase Credit Note, (a “debit
note”) enter here the number of the Purchase Invoice
being credited. The Purchase Invoice being credited
cannot itself be a credit note.
Remember to specify a Payment Term of type “Credit
Note” in the Payment Terms field: you must leave the
Credit of Inv. field blank when the Payment Term is of
any other type.
Due Date

The last day for payment of this invoice, calculated by
FirstOffice using the Invoice Date and the Payment
Terms. You can change the Due Date, even after the
Invoice has been approved. If you receive an extended
credit time for this Invoice, it will be re-scheduled in
your Purchase Ledger.

VAT Zone

Default taken from

Customer

This information is taken from the Customer record for
the Supplier, and indicates the origin of the Supplier.
The selection of a VAT Code for each row depends on
the Zone of the Supplier. The Zone cannot be changed
336

Chapter 7: Transaction Registers - Purchase Invoices

for an individual Invoice: any change should be made in
the Customer register before entering Invoices.
VAT is calculated as follows—
Domestic, Inside EU (Post VAT) and Outside EU (Post VAT)
VAT is calculated using the VAT Code of each
row. In any Nominal Ledger Transaction
resulting from the Invoice, VAT is debited to the
Input Account from the VAT Code and credited
to the Creditor Account.
Inside EU

Invoices received from other countries in the EU
do not carry VAT. However, depending on the
nature of the Invoice, VAT can be payable.
VAT is calculated using the VAT Code of each
row. In any Nominal Ledger Transaction
resulting from the Invoice, VAT is debited to the
Input Account from the VAT Code and credited
to the Output Account from the VAT Code.
Therefore, it is recommended that a dedicated
VAT Code be used for VAT on EU Acquisitions,
with an Output Account that is not used in any
other VAT Code.
It is usually recommended that you leave the
VAT field in the header empty when entering
Purchase Invoices from inside the EU.

Outside EU

VAT is not calculated. Any Nominal Ledger
Transaction resulting from the Invoice will not
include a VAT element.

The remainder of the Purchase Invoice screen contains a grid that you can use
to list the Purchase Invoice Items and Costs. To add rows to a Purchase
Invoice, click in any field in the first blank row and enter appropriate text. To
remove a row, click on the row number on the left of the row and press the
Backspace key. To insert a row, click on the row number where the insertion
is to be made and press Return.
Account

Paste Special

Accounts setting

Specify the Cost Account to be debited by the Purchase
Invoice. Enter an Account number and press Enter. The
Account name will be entered automatically to the
Description field.
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If the Customer record for the Supplier has a Cost
Account specified on the ‘Account’ card, this will be
entered as a default.
You can also enter the Code of an Autotransaction to
this field. Autotransactions are used to automate the
entry of frequently used Transactions, not only reducing
labour but also ensuring the correct Accounts are used
every time. Autotransactions are fully described on page
198 in Chapter 5, ‘Settings’.
Description

Default taken from

Account

The Account name is entered automatically. The text can
be changed.
Amount

The amount to be debited to the Cost Account.
A convenient way of quickly entering the correct value
is to move the cursor into the field and then to press the
Enter or Return key. FirstOffice will enter the correct
value to balance the Invoice, taking the TOTAL and any
previous rows into account.

V-Cd

Paste Special

VAT Codes setting

The VAT Code entered here will determine the rate at
which VAT will be charged on this Item and the Input
VAT Account to be debited.
A default is offered, depending on the Zone of the
Supplier. If the Supplier is in the Domestic Zone, the
VAT Code will be taken from the Account record or, if
none is specified there, from the Account Usage P/L
setting. Otherwise, the VAT Code will be that of the
appropriate Zone specified in Account Usage P/L (that
of the Account will be ignored).
OK

When you check this box and save the record by clicking
[Save], the Purchase Invoice will be approved and
entered into the Purchase Ledger, and a corresponding
Transaction will be created in the Nominal Ledger.
Because of these consequences, you will no longer be
able to make changes to the Purchase Invoice except to
the Due Date field.
References in this manual to approved Purchase Invoices
are to Purchase Invoices whose OK check box has been
switched on.
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Calculated VAT The VAT sum, calculated from the Purchase Invoice
rows. This figure is calculated automatically as you add
rows to the Purchase Invoice.
This figure is rounded up or down according to rounding
rules set in the Round Off setting. In the Nominal Ledger
Transaction resulting from this Purchase Invoice, any
amounts lost or gained in this rounding process are
posted to the Round Off Account specified in the
Account Usage S/L setting.

Entering a Purchase Invoice - Example
We shall now show how to use the various fields on the Invoice screen with
the help of a few examples.
Open the Purchase Invoice register using the button in the Master Control
panel. When the ‘Purchase Invoices: Browse’ window appears, click the
[New] button. The ‘Purchase Invoice: New’ window is shown, with internal
Invoice Number entered. Enter the Invoice Date as shown on the Invoice and
press the Return key twice. The Invoice Date is copied to the Transaction
Date field. In almost all cases, these two dates should be the same otherwise
your Creditor Account may differ from your Aged Creditor report. The
insertion point is now in the Supplier Number field. Press Ctrl-Return
(Windows) or -Return (Macintosh): this brings up the ‘Paste Supplier’
window.
Select a Supplier from the list by double-clicking on its name (or by using the
cursor keys and pressing Return). Press Return again and Supplier
information such as Name and Address is placed in the appropriate fields on
the Purchase Invoice screen.
The insertion point should now be in the TOTAL field. Enter the total
amount payable (inclusive of tax), and, in the VAT field, the tax amount (this
latter is optional). Press Return again to move the insertion point to the
Supplier Invoice Number field, and enter the number.
Continue and enter the accounting information. Move the insertion point to
the Account Number field of the first row in the grid area, and enter the
Account Number. Use the ‘Paste Special’ function to get access to the Chart
of Accounts, from which the appropriate Account can be chosen: search
among the Accounts in the normal way, by Number or by Name. On pressing
Return, the insertion point will move to the Description field. Press Return
once again and enter the row amount (excluding VAT).
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When you have added all the items and have checked the Invoice, approve it
by checking the OK box. When you save it, it will be committed to the
Purchase Ledger.
Save the Invoice by clicking [Save] or [New]: use the latter option to
continue with the next invoice. The TOTAL field must equal one of the
following before you can continue, depending on the Zone of the Invoice—
Domestic, Inside EU (Post VAT) and Outside EU (Post VAT)
the sum of the Amounts of the Invoice rows plus the
VAT.
Inside EU

the sum of the Amounts of the rows.

Outside EU

the sum of the Amounts of the rows. No VAT is
calculated in this case.

If this is not the case, FirstOffice will display the error message: “Transaction
out of balance”.
Until you have approved the Invoice by checking the OK box and saving,
you can still change it.

Inspecting and Approving Purchase Invoices
If you did not approve a Purchase Invoice when you entered it, you must
approve it at a later time in order to commit it to the Purchase Ledger, and for
the Nominal Ledger Transaction to be generated. Approval also causes the
Invoice record to be locked, so that it cannot be altered after this point.
Payments can only be issued against approved Purchase Invoices.
There are two ways to approve an Invoice—
1.

When viewing a Purchase Invoice, click the OK check box; or

2.

Highlight one or more Invoices in the ‘Purchase Invoices: Browse’
window and select ‘OK’ from the Operations menu.

Nominal Ledger Transactions from Purchase Invoices
When you approve and save a Purchase Invoice, a Nominal Ledger
Transaction will be generated automatically. Please refer to page 136 in
Chapter 3, ‘Accounting Principles’, for full details of this Transaction.
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Error Messages
When you approve Purchase Invoices, Nominal Ledger Transactions are
automatically generated and put in your Nominal Ledger journal.
An error message will appear if an Account or other setting is incorrect. All
Account numbers used by the Purchase Invoice, which may have been
offered as defaults from the Account Usage P/L setting or the Supplier, must
exist in the Accounts setting. The VAT Codes used must be defined.
While the Purchase Invoice is still on screen, you can correct the error, by
adding the missing Account(s) to the Accounts setting or by changing the
settings accordingly.
The program cannot post transactions to non-existent Accounts, to prevent
accounting errors.

Crediting Purchase Invoices
If you want to credit a Purchase Invoice that has been sent to you, follow
these steps—
1.

Create a new Purchase Invoice record, or copy the Purchase Invoice you
want to credit. Copying will ensure that the correct Purchase Account
will be credited.

2.

Fill in the data in the normal way, but change the Payment Terms to
“CN” and enter the number of the credited Invoice in the Credit on Inv.
field. Use ‘Paste Special’ from this field to search for the correct
Purchase Invoice Number.
Note: this assumes a Payment Term record with a Code of “CN” and of
type “Credit Note” has been entered using the Payment Terms setting.

3.

When you approve and save the Invoice, the Purchase Ledger will be
updated, and a new Nominal Ledger Transaction will be generated.

Credit Notes and Cash Notes
If you need to reverse a Cash Note, you cannot follow the standard crediting
procedure described above. A Credit Note will debit the Creditor Account,
while reversing a Cash Note should debit the Cash Account. Instead you
should enter a new Cash Note (i.e. with a cash Payment Term) with a
negative value.
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Operations Menu

The Operations menus for Purchase Invoices are shown above. On the left is
that for the ‘Purchase Invoices: Browse’ window: highlight one or more
Purchase Invoices (hold down the Shift key while clicking) in the list before
selecting the function. On the right is that for the ‘Purchase Invoice: New’
and ‘Purchase Invoice: Inspect’ windows.
OK
This command is available on the Operations menu only from the ‘Purchase
Invoices: Browse’ window. It allows you to approve a Purchase Invoice and
is therefore the equivalent of checking the OK box in a Purchase Invoice
record. You can also select several Purchase Invoices (hold down the Shift
key to select a range of Purchase Invoices in the list) and approve them all at
once. Remember that this action causes Nominal Ledger Transactions to be
created for each Purchase Invoice in the selection and that therefore once it
has been carried out you will no longer be able to modify those Purchase
Invoices.
Invoice Status
This command creates a quick report, only available through this menu. This
report summarises all aspects of the Invoice, including Accounts and
payment history.
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In the Invoice History section showing the payment history, you can doubleclick on a transaction number (Purchase Invoice Number, Credit Note
Number or Payment Number) to view that Invoice, Credit Note or Payment.
Balance
Before you can save a Purchase Invoice, the amount in the VAT field in the
header must equal that in the Calc VAT field (which contains the VAT sum
of the Invoice rows), and the TOTAL field must equal the sum of the
Amounts of the Invoice rows plus the VAT. If this is not the case, an error
message ‘Transaction out of balance’ will appear when you try to save. You
can then use this function to balance the figures.
Before you use the function, you should place the cursor either in the TOTAL
field in the header or in the Amount field of one of the Purchase Invoice
rows. Selecting the function will cause the field containing the cursor to be
adjusted so that the Purchase Invoice balances, allowing it to be saved.
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Open NL Transaction
When you approve and save a Purchase Invoice, a Nominal Ledger
Transaction will be created. This function allows you to view that
Transaction.
On selecting the function, the Transaction will be opened in a new window.
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Payments
Use this register to issue Payments to creditors. Keeping the Purchase Invoice
and Payment registers up to date will allow you to operate an efficient system
for paying your Suppliers and will help you to predict your cash flow
accurately.

Entering a Payment
To open the Payment register, click the [Payments] button in the Master
Control panel or use the Ctrl-4 (Windows and Linux) or -4 (Macintosh)
keyboard shortcuts.

The ‘Payments: Browse’ window is opened, showing Payments already
entered.

Payments are numbered consecutively. In the list, the Payment Number is
followed by check marks if the Payment has been Ordered or approved, by
the Transaction Date, the bank account number from which the Payment was
issued and the total amount of the Payment.
To enter a new Payment, click [New] in the Button Bar or use the Ctrl-N
(Windows) or -N (Macintosh) keyboard shortcut. Alternatively, select a
Payment similar to the one you want to enter and click [Duplicate] on the
Button Bar.
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The ‘Payment: New’ window is opened, empty if you clicked [New] or with
a copy of the copied Payment. Complete the Payment record as described
below, then save it using the [Save] button and close the window by clicking
the close box. Then, close the browse window using the close box again.
The principle for entering a Payment is that you know the following—
1.

How much has actually been withdrawn; and

2.

any extra fees charged by the bank.

FirstOffice provides several shortcuts to simplify your work entering
Payments. You can for example bring a date into a date field using the ‘Paste
Special’ function (Windows users should press Ctrl-Enter, Macintosh users
-Enter). You can also use this function to simplify the entering of Supplier
Numbers, Payment Modes etc. When a transaction window is open for data
entry, you also have the Operations menu available. This menu is explained
in the following sections.
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First, a run-through of the fields.
No.

The Serial Number of a new Payment is provided
automatically by FirstOffice following on from the
Number of the last Payment entered.
When you start using FirstOffice, the Serial Number
sequence will start at 1 and continue consecutively. If
you want the sequence to start from another number,
change the Number of the first Payment: FirstOffice will
then continue the sequence from there. You can then
change the Number of any subsequent Payment if you
want to use another number sequence. Note that you
must change the Serial Number before you save the
Payment: it cannot be changed afterwards.

Pay Date

Paste Special

Choose date

The date when you want the Payment to be executed.
After you have Ordered a Payment, you can still change
the Payment Date. After approval, however, no further
changes are possible.
Trans. Date

The date of the Nominal Ledger Transaction resulting
from this Payment. This date is always the same as the
Payment Date and cannot be changed independently.

Pay Mode

Paste Special

Payment Modes setting

The Payment Mode is the method of payment (e.g.
cheque, credit card or cash). It determines the Nominal
Ledger Account that will be credited by the Payment.
On a single Payment record it is possible to enter
payments to different Suppliers against different
Invoices. However, it is not possible to enter payments
across Payment Modes.
Own Bank A/C

The number for the bank account you want to use for the
Payment. This information will be brought in from the
Payment Mode record.

Use the grid area that takes up most of the screen to list the Purchase Invoices
being paid by this Payment. A single Payment can be allocated to several
Invoices, but all payments must use the same Payment Mode. The Payment
Mode reflects not only the payment method (i.e. cheque, cash or credit card)
but also the Bank Account credited. So, all payments issued in a single day
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from a particular Bank Account can be entered using a single Payment
record.
Each record in the Payment register results in one Nominal Ledger
Transaction, with bank or other institution as credit Account (taken from the
Payment Mode).
You can also bring Purchase Invoices into a Payment by opening the
‘Purchase Invoices: Browse’ window, selecting a range of Invoices by
clicking while holding down the Shift key, and then dragging them to the
Invoice No field in the first empty Payment row. You can also copy a list of
Invoice Numbers from a spreadsheet or word processor and paste them in the
Invoice No field in the first empty row.

Flip A
No.

Paste Special

Open, approved Purchase
Invoices, Purchase Invoice
register

The number of the Purchase Invoice being paid.
Note that when you use ‘Paste Special’, only unpaid
Purchase Invoices will appear in the selection list.
Purchase Invoices against which an unapproved
Payment has been entered are treated as paid and thus
will not be listed. Sorting the ‘Paste Special’ selection by
Supplier will allow you to find the Invoice that is being
paid quickly and easily.
If the Payment is an On Account Payment to a Supplier
with whom you have an account (marked using the On
Account box on the ‘Terms’ card of the Customer record
for the Supplier) for which an Invoice has not yet been
received, leave this field blank. This is fully described in
the ‘On Account Payments’ section below on page 353.
Supplier

Paste Special

Suppliers in Customer register

Default taken from

Purchase Invoice

Entered by FirstOffice when you enter an Invoice
Number.
Text
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will appear in the Text field of the Nominal Ledger
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To Bank A/C

The number of the Supplier’s bank account receiving the
Payment is brought in from the Purchase Invoice or from
the ‘Account’ card of the Customer record for the
Supplier.

Open Inv. Value The outstanding amount of the Invoice being paid. This
field cannot be changed.
Sent Val

Default taken from

Outstanding amount on Invoice

The amount paid against the Purchase Invoice. You can
change the default figure, in the event of partial
payments or overpayments.

Flip B
VAT Code, VAT Value
These fields are provided to satisfy a requirement of
users in Latvia, where it can be necessary to post VAT
on Payment. This is also the case for users of the Cash
VAT scheme in the UK and for some users in Poland. If
you are using the Post Payment VAT option in the
Account Usage P/L setting, the VAT Code and VAT
Amount will be brought in to these fields automatically
when you enter a Purchase Invoice Number on flip A
(the VAT Code comes from the first row of the Invoice).
When you approve and save the Payment, the VAT
amount will be moved from the temporary VAT Input
Account to the final one (the I/P Account), as specified
in the VAT Codes setting .
The Post Payment VAT option also adds a VAT element
to On Account Payments. Once again, the I/P Account
for the VAT Code is debited and the Input Account for
the VAT Code is credited with the VAT amount.
Take care with these fields when entering On Account
Payments. As On Account Payments do not have an
Invoice Number, you must enter a VAT Code manually
if you are using the Cash VAT scheme (i.e. if you are
using the Post Payment VAT option). The VAT Value
will then be calculated from the Sent Value. The
Nominal Ledger Transaction resulting from the Payment
will not have a VAT element if the VAT Code or VAT
Value is blank.
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Footer
Ordered

The Ordered and OK check boxes are provided to allow
for the delay between the issuing of a Payment and the
clearing of the funds from your company’s bank
account. Checking the Ordered box indicates that you
have issued a Payment, while checking the OK box
indicates that the funds have been cleared. You must
therefore check the Ordered box before the OK box.
When you save a Payment with its Ordered box checked,
the Invoice being paid is no longer treated as open, even
if the OK box is not checked.
If, once a Payment has been issued, it transpires that the
funds are not cleared from your company’s bank account
(perhaps because the cheque bounced or was lost),
highlight each row in the Payment in turn by clicking the
row number. Then, press the Backspace key. A red line
will be drawn through the row, re-opening the Purchase
Invoice.

OK

Approve a Payment by clicking this check box. On
clicking [Save] to save the Payment, a Transaction will
be generated crediting the Bank Account specified for
the Payment Mode and debiting the Creditor Control
Account of the Invoice being paid.
References in this manual to approved Payments are to
Payments whose OK check box has been switched on.

Withdrawn

The sum of the Payment Amounts: the total for this
Payment.

Entering a Payment - Example
We shall now show how to enter a Payment with the help of a few examples.
Open the Payment register using the button in the Master Control panel.
When the ‘Payments: Browse’ window appears, click the [New] button. The
‘Payments: New’ window is shown with a Payment Number already entered.
Press Enter to move the insertion point to the Payment Date field. Enter the
date when you want the Payment to go out.
The next field is Payment Mode. You can choose between the various modes
you have entered in Settings. FirstOffice will automatically enter the details
such as the Bank account number.

350

Chapter 7: Transaction Registers - Payments

Press Return again to move the insertion point to the Number field, the top
left-hand field in the Payment rows grid. For each line, enter the Purchase
Invoice Number from your Purchase Ledger. Ctrl-Enter (Windows) or Enter (Macintosh) will activate the ‘Paste Special’ function, showing all open
(unpaid) Supplier invoices.
Select a Purchase Invoice by double-clicking. Press Return to bring in
information such as the Supplier Number and Name. Enter the amount you
want to pay. Check the Ordered box to order the Payment and save.

Reconciling and Approving Payments
When paying Purchase Invoices by cheque, there will be a delay between the
ordering of the Payment and the clearing of the funds from your company’s
bank account.
In such a situation, when you issue the cheque, enter the Payment in the usual
way and check the Ordered box but not the OK box. Then click the [Save]
button in the Button Bar. This will ensure the Purchase Invoice(s) being paid
will no longer be treated as open (due). You can order several Payments at
once by highlighting them in a browse window and selecting ‘Order’ from
the Operations menu.
When you receive a statement from the bank, you can reconcile it with the
ordered Payments. You should approve Payments that agree with your bank
statement by clicking the OK check box and saving. Nominal Ledger
Transactions will be generated, debiting the Creditor Control Account of the
Invoice(s) being paid and crediting the Bank Account specified in the
Payment Mode. You can approve several Payments at once by highlighting
them in the ‘Payments: Browse’ window and selecting ‘OK’ from the
Operations menu.

!

After approving a Payment, it cannot
be altered.

If an Ordered Payment is not included on the statement (perhaps because the
cheque bounced or was lost), highlight each row in the Payment in turn by
clicking the row number. Then, press the Backspace key. A red line will be
drawn through the row, re-opening the Purchase Invoice. When you approve
the Payment, rows with red lines will not be included in the resulting
Nominal Ledger Transaction.
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Operations Menu

The Operations menus for Payments are shown above. On the left is the
Operations menu for the ‘Payments: Browse’ window: highlight a Payment
in the list before selecting the function. You can also apply the function to a
group of Payments: highlight the first Payment in the group and then click on
the last while holding down the Shift key. Then select the function. On the
right is the Operations menu for the ‘Payment: New’ and ‘Payment: Inspect’
windows.
Order
This command is available on the Operations menu only from the ‘Payments:
Browse’ window. It allows you to order a Payment and is therefore the
equivalent of checking the Ordered box in a Payment record. You can also
select several Payments in the ‘Payments: Browse’ window (hold down the
Shift key to select a range of Payments in the list) and order them all at once.
OK
This command is available on the Operations menu only from the ‘Payments:
Browse’ window. It allows you to approve a Payment and is therefore the
equivalent of checking the OK box in a Payment record. You can also select
several Payments (hold down the Shift key to select a range of Payments in
the list) and approve them all at once. Remember that this action causes
Transactions to be created for each Payment in the selection and that
therefore once it has been carried out you will no longer be able to modify
those Payments.
New Fee
You should use this function when you need to pay bank charges. Start by
entering the Purchase Invoice number in the left-hand column. Then select
‘New Fee’ from the Operations menu. A new row will be created, containing
the phrase “Fee”. Enter the Bank Fee in the right-hand Amount field. When
the Nominal Ledger Transaction is created, the Bank Fee Account specified
in the Account Usage P/L setting will be credited. The Sent Value plus the
Bank Fee will be credited to the Bank Account from the Payment Mode,
while the Sent Value will be debited to the Creditor Account.
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Open NL Transaction
When you approve and save a Payment, a Nominal Ledger Transaction will
be created. This function allows you to view that Transaction.
On selecting the function, the Transaction will be opened in a new window.

On Account Payments
You can use On Account Payments when you issue payments to Suppliers
without reference to specific Invoices (usually before you have received the
Invoices). You can enter these payments to the Payment register without
specifying a Purchase Invoice Number on flip A—

In the Customer records for every Supplier to whom you are likely to pay
deposits, switch on the On Account check box on the ‘Terms’ card. Then
specify the separate control or suspense Account number in the Account
Usage P/L setting, using the On Account A/C field. In the example
illustration below, the special Account for on account Suppliers is 755 since
raising a Prepayment creates an asset. The Nominal Ledger Transaction
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generated when the Payment is approved and saved will debit the Sent Value
to this Account. The Credit Account is taken from the Payment Mode as
usual—
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You can then connect the On Account Payment to a subsequent Purchase
Invoice, to remove it from your Purchase and Nominal Ledgers. First enter
and approve the Purchase Invoice as normal without reference to the On
Account Payment. You must then register that the Purchase Invoice has been
paid by the On Account Payment. You can do this in a Payment record as a
two-step process—
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In order to update the Purchase Ledger correctly, you must enter the payment
information twice as shown above; first as a normal row, and then with a
negative sign as an On Account Payment. The example Periodic Supplier
Statement below shows how the Purchase Invoice for 164.50 has been paid
by the earlier On Account Payment of 1,000. The remainder of the On
Account Payment is outstanding—
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In the Nominal Ledger, the Purchase Invoice is removed from the Creditor
Account, and the balance of the On Account A/C is reduced by the value of
the Purchase Invoice—

Correcting Mistakes in Payments
Even with the tightest quality control, it is probable that the occasional
mistake will be made when entering Payments. Once you have approved a
Payment, you cannot change it, but you can correct mistakes easily. The
following procedure ensures that the Supplier’s history remains correct.
1.

Highlight the Payment with the error in the ‘Payments: Browse’ window.

2.

Click [Duplicate]. A new Payment record is created, containing the
details of that copied.

3.

Insert a minus sign in front of the Sent Value, ensuring the Sent Value
figure itself remains unchanged.

4.

Click the OK check box and save the Payment.

5.

Enter a new, correct, Payment.
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Transactions
In a company, all accounting events are entered as Transactions. Depending
on the nature of the Transaction, this can be done directly to the Transaction
register or remotely from the other transaction registers (sometimes described
as ‘Sub Systems’).
Typically, Transactions representing Sales and Purchase Invoices, Receipts
and Payments will be generated remotely from the Sub System registers.
Other types of transactions will be entered directly to the Transaction
register: these might include bank transfers, overhead costs, salaries etc.
Before you start entering Transactions, you must ensure that you have
defined the current financial (accounting) year, using the Fiscal Years setting.
This is described on page 220 in Chapter 5, ‘Settings’.
To open the Transaction register, click [Transactions] in the Master Control
panel or use the Ctrl-5 (Windows and Linux) or -5 (Macintosh) keyboard
shortcuts.

The ‘Transactions: Browse’ window is opened, showing a list of Transactions
already entered.

Transactions that have been entered directly to the Transaction register are
shown with their Transaction Numbers preceded by the financial year: the
Transactions numbered 2004.1 to 2004.4 in the illustration are examples of
this. The characters representing the financial year are taken from the Fiscal
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Years setting. Transactions that have been created from a Sub System register
are shown with their Transaction Numbers preceded by a code depending on
their nature. In their case, the Transaction Numbers themselves are
determined in the Sub System in which they were created. For example,
Transactions generated from Sales Invoices have a Transaction Number that
is the same as their Invoice Number, and are shown in the browse window
with a prefix of S/INV.
In the Text column you can see the short explanatory text that was entered for
each Transaction. For those Transactions created from Sub Systems, the Text
column usually shows details of the Customer or Supplier involved.
As in other lists you can change the sort by clicking on the column headings.
The current sort column is shown with its heading coloured blue. You can
also scroll the list using the scroll bars. Finally, you can search for a record
by entering a keyword in the field in the top right-hand corner. FirstOffice
will search for the first record matching the keyword in the same column as
the selected sorting order.
There are four things you can do with your Transactions—
•

Enter Transactions

•

Inspect Transactions

•

Make corrections

•

Print the Transactions

Entering a Transaction
To enter a Transaction, first open the Transaction register using the
[Transactions] button in the Master Control panel.
Then, click [New] in the Button Bar or use the Ctrl-N (Windows) or -N
(Macintosh) keyboard shortcut. Alternatively, select a Transaction similar to
the one you want to enter and click [Duplicate] on the Button Bar.
The ‘Transaction: New’ window is opened, empty if you clicked [New] or
with a copy of the copied Transaction.
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In the following list you will find short descriptions of each of the fields in
the above picture.
Header
No.

The Transaction Number of a new Transaction is
provided automatically by FirstOffice following on from
the Number of the last Transaction entered.
When you start using FirstOffice, the Transaction
Number sequence will start at 1 and continue
consecutively. If you want the sequence to start from
another number, change the Number of the first
Transaction: FirstOffice will then continue the sequence
from there. You can then change the Number of any
subsequent Transaction if you want to use another
number sequence. Note that you must change the
Transaction Number before you save the Transaction: it
cannot be changed afterwards.
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Trans. Date

Paste Special

Choose date

The date of the Transaction does not have to coincide
with the date when the Transaction was recorded. The
last used Transaction Date is offered as a default.
Text

A short description of the Transaction.

Footer
Difference

Any difference between the sums of Debited and
Credited amounts is shown here: the two sums must be
the same before the Transaction can be saved. A
balancing entry shows a zero difference in this field.

Total

These two fields show the sums of Debits and Credits for
this Transaction.

The remainder of the screen contains the rows of the Transaction, showing
the postings to the individual Accounts. These must balance (the debits must
equal the credits) before the Transaction can be saved.
To add rows to a Transaction, click in any field in the first blank row and
enter appropriate text. To remove a row, click on the row number on the left
of the row and press the Backspace key. To insert a row, click on the row
number where the insertion is to be made and press Return.
Account

Paste Special

Accounts setting

Specify here the Account used by the Transaction row.
You can also enter the Code of an Autotransaction to this
field. Autotransactions are used to automate the entry of
frequently used Transactions, not only reducing labour
but also ensuring the correct Accounts are used every
time. Autotransactions are fully described on page 198 in
Chapter 5, ‘Settings’.
Text

A default Description is brought in from the Account
record. It can be modified for this Transaction if
necessary.

Debit, Credit

For each row, specify a debit or credit amount. The
debits total must equal the credits total before the
Transaction can be saved: each Transaction must
therefore have at least two rows.
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V-Cd

Paste Special

VAT Codes setting

You can mark each row in a Transaction with a VAT
Code. The VAT Code may be brought in automatically
when you enter an Account number, or you can enter it
manually. No calculation ensues: the field is for
reporting purposes only. Nevertheless, take care to
ensure you enter the correct VAT Code (if any), since it
will affect the accuracy of your VAT Return. Please
refer to the section on page 467 in Chapter 10, ‘Reports’,
describing the VAT Return report for full details.

Entering a Transaction - Example
As described above, FirstOffice provides several shortcuts to simplify your
work when entering Transactions. You can bring a date into a date field using
the Ctrl-Enter key combination (Macintosh users can press -Enter). If you
will be entering Transactions of the same type repeatedly (e.g. salaries), you
can automate their entry using Autotransactions. Their use is fully described
on page 198 in Chapter 5, ‘Settings’.
1.

Open the Transactions register by clicking the [Transactions] button in
the Master Control panel. Then, click [New] or press Ctrl-N/-N or
highlight a Transaction similar to the one you want to enter, and click
[Duplicate] in the Button Bar.
The ‘Transaction: New’ window is opened with an empty Transaction or
a copy of the copied one. FirstOffice suggests a Transaction Number by
adding one to the Number last used, and as Transaction Date the date
from the last entered Transaction.

2.

Enter and edit the data in the normal way. We will show how to enter the
various items with the help of a few examples.
We assume that you have bought some office material from the local
stationery store.
You have purchased two boxes of copy paper for 12.50 each, a box of
pencils for 6.00, and a box of adhesive tape for 3.20. The VAT was 5.22,
and the total 39.42. You paid by cheque from the company’s current
account.
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The Transaction will look like this—

3.

Click [Save] to enter the Transaction in the Nominal Ledger.

4.

The next Transaction records the purchasing of a new desk. Start by
clicking [New]. The stationery Transaction is closed and replaced with
an empty record ready for data entry.
The desk cost 247.00 excluding VAT. You are charged 20.00 for
transport, and then of course VAT.
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5.

Here you can try the automatic balancing function, since all crediting is
done to the same Account. Enter the three debit postings and continue
with row 4 until you are going to enter the amount. The Transaction will
look like this—

With the cursor in the Credit column, press the Return or Enter key.
FirstOffice enters the correct credit amount to balance the entry for you. If
you press Return or Enter again, the Transaction will be saved, closed and
committed the Transaction to the Nominal Ledger, and a new, empty,
Transaction will be opened. You can use this feature when you need to enter
several Transactions quickly in one sitting.
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Correcting Transactions
In the program you can easily correct Transactions in a legal manner.

!

You may not alter an entry in your
Ledger just any way you want to. A
correction of a Transaction means
that you create a new Transaction,
which also cancels the old one. The
altered Transaction should be marked
that it has been cancelled.

When a Transaction is open for data entry, the Operations menu is available
in the menu bar, allowing you to make several types of corrections after the
Transaction has been entered.
Assume that you have entered the wrong VAT amount, and that you find out
only after entering the Transaction.
1.

Highlight the Transaction containing the error in the ‘Transactions:
Browse’ window and click [Duplicate].
This creates a copy of the faulty Transaction. First you want to remove
the error.

2.

Select ‘Swap Debit & Credit’ from the Operations menu. This takes the
existing Transaction rows and reverses them (what were Credit amounts
become Debits). This action thus cancels out the original, erroneous,
Transaction.
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3.
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Then select ‘Correction Mark’ from the same menu. This will add a new
line where you can enter a cross reference to the Transaction containing
the error. Note: do not save the Transaction before selecting ‘Correction
Mark’.
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4.

Enter the journal number of the transaction to be corrected, including the
financial year prefix, and then on the following rows make new, correct,
entries as in the illustration above. Click [Save] when you have finished.
The new Transaction is saved, and the old Transaction is marked as
corrected, as shown in the following picture.

FirstOffice also provides you with another method to correct entries. In
manual ledgers, errors are often corrected or eliminated by striking a line
(sometimes in red ink) across the entry. A note is made with the initials of the
accountant, and a corrected entry is made with the next unused journal
number. FirstOffice provides a similar method.
1.

In the ‘Transactions: Browse’ window, find and double-click the old
Transaction you want to change. Select ‘Update Mark’ from the
Operations menu. A new line is added in the Transaction, showing the
original date of the Transaction. Record your initials in the space
provided.

2.

You will now want to cancel - draw a (red) line across - the faulty row.
Highlight the row by clicking the number to the left of the row. Press the
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Backspace or the Backspace key to draw the correction line across the
row. Then you can enter the correct information. Save in the normal way.

3.

If the error is in the header area of the Transaction (i.e., the Transaction
Date is wrong), it can also be corrected using the ‘Update Mark’
function. Select the function and change the date as appropriate. There is
no need to use the ‘Update Mark’ function to change the Text in the
header or in any of the rows.

If you discover an error in a Transaction that falls within a closed month, you
cannot correct it using ‘Update Mark’. This is because ‘Update Mark’
modifies the Transaction and attempts to save it using the original
Transaction Date. This falls in a period when modifications are not permitted.
Therefore, the only way you can correct such Transactions is by using the
‘Correction Mark’ function to create a new, correcting, Transaction whose
Transaction Date must fall within an open month. Months are closed using
the Locking setting: please refer to page 236 in Chapter 5, ‘Settings’, for full
details.
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Operations Menu
When a Transaction is open in a record window, the Operations menu is
available. The menu has four commands.

Balance Transaction
If the cursor is in one of the Transaction rows, selecting this command
changes the Debit or Credit value in that row, so that the Transaction
balances. This is particularly practical when you have made an error of the
amount in just one line.
An alternative to selecting this function is to place the cursor in the Credit
field of the last row and press the Return or Enter key.
Swap Debit & Credit
This command swaps the entries of a Transaction, transferring all Debit
values to the Credit column and all Credit values to the Debit column.
This is useful when you wish to cancel a Transaction with an opposing
correction Transaction. To do this, find the erroneous Transaction in the
‘Transactions: Browse’ window, highlight it and click [Duplicate]. A copy of
the Transaction is opened. Select this function and save by clicking [Run].
The erroneous Transaction is now cancelled. Full details are contained in the
section above on page 365 entitled ‘Correcting Transactions’.
Update Mark
In the case of a Transaction that contains an error, use this command to insert
a special update mark allowing you to record a signature before entering the
correct posting on the Transaction. Full details are contained in the section
above on page 365 entitled ‘Correcting Transactions’.
Correction Mark
When you use a correction Transaction to correct a Transaction, use this
command to enter the number of the cancelled Transaction. The cancelled
Transaction will also gain a cross-reference to the correction Transaction.
Full details are contained in the section above on page 365 entitled
‘Correcting Transactions’.
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Chapter 8: Personal Registers
The Calendar and Task Manager are simple and efficient tools for keeping
track of contacts with Customers and for planning activities of all kinds. You
can use them to record the different tasks and events in the business day, such
as customer contacts for sales, service support, consultancy appointments etc.
In FirstOffice, each task and event is saved as a separate record in the
Activity register. The Calendar and the Task Manager allow you to view,
review and change your Activities, and to add new ones. You can use the
Activity register as a planning and monitoring tool for a sales force, or as a
tool to log telephone calls to a customer service centre, and in many other
ways. As with all FirstOffice features, there is a great deal of flexibility, and
different users will adapt it to their own requirements.
This chapter begins with an example and continues with a description of the
Activity register, the heart of FirstOffice’s time and contact management
systems. To keep your Activities separate from those of other users, you
cannot open the Activity register itself. Instead, you can access the register
using the Task Manager, the Calendar and the Personal Calendar report.
These are described on pages 397, 402 and 409 respectively.

Examples
Contact Management
To explain Activities, the Calendar and the Task Manager, we have prepared
a small example. The business is an export business with a number of sales
persons who communicate with domestic and foreign firms via phone, fax
and e-mail. We shall follow one of the sales persons through a day’s work
with the Calendar and Task Manager.
In the morning, Françoise French will open the Task Manager (i.e. her ‘To
Do’ list). To do this, she will click the [Tasks] button in the Master Control
panel—

The Task Manager lists Activities whose Task Type is To Do. In practice, it
is a list of the Activities that Françoise is to carry out by the end of the day
(including Activities from previous days that have not been completed).
Activities that have been marked as Done are not shown. The Activities are
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sorted by Start Date and Time, but Françoise can change this by clicking on
one of the column headings.

If the list was a long one, Françoise could reduce it to show Activities of a
particular Type and/or Customer using the fields above the list.
When Françoise carries out one of these planned Activities, she will doubleclick the Text in the appropriate row to open the corresponding record in the
Activity register. She can then remind herself of the details of the Activity
before carrying it out. She does this now for the last Activity in the list.
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When she has finished the task, she can mark the Activity as Done by
marking the check box in the top right-hand corner—

In this case, the call was made successfully and the Customer expressed
interest in the products Françoise was selling. She recorded this interest in the
Activity record, using the grid on the ‘Text’ card that is visible at the bottom
of the Activity window.
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On saving and closing the Activity, the Task Manager is updated
automatically. The last Activity is removed, since Activities that have been
marked as Done are not usually listed—
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Sometimes, it will not be necessary to open an Activity in order to complete
it. The Task Manager itself displays sufficient information to carry out the
work, including any notes and comments already entered on the ‘Text’ card.
These notes can be seen by clicking the arrow icon to the left of the Activity
Text. Françoise does this for the first Activity in the list—
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When she has completed the task, if there is no need to enter more notes or to
create a new follow-on Activity by duplication, Françoise can mark the Done
box by clicking—

This marking of the Done box is not fed through to the corresponding
Activity immediately. Françoise must save the Task Manager (by pressing
the Shift-Enter key combination or by selecting ‘OK’ from the Record menu)
in order to mark Activity as Done and to remove it from the Task Manager
list. Of course, she could mark several rows as Done before saving.
At other times during the day, Françoise will be contacted by several of her
Customers. By entering an Activity for each contact or event, she will
quickly build up a contact history for each Customer. This means that if, for
example, Mr. Wang from Hong Kong sends a fax complaining about a
missing delivery of goods, she will easily be able to call up a list of recent
Activities in relation to Mr Wang’s company. This list would include both
her own contacts with the New World Import/Export Co and those of other
members of staff.
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One way Françoise can do this is to use the ‘Filter’ card of the Task Manager.
She can remove her initials from the Person field, enter “002” as the
Customer (using ‘Paste Special’ to select the correct one if necessary) and
choose to view Done Activities using the fourth column of options. She will
then see a complete contact history for Customer 002—

She can double-click the Text of any Activity to see more details if
necessary.
Françoise can see at a glance the comments recorded on the ‘Text’ card of
each Activity. Every relevant Activity carried out and entered by different
Persons over the time period will be listed. The Task Manager is therefore an
excellent tool that can be used to sort out any queries or mistakes in relation
to a series of events, providing, of course, that each member of staff has
conscientiously entered a record of each task they have carried out.
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Time Management
Françoise is also engaged in time management and analysis. She is in charge
of a department in which there are two other sales people working. In
planning the work for the coming month, she decides to book a particular
afternoon to be spent on the telephones following up leads and making cold
calls. She opens her Calendar by clicking the [Calendar] button in the Master
Control panel—

Then, she clicks the [New Activity] button and enters an Activity in the
names of all three department members booking their time. To do this, she
enters the initials of the three members of the department in the Persons field
on the ‘Persons’ card, separated by commas—

On the ‘Time’ card she sets the Task Type to Calendar, signifying that the
Activity is to appear in the Calendar rather than in the Task Manager. She
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chooses the Profile option as the Calendar Type to indicate that this is
planned time.
When Francoise saves the Activity, it will appear in the Calendar for each of
the three members of personnel. When they open their Calendars by clicking
the [Calendar] button in the Master Control panel, they will become aware
that their time that afternoon has been booked—

The Activity appears in their Calendars as a hollow coloured bar, because
Françoise selected the Profile option. This bar signifies to the other two
members of the department that their time has been booked. If either of them
clicks the bar once, the Text of the Activity appears in the Search field at the
bottom of the screen. They can also double-click this bar to open the Activity
record if they want to see more details about what they will be doing.
Everyone else in the company can also view the Calendars of these three
members of staff and see that their time has been booked.
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During the afternoon in question, various methods are available to Françoise
by which she can record the work actually carried out. She decides to ensure
that separate Activities are entered for each telephone call. These will record
the details of each call (keeping the contact history for each Customer up to
date) and allow the creation of follow-up Activities should these be required.
One such Activity recorded by Françoise’s colleague Neil Brooker is shown
on the next page.

The Calendar is not really suitable for the displaying of many small Activities
representing individual telephone calls, so the Task Type is set to To Do.
These Activities are not entered for time management purposes but to
contribute to the contact histories of the Customers affected. Selecting To Do
means the Activity will not appear in the Calendar.
Details of each telephone call are recorded in the grid on the ‘Text’ card of
each Activity, as shown at the bottom of the illustration above.
In this example, the call ended with a request to send some information to the
Customer. After saving the Activity and while it is still on screen, Neil can
click the [New] or [Duplicate] button to create a new Activity containing the
instruction to send out the information. This can be in his own name, to
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remind himself to do this job later, or it can be in the name of the Person that
usually sends out information. In the latter case, this Person will become
aware that a job needs to be done when the Activity appears in their Task
Manager or Calendar (depending on whether Neil sets the Task Type to To
Do or Calendar respectively).
At the end of the day, Françoise enters new Activities for each member of
staff, representing the afternoon’s work. These Activities are solely for time
management purposes. Neil Brooker had to leave early to go to the dentist, so
Françoise enters this Activity recording the work that he was able to do—
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Since this Activity is to serve a time management purpose only, she sets the
Task Type to Calendar. She selects Time as the Calendar Type, because the
Activity represents the actual time spent making the calls. As a result, the
Activity will appear in Neil’s Calendar as a solid coloured bar to the right of
the hollow bar entered earlier to book his time. It was for this purpose of
comparison that Françoise created a new Activity instead of changing the
earlier Activity from Profile to Time—

Neil’s early departure is represented by his Time bar (solid colour, to the
right) being shorter than his Profile bar (hollow).
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The time spent by all three employees can be shown in the Calendar by
entering the three sets of initials in the Persons field, separated by commas—

The position of the coloured bars corresponds to the position of each set of
initials in the Persons field. So, the two left-hand coloured bars represent
Neil’s Profile and Time, and the two right-hand bars represent Françoise’s
Profile and Time.

Note on Terminology
Throughout this chapter (as elsewhere in this manual), the word “Customer”
is used to refer to a record in the Customer register. That record does not
necessarily represent a firm that has purchased goods or services from your
business, and in fact can represent any company that is a potential customer
or supplier. As soon as contact is established between your business and a
potential client, you should record their details in the Customer register.
The following phrases have sometimes been used to describe Activities of
various kinds—
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Phrase

Refers to an Activity where…

Calendar Activity

the Task Type is Calendar

To Do Activity

the Task Type is To Do

Timed To Do Activity

the Task Type is Timed To Do
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Time Activity

the Task Type is Calendar and the Calendar Type
is Time (an Activity representing actual time
spent in carrying out a task)

Profile Activity

the Task Type is Calendar and the Calendar Type
is Profile (an Activity representing the booking
of planned [future] time)
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The Activity Register
You can record all business events, appointments and tasks as Activities.
Through the careful use of Activity Types and Classes, the Activity register
can become a valuable source of information recording many different types
of customer and other business related operations. You can record both past
and future events, so you can use the register as an efficient diary
management tool.

Viewing Activities
You can view Activities using any of three methods—
1.

From the Task Manager, double-click the Activity Text of any Activity.

2.

From the monthly, weekly or daily Calendar view, double-click the
coloured bar representing a particular Activity.

3.

Having printed the Personal Calendar report to screen, click the Start
Time or Activity Text of any Activity.

In each case, the ‘Activity: Inspect’ window is opened, allowing to view the
details of the Activity and to change it if required.
The Task Manager, Calendar and Personal Calendar report are described
below on pages 397, 402 and 409 respectively.

Entering an Activity
You can enter Activities in many ways—
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1.

From any Calendar view, click the [New Activity] button in the top
right-hand corner or use the Ctrl-N (Windows and Linux) or  - N
(Macintosh) keyboard shortcut. The Task Type of the new Activity will
be Calendar, and the Symbol will be Other. The Start Date and Start
Time of the new record will show the current date and time.

2.

When viewing an existing Activity, click the [Duplicate] button in the
Button Bar or use the Ctrl-K (Windows and Linux) or -Y (Macintosh)
keyboard shortcut. The Start Date of the copied Activity will be copied
to the new one, but the End Date will be made blank.
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3.

Having printed the Personal Calendar report to screen, click the “New
Activity” text at the top of the report. The Task Type of the new Activity
will be Calendar, and the Symbol will be Other. The Start Date and Start
Time of the new record will show the current date and time.

4.

Having printed the Customer Status report to screen, click the “New
Activity” text at the top of the report. The Task Type of the new Activity
will be To Do, and the Symbol will be Other. The Start Date and Start
Time of the new record will show the current date and time.

5.

From the Task Manager, click the [New Task] button in the top righthand corner. The Task Type of the new Activity will be To Do, and the
Symbol will be Other. The Start Date and Start Time of the new record
will show the current date and time.

Whichever method you use, when the Activity window opens, enter whatever
relevant information you need to record about the event. In the case of future
appointments, you will easily be able to return to the record to review it and
mark it as completed at the appropriate time.
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Since the amount of information stored about each Activity will not fit on a
single screen, the Activity window has been divided into four cards. At the
top of each is the header. This contains the Text and Type and an indication
of whether the Activity has been approved (completed). There are four
named buttons (‘tabs’) in the header.

By clicking the tabs you can navigate between the cards, and always go
directly to a certain card. The header is always visible, so you can always
identify the Activity you are working with.
Header
Text

A free text field to be used to describe the Activity.
This Text will be shown in the Day Planner, Task
Manager and in the Personal Calendar report.

Type

Paste Special

Activity Types setting

Enter an Activity Type by which this Activity can be
classified. Each Activity Type should represent a
specific job or task (e.g. sales call, sales appointment or
internal meeting).
Each Activity Type can in turn belong to an Activity
Class (e.g. you might have a single Activity Class for all
Types to do with sales, or all those to do with
administration). The Activity Class will determine the
colour of the bar representing this Activity in the
Calendar, and can also force you to enter a Customer
and/or a Cost (Time) (see below). It will also determine
which Calendar Type will be selected by default.
Done

Use this check box to mark the Activity as done or
finished. You should enter planned or scheduled
Activities without checking the Done box. As you
complete these Activities, check the Done box and
perhaps enter some notes in the grid area on the ‘Text’
card. In this way, you can easily maintain a ‘To Do’ list:
by default, Activities that have been marked as Done
will not be shown in the Task Manager.
Once an Activity has been marked as Done and saved,
many fields such as the Start and End Dates and Times
and the Person cannot be changed.
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Time Card

Start Time

Paste Special

Current Time

The time when work on the Activity is to be or was
started. The current time is filled in as a default. The 24hour clock should be used.
Once an Activity has been marked as Done and saved,
the Start Time cannot be changed.
Start Date

Paste Special

Choose date

The date when work on the Activity is to be or was
started. The current date is filled in as a default.
Once an Activity has been marked as Done and saved,
the Start Date cannot be changed.
End Time

Paste Special

Current Time

The time when work on the Activity was is to be or was
finished.
Once an Activity has been marked as Done and saved,
the End Time cannot be changed.
End Date

Paste Special

Choose date

The date when work on the Activity is to be or was
finished.
Once an Activity has been marked as Done and saved,
the End Date cannot be changed.
Cost (Time)

The overall time required to complete the Activity,
calculated by FirstOffice from the Start and End Times
and Dates. If this is not a true figure (perhaps there was a
break for lunch, for example), you can overwrite it with
the correct figure.
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If the Activity Type of this Activity belongs to an
Activity Class whose Force Entry Of Time option is on,
you must enter a Cost (Time) before you can save the
Activity.
Once an Activity has been marked as Done and saved,
the Cost (Time) cannot be changed.
The Cost (Time) is sometimes referred to as the Elapsed
Time in this manual.
Task Type

Use these options to specify the main purpose of the
Activity—

Calendar

Choose this option if the Activity is to appear in
the Calendar.
Typically, you should use Calendar Activities for
time management, scheduling and analysis. A
Calendar Activity can represent either planned or
actual time. If an Activity is to represent planned
time, choose Profile from the Calendar Type
options to the right. If it is to represent actual
time, choose Time from those options. Choose
Don’t Show if the Activity is not to appear in the
Calendar.

To Do

Check this box if you would like this Activity to
be shown in the Task Manager. Usually this will
be because the purpose of the Activity is to
schedule a single task, such as a telephone call.
The task is to be completed on a particular day,
but the time is not important. You can use such
Activities to build up a contact history for each
Customer.

Timed To Do

Choose this option if the Activity is to appear in
the right-hand panel of the Day Planner. Usually
this will be because the purpose of the Activity is
to schedule a single task for a specific time. Such
Activities can contribute to the contact history for
each Customer.

In all cases, if the Calendar Type to the right is Time or
Profile, the Activity must have both Start and End Times
before you can save it. The Calendar Type has no other
effect if the Task Type is To Do or Timed To Do.
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Once an Activity has been marked as Done and saved,
the Task Type and Calendar Type can still be changed,
providing the Activity has both Start and End Times.
As an example of how you will use these options,
imagine you decide to spend an afternoon making sales
telephone calls. You will probably book the afternoon in
advance by entering a single Activity covering the whole
afternoon in which the Task Type is Calendar. This will
appear in your Calendar in the appropriate colour,
showing how the afternoon is to be spent. You should
choose Profile as the Calendar Type, since the Activity
represents planned time. Other members of the company
will be able to view your Calendar and see that your time
for the afternoon in question has been booked. When the
afternoon’s work is done, you will copy this Activity,
change the times if necessary and change the Calendar
Type to Time. Turning to the individual telephone calls
that you wish to make during the afternoon, you may
have scheduled some of these in advance by entering
separate Activities for each call to be made in which the
Task Type is To Do or Timed To Do. Each of these
Activities will have a Customer, Contact and Telephone
Number. You will probably start the afternoon’s work by
viewing a list of these calls in your Task Manager or
Day Planner and you will work through them, recording
the details of each call and possibly making new
Activities for follow-on tasks. You might also create
similar Activities (again with a Task Type of To Do) as
and when you make unscheduled telephone calls (e.g. if
it is a cold-calling exercise). As you complete each call,
you will check the Done box of the appropriate Activity.
This will remove them from the Task Manager or Day
Planner. Their remaining use will be to form part of the
contact history of the Customer in question.
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Calendar Type

Use these options to control how the Activity will be
shown in the Calendar. Usually these options apply only
to Activities whose Task Type (above) is Calendar. You
can change the Calendar Type after you have marked the
Activity as Done and saved it.

Time

You should choose this option in an Activity that
represents actual time spent in carrying out a task.
It will then appear in the Personal Calendar report
together with its Cost (Time) and in the Calendar
with a solid colour bar.

Profile

Use this option to book future time in the
Calendar. Activities of this type appear in the
Calendar as hollow coloured bars and to the left
of those whose Time option has been selected.
Time Activities have a solid colour bar. Profile
Activities are shown on the Personal Calendar
report with no Cost (Time).

Don’t Show

Use this option if you don't want the Activity to
be shown in the Calendar. It will still appear in
the Personal Calendar report.
It can be difficult to return to a Don’t Show
Activity after you have saved it, because it will
not appear in the Calendar. You can drill down to
it from the Personal Calendar report, or you can
use the ‘Filter’ card of the Task Manager.
Choosing the correct Task Type option in the
Task Manager will cause all Calendar Activities
to be listed, even those marked as Don’t Show.
If you specify an Activity Type that belongs to an
Activity Class in an Activity, the Calendar Type will
change to that set in the Activity Class. You can choose
another Calendar Type in a particular Activity, but take
care to note that another option may be selected if you
then change the Activity Type.

Symbol

Call
Meeting
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When an Activity is shown in the Task Manager, it can
be accompanied by a small image so that you can see at
a glance the type of work that it entails. The available
images are—
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Deskwork
Other

(no image)

Persons Card

Persons

Paste Special

Persons setting

The Person doing the Activity. The initials of the current
user are entered as a default.
If the Activity is to be carried out by more than one
Person, enter all appropriate initials, separated by
commas. It will appear in all their Calendar views, Task
Managers and Personal Calendar reports.
If you need to use ‘Paste Special’ to enter several sets of
initials, type the comma before opening the ‘Paste
Special’ list. This will cause FirstOffice to add the next
set of initials to those already entered. Otherwise, the
previous initials will be overwritten.
Once an Activity has been marked as Done and saved,
the Person cannot be changed.
Cc

Paste Special

Persons setting

Enter the initials of anyone else that needs to know about
the Activity (e.g. the person responsible for the
Customer). Again, you can enter the initials of more than
one Person, separated by commas. The Activity will
appear in all their Calendar views and Personal Calendar
reports, but it will only appear in their Task Managers if
they so choose on the ‘Filter’ card.
Priority

You can grade the importance of each Activity using the
Priority field. The Priority will be shown in the Task
Manager, and you can reduce the list in the Task
Manager so that it shows Activities with a particular
Priority only.
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Customer Card

Customer

Paste Special

Customers and Suppliers in
Customer register

Enter the Customer Number or use the ‘Paste Special’
function. When you press Return, the Customer’s or
Supplier’s name, Primary Contact and Telephone
Number will be entered into the fields below.
If the Activity Type of this Activity belongs to an
Activity Class whose Force Entry Of Customer option is
on, you must enter a Customer before you can save the
Activity.
By default, the ‘Paste Special’ list shows Customers.
Click the [Suppliers] button in the top left-hand corner of
the ‘Paste Special’ window if you need to see Suppliers.
Name

The Customer or Supplier Name is entered by
FirstOffice after you have entered the Customer or
Supplier Number.

Contact

Paste Special

Contact Person register

Enter the name of a Contact Person or select one from
the Contact Person register. The ‘Paste Special’ function
only lists Contact Persons for the Customer in question.
If a Contact has been entered to the Attn. field on the
‘Contact’ card of the Customer record, this will be
brought in as a default.
Phone
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The Customer’s or Supplier’s Telephone Number is
entered by FirstOffice after you have entered the
Customer or Supplier Number.
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Text Card

Code

Paste Special

Text Types setting

The grid area is useful if you need to make notes about
the Activity. Use the ‘Paste Special’ link to the Text
Types setting to bring in certain generic comments, or
leave the Code field blank and simply type some ad hoc
text in the Text field. There is space for several rows of
notes.
Text

This field will contain the text for the Text Type. You
may add any free text as appropriate.
If you need to enter more than one line of text, keep
typing. The cursor will move to the next line
automatically when necessary.
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Completing an Activity
As you work your way through your Activities, you will want to mark off
each one as completed. This will have the effect of building up an accurate
contact history for the Customers concerned.
To do this, open the Activity and click the Done box. Change to the ‘Text’
card to record any comments about the carrying out of the task in the grid
area. Click the [Save] button in the Button Bar to save the changes.
Once an Activity has been marked as Done and saved, many fields such as
the Start and End Dates and Times and the Persons cannot be changed. If you
realise that a Done Activity contains a mistake, you can be delete it by
selecting ‘Delete’ from the Record menu.

396

Chapter 8: Personal Registers - Task Manager

The Task Manager
The Task Manager is a list of Activities sorted by Start Date and Time. Its
main purpose is to list Activities that have not yet been completed to provide
a check list of tasks to be undertaken. By default, only To Do Activities are
included in the list. Usually, these will be Activities representing short tasks,
such as telephone calls, that are to be completed on a particular day.
From the Task Manager, you can open an Activity by double-clicking the
Activity Text. You can then remind yourself of the details of the Activity
before carrying it out. When you have completed the task, you can mark the
Activity as Done. When you save the Activity, it will immediately and
automatically be removed from the Task Manager. If, as a result of carrying
out the Activity, you need to schedule another one for a future time, this can
also be done from the Task Manager.
To open the Task Manager, click the [Tasks] button in the Master Control
panel—

The Task Manager for the current user (i.e. the Person signed in to
FirstOffice for this work session) is opened, showing To Do Activities in
Start Date and Time order. These are Activities whose Start Dates are the
current date or earlier and whose Done boxes are not checked.
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Header
Person, Type, Customer, Priority
If the list of Activities is a long one, you can reduce it to
show Activities of a particular Person, Type, Customer
and/or Priority in any combination using the fields above
the list. For example, to list sales calls, enter the
appropriate Activity Type in the Type field and press
Tab or Return. To further reduce the list to show calls to
be made to a particular Customer, enter the appropriate
Customer Number in the Customer field and press Tab
or Return once more.
You can use ‘Paste Special’ from the Person, Type and
Customer fields to ensure the correct entry.
Activities Card
The main part of the Task Manager is a list of the Activities that are to be
carried out by the end of the day (including Activities from previous days that
have not been completed). Activities that have been marked as Done are not
shown. The Activities are sorted by Start Date and Time, but you can change
this by clicking on one of the column headings.
You can change the composition of this list in two ways—
1.
398

You can use the fields in the header as described above.
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2.

You can use the radio buttons on the ‘Filter’ card (described below on
page 400) to add to the list Activities that would not be shown by default
(e.g. Done Activities or Activities whose Task Types are not To Do).

Prio

This column shows the Priority of each Activity, and it
also shows a small image determined by the Symbol
option chosen for each Activity.

Done

Use this column to mark an Activity as Done once you
have completed it. This will not be fed through to the
corresponding Activity immediately: you must save the
Task Manager (by pressing the Shift-Enter key
combination or by selecting ‘OK’ from the Record
menu) in order to mark Activity as Done and to remove
it from the Task Manager list. You can mark several
rows as Done before saving.

!

If you have marked any Activities as
Done, remember to save the Task
Manager before closing it.
If you have used the options on the ‘Filter’ card
(described below on page 400) to include Done
Activities in the list, they will be shown with a tick (√) in
the Done column.

Text

This column contains the Text from the header of each
Activity. Double-click this Text to open the Activity
record.
There will be a small arrow to the left of this Text if any
notes and comments have been entered on the ‘Text’
card of an Activity. Click this arrow to read the
comments. This has been done in the fourth row in the
illustration above.

Contact

This column contains the Contact or Customer/Supplier
Name from the Activity.

Phone

This column shows the Customer or Supplier Telephone
Number from the ‘Customer’ card of each Activity.
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Filter Card

By default, the Activities listed in the Task Manager have Task Types of To
Do, are not Done and have Start Dates that are on or before the current date.
Use the ‘Filter’ tab (in combination with the fields in the header) if you
would like to change these settings.

400

Select

Use one of these options to list Activities with different
Symbols.

Task Type

Use one of these options to list Activities with different
Task Types.

Display

Use one of these options to list Activities with different
Start Dates. The Next Week and Next Month options do
not include the current date.

Incl. Done

Choose one of these options if you would like Done
Activities to be listed (in addition to those that are not
Done). The Done Activities will be marked with a tick in
the Done column. You can choose to include all Done
Activities, or those whose Start Dates are in the past
month or year.

Persons

By default, the Task Manager lists the Activities entered
for the Person whose initials appear in the header. This
means those Activities with these initials in their Persons
fields. Use these options to change this to the Activities
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with these initials in their Cc fields, or in both their
Persons and Cc fields.
Button Bar
The Button Bar contains two buttons, as follows—
Day Planner

Click this button to open the Day Planner. The Day
Planner is described in the ‘Calendar’ section of this
chapter below on page 406.

New Task

Click this button to create a new Activity. Its Task Type
will be To Do, and its Symbol will be Other. You can
also use the Ctrl-N or -N keyboard shortcut. When you
save the new Activity, it will immediately and
automatically be added to the Task Manager, providing
it meets your chosen filter criteria.

Printing the Task Manager
To print a list of the Activities shown in the Task Manager, choose ‘Print’
from the File menu.
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The Calendar
Opening the Calendar
The Calendar is useful for booking employees’ time and for analysing
employee time statistics. Every member of the company can see a particular
individual’s Calendar, so its graphical format makes it easy to check
employees’ availability and to schedule major tasks.
To open the Calendar, click the [Calendar] button in the Master Control
panel—

When it opens, the Calendar shows the current month in the centre of the top
row, the previous month and the next four months. This six-monthly format
is one of the four ways of viewing the Calendar in FirstOffice. These four
views are—
•

The six-monthly view (known as the “Overview”)

•

The monthly view

•

The weekly view

•

The daily view (known as the “Day Planner”)

The Four Calendar Views
The Six-monthly View (the “Overview”)
In the Overview, the current date (August 5th in the illustration) is marked
with a square and weekends are red.
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•

To open the Overview, click the [Calendar] button in the Master Control
panel.

•

To change the months shown, use the ‘Next’ and ‘Previous’ functions on
the Record menu or the equivalent buttons on the left of the Button Bar.

•

To open a monthly view, double-click on the name of any month. To
open a monthly view for the current month, select ‘Month’ from the
Operations menu or use the Ctrl-Shift-M (Windows and Linux) or Shift-M (Macintosh) keyboard shortcuts.

•

To open a weekly view, double-click on the number of any week. To
open a weekly view for the current week, select ‘Week’ from the
Operations menu or use the Ctrl-Shift-W (Windows and Linux) or Shift-W (Macintosh) keyboard shortcuts.

•

To open the Day Planner, double-click on any date. To open the Day
Planner for the current day, select ‘Day’ from the Operations menu or
use the Ctrl-Shift-D (Windows and Linux) or  -Shift-D (Macintosh)
keyboard shortcuts.

•

To close the Overview, use the close box.
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The Monthly View
In the monthly view, the current date (August 5th in the illustration) is
marked with a thick border. Weekends shaded, with dates in red.
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•

To open the monthly view, double-click any month name in the
Overview.

•

To change the month shown, use the ‘Next’ and ‘Previous’ functions on
the Record menu or the equivalent buttons on the left of the Button Bar.

•

To open a weekly view, double-click on the number of any week.

•

To open the Day Planner, double-click on any date.

•

The Activities for each day are represented by coloured bars. These are
solid for Time Activities and hollow for Profile Activities. Double-click
any coloured bar to open the Activity. The colours are determined by the
Activity Class of each Activity. Only Calendar Activities are shown.

•

The monthly view can show more than one Person’s Activities at once.
Enter each Person’s initials (use ‘Paste Special’ if necessary) separated
by commas in the Persons field and press the Return key. A separate
column of coloured bars is shown for each Person. The left-hand column
belongs to the first Person named in the Persons field and the right-hand
column to the last Person.

•

To close the monthly view, use the close box.
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The Weekly View

•

To open the weekly view, double-click any week number in the
Overview or monthly view.

•

To change the week shown, use the ‘Next’ and ‘Previous’ functions on
the Record menu or the equivalent buttons on the left of the Button Bar.

•

To move to an earlier or later part of the day, use the scroll bar on the
right-hand side of the window. Activities beginning at a time too early to
be shown have an arrow at the top of their coloured bar, while those
ending too late to be shown have an arrow at the bottom of their bar.

•

To open the Day Planner, double-click on any date.

•

The Activities for each day are represented by coloured bars. These are
solid for Time Activities and hollow for Profile Activities. Double-click
any coloured bar to open the Activity, or click once for its Text to appear
in the Search field. The colours are determined by the Activity Class of
each Activity. Only Calendar Activities are shown.

•

The weekly view can show more than one Person’s Activities at once.
Enter each Person’s initials (use ‘Paste Special’ if necessary) separated
by commas in the Persons field and press the Return key. A separate
column of coloured bars is shown for each Person. The left-hand column
belongs to the first Person named in the Persons field and the right-hand
column to the last Person.
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•

You can move an Activity to another time and/or date by dragging and
dropping, providing the Activity has not been marked as Done.

•

To close the weekly view, use the close box.

The Daily View (the “Day Planner”)
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•

To open the Day Planner, double-click any date in the Overview or in the
monthly or weekly views, or click the [Day Planner] button in the Task
Manager.

•

To change the day shown, use the ‘Next’ and ‘Previous’ functions on the
Record menu or the equivalent buttons on the left of the Button Bar.

•

The Day Planner is divided into two sections. The panel on the left
contains the day’s Calendar Activities, represented by coloured bars.
These are the same Activities that were visible in the monthly and
weekly views. The coloured bars are solid for Time Activities (the first
Activity in the illustration above) and hollow and to the left for Profile
Activities (the second, third and fourth in the illustration). Double-click
any coloured bar to open the Activity, or click once for its Text to appear
in the Search field. The colours are determined by the Activity Class of
each Activity. Only Calendar Activities are shown.

•

To move to an earlier or later part of the day, use the scroll bar on the
right-hand side of the left-hand panel. Activities beginning at a time too
early to be shown have an arrow at the top of their coloured bar, while
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those ending too late to be shown have an arrow at the bottom of their
bar.
•

The left-hand panel can show more than one Person’s Activities at once.
Enter each Person’s initials (use ‘Paste Special’ if necessary) separated
by commas in the Persons field and press the Return key. A separate
column of coloured bars is shown for each Person. The left-hand column
belongs to the first Person named in the Persons field and the right-hand
column to the last Person.

•

The panel on the right lists Timed To Do Activities. This list only
contains Activities for the Person whose initials appear first in the
Persons field.

•

In the right-hand panel, double-click the Activity Text to open an
Activity.

•

You can use the check boxes in the Done column in the right-hand panel
to mark each Activity as Done once you have completed it. This will not
be fed through to the corresponding Activity immediately: you must save
the Day Planner (by clicking the [Save] button, by pressing the ShiftEnter key combination or by selecting ‘OK’ from the Record menu) in
order to mark Activity as Done. You can mark several rows as Done
before saving.

!
•

If you have marked any Activities as
Done, remember to save the Day
Planner before closing it or changing
to a different day.
To close the Day Planner, use the close box.

The [New Activity] button
Click the [New Activity] button in any Calendar view to enter a new Activity
record. The Task Type in the new Activity will be Calendar, and the Symbol
will be Other. The Person(s) in the Persons field of the Calendar view will be
copied to the Persons field of the Activity. Please refer to the section entitled
‘The Activity Register’ above on page 386 for full details.
The [Report] button
Click the [Report] button in any Calendar view to produce a Personal
Calendar report. Please refer to the ‘Personal Calendar Report’ section below
on page 409 for full details.
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If there are no Week Numbers
If dashes appear instead of Week Numbers in any of your Calendar views,
the probable cause is that there is no record in the Weeks setting, or the
record that is there is incomplete. In the latter case, if the current year has
already been entered and the dashes remain, it is recommended that you
delete the existing record and enter a new one. The Weeks setting is
described on page 263 in Chapter 5, ‘Settings’.
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The Personal Calendar Report
The Personal Calendar report is effectively a report version of the Calendar.
As with the Calendar, it shows Calendar Activities only. They are sorted into
Start Date and Start Time order.
When printed to screen, the Personal Calendar has FirstOffice’s Drill-down
feature. Click on the Start Time or Activity Text of any Activity in the report
to open that Activity.
To open the Personal Calendar report, click the [Report] button in the top
right-hand corner of any Calendar view. The Personal Calendar is
immediately printed to screen. The report period and Person are taken from
the Calendar view from where the report was created. For example, if the
report was produced from a weekly view, the report period will be the week
shown in the view. The Activities shown will be those shown in the Calendar,
with two exceptions: if the initials of more than Person are shown in the
Calendar view separated by commas, the report will only show those
Activities common to all those Persons, not all Activities for all Persons; and
Activities marked as Don't Show, which are not shown in the Calendar, are
shown in the report. For Time Activities, the Cost (Time) (i.e. the time taken
to complete the Activity, or elapsed time) will be shown (together with a total
at the bottom); no elapsed time will be shown for Profile Activities. The
elapsed time figure shows partial hours as decimals, not as numbers of
minutes. If an Activity has been marked as Done, “OK” will be shown to the
right of the elapsed time.
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This screen version of the report contains a number of text buttons, as
follows—
New Activity

Click this text (just underneath the report header) to
create a new Activity. Its Task Type will be Calendar
and its Symbol will be Other. On saving and closing the
new Activity and returning to the report, select
‘Recalculate’ from the Operations menu. The new
Activity will then be shown in the report, providing you
did not change its Task Type.

Start Time, Activity Text
Click the Text of any Activity to open that Activity
record.
To print the Personal Calendar to a printer, first print it to screen and then
click the Printer icon or select ‘Print’ from the File menu.
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Chapter 9: Documents
Use the ‘Documents’ function to print particular documents or Forms in
batches. To begin printing documents, select ‘Documents’ from the File
menu or click the [Documents] button in the Master Control panel. You can
also use the Ctrl-D (Windows) or -D (Macintosh) keyboard shortcut.

The ‘Documents’ list window opens, showing the documents that can be
printed from FirstOffice. Each item (“Document”) will be printed using a
different Form.

To print a document, follow this procedure—
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1.

Double-click the appropriate item in the ‘Documents’ list.

2.

A specification window will then appear, where you can determine the
documents that you want to be printed (e.g. which Invoices are to be
printed). The specification window for each document is described in
detail below.

3.

Click [Run] to print the documents.

4.

Close the ‘Documents’ window using the close box.
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Each document will be printed using a different Form. To determine the
Form that will be used when a document is printed, follow this procedure
(when FirstOffice is supplied, a sample Form is attached to each
document)—
1.

For each option, design a Form (or change the sample Form supplied to
reflect your own requirements) using the Forms setting. This process is
fully described on page 222 in Chapter 5, ‘Settings’.

2.

Open the ‘Documents’ window using the ‘Documents’ item on the File
menu or by clicking the [Documents] button in the Master Control panel.

3.

Click once on each item in the list and select ‘Define Document’ from
the Operations menu. In the subsequent window, assign a Form (or more
than one Form) to each document: this window is fully described in the
‘Documents’ section on page 94 of Chapter 2, ‘Work Area’.

4.

You only need use the ‘Define Document’ function once for each
document. Afterwards, Form selection will be automatic.

The selection process for each document is described below. In all cases,
leave all the fields in the specification window blank if documents for all the
records in the database are to be printed. If it is necessary to restrict the
number of documents printed, use the fields as described.
Where specified below, it is often possible to report on a selection range,
such as a range of Invoice Numbers. To do this, enter the lowest and highest
values of the range, separated by a colon. For example, to report on
Customers 001 to 010, enter “001:010” in the Customer field. Depending on
the field, the sort used might be alpha or numeric. In the case of an alpha sort,
a range of 1:2 would also include 100, 10109, etc.
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Invoices
There are several occasions when you may want to print an Invoice: to view a
test print-out to check the Invoice before you finally approve it; to produce a
copy for your own files, or to send the original Invoice to the Customer.
For a sample printout, click the Printer icon in the Button Bar while you are
working with an Invoice, and before you click the OK check box. FirstOffice
will print an Invoice marked “Test Printout” diagonally across the page.
Since you have not yet committed the Invoice by clicking the OK check box,
you can check it and change it if necessary. This is true also for Cash Notes
and Credit Notes. If you want to print to screen, click the Preview icon.
When you want to print the final Invoice, you can do so again by clicking the
Printer icon while the Invoice is open on screen, or, to print a number of
Invoices at one go, follow the instructions below.
1.

Click the [Documents] button in the Master Control panel, or select
‘Documents’ from the File menu. In the ‘Documents’ list, double-click
the Invoice type you want to use.
The ‘Specify Invoices’ window is opened.
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2.

Enter the Invoice Number to print a single Invoice, or a range of Invoice
Numbers separated by a colon. Use the Status options to specify which
Invoices are to be printed.

Unprinted Only

This option ignores any Invoices in the range that have
already been printed.

All

Prints all Invoices in the range. Any Invoices previously
printed will have the word “Copy” printed diagonally
across the page.

Original Print

This option also prints all Invoices in range. However,
any Invoices previously printed will be printed again as
though they were original copies, without the word
“Copy”.

Use the Invoice Type check boxes to limit your selection to specific
kinds of Invoice.
3.

Press [Run] in the Button Bar to start the printing, or cancel by closing
the window.

When designing the Form to be used when printing Invoices, two fields are
available to print the Quantities. The Quantity field prints the same number of
decimal places that were used in the Invoice record. The Quantity In field
always prints two decimal places, rounding up or down where necessary.
If you specified in the Invoice Form that several copies are to be printed,
perhaps on different printers, these copies will only be printed the first time
you print an Invoice after approving it. If you need to print all copies again,
you must print the Invoice using this function (i.e. not by clicking the Printer
icon in the Invoice record), and you should choose the Original option.

Cash Notes, Credit Notes
These options behave in the same manner as ‘Invoices’ already described.
They are provided to enable you to assign a separate Form for each Invoice
type. To do this, click once on each option in turn in the ‘Documents’ list and
select ‘Define Document’ from the Operations menu. This should be done for
each document that you are likely to use. Otherwise FirstOffice will give the
warning “Can’t find document” when you try to print an Invoice of a type
that has no Form. If you get this warning, check the type of the Invoice
before looking to see which document is missing its Form.
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Customer Labels
This document prints name and address labels to Customers. It uses the
Address and Contact from each Customer record.

Customer

Paste Special

Customers and Suppliers in
Customer register

Range Reporting

Alpha

Enter the Customer Number or range of Numbers for
which you want the labels printed.
By default, the ‘Paste Special’ list shows Customers.
Click the [Suppliers] button if you need to see Suppliers.
Category

Paste Special

Customer Categories setting

Select a Customer Category. Labels will be printed for
all Customers in that Category.
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Sorting

The labels can be sorted by Customer Number,
Customer Name or by Sort Key.

Function

Choose which of the three standard label formats you are
using, 2 or 3 columns and 8 rows on an A4 page, or a
single label per page.
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Illustrated below is a sample CUST_LABEL record from the Forms setting.
Note that you should only draw each field once: the label printing function
will print the fields the appropriate number of times on each page.

If you want static text to be printed on your labels (i.e. text that identifies the
information on the labels, such as “Customer Name”), open your
“CUST_LABEL” Form (using the Forms setting) and follow these steps—
1.

Click the [Field] button and draw a rectangle where you want the static
text to appear. The Field dialogue box opens.

2.

Leave the Fieldname blank and enter the static text in the Field
Argument field.

3.

Click [OK] to save.

4.

Do not use the [Text] button for this purpose: any text entered this way
will be printed for the first label only.
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Chapter 10: Reports
To print a report in FirstOffice, select ‘Reports’ from the File menu or click
the [Reports] button in the Master Control panel. You can also use the Ctrl-R
(Windows) or -R (Macintosh) Keyboard shortcut.

The ‘Reports’ list window opens, showing the reports available in
FirstOffice—

To print a report, double-click the appropriate item in the list. A specification
window will then appear, where you can decide what is to be included in the
report. Leave all the fields in the specification window blank if the report is
to include every record in the relevant register. If you need to restrict the
coverage of the report, use the fields as described individually below for each
report.
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Where specified below, it is often possible to report on a selection range,
such as a range of Customers, or a range of Items. To do this, enter the lowest
and highest values of the range, separated by a colon (:). For example, to
report on Customers 001 to 010, enter “001:010” in the Customer field.
Depending on the field, the sort used might be alpha or numeric. In the case
of an alpha sort, a range of 1:2 would also include 100, 10109, etc. Similarly,
wherever a report period is required, enter the start and end dates, again
separated by a colon (e.g. 01/01/2005:31/01/2005).
Use the Media options at the bottom of the specification window to
determine the print destination of the report. The default is to print to screen.
You can initially print to screen and subsequently send the report to a printer
by clicking the Printer icon at the top of the report window. You can also
print the report to disk as a text file. This will be useful if you want to format
the report in your house style before printing.
When you have specified what is to be included in the report, click [Run] to
print the report.

Definition of Reports
The appearance and format of some reports can be changed to suit your
specific requirements. This is known as changing the report’s definition. The
reports for which this facility is available are the Balance Sheet, the Profit &
Loss Report and the VAT Report.
To change a report definition, first select ‘Settings’ from the File menu and
double-click ‘Report Settings’ in the subsequent list. Then, highlight a report
name in the list on the left-hand side of the ‘Report Settings’ window and
click the [Definition] button. The subsequent definitions windows are
described in the sections covering the particular reports below.

!

If you have modified the standard
Chart of Accounts or imported your
own, you must change the report
definitions accordingly.

Drill-down
FirstOffice has a unique drill-down feature in some of the reports when they
are printed to screen. For example, when you have a Profit & Loss statement
on the screen, you can click on any of the Account numbers in the report. The
Nominal Ledger report for the same Account and period is then opened in a
separate window, showing all the Transactions that constitute the total
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amount on the P&L statement. If you then click on one of the Transaction
Numbers in the Nominal Ledger report, the Transaction record will open,
showing all the details recorded for the event. This example is illustrated
below—
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Text with the drill-down feature is shown underlined in a screen report.

The Operations Menu

When a report window is active on the screen, the Operations menu is
available. The ‘Recalculate’ command will immediately recalculate the report
to include all changes made in any Transactions, Customer records etc. since
the report was last calculated. The ‘Reopen Report Specification’ command
on the same menu allows you to produce a new report using different
reporting criteria.
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Balance Sheet
The Balance Sheet shows the assets, liabilities and capital of the company at
a given point in time. You can use the Balance Sheet model supplied with
FirstOffice, or you can define your own, possibly editing the standard
definition to suit your needs.

Setting up a Balance Sheet
You can define the structure of the Balance Sheet to suit your requirements.
The following example illustrates the set-up process.
To change the report definition of the Balance Sheet, first select ‘Settings’
from the File menu and double-click ‘Report Settings’ in the subsequent list.
Then, highlight ‘Balance Sheet’ in the list on the left-hand side of the ‘Report
Settings’ window and click the [Definition] button. The ‘Definition of
Balance Sheet: Browse’ window is opened.

The window shows the Balance Sheet row by row, as it has been presented
up to now. The rows are numbered 10, 50, etc., so there is room to insert new
rows in between.
Double-click the first row, “10: Fixed Assets”.
The ‘Definition of Balance Sheet Definition: Inspect’ window is opened with
the current definition of the row.
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The number identifies the row in the Balance Sheet, and the text “Fixed
Assets” is printed in the report as a heading for a group of Accounts.

In the Accounts field a sequence of Account numbers has been entered. An
alpha sort is used so, in the example illustration above, “600:69999”
effectively means that all Accounts whose first digit is “6” are to be used.
Of the four Type options, “Accounts” has been selected to indicate that each
of the Accounts in the number interval will be presented individually. After
the last Account in the group, a total for the group will be printed.
The Account Type is “Asset”. The Account Type concept is explained in the
section describing the Accounts setting on page 192 in Chapter 5, ‘Settings’.
The Side and Active/Passive options are described in the ‘Special Features of
the Balance Sheet’ section below on page 431.
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The Accounts field consists of three rows, with room for a definition 300
characters long. As alternatives to specifying a range of Accounts, you can
also specify a number of individual Accounts, or ranges of Accounts,
separated by commas. If you enter a range of Accounts with the highest
number first, the Accounts in that range will be presented in reverse order.
For example, the sequence “605:601,626,651:655” will appear as follows in
the printed report—

If you click the [Next Record] button (on the left-hand side of the Button
Bar) or select ‘Next’ from the Record menu, the next definition row, number
25, “Cash in Hand & at Bank”, is shown. This definition contains a range of
Accounts — 700 to 739999. This row is of the type “Accounts”, and of the
“Asset” Account Type.

!
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If you move from record to record by
clicking the [Next Record] or
[Previous Record] buttons, remember
that any changes you make will be
saved. If you don’t want to save the
changes, you must use the close box,
or click [Cancel].
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Click forward to number 40, “Total Current Assets”. Here the values of rows
25, 30 and 35 are added together, and the result is shown on line 40 with the
heading “Total Current Assets”. The Type is “Sum” and the Account Type is
still “Asset”.

In this way the Balance Sheet is designed, row by row.
When you have finished with the last row, if you want to save your changes,
click [Save], or else close the window with the close box. Then, close the list
of definitions using the close box once again.
The new Balance Sheet report is now ready to print.
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!

FirstOffice comes with a standard
Chart of Accounts and a set of Report
Definitions. This is a well-structured
Chart, with systematic groupings of
Accounts. It is suitable without any
changes for most small or medium
companies, but it is also easily
modified by you or your financial
adviser.

If you stay within the structure of the Chart (e.g. avoid putting Liability
Accounts among the Assets!), there is no need to alter the definitions. But
remember, it is a good idea to print a test Balance Sheet to see if your
definitions produce exactly what you expect.
Inserting a Row in the Balance Sheet
1.

Click the [Settings] button in the Master Control panel and double-click
‘Report Settings’ in the subsequent list. Then, highlight ‘Balance Sheet’
in the list on the left-hand side of the ‘Report Settings’ window and click
the [Definition] button.
The ‘Definition of Balance Sheet: Browse’ window is opened.

2.

Click [New] or highlight a row similar to the one you are creating and
click [Duplicate].
An empty form or a copy of the highlighted row is opened.

3.

Enter the information for the new row.
Remember to give the new row a number that will insert it in the right
place in the Balance Sheet. (If you want to insert a row between e.g.
rows 30 and 40, you can use 35.)

4.

Click [Save] and close the window, or click the close box to cancel.
You will now be brought back to the ‘Definition of Balance Sheet:
Browse’ window, where the new row is shown in its proper place in the
list.

Deleting a row from the Balance Sheet
1.
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Click the [Settings] button in the Master Control panel and double-click
‘Report Settings’ in the subsequent list. Then, highlight ‘Balance Sheet’
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in the list on the left-hand side of the ‘Report Settings’ window and click
the [Definition] button.
The ‘Definition of Balance Sheet: Browse’ window is opened.
2.

Double-click the row you want to remove, to show its definition window.

3.

Select ‘Delete’ from the Record menu.
The row is deleted from the Balance Sheet and the definition for the
following row is shown in its place.

4.

Close the window.
You will be returned to the ‘Definition of Balance Sheet: Browse’
window.

!

You cannot undo the deletion of a
row in the Balance Sheet.

Printing a Balance Sheet
Click the [Reports] button in the Master Control panel and then double-click
‘Balance Sheet’ in the ‘Reports’ list. The ‘Specify Balance Sheet’ window is
opened.
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Period

Paste Special

Reporting Periods setting

Enter the period for the Balance Sheet you want to print.
FirstOffice will suggest the first period in the Reporting
Periods setting as a default.
Accounts

Select how you want the Accounts printed in the report.

All

This option will show all Accounts that have been
included in the Balance Sheet definitions.

Used Only

This option will only show Accounts that have
been used. This includes Accounts that have
balances brought forward from a previous period
but that have not been used in the report period.

Groups Only

This option does not show balances for individual
Accounts. Instead, it simply shows an overall
balance for each row as entered in the Balance
Sheet definitions.

Used Groups Only
This option only shows balances for rows as
entered in the Balance Sheet definitions that have
been used.
Comparison

Choose to compare with Net Change or the Previous
Year.

List Transaction Nos
With this box checked, the Transaction Numbers of all
Transactions that fall within the reporting period,
together with debit and credit totals, will be listed at the
bottom of the report.
When you click [Run], the Balance Sheet is printed as you have specified it.
When printed to screen, the Balance Sheet has FirstOffice’s Drill-down
feature. Click on the Account Number of any Account in the report to open
the Nominal Ledger Report for the same Account and period. From the
Nominal Ledger report, you can click on any Transaction Number to open an
individual Transaction record.
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Special Features of the Balance Sheet
This section has no relevance for those companies that practise standard
western accounting conventions.

In the Balance Sheet definition, there are two groups of options that need a
special mention. This design has been made in order to facilitate certain
accounting and reporting requirements in various countries. The easiest way
to explain the usefulness of these facilities is with the help of an example. In
most companies, there are a number of reconciliation or suspense accounts,
either assets or liabilities, which alternately can hold debit or credit balances.
The accounting conventions of some countries only allow “pure” debit or
credit accounts, and when a balance sheet is produced, it becomes necessary
to move individual accounts back and forth between the active or the passive
groups, depending on the current positive or negative balance.
To complicate things even further, in some countries it is customary to
distinguish between four different “states” of a book entry: Debit+, Debit-,
Credit+ and Credit-. In modern western accounting systems, a book entry is
either debit or credit, regardless of the class of the account, i.e. we have a
simple arithmetic definition of balances.
In those environments where all these special rules are used, the preparation
of balance reports tends to become complicated and labour consuming. These
special functions of FirstOffice allow the far-reaching automation of many of
these routine tasks. This is how it works.
Let us start with the following Nominal Ledger report, showing the actual
debit and credit balances for two Accounts.
Account 702 - Bank Current Account 2—

431

HansaWorld FirstOffice Start

Account 703 - Advances and Settlements 3—

Account no. 703 is defined as an asset, and currently has a balance in credit.
Total Debits during the period is 15, and total Credits 1000. Account no. 702
has a normal debit balance, but on this account two negative values have
been entered, one in debit and one in credit. If the Accounts are used in a
report definition in the normal way, with the buttons Side:Normal and
Active/Passive:Normal selected, the balance of Account no 703 will be
shown as a negative asset value.

With the buttons Side:Debit and Active/Passive:Only Debit options selected,
the debit column total for Account 702 will be shown, because the Account
balance is in debit—
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With Side:Credit and Active/Passive:Only Credit selected, the balances from
both the Accounts’ credit columns will be shown, because both are negative.

With Side:Credit and Active/Passive:Only Debit selected, nothing will be
shown, because the credit column of Account 702 has a positive value, and
703 has an overall debit balance.
With Side:Debit and Active/Passive:Only Credit selected, once again nothing
will be shown.
The combination Side:Credit and Active/Passive:Normal shows the credit
column balances for both Accounts—

Company Info
This report is effectively a print-out of the Company Info setting. It also
shows licensing information such as the Control String and Control Code. It
is sometimes necessary to print this report when applying to your local
FirstOffice representative for an Enabler key.
To print this report, click the [Reports] button in the Master Control panel
and then double-click ‘Company Info’ in the ‘Reports’ list. There is no
specification window for this report, so print it by clicking either the Printer
icon or the [Run] button.

Convert Suppliers to Customers
This report is described in the section entitled ‘Combining Customers and
Suppliers’ on page 279 in Chapter 6, ‘Base Registers’.
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Correction List
The Correction List is a list of the corrections and updates made to
Transactions from a specified period. You can make corrections to
Transactions using the ‘Correction Mark’ function on the Operations menu of
the Transaction window, while you can make updates using the ‘Update
Mark’ function on the same menu. You cannot change the definition of this
report.
When printed to screen, the Correction List has FirstOffice’s Drill-down
feature. Click on any Transaction Number in the report to open an individual
Transaction record.
Double-clicking ‘Correction List’ in the ‘Reports’ list opens the following
window—

Period

Paste Special

Reporting Periods setting

Enter the report period in the format 01-02-05:28-02-05.
If you are using four-digit years as in the illustration, the
leading digits will be inserted automatically. If your
report period is a single day, just enter the date once and
this will be converted to a period format automatically.
The first row of the Reporting Periods setting is used as
a default value.
The report will list corrections and updates made to
Transactions whose Transaction Date falls in the period
specified here. It can therefore include corrections and
updates made later than this period.
From Reg. Date
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Enter a date to list updates and corrections made on or
after that date.
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All Transactions By default, this report only lists corrections or updates
made to Transactions. It shows the Transaction Number,
the Transaction Date, the action (i.e. correction or
update) and date of the action. If you check this box, the
report will also show the registration dates of every
Transaction, including those that have not been updated
or corrected. You might use this option to gain an
impression of the proportion of Transactions that have
been changed, or to get an idea of how long it takes for
updates and corrections to be made.
Click [Run] to print the Correction List.
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Customer List
This report is a simple listing of all the Customers in the Customer register.
If you need to print a list of Suppliers in the Customer register, use the
Supplier List report in the Purchase Ledger.
The Customer List report has FirstOffice’s Drill-down feature. Click on any
Customer Number in the report to open that Customer record.

Leave all the fields blank if the report is to cover all the Customers in the
Customer register. If it is necessary to restrict the coverage of the report, use
the fields as described below.
Customer

Paste Special

Customers in Customer register

Range Reporting

Alpha

Use this field to limit the report to a single Customer, or
range of Customers.
Category

Paste Special

Customer Categories setting

To restrict the report to Customers of a single Category,
enter a Category Code here.
Function
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These radio buttons control the level of detail shown in
the report.
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Detailed

This, the default option, causes all data in the
Customer register to be printed.

Contact Data

This alternative limits the output to Customer
Number, Name, Telephone Number, and Contact
Person.

Sorting

These radio buttons control the sort order of the report.
The default is to print the report in Customer Number
order, but you can also print in Name order.
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Customer Statistics
This report displays trading statistics for each Customer, including turnover,
margin and gross profit.

Leave all the fields blank if the report is to cover all the Customers in the
Customer register. If it is necessary to restrict the coverage of the report, use
the fields as described below.
Customer

Paste Special

Customers in Customer register

Range Reporting

Alpha

Use this field to limit the report to a single Customer, or
range of Customers. Customers in the range that have
not purchased anything during the report period will not
be shown in the report.
Categories

Paste Special

Customer Categories setting

Range Reporting

Alpha

To restrict the report to Customers of a single Category,
enter a Category Code here.
Period
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Enter the start and end dates of the reporting period,
separated by a colon (:).
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Electronic Invoice Status
This report is used in Finland. Please refer to your local FirstOffice
representative for details.
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Item List
For each Item, this report displays the Item Number, Name, any Group
membership, Unit, VAT Code and the sales Price.

Leave all the fields blank if the report is to cover all the Items in the Item
register. If it is necessary to restrict the coverage of the report, use the fields
as described below.
Item No.

Paste Special

Item register

Range Reporting

Alpha

Use this field to limit the report to a single Item, or range
of Items.
Item Group

Paste Special

Item Groups setting

Range Reporting

Alpha

To limit the report to a single Item Group, enter an Item
Group Code here.
If you specify both a range of Items and a range of Item
Groups, the report will cover only those Items in the
range that are members of the specified Item Groups.
Sorting
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The report can be sorted by Item Number, Item Group or
Name.
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Item Statistics
This report displays sales statistics for each Item (turnover and quantity sold).
The report period is the first period in the Reporting Periods setting.
When printed to screen, the Item Statistics report has FirstOffice’s Drilldown feature. Click on any Item Number to open the corresponding Item
record.

Leave all the fields blank if the report is to cover all the Items in the Item
register. If it is necessary to restrict the coverage of the report, use the fields
as described below.
Item

Paste Special

Item register

Range Reporting

Alpha

Use this field to limit the report to a single Item, or range
of Items. Only Items in the range that have been sold
(i.e. included on Invoices) during the report period will
be shown in the report.
Item Groups

Paste Special

Item Groups setting

Range Reporting

Alpha

To limit the report to a single Item Group, enter an Item
Group Code here.
If you specify both a range of Items and a range of Item
Groups, the report will cover only those Items in the
range that are members of the specified Item Groups.
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Journals
This report is a chronological listing of the records entered to any or all of the
transaction registers during the specified period (i.e. Invoices, Receipts,
Purchase Invoices and Payments). To list Nominal Ledger Transactions, use
the separate Transaction Journal report.

No

Range Reporting

Numeric

If necessary, enter here the transaction number (or range
of transaction numbers) of the transactions that you wish
to include in the report. This selection will apply to all
Journals chosen.
Period

Paste Special

Reporting Periods setting

Enter the start and end date of the reporting period,
separated by a colon (:). The first period in the Reporting
Periods setting is the default.
Function

Overview
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These options are used to control the level of detail
shown in the report. They are only applicable when
reporting on Invoices and Purchase Invoices.
This choice gives a summary report with one row
per Invoice, showing the Invoice Number, Date,
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Customer or Supplier and the Total including
VAT. For Customer Invoices, the Invoice Type
(e.g. Invoice, Credit Note or Cash Note) and the
Total excluding VAT are also shown, while for
Purchase Invoices the Supplier Invoice Number is
shown.
Detailed

Journals

In addition to the information shown in the
Overview, this option shows, for Customer
Invoices, the Invoice Address, Due Date and
Contact. For both Customer and Supplier
Invoices, each row of each Invoice is listed with
row totals. You can use this report as an archive
file instead of a copy of each Invoice.
Check the boxes to report on transactions of different
types. Separate reports will be produced for each type
selected.

Include not OKed By default, only approved transactions (i.e. those whose
OK box has been checked and which have therefore
been posted to the Nominal Ledger) will be included in
the report. If you want to include unapproved
transactions as well, check this box.
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Nominal Ledger
The Nominal Ledger report is a list of the Transaction rows entered during
the report period (i.e. it is a list of the amounts posted to each Account in that
period). This report definition cannot be altered.
When printed to screen, the Nominal Ledger report has FirstOffice’s Drilldown feature. Click on any Transaction Number to open an individual
Transaction record.
Double-clicking ‘Nominal Ledger’ in the ‘Reports’ list opens the following
window—

Period

Paste Special

Reporting Periods setting

Specify a report period, in the format ”01-02-05:28-0205”. If you are using four-digit years as in the
illustration, the leading digits will be inserted
automatically. If your report period is a single day, just
enter the date once and this will be converted to a period
format automatically. The first row of the Reporting
Periods setting is the default value.
Accounts

Paste Special

Accounts setting

Range Reporting

Alpha

Limit the report to a single or range of Accounts.
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Only with Text

Enter a search string in this field to list Transaction rows
with certain descriptions (shown in the Text field). Thus,
assuming you have used the default entries in the Text
field of each Transaction row, you can enter an Account
Name here to report on all postings to that Account.
Note that you do not have to enter the complete text
string: “Sales” finds “Sales Type 1”, “Sales Type 2”, etc.

Used Accounts Only
Check this box to exclude Accounts that were not used
during the report period. Accounts not used but with a
balance brought forward will be shown.
With Corrections Check this box if you want all corrections in the
Transactions to be shown.
Subtotal VAT Codes
Check this box if you want the total debit and credit
amounts for each VAT Code to be shown at the bottom
of the report.
List Transaction Nos
With this box checked, the Transaction Numbers of all
Transactions that fall within the reporting period,
together with debit and credit totals, will be listed at the
bottom of the report.
Long Lines

Three options are available for dealing with long
descriptions when printing on paper. The Don’t Break
option is always used when printing to screen. If you
preview the report to screen, choose ‘Recalculate and
Print’ from the Operations menu to invoke the Long
Lines option (i.e. do not click the Printer icon).
If you use a landscape Page Setup and/or reduce the
page magnification, the space available for long
descriptions (i.e. the width of the description column) is
increased.

Don’t Break

The full length of the description is printed on one
line. If it interferes with figures in the next
column, these are moved to the next line.

Break

The full length of the description is printed,
spread over several lines if necessary.
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Cut

The final characters of the description are not
printed, so that it fits onto one line in the
allocated column.

Click [Run] to print the Nominal Ledger report as you have specified it.
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Payments Forecast
This report, which, together with the Receipts Forecast, will be very useful
for cash-flow prediction purposes, gives information about outstanding
credits (i.e. unpaid approved Purchase Invoices), sorted by Due Date. This
shows how much it is expected the company will have to pay out in the near
future.

Supplier

Paste Special

Suppliers in Customer register

Use this field to show how much is outstanding to a
single Supplier.
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Periodic Customer Statement
The Periodic Customer Statement contains information about the current
balance for each Customer showing open (unpaid) Invoices, paid Invoices
and Receipts. You can therefore use it to produce a full Sales Ledger
transaction history for a specified Customer and period.
When printed to screen, the Periodic Customer Statement has FirstOffice’s
Drill-down feature. Click on any Invoice or Receipt Number to open an
individual Invoice or Receipt record.

Customer

Paste Special

Customers in Customer register

Range Reporting

Alpha

If necessary, enter here the Customer Number of the
Customer (or range of Customers) you wish to include in
the report.
Category

Paste Special

Customer Categories setting

If you want to restrict the report to Customers of a
particular Category, specify that Category here.
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Period

Paste Special

Reporting Periods setting

Enter the report period. The first row of the Reporting
Periods setting is used as the default.
Customers with Balance Only
Check this box to exclude Customers with no current
balance.
Function

Specify here the level of detail required in the report.

Overview

This option produces a single line summary of
each Customer’s credit situation.

Detailed

This option shows each Sales Ledger transaction
in the selected period, including Invoices and
Receipts.
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Periodic Supplier Statement
The Periodic Supplier Statement contains information about the current
balance for each Supplier showing open (unpaid) Purchase Invoices, paid
Invoices and Payments. You can therefore use it to produce a full Purchase
Ledger transaction history for a specified period.
When printed to screen, the Periodic Supplier Statement has FirstOffice’s
Drill-down feature. Click on any Purchase Invoice or Payment Number to
open an individual Purchase Invoice or Payment record.

Supplier

Paste Special

Suppliers in Customer register

Range Reporting

Alpha

To limit the report to a single Supplier, enter its Supplier
Number here. Alternatively you can enter a range of
Suppliers.
Category

Paste Special

Supplier Categories setting

If you want to restrict the report to Suppliers of a
particular Category, specify that Category here.
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Period

Paste Special

Reporting Periods setting

Enter the first and last date of the report period,
separated by a colon (:).
Function

Specify here the level of detail required in the report.

Overview

This option produces a single line summary of
your credit situation with each Supplier.

Detailed

This option shows each Purchase Ledger
transaction in the selected period, including
Invoices and Payments.

Suppliers with Balance Only
To limit the report to only Suppliers with a current
balance, check this box.
Include Ordered Payments
Switch this check box on to include Payments that have
been Ordered but not approved in the report.
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Profit & Loss
The Profit & Loss report shows the sales turnover achieved by your company
in the specified period. It also shows the total cost of sales and thus the gross
profit, and the total overheads and thus the net profit of your business.
When printed to screen, the Profit & Loss report has FirstOffice’s Drill-down
feature. Click on the Account Number of any Account in the report to open
the Nominal Ledger Report for the same Account and period. When in the
Nominal Ledger report, you can click on any Transaction Number to open an
individual Transaction record.

Definition
The content of the Profit & Loss report is defined in the same way as the
Balance Sheet. Please refer to the ‘Balance Sheet’ section above on page 424
for full details.

Printing a Profit & Loss Report
Click the [Reports] button in the Master Control panel and then double-click
‘Profit & Loss’ in the ‘Reports’ list. The ‘Specify Profit & Loss Report’
window is opened.
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Period

Paste Special

Reporting Periods setting

The report period: enter the first and last date separated
by a colon (:). The first period in the Reporting Periods
setting is the default.
Accounts

Select how you want the Accounts printed in the report.

All

This option will show all Accounts that have been
included in the Profit & Loss report definitions.

Used Only

This option will only show Accounts that have
been used. This includes Accounts that have
balances brought forward from a previous period
but that have not been used in the report period.

Groups Only

This option does not show balances for individual
Accounts. Instead, it simply shows an overall
balance for each row as entered in the Profit &
Loss report definitions.

Used Groups Only
This option only shows balances for rows as
entered in the Profit & Loss report definitions that
have been used.
Comparison

Select one option for the comparison column in the
report.

Accumulated

This option compares the report period with the
Year To Date.

Previous Year

This compares the report period with the same
period last year.

Previous Result

This compares the report period with the previous
financial year.

List Transaction Nos
With this box checked, the Transaction Numbers of all
Transactions that fall within the reporting period,
together with debit and credit totals, will be listed at the
bottom of the report.
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Purchase Ledger
The Purchase Ledger report is a summary of the Suppliers’ Invoices that have
been issued to your company and which have not yet been paid. For each
one, the Due Date, the outstanding amount and the number of days by which
it is overdue are shown, so, together with the Periodic Supplier Statement and
Payments Forecast reports, this report is a very useful tool for payment
scheduling purposes. Note that, as in all FirstOffice reports, the number of
overdue days is shown as a negative figure. You can limit the selection to a
specified period, or to a certain Supplier.
When printed to screen, the Overview option of this report has FirstOffice’s
Drill-down feature. Click on any Purchase Invoice Number to open an
individual Purchase Invoice record.

Supplier

Paste Special

Suppliers in Customer register

Range Reporting

Alpha

To limit the report to a single Supplier (or range of
Suppliers), enter the Supplier Number here.
Category

Paste Special

Supplier Categories setting

If you want to restrict the report to Suppliers of a
particular Category, specify that Category here.
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Date

Enter a date to show the status of the Purchase Ledger as
of that date. If the field is left blank, the status will be
shown as of the date of printing.

Function

Use these options to control the level of detail shown in
the report.

Detailed

This option produces a report listing for each
open Invoice any Payments, partial payments and
Credits.

Overview

This option is a summary showing an outstanding
balance, due date and age for each open Purchase
Invoice.

Balance

This option simply prints the total balance
payable to each Supplier.

Status

Use these options to determine which Purchase Invoices
are included in the report.
Open

When this option is selected the report will
contain all unpaid Purchase Invoices.

Due

When this option is selected the report is limited
to those Invoices that are due for payment.

Sorting

The report can be sorted by Supplier Number or Name.
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Receipts Forecast
This report, which, together with the Payments Forecast, will be very useful
for cash-flow prediction purposes, gives information about the incoming
payments expected by a particular date. It gives you information about
outstanding Invoices, sorted by due date.

Customer

Paste Special

Customers in Customer register

Use this field to show how much is outstanding from a
single Customer.
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Sales Ledger
The Sales Ledger report is a summary of the position on each Customer’s
account. Together with the Receipts Forecast and Periodic Customer
Statement report, it is a very useful tool for debt-chasing purposes.
In its basic form, it shows Customer Name and Telephone Number and, for
each Invoice, the amount outstanding, the Due Date and the age or number of
days overdue. Note that, as in all FirstOffice reports, the number of overdue
days is shown as a negative figure.
When printed to screen, the History and Overview options of this report have
FirstOffice’s Drill-down feature. Click on any Invoice or Receipt Number to
open an individual Invoice or Receipt record.

Customer

Paste Special

Customers in Customer register

Range Reporting

Alpha

If necessary, enter here the Customer Number of the
Customer (or range of Customers) you wish to include in
the report.
Date

If necessary, you can print a report showing the debtor
situation as it was on a particular date. To do this, enter
that date here. If you don’t need to use this feature, leave
the field blank.
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Category

Paste Special

Customer Categories setting

If you want to restrict the report to Customers of a
particular Category, specify that Category here.
Function
History

With this option selected, the report lists for each
Invoice any Receipts, partial payments and Credit
Notes.

Overview

This option is a summary showing an outstanding
balance, due date and age for each unpaid
Invoice.

Balance

This choice simply prints the total outstanding
balance for each Customer.

Status

Use these options to determine which Invoices are
included in the report.
Open

Select this alternative to include all unpaid
Invoices.

Due

Include only those Invoices that are due for
payment.

Sorting
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Use these options to control the level of detail shown in
the report.

The report can be sorted by Customer Number or Name.
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Supplier List
The Supplier List is a simple listing of the Suppliers entered in the Customer
register.

Supplier

Paste Special

Suppliers in Customer register

Range Reporting

Alpha

Use this field to limit the report to a single Supplier, or
range of Suppliers.
Category

Paste Special

Supplier Categories setting

To restrict the report to Suppliers of a single Category,
enter a Category Code here.
Function

These options control the level of detail in the report.

Detailed

This gives a report showing all available
information for each Supplier.

Contact Data

This gives a report showing only contact data
(Supplier Number and Name, Contact Person and
Telephone Number), and is therefore a more
compact listing.

Sorting

The report can be sorted by Supplier Number or Name.
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System Documentation
System Documentation produces a number of lists showing the records that
have been entered to certain settings. You can therefore use it to describe the
contents and set-up of your system. It may be a good idea to check the
contents of your system from time to time. This report is also useful for
auditing purposes since it contains important system information to be
included in a professional audit, such as the Chart of Accounts.
Click the [Reports] button in the Master Control panel and then double-click
‘System Documentation’ in the ‘Reports’ list. The ‘Specify System
Documentation’ window is opened.

Click the check boxes for each option that you would like to be included in
the report and click the [Run] button in the Button Bar.
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Transaction Journal
The Transaction Journal (also called Daily Transaction Ledger) is a summary
of all entries made in the ledger. Its definition cannot be changed.
Reporting in FirstOffice is non-destructive. That means you can make and
print a report as many times as you wish. Some accounting programs are
designed in such a way as to allow journal printing only directly in
connection with the data entry. FirstOffice does not have this limitation.
Click the [Reports] button in the Master Control panel and then double-click
‘Transaction Journal’ in the ‘Reports’ list. The ‘Specify Transaction Journal’
window is opened.

Transactions

Range Reporting

Numeric

If you only want to print a certain range of Transactions,
e.g. those entered today, you can select this range using
the Transactions field. Enter the first and the last
Transaction Number, separated by a colon (:). If you
leave the field blank, all records in the Transaction
register from the selected period will be printed.
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The Transaction Number must include the prefix as
shown in the ‘Transactions: Browse’ window. To print a
Transaction that was entered directly to the Nominal
Ledger, enter, for example, “2005.3” or, for a range,
“2005.3:2005.10”. To print a Transaction that was
created remotely from one of the other transaction
registers, enter, for example, “S/INV.050003” or
“S/INV.050003:S/INV.050010” for a range.
Period

Paste Special

Reporting Periods setting

Enter the period to be covered by the report.
Only VAT Code

Paste Special

VAT Codes setting

You may limit the report to Transactions that include
postings with a particular VAT Code.
Report Header

Specify the report title here. If none is specified,
‘Transaction Journal’ is used.

Legal Serial No.

In some countries it is mandatory for all Transactions to
follow a single number series, irrespective of their
nature. If that is the case, enter the first number in the
series here and check the Don’t Print Transaction Prefix
box below. Each Transaction will be given a number in
the specified series, in place of the usual Transaction
Number.

Fwd Turnover

If you enter an amount in this field, this amount will be
added to the total turnover at the bottom of the report.

Sorting

The report can be sorted by Transaction Number or
Transaction Date.

List Transactions With this box checked, each Transaction used by the
report, together with debit and credit totals, will be listed
at the bottom of the report. If the scope of the report has
been restricted using any of the fields above, only those
Transactions included in the report will be listed.
Don’t show Account description
Use this option if you don’t wish Account Descriptions
for each Transaction row to be shown.
List Accounts
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With this box checked, each Account used by the
Transactions in the report, together with debit and credit
totals, will be listed at the bottom of the report. If the
scope of the report has been restricted using any of the
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fields above, only those Accounts affected by the
Transactions shown will be listed.
List VAT Codes With this box checked, each VAT Code used by the
Transactions in the report, together with debit and credit
totals, will be listed at the bottom of the report. If the
scope of the report has been restricted using any of the
fields above, only those VAT Codes affected by the
Transactions shown will be listed.
Don’t print Transaction Prefix
Transaction Numbers are usually shown in the report
together with their prefixes as shown in the
‘Transactions: Browse’ window. Transactions entered
directly to the Nominal Ledger, for example, are shown
as “2005.3” while those created from a Sub System are
shown as, for example, “S/INV.050003”. If you do not
want these prefixes to be shown in the report (i.e. in the
examples, to omit “2005.” and “S/INV.”), check this
box.
If you check this box and enter a Legal Ser. No. above,
each Transaction will be given a number in the sequence
beginning with the Legal Ser. No. in place of the usual
Transaction Number.
Click [Run] in the Button Bar. The Transaction Journal is printed.
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Trial Balance
The Trial Balance is a report showing all individual Account balances. It is
mostly used for reconciliation. You cannot alter the definition of the Trial
Balance report, but you can determine which Transactions are to be included.
When printed to screen, the Trial Balance has FirstOffice’s Drill-down
feature. Click on the Account Number of any Account in the report to open
the Nominal Ledger Report for the same Account and period. When in the
Nominal Ledger report, you can click on any Transaction Number to open an
individual Transaction record.
The totals of the three columns in the report should each be zero, signifying
that in your accounts the total debits and the total credits are equal. If this is
not the case, there may be an error in one or more of your Transactions that
should be corrected immediately.
Click the [Reports] button in the Master Control panel and then double-click
‘Trial Balance’ in the ‘Reports’ list. The ‘Specify Trial Balance’ window is
opened.

Period

Paste Special

Reporting Periods setting

Enter the period for which you want to produce the Trial
Balance. The first period in the Reporting Periods setting
is the default value.
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Accounts

Paste Special

Accounts setting

Range Reporting

Alpha

Limit the report to a certain Account, or a range of
Accounts.
VAT Code

Paste Special

VAT Codes setting

Enter a VAT Code here to restrict the report to
Transactions with a certain VAT Code.
Used Accounts Only
With this box checked, the report will only show
Accounts with Transactions registered during the report
period, and/or with balances brought forward from a
previous period.
List Transaction Nos
With this box checked, the Transaction Numbers of all
Transactions that fall within the reporting period,
together with debit and credit totals, will be listed at the
bottom of the report. All Transactions will be listed,
irrespective of any restrictions in the scope of the report
specified in the fields above.
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VAT Listing
This report lists the transactions used in calculating the VAT Return
(produced using the VAT Report described below on page 467). For each
transaction, the total including and excluding VAT, the VAT total and the
overall VAT percentage are shown.

Period

Paste Special

Reporting Periods setting

Enter the period for which you want to print the report in
the format 01/02/05:28/02/05. If you are using four-digit
years as in the illustration, the leading digits will be
inserted automatically. If your report period is a single
day, just enter the date once and this will be converted to
a period format automatically. The first period in the
Reporting Periods setting is the default value.
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Specify

You can choose to have Sales Invoices, Purchase
Invoices and/or Nominal Ledger Transactions listed in
the report. At least one section must be chosen or the
report will be blank. For each section, the list of
transactions will be followed by a list of VAT Codes
used by those transactions, together with totals.

Select

The report can show all Transactions or just those
without VAT.
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VAT Report
Whenever a VAT Return is due you have to print a VAT Report. The report
is used both as a transaction document for the ledger and as the basis for
payment.
The report summarises the Input and Output VAT Accounts for the specified
period, and also shows the total Inputs (purchases) and Outputs (sales). A
positive total indicates that you are liable for VAT, a negative one signifies
that you are owed money by the VAT authority.
Once a VAT Return has been printed for a given period, it is recommended
that you enter a Transaction in the Transaction register transferring the VAT
amount payable/receivable into the VAT Payments Account (835 in the Chart
of Accounts supplied with FirstOffice). This Transaction would debit the
VAT Outputs Payable Account (830) and credit the VAT Inputs Receivable
Account (831), with a balancing posting to the VAT Payments Account. This
Transaction must be entered within the period it concerns, preferably as the
last Transaction of the period. The amount payable/receivable can then be
transferred to your bank account with a further Transaction when payment is
made/received.

Setting up the VAT Report
You can define the VAT Report to determine which Accounts should be
included.
To change the report definition of the VAT Report, first select ‘Settings’
from the File menu and double-click ‘Report Settings’ in the subsequent list.
Then highlight ‘VAT Report’ in the list on the left-hand side of the ‘Report
Settings’ window and click the [Definition] button. The ‘Definition of VAT
Report: Browse’ window is opened.
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The definition above is a standard UK VAT report, using the Chart of
Accounts and definitions supplied with FirstOffice. It can be altered to suit
your specific requirements: you will need to change it if you have modified
the standard Chart of Accounts or imported your own.
Each row in the definitions list represents a line on the VAT Report. Rows
can be added, inserted or deleted as necessary. To insert a row, highlight the
row above which the new one is to be inserted (by clicking the row number)
and press the Return key. To delete a row, highlight it and press the
Backspace key.
If you are an existing user of FirstOffice updating to version 4.1 or later, note
that the syntax used in the formulae changed in this version. All parameters
should now be enclosed in quotation marks. The order of parameters for the
VATRESULT,
VATBALANCE,
VATCREDRESULT
and
VATDEBRESULT commands has been transposed.
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Row

Each line of the report is defined on its own numbered
row.

Code

A code identifying a row that may be used in the
definitions of other rows.
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Comment

A descriptive text that identifies the line in the finished
report.

Definition

The definition of the row in the report, i.e. which
Accounts should be used in calculating the figure to be
shown, and the formula of that calculation.

Several commands are available for use by formulae in the Definition field.
They are not case sensitive.
RESULT("Account Code")
This command returns the net change during the period
for the Account specified in the brackets. Some
examples of the use of this command are as follows—
RESULT("100") Returns the net change in Account 100 for the
specified period.
RESULT("100:1999")
Returns the sum of the net changes in Accounts
100 to 1999 for the specified period. The
Accounts used are determined using an alpha
sort, rather than a numeric one. Thus Account
1000001 will be included in the example range,
while Account 200 will not.
-RESULT("100:1999")
As the previous example, but the sign of the final
figure is changed. This is useful when displaying
figures for sales, which are stored as negative
figures in FirstOffice. Prefixing the RESULT
command with a minus sign will cause sales to be
displayed as positive figures.
RESULT("100+120:1999")
Takes the net change in Account 100 and adds it
to the sum of the net changes in Accounts 120 to
1999.
CREDRESULT("Account Code")
This command returns the total credit posting during the
report period to the Account specified.
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DEBRESULT("Account Code")
This command returns the total debit posting during the
report period to the Account specified.
BALANCE("Account Code")
This command returns the closing balance for the
Account specified. It therefore differs from the RESULT
command in that balances brought forward from
previous periods are taken into account.
The command can return the sum of the balances of
specified Accounts in the same manner as the RESULT
command: please refer to the description of the RESULT
command above for examples.
CREDBALANCE("Account Code")
This command returns the closing credit balance for the
Account specified. It therefore differs from the
CREDRESULT command in that balances brought
forward from previous periods are taken into account.
DEBBALANCE("Account Code")
This command returns the closing debit balance for the
Account specified. It therefore differs from the
DEBRESULT command in that balances brought
forward from previous periods are taken into account.
KEY("Code")

The value of another VAT Report row can be included in
the calculation. The VAT Report row referred to must
already have been defined. If not, a zero value is used.
Therefore, in the example illustration, the SALT line
must appear below the SAL0, SAL1 etc. lines.
Note that although the KEY command itself is not case
sensitive, the reference to another VAT Report row is.
Thus, in the example illustration, key(“SAL0”) and
KEY(“SAL0”) are relevant, but key(“sal0”) is not.

VATRESULT("Account Code","VAT Code")
This command is similar to RESULT, but in calculating
the net change during the period for the Account
specified, only Transactions with the specified VAT
Code are taken in account.
The reference to the VAT Code is not case sensitive.
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The command can return the sum of the balances of
specified Accounts in the same manner as the RESULT
command: please refer to the description of the RESULT
command above for examples.
VATBALANCE("Account Code","VAT Code")
This command returns the closing balance for the
Account specified, with only Transactions with the
specified VAT Code taken into account. It therefore
differs from the VATRESULT command in that
balances brought forward from previous periods are
taken into account.
VATCREDRESULT("Account Code","VAT Code")
This command returns the total credit posting to the
Account specified during the period, taking only
transactions with the specified VAT Code into account.
VATDEBRESULT("Account Code","VAT Code")
This command returns the total debit posting to the
Account specified during the period, taking only
transactions with the specified VAT Code into account.
The illustration of the VAT Report definition shows examples of the various
commands. There are a few things to remember.
As the calculation uses FirstOffice’s internal values, balances on e.g. sales
Accounts will be shown as negatives, since they normally are in credit. You
solve this simply by reversing the sign for all such calculations: an example
of this is in the first row in the illustration. The examples also show how to
group different Accounts.
The value of a well-structured Chart of Accounts can easily be seen here. If
all income related Accounts are found in a consecutive series, totalling them
becomes simple.
When you have finished defining the VAT Report, click [Save].
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Printing the VAT Report
Click the [Reports] button in the Master Control panel and then double-click
‘VAT Report’ in the ‘Reports’ list. The ‘Specify VAT Report’ window is
opened.

Period

Paste Special

Reporting Periods setting

Enter the period for which you want to print the report in
the format 01/02/05:28/02/05. If you are using four-digit
years as in the illustration, the leading digits will be
inserted automatically. If your report period is a single
day, just enter the date once and this will be converted to
a period format automatically. The first period in the
Reporting Periods setting is the default value. If you
leave the field blank, statistics for the whole year will be
printed.
List Transactions With this box checked, the Transaction Numbers of all
Transactions that fall within the reporting period,
together with debit and credit totals, will be listed at the
bottom of the report.
Click [Run] to print the report.
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Chapter 11: Exports
You can export several different types of information from FirstOffice. You
can incorporate the exported information in external programs such as
spreadsheets, word processors etc. Apart from those created by the Back-up
functions, all exports are output in simple text format, with fields separated
by tabs.
To produce an export file, select the ‘Exports’ item on the File menu or click
the [Exports] button in the Master Control panel.

The ‘Exports’ list window opens, showing the Exports that can be produced
from FirstOffice.

Double-click the appropriate item. A specification window will then appear,
where you can decide the contents of the export file. Click [Run] again and a
‘Save File’ dialogue box will appear, where you can name the file and
determine where it is to be saved.
Be careful when opening a FirstOffice Export file with Microsoft Excel with
the intention of editing it before importing it to a new database. Under certain
circumstances, Excel will, when opening a text file, convert some variables
that it interprets as dates into its own internal date format. Where you are
expecting a date to appear in the spreadsheet you may see a number such as
“35475”. When you save the spreadsheet again as a text file these variables
will not be converted back to date format. So, if you import this text file to
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FirstOffice, the dates will all be wrong. To avoid this problem, make sure you
use the third step of Excel’s Import Wizard to set all imported columns to
‘text’ format (highlight all the columns in the Data Preview area using the
Shift key and select ‘Text’ as the Column Data Format).

You cannot open files created using the ‘Database Text Backup’ and
‘Company Text Backup’ functions in Excel as they are not text files.
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Banking File
Select this option when you want to export a selection of Payments from your
Purchase Ledger. This file may then be sent to the bank for use by a credit
transfer system, and serve instead of a printed payment order. The function is
not operational in every country: please refer to your local FirstOffice
representative for full details.

Enter a Payment Number, or a range of numbers separated by a colon. By
default, only Payments that have not yet been exported are included in the
export. Select the All option if you want all Payments included in the export
file.
Click the [Run] button in the Button Bar to proceed. FirstOffice will open a
dialogue box where you can name the export file and specify where it is to be
saved.
Enter a name for the file. Click [Save] or press the Enter key.
A message window informs you about the progress of the export process. The
process can be interrupted at any time by pressing Esc (Windows) or Period (Macintosh).

476

Chapter 11: Exports – Base Registers

Base Registers
You can use this function to export records from the Base Registers. This is a
practical tool for use when you want to create a new Company that will use
the same basic information as your existing ones.
You can save much work by simply copying repeated data and afterwards
changing whatever is different between the two Companies.
The Base Registers export is saved as an ordinary text file and you can
import it to the new Company using the ‘Automatic’ or ‘Automatic, manual
file search’ Import functions (described on pages 493 and 495 respectively in
Chapter 12, ‘Imports’).
Click the [Exports] button in the Master Control panel and double-click ‘Base
Registers’ in the ‘Exports’ list. The ‘Specify Base Registers’ window is
opened—

Choose one or more options as appropriate and click [Run] to proceed. If you
have selected a single register, you may export a selection of records in that
register by specifying a code range in the Code field. Then, give a name and
destination to the file and click [Save] or press the Enter key.
A message window informs you about the progress of the export process. The
process can be interrupted at any time by pressing Esc (Windows) or Period (Macintosh).
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Company Text Backup, Database Text
Backup
These functions provide you with an effective way to back up your data.
They copy all data from the program to a separate file. You can also copy or
duplicate the database file (1office.HDB) as it appears on your hard disk, but
FirstOffice’s method has two advantages—
•

The back-up file takes up very little space.

•

The back-up file is independent of the program version. IT CAN
ALWAYS BE USED, whereas a new version of the FirstOffice program
(for reasons of internal updates in the program) may have difficulties in
reading old database files.

!

Use FirstOffice’s built-in back-up
feature to guarantee a successful
restoration.

This is how you back up your data—
1.

Select ‘Exports’ from the File menu or click the [Exports] button in the
Master Control panel. The ‘Exports’ list window opens showing the
available export functions.

2.

Double-click ‘Company Text Back-up’ (if you wish to back up the data
in the database relating to the single Company currently selected) or
‘Database Text Back-up’ (if you wish to back up the whole database) in
the ‘Exports’ list. You can use the [Backup] button in the Master Control
panel as a short cut to the ‘Database Text Back-up’ option.
Usually you should use the ‘Database Text Back-up’ option, as this is the
only choice that backs up the entire database. You must use it regularly
for your safety and peace of mind. Some registers and settings (e.g. the
Configuration setting) are stored at database level, not Company level.
These will not be exported by the ‘Company Text Back-up’ option, even
if your database only contains a single Company. The ‘Company Text
Back-up’ option is intended for use in the situation where you need to
move all the information relating to a specific Company from one
database to another.

3.
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If you clicked the [Backup] button in step 2 above, the “Specify Text
Backup” window appears where you can describe the back-up file using

Chapter 11: Exports - Company and Database Text Backups

up to 40 characters. This description will be shown in the list of
importable files shown by the ‘Imports’ function. Click [Run] to
proceed.
4.

FirstOffice opens a standard dialogue box where you can name and place
the export file. Enter the name of the file in the filename area and locate
it in the appropriate directory in the usual way.
The name of the back-up should include the date the back-up was made
(e.g. TC0711 for Training Company and date). If you are intending to
restore from the back-up file using the ‘Automatic’ function, add a .txt
extension but do not include any spaces or other non-alphabetic
characters in the file name (the ‘Automatic, manual file search’ function
can import files with names that include non-alphabetic characters and
without extensions). Then, click [OK].
It is recommended that you store the back-up file in a folder or directory
named “Backup” which should be in the same folder or directory as the
FirstOffice application. All back-up files in this folder will be shown in a
list of importable files if it becomes necessary to restore from a back-up.

5.

A message window informs you about the progress of the export.

6.

When the export is finished, you are brought back to the ‘Exports’ list.
Close it using the close box.
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!

Make a rule to take a safety back-up
EVERY DAY! Your database can be
damaged, through hardware failures,
power cuts and other reasons. A
back-up file is a safety guarantee
against loss of data and loss of work,
should anything go wrong.

Note that, for reasons of security and unlike the other export files produced
by FirstOffice’s Export functions, the files created by the ‘Company Text
Backup’ and ‘Database Text Backup’ functions are encrypted files, not text
files.
For details about restoring from a back-up, please refer to page 493 in
Chapter 12, ‘Imports’.
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Contact Data
This function exports the Customer Number, Name, Contact, Address,
Telephone Number and Fax Number for all Customers in the selection range.

Category

Paste Special

Customer Categories setting

Enter a Category Code to export Customers in a
particular Category.
Customer

Paste Special

Customers and Suppliers in
Customer register

Range Reporting

Alpha

Choose the records to be exported by entering a
Customer Number or a range of Numbers.
When you have entered the search criteria, click the [Run] button. FirstOffice
will open a dialogue box where you can name the export file and specify
where it is to be saved.
Enter a name for the file. Click [Save] or press the Enter key.
A message window informs you about the progress of the export process. The
process can be interrupted at any time by pressing Esc (Windows) or Period (Macintosh).
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Customer Statistics
This command exports monthly sales values for each specified Customer for
the first period in the Reporting Periods setting.

Enter a single Customer Number, or a range of Customer Numbers, separated
by a colon (:) and click [Run]. Use ‘Paste Special’ to select the appropriate
Customer Numbers if necessary. FirstOffice will open a dialogue box where
you can name the export file and specify where it is to be saved.
Enter a name for the file. Click [Save] or press the Enter key.
A message window informs you about the progress of the export process. The
process can be interrupted at any time by pressing Esc (Windows) or Period (Macintosh).
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Invoice Rows
This will export the Invoice rows for a selection of Invoices. The rows will be
exported in a simple table format, with one row per Invoice row. The data
can be imported into other applications, spreadsheets, database programs or
statistical analysis programs.

Period

Paste Special

Reporting Periods setting

Enter the start and end dates for the period to be covered
by the export, separated by a colon (:). The default is the
first period in the Reporting Periods setting.
No

Range Reporting

Numeric

If necessary, specify an Invoice Number or range of
Invoice Numbers separated by a colon (:). Only rows
from Invoices in the range will be exported.
Customer

Paste Special

Customers in Customer register

Range Reporting

Alpha

Enter a Customer Number or range of Numbers to export
rows from Invoices made out to specific Customers.
Item

Paste Special

Item register

Range Reporting

Alpha

Enter an Item Number or range of Numbers to export
Invoices rows featuring specific Items.

483

HansaWorld FirstOffice Start

Invoice Type

Check the boxes to export rows from approved and/or
unapproved Invoices as appropriate.

Click the [Run] button in the Button Bar to proceed. FirstOffice will open a
dialogue box where you can name the export file and specify where it is to be
saved.
Enter a name for the file. Click [Save] or press the Enter key.
A message window informs you about the progress of the export process. The
process can be interrupted at any time by pressing Esc (Windows) or Period (Macintosh).
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Item Statistics
Use this to export statistics about the various Items in your business. The
result is a file with 12 + 12 monthly summaries for the first period in the
Reporting Periods setting. The first group of 12 contains quantities, and the
second group of 12 contains sales values.

Enter a single Item Number or a range of Item Numbers separated by a colon
(:) and click [Run]. Use ‘Paste Special’ to select the appropriate Item
Numbers if necessary. FirstOffice will open a dialogue box where you can
name the export file and specify where it is to be saved.
Enter a name for the file. Click [Save] or press the Enter key.
A message window informs you about the progress of the export process. The
process can be interrupted at any time by pressing Esc (Windows) or Period (Macintosh).
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Monthly Balances
Select this command if you want to export the monthly balances of the
company - for all or a selection of Accounts. The resulting export file can be
read directly by most word processors or spreadsheet programs, for further
processing. You can limit the export to a certain time period or to certain
Accounts.
Open the ‘Exports’ list by clicking the [Exports] button in the Master Control
panel and then double-click ‘Monthly Balances’ to open the ‘Specify
Monthly Balances Export’ window.

Period

Paste Special

Reporting Periods setting

Enter the period for the balances you wish to export. For
each month that is included in the period, a separate
column will be created in the export file.
Account

Paste Special

Accounts setting

Range Reporting

Alpha

Fill out this field if you only want to export the balances
for certain Accounts.
Confirm by clicking [Run] (or cancel using the close box). FirstOffice will
open a dialogue box where you can name the export file and specify where it
is to be saved.
Enter a name for the file, and click [Save] or press the Enter key.
A message window informs you about the progress of the back-up process.
The process can be interrupted at any time by pressing Esc (Windows) or Period (Macintosh).
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SIE (Swedish Std Import/Export)
This option is used in Sweden to export accounting information in a standard
format to other systems. For more details, please contact your local
FirstOffice representative.
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System Data
You can use this function to export basic information from a database. This is
a practical tool when you want to create a new Company that will use the
same basic accounts structure as your existing ones.
You can save much work by simply copying repeated data such as the Chart
of Accounts and afterwards changing whatever is different between the two
Companies.
The System Data export is saved as an ordinary text file and you can import it
to the new Company using the ‘Automatic’ or ‘Automatic, manual file
search’ Import functions (described on pages 493 and 495 respectively in
Chapter 12, ‘Imports’).
Click the [Exports] button in the Master Control panel and double-click
‘System Data’ in the ‘Exports’ list. The ‘Specify System Data Export’
window is opened—

Check the boxes to determine the data to be exported. Click [Run] to proceed.
FirstOffice will open a dialogue box where you can name the export file and
specify where it is to be saved.
Enter a name for the file and click [Save] or press the Enter key.
A message window informs you about the progress of the export. The process
can be interrupted at any time by pressing Esc (Windows) or -Period
(Macintosh).
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Trial Balance
The Trial Balance is a form of combined Balance Sheet and Profit & Loss
report, showing balances for each Account but not debit and credit subtotals.
You may export the Trial Balance for the whole year or for an arbitrary part
of the year as a tab-separated text file, and it can then be imported for further
processing for example by an Annual Report generating program.
Open the ‘Exports’ list and double-click ‘Trial Balance’ to open the ‘Specify
Trial Balance Export’ window.

Period

Paste Special

Reporting Periods setting

Enter the start and end dates for the period to be covered
by the export, separated by a colon (:).
Confirm with [Run] (or cancel using the close box). FirstOffice will open a
dialogue box where you can name the export file and specify where it is to be
saved.
Enter a name for the file. Click [Save] or press the Enter key.
A message window informs you about the progress of the export process. The
process can be interrupted at any time by pressing Esc (Windows) or Period (Macintosh).
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Chapter 12: Imports
The ‘Imports’ function allows you to import information from tab-delimited
text files exported by other FirstOffice databases or Companies, or from other
applications such as spreadsheets. It also imports the encrypted back-up files
created by the ‘Company Text Backup’ and ‘Database Text Backup’ Export
functions.
When you select the function using the ‘Imports’ item on the File menu, an
‘Imports’ list window appears—

There are three import options: double-click one to start the import process.
An ‘Open File’ dialogue box will appear, asking you to locate the file to be
imported. Click [Open] and the import will begin.
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Automatic
You can use the ‘Automatic’ import to import from text and encrypted files
created by any of FirstOffice’s export functions. It determines from
information contained in the first line of such files what the file contains and
thus in which register the information is to be saved.
You should use this function when you need to restore from a back-up.
Please refer to the section describing the ‘Company Text Backup’ and
‘Database Text Backup’ exports on page 478 in Chapter 11, ‘Exports’, for
details about creating back-up files. You can also use the ‘Automatic’ import
to import information to a new Company from an old one.
A further use will be to import set-up information such as a Chart of
Accounts and base register data such as Customers and Suppliers, thus
ensuring that the task of accurately entering this information need only be
undertaken once.
Finally, you can also use this function to import data exported from other
systems, after appropriate formatting. To do this, follow the procedure as
described below, but omit steps 1 and 2. If you have more than one
Company, ensure you are in the correct one before importing.
Restoring from a back-up is done in the following way—
1.

Move the old database (named “1Office.HDB”) to another
folder/directory, to avoid mixing things up. Rename it so that you know
what it contains.

2.

Delete the database file “1Office.HDB” from the folder or directory with
your FirstOffice application, but make sure that the “DBDef.txt” and
“Default.txt” files are present in that folder. Double-clicking the
FirstOffice application now will force it to create a new database.

!

It is important to restore to a new,
empty database, to avoid mixing the
restored data with the old, damaged
database.

3.

Choose ‘Imports’ from the File menu. The ‘Imports’ window is shown.

4.

Select ‘Automatic’ and press the Enter key (or double-click on
‘Automatic’).
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FirstOffice opens a list of back-up files. To be included in this list, a
back-up file must be stored in the “Backup” or “Setup” folder or
directory which should be in the same folder or directory as the
FirstOffice application.
In the list, the filename of each back-up file is shown together with the
date it was saved and any comment added when it was created (this last
is only applicable to back-up files created by clicking the [Backup]
button in the Master Control panel).

5.

Highlight the file you want to import (the back-up to which you wish to
revert) and press the Enter key (or double-click on the name of the file).

6.

A message window informs you about the progress of the import.

7.

When the import has finished, FirstOffice will shut down for reasons of
security if the imported file contains any records in the Persons setting.
Restart the program and you will then be ready to continue working.

!

Copy the old database to another
folder/directory or remove it, to avoid
mixing things up.

If the Restoration Appears to Fail
Files whose name contains a space will be shown in the list of available backup files, but FirstOffice will not be able to import them successfully. If the
name of your back-up file contains a space (or it is not shown in the list of
available files because it is not stored in the “Backup” or “Setup” folder or
directory, or because its name does not have a .txt extension), please refer to
the next section, ‘Automatic, manual file search’.
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Automatic, manual file search
This import is similar to the ‘Automatic’ import described immediately above
in that you can use it to import from files created by any of FirstOffice’s
export functions. The only differences are—
1.

It allows you to import files from anywhere on your hard disk or on your
network, while files imported by the ‘Automatic’ function have to be
located in the “Backup” or “Setup” folders in the same folder as the
FirstOffice application.

2.

It allows you to import files with any filename. The ‘Automatic’ function
is restricted to files whose names do not contain any spaces or other nonalphabetic characters but have .txt extensions.

3.

Comments inserted in any back-up files created by clicking the [Backup]
button in the Master Control panel are not visible when you use the
‘Automatic, manual file search’ function, so be certain that you are
selecting the correct file to be imported. You can see these comments
when you use the ‘Automatic’ import.

To use the function to restore from a back-up, follow procedure below. To
import data exported from other systems, after appropriate formatting or from
other Companies in your FirstOffice database, follow the procedure as
described below, but omit steps 1 and 2. If you have more than one
Company, ensure you are in the correct one before importing.
1.

Move the old database (named “1Office.HDB”) to another
folder/directory, to avoid mixing things up. Rename it so that you know
what it contains.

2.

Delete the database file “1Office.HDB” from the folder or directory with
your FirstOffice application, but make sure that the “DBDef.txt” and
“Default.txt” files are present in that folder. Double-clicking the
FirstOffice application now will force it to create a new database.

!

It is important to restore to a new,
empty database, to avoid mixing the
restored data with the old, damaged
database.

3.

Choose ‘Imports’ from the File menu.
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4.

Select ‘Automatic, manual file search’ and press the Enter key (or
double-click on ‘Automatic, manual file search’).
FirstOffice opens a standard dialogue box with a list of the files in the
current folder of the current volume. To find the back-up file, scroll
through the list or select another folder or volume in the normal way.
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5.

Once you have found the file you want to import (the back-up to which
you wish to revert), highlight it and click [Open] or [Select] (depending
on the operating system), or double-click on the name of the file.

6.

A message window informs you about the progress of the import.

7.

When the import has finished, FirstOffice will then close for reasons of
security if the imported file contains any records in the Persons setting.
Restart the program and you will then be ready to continue working.

!

Copy the old database to another
folder/directory or remove it, to avoid
mixing things up.

Chapter 12: Imports - Automatic, manual file search

SIE (Swedish Std Import/Export)
This option is used in Sweden to import accounting information in a standard
format from other systems. For more details, please contact your local
FirstOffice representative.
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Bank Fee Account, 182, 352
Cash Account, 137, 182, 241, 257, 336
Creditor Account, 137, 181, 257, 275
On Account A/C, 182, 274, 353
Post Payment VAT check box, 183, 261, 349
VAT Code, 137, 182, 275, 336, 338
Account Usage S/L, 184
Bank Fee Account, 186, 325
Base Price options, 188
Cash Account, 134, 187, 241, 303
Debtor Account, 134, 185
On Account A/C, 186, 274, 326
Post Receipt VAT check box, 187, 261, 322
Round Off Account, 185, 254, 307, 339
Sales Account, 134, 186, 275, 295, 308
VAT Code, 134, 187, 275, 295, 306, 308
Write Off Account, 185, 325
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Accounting Periods. See Fiscal Years and
Locking
Accounting Systems
Changing, 158
Accounts, 189
Account Type, 192
Autotransaction, 191
Closed check box, 192
Credit check box, 192
Debit check box, 192
Deleting, 192
Entering, 192
Exporting, 488
Importing a Basic Template, 48
Introduction to, 130
Listing amounts posted to, 444
Modifying, 191
Moving Balances to other Accounts, 213
Printing, 460
Setting up a Basic System, 49
VAT Code, 137, 191
Activate Personal Desktop
Operations menu command, Master Control
Panel, 119
Operations menu command, Persons, 119, 248
Activities, 386
Activity Type, 388
Appearing in Calendar, 195, 390, 392, 406
Appearing in Day Planner, 390, 407
Appearing in Personal Calendar, 409
Appearing in Task Manager, 390, 397
Appearing in To Do List, 246
Approving, 388
Calendar Type, 195, 392
Don't Show, 392
Profile, 392, 406
Time, 392, 406
Cc, 393
Completing, 396
Compulsory Entry of Cost (Time) and
Customer, 195
Compulsory Entry of Elapsed Time, 195
Contact, 394

Index - A
Correcting mistakes after marking as Done,
396
Cost (Time), 389
Creating from Calendar, 386, 407
Creating from Customer Status Report, 277,
387
Creating from Personal Calendar, 387, 410
Creating from Task Manager, 387, 401
Customer, 394
Deleting, 396
Determining Calendar Colour, 195
Done check box, 388
End Date, 389
End Time, 389
Entering, 386
Invalidating, 396
Marking as Done from Day Planner, 407
Marking as Done from Task Manager, 399
Notes, 395
Viewing in Task Manager, 399
Opening from Calendar, 386
Opening from Personal Calendar, 386
Opening from Task Manager, 386, 399
Person, 393
Phone, 394
Preventing double-booking, 195
Priority, 393
Start Date, 389
Start Time, 389
Symbol options, 392
Task Type options, 390
Calendar, 390
Timed To Do, 390
To Do, 390
Text, 388
Viewing, 386
Activity Classes, 194
Calendar Colour, 195
Code, 195
Comment, 195
Force Entry Of options, 195
Activity Type
Activities, 388
Activity Types, 196
Class, 197
Code, 196
Comment, 197

Actual Time, 384
Address
Contact Persons, 292
Invoices, 308
Addresses
Format in printed Documents, 221
Allow Transaction Date Changing
Transaction Settings, 259, 303, 322
Alphabetical Order, 212
Amount
Purchase Invoices, 338
Appearance of Reports
Changing. See Definition of Reports
Archives, 117, 125
Creating, 117, 125
Naming, 118
Removing, 118, 127
Renaming, 126
Attach File
Operations menu command, Attachments, 112
Attachments, 111
Changing Names, 114
Copying, 116
Files, 112
Notes and Comments, 113
Organising, 117
Reading, 112, 113, 116, 123
Records, 114
Removing, 116
Reports, 115
Attachments Button, 111
Attention
Invoices, 304
Automatic
Import function, 493
Automatic, manual file search
Import function, 57, 495
Autotransaction
Accounts, 191
Autotransactions, 198
Account, 199
Code, 199
Credit, 200
Debit, 200
Description, 200
Exporting, 488
Name, 199
Printing, 460
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Using in the Purchase Ledger, 203
VAT Code, 200

B
Backing Up, 51, 478
Automatic, 54
Back-up
Restoring from, 55, 493, 495
Backup Button, 51, 64, 478
Bad Debts. See Write-offs
Balance
Operations menu command, Purchase
Invoices, 343
Balance Sheet, 145, 424
Customising, 424
Deleting Rows, 428
Inserting Rows, 428
Printing, 429
Balance Transaction
Operations menu command, Transactions, 369
Balances
Negative and Positive, 192
Balancing Nominal Ledger Transactions, 361,
364
Bank
Suppliers, 275
Bank 1, Bank 2
Company Info, 211
Bank Account
Purchase Invoices, 335
Setting Default, 135, 138
Suppliers, 275
Bank Account Number
Payment Modes, 239
Payments, 347
Bank Charges. See Bank Fee
Bank Customer ID
Company Info, 40, 211
Bank Fee
Payments, 352
Receipts, 325
Bank Fee Account
Account Usage P/L, 182, 352
Account Usage S/L, 186, 325
Bank Files, 205
Banking File
Exporting, 476
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Base Price
Including or Excluding VAT, 188
Base Price options
Account Usage S/L, 188
Base Registers, 66, 266
Exporting, 477
Base Window, 62
Brought Forward Balances, 167, 206
Account, 207
Adding Rows, 207
Credit, 207
Debit, 207
Description, 207
Difference, 207
Inserting Rows, 207
Number, 206
Removing Rows, 207
Text, 207
Total, 207
Transaction Date, 207
Browse Window, 67
Button Bar, 68
Scrolling, 68
Searching, 69
Sorting Data, 68
Button Bar
in Browse Windows, 68
in Record Windows, 71
Buttons
Attachments, 111
Backup, 51, 64, 478
Calendar, 64
Cancel, 73
Communicate, 72
Companies, 64
Day Planner, 406
Documents, 65
Duplicate, 69, 73
Exports, 65
HansaWorld.com, 58, 66
New, 68, 73
New Activity, 407
New Task, 401
Next Record, 71
OK, 73
Preview, 72
Previous Record, 71
Reports, 64

Index - C
Settings, 65
Tasks, 64

C
Calculated VAT
Purchase Invoices, 339
Calendar, 402
Activities appearing in, 195, 390, 392, 406
Booking Future Time, 392
Creating Activities from, 386, 407
Daily View. See Day Planner
Defining Week Numbers, 263
Determining Colour of Activities, 195
Monthly View, 404
Opening, 402
Showing Time Spent, 392
Six-monthly View. See Overview
Viewing Activities from, 386
Week Numbers are missing, 408
Weekly View, 405
Calendar Activities, 384, 390
Viewing in Calendar, 406
Viewing in Task Manager, 400
Calendar button, 64
Calendar Colour
Activity Classes, 195
Calendar Type
Activities, 195, 392
Don’t Show, 392
Profile, 392
Time, 392
Cancel
Record menu command, 101
Cancel Button, 73
Cash Account
Account Usage P/L, 137, 182, 241, 257, 336
Account Usage S/L, 134, 187, 241, 303
Payment Terms, 241
Setting Default, 135, 138
Cash Customers, 134
Cash Notes, 241, 303, 336
Creating Nominal Ledger Transactions from,
241
Entering, 314
Printing, 415
Reversing, 316, 341

Cash VAT, 183, 187, 261, 322, 349
Cashflow
Reports Aiding Forecasting, 447, 456
Cc
Activities, 393
Century, 218
Change Password
Operations menu command, Master Control
Panel, 66
Operations menu command, Persons, 245
Changing Accounting Systems, 158
Character Set
Company Info, 40, 212
In exported and importable files, 90, 235
Chart of Accounts, 139, 189
Exporting, 488
Printing, 145, 193, 460
Cheques
Returned by Bank, 350, 351
Class
Activity Types, 197
Closed check box
Accounts, 192
Closing
Months and Periods, 236, 368
Code
Activity Classes, 195
Activity Types, 196
Autotransactions, 199
Company, 35
Forms, 227
Payment Modes, 238
Payment Terms, 240
VAT Codes, 260
Comment
Activity Classes, 195
Activity Types, 197
Customers, 274
Payment Modes, 239
Receipts, 321
Comments
Attaching to Records, 113
Attaching to the Personal Desktop, 123
Printing, 113
Reading, 113, 123
Removing, 116
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Communicate Button, 72
Companies, 34, 42, 87, 107, 208
Adding, 40, 42
Changing, 209
Creating, 34
Number of, 41
Reporting on, 433
Selecting, 36
Transferring Information by Dragging and
Dropping, 77
Working with, 107
Companies Button, 64
Company, 33
Code, 35
File menu command, 87
Name, 35
Opening, 33
Selecting, 87
Short, 35
Company Info, 39, 210, 433
Bank 1, Bank 2, 211
Bank Customer ID, 40, 211
Character Set, 40, 212
Edit Font, 40, 211
Report Font, 40, 211
Report Font Size, 211
VAT Law, 40, 211
Company Name
Changing, 39
Company Registration Number. See Registration
Number
Company Text Backup, 478
Configuration, 41, 212
Control String, 43
Connect to get your Enabler
Operations menu command, Configuration, 46
Contact
Activities, 394
Customers, 271, 304
Contact Data
Exporting, 481
Contact History
Building up, for Customers, 390
Contact Persons, 291
Address, 292
Customer, 292
Name, 292
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Contacts. See also Attention
Contents of FirstOffice Directory/Folder, 31
Continuous Stationery, 228
Control String
Configuration, 43
Conversions - Accounts, 213
Conversions - Master, 213
Conversions - Suppliers, 283
Convert Suppliers to Customers function, 290
Convert Suppliers to Customers report, 280
Copies
Operations menu command, Forms, 228
Printing Several, 97
Copy
Edit menu command, 99
Correction List, 434
Correction Mark
Operations menu command, Transactions,
366, 369, 434
Corrections
Transactions, 365
Listing, 434
Cost (Time)
Activities, 389
Forcing Entry of, in Activities, 195
Cost Account. See also Purchase Account
Customers, 137
Setting Default for Purchase Invoices, 275
Suppliers, 275
Create Archive
Operations menu command, Attachments, 117
Operations menu command, Master Control
Panel, 125
Create Note
Operations menu command, Attachments, 113
Operations menu command, Master Control
Panel, 123
Creating Records, 68, 105
Credit
Autotransactions, 200
Brought Forward Balances, 207
Transactions, 361
Credit check box
Accounts, 192
Credit Limit, 216, 273
Customers, 273
Credit Notes, 241, 303, 336
and Cash Notes, 316, 341

Index - D
Entering, 314
Printing, 415
Credit of Invoice
Purchase Invoices, 336, 341
Crediting Purchase Invoices, 336
Creditor Account
Account Usage P/L, 137, 181, 257, 275
Customers, 275
Overall Default, 181
Setting Default, 137, 275
Setting Default for Suppliers, 257, 269
Current Record, 105
Customer
Activities, 394
Contact Persons, 292
Forcing Entry of, in Activities, 195
Invoices, 302
Customer Categories, 217, 269
Customer Category
Customers, 269
Customer check box
Customers, 269
Customer Labels, 416
Designing, 417
Customer List, 436
Customer Name
Customers, 269
Printing in Documents, 221
Customer Number
Customers, 269
Receipts, 322
Customer Statistics, 438
Exporting, 482
Customer Status
Creating Activities from, 277, 387
Operations menu command, Customers, 233,
277
Sales Ledger report, 277
Customers, 156, 267
Building up Contact History, 390
Cash, 134
Comment, 274
Contact, 271, 304
Cost Account, 137
Credit Limit, 273
Creditor Account, 275
Customer Category, 269
Customer check box, 269

Customer Name, 269
Printing in Documents, 221
Customer Number, 269
Deleting, 277
Editing, 276
Email, 271
Entering, 156
Exporting, 477
Fax Number, 271
Inability to copy from one Company to
another, 110
Invoice Address, 271
Listing, 436
Listing Invoices, 233
On Account check box, 182, 186, 273, 322,
326, 348, 353
Payment Terms, 273
Price List, 250, 273
Purchase Credit Limit, 273
Purchase Payment Terms, 273, 335
Registration Number, 272
Sales Credit Limit, 216, 273
Sales Payment Terms, 273, 303
Skype Name, 271
Supplier Category, 269
Supplier check box, 269
Telephone Number, 271
Type, 274
VAT Registration Number, 272
Web Site, 272
Zone, 182, 186, 187, 275, 295
Customising Reports. See Definition of Reports
Cut
Edit menu command, 98

D
Daily Transaction Register. See Transaction
Journal
Daily View
Calendar. See Day Planner
Data
Entering, 154
Exporting, 65, 87
Importing, 88
Database, 33
Creating, 34
Opening, 33
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Structure, 131
Database Backup Path
Timed Operations, 54
Database Backup Time
Timed Operations, 54
Database Key. See Enabler Key
Database Text Backup, 478
Date and Numeric Format, 218
Date Formats
Year 2000, 218
Date Order
In exported and importable files, 88
Dates
and Export Text Files, 219, 474
Day Planner, 406
Activities appearing in, 390, 407
Marking Activities as Done from, 407
Day Planner button, 406
DBDef.txt, 34, 56
Debit
Autotransactions, 200
Brought Forward Balances, 207
Transactions, 361
Debit check box
Accounts, 192
Debt Chasing, 448
Debtor Account
Account Usage S/L, 134, 185
Overall Default, 185
Setting Default, 134, 135
Decimal Character
In exported and importable files, 89
Decimal Places. See Round Off and Rounding
Rules
in Quantities on Printed Invoices, 415
Default Export Codepage, 235
Defaults
Bank Account, 135, 138
Cash Account, 135, 138
Cost Account on Purchase Invoices, 275
Creditor Account, 137, 181, 275
Creditor Account for Suppliers, 257, 269
Debtor Account, 134, 135, 185
Price List, 251
Purchase Account, 136, 181
Reporting Period, 253
Sales Account, 133, 163, 184, 186, 295
VAT Account in Invoices, 134

506

VAT Account in Purchase Invoices, 137
VAT Code for Items, 295
VAT Code for Purchases, 181, 182
VAT Code for Sales, 184, 187
VAT Code on Invoices, 163
Definition of Reports, 252, 421
Balance Sheet, 424
Exporting, 488
Profit & Loss, 452
VAT Report, 467
Delete
Record menu command
Warning before, 102, 235
Deleting Records, 106
Department. See Companies
Deposited
Receipts, 323
Description
Autotransactions, 200
Brought Forward Balances, 207
Price Lists, 250
Purchase Invoices, 338
VAT Codes, 262
Destination
Specifying when Printing Reports, 92
Difference
Brought Forward Balances, 207
Transactions, 361
Discount
Invoices, 306
Disk Space, 103
Document Editor, 222
Documents, 130, 412
Address Formats, 221
Adjusting Page Setup/Magnification, 97
Attaching to the Personal Desktop, 122
Cash Note, 415
Credit Note, 415
Customer Labels, 416
Defining, 95
Invoices, 414
Matrix field columns not aligned correctly,
226
Printing in Documents, 221
Printing more than one Copy, 97
Superimposed Text, 225

Index - E
Documents Button, 65
Done check box
Activities, 388
Updating from Day Planner, 407
Updating from Task Manager, 399
Don't Show Activities, 392
Download File
Operations menu command, Attachments, 112
Drag and Drop
Using to Copy Data between Companies, 77
Using to Insert Data into Fields, 77
Drill-down in Reports, 81
Drill-down reports, 421
Due Date
Invoices, 304
Purchase Invoices, 336
Duplicate button, 69, 73
Duplicating Records, 69, 105

E
Edit Font
Company Info, 40, 211
Edit Link Comment
Operations menu command, Attachments, 114
Operations menu command, Master Control
Panel, 123
Edit Menu, 98
Copy, 99
Cut, 98
Elapsed Time. See Cost (Time)
Electronic Invoicing, 219
Email
Customers, 271
Enabler Key, 43
Enablers, 233
End Date
Activities, 389
End Time
Activities, 389
Entering Records, 68, 105
Error Messages
Already Registered, 251
Can’t find document, 314, 415
Code not registered, 134, 137
Debtor Account missing, 134
Month checked, 237
Month locked, 237

On Creating Transactions from Invoices, 310
On Creating Transactions from Purchase
Invoices, 341
Sales Account missing, 134
Transaction out of balance, 343
EU
VAT on Acquisitions, 261, 337
Example Database, 32
Excel. See Microsoft Excel
Excl %
VAT Codes, 260
Exclude from page options
Forms, 229
Expense Account. See Purchase Account
Export Files
Opening in Excel, 219, 474
Exporting Data, 65, 87
Exports, 474
Attaching to the Personal Desktop, 122
Banking File, 476
Base Registers, 477
Company Text Backup, 478
Contact Data, 481
Customer Statistics, 482
Database Text Backup, 478
Invoice Rows, 483
Item Statistics, 485
Monthly Balances, 486
SIE (Swedish Std Import/Export), 487
System Data, 488
Trial Balance, 489
Exports Button, 65

F
Fax Number
Customers, 271
Fields
in Forms, 225
Moving between, 70
File Dialogue Window, 85
File Menu
Imports, 88
Master Control, 87
Page Setup, 97
Print, 72, 97
Reports, 91
Settings, 39, 97
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Files. See Registers
Attaching to Records, 112
Reading, 112
Removing, 116
Financial Years. See Fiscal Years
First Only
Operations menu command, Forms, 230
FirstOffice
Base Window, 62
Changing To, 158
Importing process appears to fail, 57, 494
Installation, 25
Keyboard Commands, 128
Quitting, 98
Starting, 33
Structure, 131
Structure of Registers, 18
Updating from Previous Versions, 58
Version Number, 103
Website, 58, 66
Work Area, 62
FirstOffice Directory
Contents, 31
FirstOffice Folder
Contents, 31
Fiscal Years, 151, 220
Ending, 143
Fonts
Setting for Reports, 40
Force Entry Of options
Activity Classes, 195
Form Editor, 222
Form Settings, 221
Forms, 96, 222. See also Documents
Address Formats, 221
Code, 227
Defining Type Styles, 255
Exclude from page options, 229
Exporting, 477
Fields, 225
Frames, 225
Lines, 225
Matrix field columns not aligned correctly,
226
Naming, 227
Pictures, 226
Printing, 231
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Printing a specific number of copies
automatically, 228
Printing in Documents, 221
Printing on Continuous Stationery, 228
Single- and Multi-page, 229
Superimposed Text, 225
Text Objects, 223
Formulae
Using in Nominal Ledger Transactions, 200
FOStartDemoDataMay2005.Txt
Example Database, 32
FOStartForms.Txt
Accounts Template File, 32
FOStartStandard.Txt
Accounts Template File, 32
Frames
in Forms, 225

G
Gross Margin
Reporting, 438
Gross Profit
Reporting, 438

H
HansaWorld.com, 58
HansaWorld.com button, 66
HDB File, 33

I
I/P Account
VAT Codes, 261, 349
Importing Files
Process Appears to Fail, 57, 494
Imports, 492
Attaching to the Personal Desktop, 122
Automatic, 493
Automatic, manual file search, 57, 495
Character Set, 90, 235
Date Order, 88
Decimal Character, 89
File menu command, 88
Machine Mode, 89
Replacing existing data, 89
SIE (Swedish Std Import/Export), 497

Index - I
Incl %
VAT Codes, 260
Info on Customer Status Report, 233, 277
Initials. See Signature
Inp A/C. See Input Account
Input Account
VAT Codes, 137, 261
Installation, 25
Linux, 25
Macintosh, 25
Windows, 25
Integration, 131
Workflow, 20
Internet Enablers, 44
Invoice Address
Customers, 271
Invoice Date
Invoices, 303
Purchase Invoices, 334
Invoice History
Viewing for each Customer, 277
Viewing for each Supplier, 278
Invoice Journal, 442
Invoice Number
Invoices, 302
Receipts, 321
Invoice Rows
Exporting, 483
Not printed correctly in Documents, 226
Invoice Status
Operations menu command, Invoices, 317
Operations menu command, Purchase
Invoices, 342
Invoices, 132, 162, 299
Account for Amounts Lost/Gained after
Rounding, 185
Address, 308
Approving, 307, 310, 317
Attention, 304
Crediting, 314
Customer, 302
Discount, 306
Due Date, 304
Entering, 159, 301, 309
Generating Nominal Ledger Transactions
from, 132
Invoice Date, 303
Invoice Number, 302

Item Number, 305
Listing for a Customer, 233
Number of Decimal Places in Quantity column
when printing, 415
Official Serial Number, 305
OK check box, 307, 310, 317
Our Reference, 303
Paying off, 321
Payment Terms, 303
Printing, 311, 414
Quantity, 306
Sales Account, 133
Service Delivery Date, 304
Setting Rounding Rules for Total, 254, 307
Setting Rounding Rules for VAT, 254, 307
Subtotal, 307
Sum, 306
Total, 307
Transaction Date, 304
Unit Price, 306
VAT, 307
VAT Account, 134
VAT Code, 306
Viewing Transactions Generated From, 318
Writing Off, 185, 325
Zone, 308
Item Group
Items, 295
Item Groups, 234, 295
Item List, 440
Item Number
Invoices, 305
Items, 295
Item Rows
Not printed correctly in Documents, 226
Item Statistics, 441
Exporting, 485
Items, 158, 294
Deleting, 296
Entering, 158
Item Group, 295
Item Number, 295
Name, 295
Price, 249, 250, 295
Sales Account, 134, 295
Unit, 295
VAT Code, 295
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J
Job Description
Persons, 244
Journal Entries. See Transactions
Journals Report, 442

K
Key, 43
Keyboard Shortcuts, 128

L
Labels
Designing, 417
Printing for Customers, 416
Printing Static Text, 417
Last Only
Operations menu command, Forms, 230
Launching FirstOffice, 33
Importing process appears to fail, 57, 494
Lines
in Forms, 225
Linux
Installation, 25
System Requirements, 25
List Window, 83
Loading FirstOffice, 33
Importing process appears to fail, 57, 494
Local Machine, 235
Locking, 236
Months and Periods, 236, 368
Lookup Table
Using to Insert Data into Fields, 73
Loss
Posting, 150

M
Macintosh
Installation, 25
System Requirements, 25
Maintenance Functions
Attaching to the Personal Desktop, 122
Convert Suppliers to Customers, 290
Prepare Conversion Suppliers Settings, 284
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Maintenance Window, 90
Master Control
File menu command, 87
Master Control Panel, 63
Backup button, 64, 478
Calendar button, 64
HansaWorld.com button, 58, 66
Personal Desktop, 119
Tasks button, 64
Master Control panel Buttons
Companies, 64
Documents, 65
Exports, 65
Reports, 64
Settings, 65
Matrix Columns
Not printed correctly in Documents, 226
Menus
Edit, 98
Record, 100
Window, 102
Microsoft Excel
Opening Reports in, 93
Middle Only
Operations menu command, Forms, 230
Modifying Records, 69
Monthly Balances
Exporting, 486
Monthly View
Calendar, 404
Months
Locking/Closing, 236, 368
Multi-company Capability, 33
Multi-page Forms, 229

N
Name
Autotransactions, 199
Company, 35
Contact Persons, 292
Items, 295
Name of Company
Changing, 39
Names of Attachments
Changing, 114
Net Days
Payment Terms, 241

Index - O
New Activity button, 407
New button, 68, 73
New Fee
Operations menu command, Payments, 352
Operations menu command, Receipts, 325
New Task button, 401
New Write-off
Operations menu command, Receipts, 185,
325
Next Record button, 71
Nominal Ledger, 298
Entering Opening Balances, 166
Nominal Ledger Report, 144, 444
Nominal Ledger Transactions. See Transactions
Notes
Activities, 395
Viewing in Task Manager, 399
Attaching to Records, 113
Attaching to the Personal Desktop, 123
Printing, 113
Reading, 113, 123
Removing, 116
Notional EU VAT, 261, 337
Number Format, 218
Number of Companies, 41

O
O/P Account
VAT Codes, 261, 323
Official Serial Number
Invoices, 305
OK
Operations menu command, Invoices, 317
Operations menu command, Payments, 352
Operations menu command, Purchase
Invoices, 342
Operations menu command, Receipts, 324
OK Button, 73
OK check box
Invoices, 307, 310 , 317
Payments, 350, 351, 352
Purchase Invoices, 338, 340
Receipts, 323, 324
On Account A/C
Account Usage P/L, 182, 274, 353
Account Usage S/L, 186, 274, 326

On Account check box
Customers, 182, 186, 273, 322, 326, 348, 353
On Account Payments, 182, 273, 353
VAT, 183, 349
On Account Receipts, 186, 273, 326
VAT, 187, 323
Open Invoice Value
Payments, 349
Receipts, 322
Open NL Transaction
Operations menu command, Invoices, 318
Operations menu command, Payments, 353
Operations menu command, Purchase
Invoices, 344
Operations menu command, Receipts, 325
Open Record
Operations menu command, Attachments, 115
Operations menu command, Master Control
Panel, 121, 122
Opening Balances. See also Brought Forward
Balances
Entering, 158
Importing, 171
Nominal Ledger, 166
Purchase Ledger, 166
Sales Ledger, 159
Operations Menu (Attachments)
Attach File, 112
Create Archive, 117
Create Note, 113
Download File, 112
Edit Link Comment, 114
Open Record, 115
Show To Links, 114
Operations Menu (Configuration)
Connect to get your Enabler, 46
Operations Menu (Customers), 277
Customer Status, 233, 277
Supplier Status, 278
Operations Menu (Forms), 227
Copies, 228
First Only, 230
Last Only, 230
Middle Only, 230
PC Printer, 228
Properties, 227
Send to Back, 229
Single Page Only, 230

511

HansaWorld FirstOffice Start
View All, 230
Operations Menu (Invoices), 316
Invoice Status, 317
OK, 317
Open NL Transaction, 318
Operations Menu (Master Control Panel)
Activate Personal Desktop, 119
Change Password, 66
Create Archive, 125
Create Note, 123
Edit Link Comment, 123
Open Record, 121, 122
Operations Menu (Payments), 352
New Fee, 352
OK, 352
Open NL Transaction, 353
Order, 352
Operations Menu (Persons), 245
Activate Personal Desktop, 119, 248
Change Password, 245
To Do List, 246
Operations Menu (Purchase Invoices), 342
Balance, 343
Invoice Status, 342
OK, 342
Open NL Transaction, 344
Operations Menu (Receipts), 324
New Fee, 325
New Write-off, 185, 325
OK, 324
Open NL Transaction, 325
Operations Menu (Reports)
Recalculate, 423
Reopen Report Specification, 81
Operations Menu (Transactions), 369
Balance Transaction, 369
Correction Mark, 366, 369 , 434
Swap Debit & Credit, 365
Swap Debit & Credit, 369
Update Mark, 367, 434
Update Mark, 369
Options List
Using to Insert Data into Fields, 73
Order
Operations menu command, Payments, 352
Ordered check box
Payments, 350, 351
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Our Ref
Persons, 244
Our Reference
Invoices, 303
Persons, 303
Outp A/C. See Output Account
Output Account
VAT Codes, 134, 261
Overview, 402
Overview Window. See Browse Window
Own Bank Account Number
Payments, 347

P
Page Setup
for Reports, 91, 92, 252
Paper Clip. See Attachments
Password
Persons, 66, 245
Paste Special, 73
Payment Date
Payments, 347
Receipts, 322
Payment Journal, 442
Payment Methods. See Payment Modes
Payment Mode
Payments, 347
Receipts, 321
Payment Modes, 136, 138, 161, 238, 321, 347
Account, 238
Bank Account Number, 239
Code, 238
Comment, 239
Exporting, 488
Payment Number
Payments, 347
Payment Terms, 240, 273, 335
Cash Account, 241
Code, 240
Customers, 273, 303
Exporting, 488
Invoices, 303
Net Days, 241
Purchase Invoices, 335
Text, 241
Type, 241
Using to create Credit Notes, 315

Index - P
Payments, 137, 166, 345
Approving, 350, 351, 352
Bank Fee, 352
Correcting Mistakes, 357
Entering, 345, 350
Generating Nominal Ledger Transactions
from, 137
OK check box, 350, 351, 352
On Account, 182, 273, 348
Open Invoice Value, 349
Ordered check box, 350, 351
Own Bank Account Number, 347
Payment Date, 347
Payment Mode, 347
Payment Number, 347
Purchase Invoice Number, 348
Reconciling, 351
Scheduling, 447
Sent Value, 349
Supplier Number, 348
Text, 348
Transaction Date, 347
VAT, 349
VAT Code, 349
VAT in On Account Payments, 183, 349
Viewing Transactions Generated From, 353
Withdrawn, 350
Payments Forecast, 447
PC Printer
Operations menu command, Forms, 228
Period Locking. See Locking
Periodic Customer Statement, 448
Periodic Supplier Statement, 450
Periods. See Reporting Periods
Locking/Closing, 236, 368
Person
Activities, 393
Personal Calendar
Activities appearing in, 409
Creating Activities from, 387, 410
Printing, 410
Viewing Activities from, 386
Personal Calendar Report, 409
Personal Desktop, 119
Activating, 248
Archives, 125
Creating, 125
Removing, 127

Renaming, 126
Attaching Notes and Comments, 123
Changing Names of Items, 123
Organising, 125
Reading Notes and Comments, 123
Removing Items from, 125
Working with Records, 121
Working with Registers, 122
Working with Reports, 124
Working with Settings, Reports, Documents
and Maintenance functions, 122
Personal Registers, 372
Persons, 243
Entering, 154
Job Description, 244
Our Ref, 244
Our Reference, 303
Password, 66, 245
Signature, 244
Phone
Activities, 394
Pictures
in Forms, 226
Planned Time, 384
Post Payment VAT check box
Account Usage P/L, 183, 261, 349
Post Receipt VAT check box
Account Usage S/L, 187, 261, 322
Preferences. See Settings
Prepare Conversion Suppliers Settings function,
284
Preview Icon, 72
Previous Record button, 71
Price
Items, 249, 250, 295
Price List
Customers, 250, 273
Setting Default, 251
Price List Code
Price Lists, 250
Price Lists, 249, 250
Description, 250
Inclusive or Exclusive of VAT, 250
Price List Code, 250
Setting Up, 250
Structure, 249
Prices, 249, 250
Sales Account, 134, 251
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Setting up Multiple Price Lists, 249
Pricing of Invoices
Selecting Discount, 306
Selecting Unit Price, 306
Print
File menu command, 72
Print Destination
Specifying for Reports, 92
Printer Dialogue
Appearing before Printing Reports, 92
Printer Icon, 72
Printing
Forms, 231
Priority
Activities, 393
Products. See Items
Profile Activities, 384, 392, 406
Profit
Posting, 150
Profit & Loss
Customising, 452
Printing, 452
Profit & Loss Report, 145, 452
Properties
Operations menu command, Forms, 227
Purchase Account. See also Cost Account
Setting Default, 136, 181
Purchase Credit Limit
Customers, 273
Purchase Invoice History
Viewing for each Supplier, 278
Purchase Invoice Journal, 442
Purchase Invoice Number
Payments, 348
Purchase Invoices, 333
Purchase Invoices, 136, 166, 331
Account, 337
Account for Amounts Lost/Gained after
Rounding, 185
Amount, 338
Approving, 338, 340
Balancing, 343
Bank Account, 335
Calculated VAT, 339
Credit of Invoice, 336, 341
Crediting, 336, 341
Description, 338
Determining Default Cost Account, 275
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Due Date, 336
Entering, 166, 333, 339
Generating Nominal Ledger Transactions
from, 136
Invoice Date, 334
OK check box, 338, 340
Paying off, 348
Payment Terms, 335
Purchase Account, 136
Purchase Invoice Number, 333
Setting Rounding Rules for VAT, 254, 339
Supplier, 334
Supplier’s Invoice Number, 335
Total, 335
Transaction Date, 334
VAT, 335
VAT Account, 137
VAT and EU, 261, 337
VAT Code, 338
Viewing Transactions Generated From, 344
Zone, 336
Purchase Ledger, 298
Entering Opening Balances, 166
Purchase Ledger Report, 454
Purchase Payment Terms
Customers, 273, 335

Q
Quantity
Invoices, 306
Number of Decimal Places on Printed
Invoices, 415

R
Recalculate
Operations menu command, Reports, 423
Recalculation of reports, 423
Receipt Journal, 442
Receipts, 135, 164, 319
Approving, 323, 324
Bank Fee, 325
Comment, 321
Correcting Mistakes, 330
Customer Number, 322
Deposited, 323
Entering, 164, 319

Index - R
Generating Nominal Ledger Transactions
from, 135
Invoice Number, 321
OK check box, 323, 324
On Account, 186, 273, 322
Open Invoice Value, 322
Payment Date, 322
Payment Mode, 321
Received Value, 322
Serial Number, 320
Text, 322
Transaction Date, 321
VAT, 322
VAT Code, 322
VAT in On Account Receipts, 187, 323
Viewing Transactions Generated From, 325
Receipts Forecast, 456
Received Value
Receipts, 322
Reconciling a Payment, 351
Record Menu, 100
Cancel, 101
Delete
Warning before, 102, 235
Record Window, 69
Button Bar, 71
Moving from field to field, 70
Records
Attaching Files, 112
Attaching Notes and Comments, 113
Attaching other Records, 114
Attaching Reports, 115
Attaching to the Personal Desktop, 121
Copying, 101
Creating, 68, 101, 105
Current, 105
Deleting, 101, 106
Warning before, 102, 235
Duplicating, 69, 105
Modifying, 69
Opening Attached Records, 115
Printing Notes and Comments, 113
Reading Attached Files, 112
Reading Attached Reports, 116
Reading Notes and Comments, 113
Removing Attachments, 116
Registers
Activities, 386

Attaching to the Personal Desktop, 122
Contact Persons, 291
Customers, 156, 267
Invoices, 162, 299
Items, 158, 294
Payments, 166, 345
Purchase Invoices, 166, 331
Receipts, 164, 319
Structure of, 18
Suppliers. See Customer register
Transactions, 169, 358
Registration Number
Customers, 272
Removing Attachments, 116
Reopen Report Specification
Operations menu command, Reports, 81
Report Definitions. See Definition of Reports
Report Font
Company Info, 40, 211
Report Font Size
Company Info, 211
Report Settings, 252, 421
Report Window, 78
Reporting Period
Setting Default, 253
Reporting Periods, 253
Reports, 130, 420
Adjusting Page Setup/Magnification, 97
as Attachments, 115
Reading, 116
Attaching to the Personal Desktop, 122, 124
Balance Sheet, 145, 424
Definition, 424
Changing Report Criteria, 93
Company Info, 433
Convert Suppliers to Customers, 280
Correction List, 434
Customer List, 436
Customer Statistics, 438
Customer Status, 277
Customising. See Definition of Reports
Defining, 92
Drill-down, 81, 421
Item List, 440
Item Statistics, 441
Journals, 442
Nominal Ledger, 144, 444
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Opening in Excel, 93
Page Setup, 91, 92, 252
Payments Forecast, 447
Periodic Customer Statement, 448
Periodic Supplier Statement, 450
Personal Calendar, 409
Printing, 171
Printing more than one Copy, 97
Profit & Loss, 145, 452
Definition, 452
Purchase Ledger, 454
Recalculating, 81, 93
Recalculation, 423
Receipts Forecast, 456
Sales Ledger, 457
Saving to Disk, 93
Selecting Print Destination, 92
Setting Fonts, 40
Specifying Printer Dialogue, 92
Supplier List, 459
System Documentation, 145, 460
Transaction Journal, 145, 461
Trial Balance, 168, 171, 172, 464
Underlined Text, 82, 423
VAT Listing, 466
VAT Report, 467
Definition, 467
Reports Button, 64
Restoring from a Back-up, 55, 493, 495
Appears to Fail, 57
Process Appears to Fail, 494
Round Off, 185, 254, 307, 339
Round Off Account
Account Usage S/L, 185, 254, 307, 339
Rounding Rules
Account for Amounts Lost/Gained after
Rounding, 185
Setting for Invoice Total, 254
Setting for Total, 307
Setting for VAT, 254, 307, 339
Rows
Adding to Brought Forward Balances, 207
Inserting in Brought Forward Balances, 207
Not printed correctly in Documents, 226
Removing from Brought Forward Balances,
207
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S
Safety Back-up, 51, 478
Automatic, 54
Restoring from, 55, 493
Sales Account
Account Usage S/L, 134, 186, 275, 295, 308
Items, 134, 295
Prices, 134, 251
Setting Default, 133, 163, 184, 186, 295
Sales Credit Limit
Customers, 216, 273
Sales Invoices. See Invoices
Sales Ledger, 298
Entering Opening Balances, 159
Sales Ledger Report, 457
Sales Payment Terms, 303
Customers, 273
Scrolling
in a Browse Window, 68
Searching
in a Browse Window, 69
Using a Wildcard, 69
Selection List
Using to Insert Data into Fields, 73
Send to Back
Operations menu command, Forms, 229
Sent Value
Payments, 349
Serial Number
Receipts, 320
Service Delivery Date
Invoices, 304
Settings, 38, 65, 97, 176
Account Usage P/L, 181
Account Usage S/L, 184
Accounts, 189
Activity Classes, 194
Activity Types, 196
Attaching to the Personal Desktop, 122
Autotransactions, 198
Bank Files, 205
Brought Forward Balances, 167, 206
Companies, 34, 42, 87, 107, 208
Company Info, 39, 210
Configuration, 41, 212
Conversion - Accounts, 213
Conversion - Suppliers, 283

Index - S
Conversions - Master, 213
Credit Limit, 216, 273
Customer Categories, 217, 269
Date and Numeric Format, 218
Electronic Invoicing, 219
Exporting Contents, 488
File menu command, 39, 97
Fiscal Years, 151, 220
Form Settings, 221
Forms, 96, 222
info on Customer Status Report, 233, 277
Internet Enablers, 44, 233
Item Groups, 234, 295
Local Machine, 235
Locking, 236
Payment Modes, 136, 138, 161, 238, 321, 347
Payment Terms, 240, 273, 303, 335
Persons, 243
Price Lists, 249, 250
Prices, 249, 250
Report Settings, 252, 421
Reporting Periods, 253
Round Off, 185, 254, 307, 339
Styles, 255
Supplier Categories, 257
Suppliers Categories, 269
Text Types, 258
Timed Operations, 54
Transaction Settings, 259
VAT Codes, 134, 137, 260, 306, 338
Weeks, 263
Short
Company, 35
Show To Links
Operations menu command, Attachments, 114
SIE Export (Swedish Std Import/Export), 487
SIE Import, 497
Signature
Persons, 244
Single Page Only
Operations menu command, Forms, 230
Single-page Forms, 229
Six-Monthly View
Calendar. See Overview
Skype Name
Customers, 271

Sort Order, 212
Sorting
in a Browse Window, 68
Specification Window, 84
Start Date
Activities, 389
Start Time
Activities, 389
Starting FirstOffice, 33
Static Text
Showing on Labels, 417
Structure of FirstOffice, 131
Styles, 255
Exporting, 477
Sub Systems, 298, 358
Subsidiary Companies. See Companies
Subtotal
Invoices, 307
Sum
Invoices, 306
Superimposed Text
Printed in Documents, 225
Supplier
Purchase Invoices, 334
Supplier Categories, 257, 269
Supplier Category
Customers, 269
Supplier check box
Customers, 269
Supplier List, 459
Supplier Number
Payments, 348
Supplier Status
Operations menu command, Customers, 278
Supplier’s Invoice Number
Purchase Invoices, 335
Suppliers. See also Customers
Bank, 275
Bank Account, 275
Copying into Customer register, 279
Cost Account, 275
Entering, 156
Exporting, 477
Listing, 459
Swap Debit & Credit
Operations menu command, Transactions,
365, 369
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Swedish Standard Import/Export. See SIE
Symbol options
Activities, 392
System Data
Exporting, 488
System Documentation, 145
System Documentation Report, 460
System Requirements
Linux, 25
Macintosh, 25
Windows, 25

T
Tabs, 71
Task Manager, 397
Activities appearing in, 390, 397
Creating Activities from, 387, 401
Images in Priority column, 392
Marking Activities as Done from, 399
Opening Activities from, 399
Printing, 401
Viewing Activities from, 386
Viewing Activities marked as Done, 400
Viewing Activities to be done in the future,
400
Viewing Calendar and Timed To Do
Activities, 400
Task Type options
Activities, 390
Calendar, 390
Timed To Do, 390
To Do, 390
Tasks button, 64
Telephone Button. See Communicate Button
Telephone Number
Customers, 271
Test Printout, 311
Text
Activities, 388
Brought Forward Balances, 207
Payment Terms, 241
Payments, 348
Receipts, 322
Transactions, 361
Text Back-up
Creating, 51, 478
Creating Automatically, 54

518

Restoring from, 55, 493, 495
Text Files
Opening in Excel, 219, 474
Text Objects
in Forms, 223
Text Types, 258
The Printer, 72
Time Activities, 384, 392, 406
Timed Operations, 54
Database Backup Path, 54
Database Backup Time, 54
Timed To Do Activities, 384, 390
Viewing in Day Planner, 407
Viewing in Task Manager, 400
To Do Activities, 384, 390
Viewing in Task Manager, 397
To Do List. See Task Manager
Activities appearing in, 246
Operations menu command, Persons, 246
Printing, 248
Total
Account for Amounts Lost/Gained after
Rounding, 185
Brought Forward Balances, 207
Invoices, 307
Purchase Invoices, 335
Setting Rounding Rules, 254, 307
Transactions, 361
Transaction Date
Brought Forward Balances, 207
Invoices, 304
Payments, 347
Purchase Invoices, 334
Receipts, 321
Transactions, 361
Transaction Journal, 145, 461
Transaction Number
Brought Forward Balances, 206
Transactions, 360
Transaction Records. See Transactions
Transaction Registers, 65, 298
Transaction Rows
Listing, 444
Transaction Settings, 259
Allow Transaction Date Changing, 259, 303,
322
Transactions, 131, 169, 358
Account, 361

Index - U
Allowing Changes after Entry, 368
Automating the entry of, 198
Balancing, 369
Changing, 367
Corrections, 365
Listing, 434
Credit, 361
Debit, 361
Difference, 361
Easy way to balance, 364
Entering, 166, 359, 362
Generated from Sub Systems
Cash Notes, 241
Generating from Sub Systems
Invoices, 132
Payments, 137
Purchase Invoices, 136
Receipts, 135
Opening from
Invoices, 318
Payments, 353
Purchase Invoices, 344
Receipts, 325
Reversing, 365
Sales Invoices, 132
Text, 361
Total, 361
Transaction Date, 361
Transaction Number, 360
VAT Code, 362
Trial Balance, 168, 171, 172, 464
Exporting, 489
Turnover
Reporting, 438
Type
Customers, 274
Payment Terms, 241
Type Styles. See Styles

U
UKAccounts1.Txt
Accounts Template File, 32, 49
Uncleared Funds, 350, 351
Underlined Text in Reports, 82, 423
Unicode, 90, 235
Unit
Items, 295

Unit Price
Use in Pricing Invoices, 306
Update Mark
Operations menu command, Transactions,
367, 369, 434
Updating from Previous Versions, 58
User Company. See Company Info

V
VAT
Account for Amounts Lost/Gained after
Rounding, 185
and Purchase Invoices from the EU, 261, 337
Base Prices include or exclude, 188
Cash VAT Scheme, 183, 187, 261, 322, 349
Determining its posting in the Nominal
Ledger, 260
in On Account Payments, 183, 349
in On Account Receipts, 187, 323
Invoices, 307
Payments, 349
Purchase Invoices, 335
Receipts, 322
Setting Rounding Rules, 254, 307, 339
Using with Price Lists, 250
VAT Account
Setting Default for Invoices, 134
Setting Default for Purchase Invoices, 137
VAT Code
Account Usage P/L, 137, 182, 275, 336, 338
Account Usage S/L, 134, 187, 275, 295 , 306,
308
Accounts, 137, 191
Autotransactions, 200
Invoices, 306
Items, 295
Payments, 349
Purchase Invoices, 338
Receipts, 322
Setting Default for Invoices, 163
Setting Default for Items, 295
Setting Default for Purchases, 181, 182
Setting Default for Sales, 184, 187
Transactions, 362
VAT Codes, 134, 137, 260, 306, 338
Code, 260
Description, 262
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Excl %, 260
Exporting, 488
I/P Account, 261, 349
Incl %, 260
Input Account, 137, 261
O/P Account, 261, 323
Output Account, 134, 261
VAT Law
Company Info, 40, 211
VAT Listing, 466
VAT Registration Number
Customers, 272
VAT Report, 467
Change in syntax for FirstOffice version 4.1,
468
Commands used in Report Definition
Formulae, 469
Customising, 467
Printing, 472
VAT Return. See VAT Report
VAT Zone. See Zone
V-Cd. See VAT Code
Version Number, 103
View All
Operations menu command, Forms, 230
Virus
Removing, 51

W
Web Site
Customers, 272
Website (HansaWorld.com), 66
Website (www.hansaworld.com), 58
Week Numbers
Defining for the Calendar, 263
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Missing from Calendar, 408
Weekly View
Calendar, 405
Weeks, 263
Wildcard. See Paste Special
Use in Searches, 69
Window Menu, 102
Window Title, 35
Windows
Closing and Saving Changes, 101
Closing without Saving Changes, 101
Management of, 67
Windows (Microsoft)
Installation, 25
System Requirements, 25
Withdrawn
Payments, 350
Work Area, 62
Workflow, 20
Working with FirstOffice, 154
Write Off Account
Account Usage S/L, 185, 325
Writing Off Invoices, 185, 325

Y
Y2K, 218
Year 2000, 218

Z
Zone
Customers, 182, 186, 187, 275, 295
Invoices, 308
Purchase Invoices, 336
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